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Safety Precautions 
 
For your safety from the Braille Sense U2 QWERTY, please read safety 
precautions carefully. 

 
1. The input voltage of the AC adapter is 100V - 240V, and the output 

is DC 5V / 2A. 
 

2. When the Braille Sense U2 QWERTY is shipped, the battery may be 
separate from the unit to avoid damage. The battery may not be fully 
charged when it is shipped. Before you use the Braille Sense U2 
QWERTY, you should make sure the battery is fully charged. When 
you use the Braille Sense U2 QWERTY for the first time, you may 
need to open the package, take the battery, and insert it into the 
battery slot at the rear panel of the unit. It is possible that the dealer 
or distributor from whom you purchased the Braille Sense U2 
QWERTY from has already done this for you. 
 

3. When you use the Braille Sense U2 QWERTY with the battery for 
the first time, the battery status may not be displayed accurately. In 
order to avoid this, connect the Braille Sense U2 QWERTY to the 
AC adapter for about six hours with turn on. If you want to use the 
Braille Sense U2 QWERTY immediately after opening the box, you 
will need to connect the AC adapter to the unit for more than six 
hours to fully charge the battery. 
 

4.  If you want or need to take the battery out of the unit, turn the power 
off, and then take the battery out of the unit. Before putting the 
battery back in to the unit, make certain that the power is off. 
There is a risk of explosion if battery is replaced by an incorrect type. 
Please dispose of used batteries according to the instructions. 
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5. When you are using the Braille Sense U2 QWERTY on battery 
power only (without the AC adapter), the status of the remaining 
battery power will be announced when the battery power is low. 
When the battery’s charge falls below 15 percent, connect the AC 
adapter to the unit for recharging. If the remaining battery power 
drops to five percent, and the unit is not connected to the AC 
adapter, the Braille Sense U2 QWERTY will shut down one minute 
after the announcement of the battery’s status. The amount of 
battery life per charge will vary depending on the options you have 
set. 
 

6. Your Braille Sense U2 QWERTY needs to be handled with care. The 
Braille Sense U2 QWERTY is a very delicate machine. You should 
make sure to handle the unit in a proper manner. Also, the Braille 
Sense U2 QWERTY is very sensitive to dust. Make sure to keep the 
Braille Sense U2 QWERTY away from dusty environments. 
 

7. The Braille cells are very sensitive parts. If any of the Braille cells 
are not working properly due to dust or any other reason, please 
contact our repair center, or the dealer whom you purchased the 
Braille Sense U2 QWERTY from for support. 
 

8. You will need to register your Braille Sense U2 QWERTY in order to 
ensure further maintenance, service, and upgrade information. 
Please visit www.hims-inc.com, to register your information. If you 
have any trouble when registering your information, please contact 
the dealer whom you purchased your Braille Sense U2 QWERTY 
product from for help. 
 

9. Do not take apart the Braille Sense U2 QWERTY by yourself. Do not 
have anyone else who is not authorized by HIMS take apart the 
Braille Sense U2 QWERTY. If an unqualified person disassembles 
the unit, serious damage may occur to the Braille Sense U2 
QWERTY. If an unauthorized person disassembles the Braille Sense 
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U2 QWERTY, the unit will be excluded from any free maintenance, 
and the warranty will become void. If any liquid or external force 
damages the unit, it may also be excluded from free maintenance, 
even if the damage occurred during the warranty period. 
 

10. If you let your Braille Sense U2 QWERTY remain for a long time at 
the closed or high temperature places like inside of car, the battery 
attached to the Braille Sense U2 QWERTY may be defected or fired. 
So please don’t keep your Braille Sense U2 QWERTY at those 
places. 
 

11. If you have any complaints or suggestions, please provide us with 
your comments on our website. We will improve our product based 
on your comments and suggestions. Thank you for using the Braille 
Sense U2 QWERTY, and we value any comments or suggestions 
you have for our product. 
 

12. To prevent possible hearing damage, do not listen at high volume 
levels for long periods. 
 

13. This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. 
 
Operation is subject to the following two conditions. 

1) This device may not cause harmful interference, and 
2) This device must accept any interference received, including 

interference that may cause undesired operation. 
 
This equipment can generate, use and radiate radio frequency 
energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 

Text Box
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communications. However, there is no guarantee that interference 
will not occur in a particular installation.  
 
If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that 
to which the receiver is connected. 
- Consult the dealer or an experienced radio/TV technician for help. 
 
IMPORTANT NOTE: 
FCC RF Radiation Exposure Statement: 
This equipment complies with FCC RF radiation exposure limits set 
forth for an uncontrolled environment. This equipment should be 
installed and operated with a minimum distance of 20 cm between 
the radiator and your body. This transmitter must not be co-located 
or operating in conjunction with any other antenna or transmitter. 

 

Text Box
Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
 --Reorient or relocate the receiving antenna.
 --Increase the separation between the equipment and receiver.
 --Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
 --Consult the dealer or an experienced radio/TV technician for help.
 
Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate this equipment.
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Congratulations on the purchase of your Braille Sense U2 QWERTY! The 
Braille Sense U2 QWERTY is capable of doing everything that an ordinary 
PDA can do, and more – all without the need for a screen!  

 

I. You will find the following items when you open the Braille 
Sense U2 QWERTY package: 
 
1) Braille Sense U2 QWERTY 
2) Battery 
3) Carrying Bag 
4) AC adapter 
5) USB Cable  
6) Earphone 
7) Sticker(2) 
8) User Manual (CD) 
9) Braille User Manual (Hot Keys List) 

 

II. How to use this manual 
 
Before using the Braille Sense U2 QWERTY, you should read the entire 
manual to familiarize yourself with the functions of the Braille Sense U2 
QWERTY. Reading the entire manual will allow you to operate the Braille 
Sense U2 QWERTY to its fullest potential. The Braille Sense U2 QWERTY 
has many functions. Many of these functions operate in a similar manner, 
so it is important to become familiar with all of the functions of the Braille 
Sense U2 QWERTY. 
 
You will see references to hot keys and shortcut keys. These keys refer to 
ways to access menus and functions quickly by using a combination of 
keystrokes. Please note that not all hot keys and shortcut keys will work 
while you are in the Braille Sense U2 QWERTY. Some hot keys and 
shortcut keys require that you be within a program in order for specific hot 
keys and shortcut keys to work. 
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This user manual uses a specific notation of how to press keys. When you 
see, “Fn-B” this means that you would press the “Fn” and “B” 
simultaneously. This is a very important concept to understand when using 
this manual. 
 
In order to use the Braille Sense U2 QWERTY, you will need to understand 
what a menu is, and how it works. You will also need to understand what a 
text box is, and how to type in information in a text box. It is very important 
that you completely understand concepts such as this, so that you are able 
to use the Braille Sense U2 QWERTY to its fullest potential. 
 
If you find that you are unable to find a solution to a problem within the 
manual, or if you need assistance with the Braille Sense U2 QWERTY, 
please email us at support@hims-inc.com.  Visit us on the web at 
www.hims-inc.com; or, you can call us at 512-837-2000. 
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1. Introduction 
 
1.1 What is the Braille Sense U2 QWERTY? 
The Braille Sense U2 QWERTY is a Braille note taker developed and 
manufactured by HIMS, for people who are blind and visually impaired. The 
Braille Sense U2 QWERTY has a variety of powerful capabilities, including 
the following. 
 

1. Use the Word Processor, and the keyboard of QWERTY type, to 
create Braille documents. 

2. Print your text documents using any compatible Bluetooth or USB ink 
printer. 

3. Create hard copy Braille documents by connecting the unit to a Braille 
embosser. 

4. Open Microsoft Word documents, and read them in contracted Braille.  
5. Send email messages to sighted colleagues and friends while reading 

incoming email messages in Braille without the need for translation. 
6. Create a schedule of important appointments with the Schedule 

Manager and set alarms to alert you to these appointments. 
7. Input contact information for colleagues, friends, and family into the 

Address Manager. 
8. Surf the Internet with the Braille Sense U2 QWERTY's Web Browser 

and integrated Braille display.  
9. Listen to music, audio books, your own personal recordings, or even 

videos with the Braille Sense U2 QWERTY's integrated media player. 
10. Listen to and record FM radio content. 
11. Calculate algebraic equations, trigonometric functions, and other 

scientific calculations with the built-in calculator. 
12. View the flashdisk of the Braille Sense U2 QWERTY as a USB drive 

on your computer and transfer files.  
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13. Use the Braille Sense U2 QWERTY as a Braille display with a 
compatible screen reader, such as Window-Eyes, JAWS, or 
VoiceOver. 

14. Copy, move, and delete files on the Braille Sense U2 QWERTY with 
its intuitive, Windows-like File Manager. 

15. Adjust the volume, speed, and pitch of the speech on the fly.  
16. Use the Database Manager to create your own Database for storing 

important information. 
17. Use MSN messenger, Google Talk, and Twitter to keep up with 

what's happening and stay in touch with friends, family, and 
colleagues.  

18. Use the built-in GPS sensor and digital compass to navigate 
independently without the need for external devices. 

 

1.2 Hardware(modify) 
 

To get the most from your Braille Sense U2 QWERTY, it is important to 
become oriented to the buttons and ports on your Braille Sense U2 
QWERTY as well as learning their functions.  
This section explains the hardware configuration of the Braille Sense U2 
QWERTY. The Braille Sense U2 QWERTY is 10 inches long by 6.1 inches 
wide by 1.9 inches high. The bottom of the unit contains rubber feet in 
order to prevent slipping while you are using it. Place the Braille Sense U2 
QWERTY on a desk or table top with the Braille display nearest you. Its 
shape resembles a small, thin rectangular box. This section of the manual 
describes each side of the Braille Sense U2 QWERTY and the basic 
function(s) of each button and port. We will discuss the panels in the 
following order: top panel, right panel, left panel, rear panel, and front panel. 
 

1.2.1 The Top Panel 
 

On the top face of the Braille Sense U2 QWERTY is located a 9 key 
Perkins-style keyboard, consisting of Braille dots 1:6, "SPACE", 
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"BACKSPACE", and "ENTER". When you are typing, you should place 
your fingers on these 9 Perkins-style keys in the following manner: 
 
Place your index finger, middle finger, ring finger, and pinky finger of your 
left hand on the left four buttons. Then, place your index finger, middle 
finger, ring finger, and pinky finger of your right hand on the right four 
buttons. Finally, place both of your thumbs on the spacebar.  
The button where you placed your left index finger corresponds with dot 
one in Braille. The button that your left middle finger is on corresponds to 
dot two, and the button under your left ring finger corresponds to dot three. 
The button on which your left pinky finger is placed is the Backspace key. 
The button under your right index finger corresponds with dot four in Braille. 
The button under your right middle finger is dot five, and the button on 
which your ring finger is placed corresponds with dot six in Braille. The 
button on which your right pinky is placed is the Enter key. And, the long 
bar shaped button under your thumbs is the spacebar. 
 
On the same row as the Space bar are 4 rectangular function keys: two to 
the left of the spacebar, and two to the right. Moving from left to right, the 
key to the far left is the "F1" key, and the key to the right of it is the "F2" key. 
The key to the right of the spacebar is the "F3" key, and the key on the far 
right is the "F 4" key. 
 
Below the keyboard is a 32 cell Braille display. Above the Braille display, 
there are 32 small, oval-shaped buttons corresponding to each of the 32 
Braille cells. These buttons are called cursor routing keys. When you are 
editing documents, you can use these keys to route your cursor to the 
character of the corresponding Braille cell. The cursor routing keys also 
serve as shortcut keys for navigating lists and groups of fields in certain 
places on the unit. 
On each side of the Braille display are two capsule shaped keys. These are 
the "UP" and "DOWN" scroll keys.  The scroll keys are used to scroll the 
Braille display through menus, fields, lists or text. You can use the scroll 
keys to scroll by display length, paragraph, line, sentence, or character. 
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You can set the left and right sets of scroll keys independently in the 
"Global Options". (See chapter 3.)  
Near the top center of the unit's top panel, is a liquid crystal display (LCD). 
The LCD displays the output of the unit visually so that a sighted person 
can see what is shown on the Braille Sense U2 QWERTY. STEREO 
speakers are located one on each side of the LCD for audio output. 
 
To the right of the LCD, along the top edge of the unit, there are 4 LED 
lights. The far left LED light shows wireless LAN status; when wireless LAN 
is on, this LED light turns blue. The next LED indicates Bluetooth status; 
again, when Bluetooth is activated, this LED light turns blue. The third LED 
light shows the status of the GPS receiver; when you are running Sense 
Navigation, the LED turns blue (Only available after purchase and 
download of a license and map data for Sense Navigation). The LED light 
on the far right indicates power status. When the Braille Sense U2 
QWERTY is powered on, the LED turns red. These LED lights help a 
sighted person easily determine the status of the unit when working with 
students. This helps them quickly evaluate whether options need to be 
changed for accomplishing current tasks, or if options are activated 
unnecessarily, and can be turned off to save power, etc. 
 

1.2.2 The Right Panel 
 

On the right panel, there is a recessed rectangular section containing 2 
ports. The port nearest the front of the unit is the USB OTG port. You can 
connect your Braille Sense U2 QWERTY to a personal computer via this 
USB port, and use it as a Braille terminal for the computer, transfer files to 
and from the computer, or to synchronize your calendar and contacts with 
Outlook. 
Behind the USB OTG port is the AC adapter jack. To charge the unit's 
battery or use the Braille Sense U2 QWERTY on AC power, plug the small, 
round end of the AC adapter in to this jack, and plug the larger box-like end 
in to a standard AC electrical outlet.  
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Near the rear of the right panel is a 3-position slide switch. This is the key 
"Lock" switch. This switch is discussed in more detail in the next section.  
 

1.2.3 The Left Panel 
 

The left panel of the Braille Sense U2 QWERTY contains a rectangular 
recessed section with 3 things. Nearer the front of the unit are 2 full-sized 
USB host ports. Use these ports to connect a USB thumb drive for auxiliary 
storage or a USB keyboard or printer. 
 
Nearer the rear of the unit, is the "SD" slot, used for housing an SD (secure 
digital) card in the unit, also for additional storage.  
 

1.2.4 The Rear Panel 
 

On the far left of the rear panel is a small, round recess, with a dot-like 
button inside it. This is the "RESET" button. If your unit is not responding 
properly, you can press this button to force a soft reboot of the unit. NOTE: 
do NOT press the "RESET" button for more than 5 seconds.  It takes about 
fifteen seconds for your unit to complete the reboot process. You can also 
perform a soft reset by pressing F2-F3-1-2-3-4-5-6.  
If you hold down dots 1-2 with the "RESET" button, while the power is on, 
the Braille Sense U2 QWERTY reboots without speech. 
To the right of the "RESET" button, is the local area network (LAN) port. If 
you connect the Braille Sense U2 QWERTY to an Ethernet interface, you 
can connect to the Internet, allowing you to browse websites as well as 
send and receive e-mail. 
 To the right of the LAN port is another USB host port. Next to the USB port 
is a video output (VGA) port. The video output port can be used to display 
the output of the Braille display on a standard video monitor. To use this 
port, you must turn it on from in the "Global Options" menu. This port is 
very beneficial when using the Braille Sense U2 QWERTY in educational 
settings. 
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On the far right of the rear panel, is a rectangular cavity used for containing 
the detachable battery. The battery is packaged separately from the unit 
when the Braille Sense U2 QWERTY is shipped. Insert the battery into this 
rectangular slot until you feel it click into place.  To remove the battery, 
locate the triangular-shaped latch on the underside of the unit. Using your 
left hand, pull the latch to the right, and use your right hand to pull the 
battery out of the compartment. 
 

1.2.5 The Front Panel 
 

On the far left of the front panel is an emblem displaying the location of the 
GPS antenna. To the right of the "GPS" emblem, is the stereo microphone 
jack, used for connecting an external microphone or line level recording 
source. To the right of the microphone jack is the stereo headphone jack. 
To the right of the headphone jack is another 3-position slide switch. This is 
the "Media Mode" switch, and determines which type of media the media 
buttons control. This switch is explained in more detail in the next section.  
 
To the right of the "Media Mode" switch, are five buttons of varying shapes. 
These buttons control media playback. As explained above, the type of 
content controlled by these buttons depends on the position of the "Media 
Mode" switch. These buttons can control media playback, DAISY playback, 
or the FM radio. These five buttons are explained further in the FM Radio, 
Daisy and Media chapters of this manual. 
To the right of the media buttons is the on/off switch. To turn on the unit, 
push the switch to the right. To turn off the unit, repeat this action. 
 
Congratulations! You are now familiar with the basic functions of the 
buttons and ports of the Braille Sense U2 QWERTY. The rest of the 
manual discusses each function in greater detail to help you maximize the 
potential of your Braille Sense U2 QWERTY. 

1.3 Hardware Specifications(modify)  
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1) Operating system: Windows CE 6.0. 
2) Flash memory: 32GB. 
3) RAM: 256MB. 
4) CPU: Mobile CPU (1GHz).  
5) Battery: Lithium Ion (detachable), backup battery and clock-battery 

installed. 
6) Battery running time: About 17 hours (with Braille, TTS and middle 

volume of internal speaker) 
7) Keyboard: keyboard of QWERTY type, 32 cursor routing keys, 4 

scroll buttons, 5 audio buttons. 
8) Additional buttons and switches: key lock switch, audio mode switch, 

reset button, 5 audio buttons. 
9) Braille display: 32 refreshable Braille cells. 
10) Video output: VGA output. 
11) Network: 10/100 based Ethernet. 
12) Wireless: WLAN (IEEE802.11 b/g/n), Bluetooth ver.2.0+EDR. 
13) Sensor: 6-axis motion sensor 
14) GPS: Internal GPS receiver 
15) Interface: 1 USB Slave(ver.2.0), 3 USB Master(ver.2.0), 1 SD slot 
16) Sound: Internal stereo speakers, stereo headphone jack. 
17) Voice recording: Internal microphone, external microphone jack. 
18) Vibrate motor is installed 

 

1.4 Memory on the Braille Sense U2 QWERTY 
 

The Braille Sense U2 QWERTY has 256MB of RAM (random access 
memory) and 32GB of flash memory. The RAM is memory reserved for 
running programs. RAM is a temporary storage area for any program files 
that are running or any currently open documents. The data in the RAM 
area disappears if your battery depletes, and the AC adapter is not 
connected. The RAM data also disappears when Braille Sense U2 
QWERTY reboots for any reason. This means, if you have an open 
document which you have not saved, the unsaved data disappears. 
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2. Basic Functions of the Braille Sense U2 
QWERTY 

 

2.1 How to Enter Commands 
 
The commands used to operate the Braille Sense U2 QWERTY are 
comprised of various combinations of the Braille and function keys. In this 
user manual, the “-“(dash) is used to indicate that keys should be pressed 
simultaneously. For example, "Alt-F4" indicates that the user should press 
"Alt" and "F4" at the same time. This manual also contains expressions like 
"Ctrl-c". This means that the Ctrl button with letter ‘c’ should be pressed 
and released simultaneously.  
 
If you are in a menu or dialog, and your cursor is placed on the command 
you want to execute, you can execute most commands by pressing "Enter". 
If you want to cancel the execution of a command, and return to your 
previous location, press "Alt-F4." "Alt-F4" is a very important command to 
remember, as it allows you to abort programs and menus if you have 
pressed keys accidentally. 
 

2.1.1 Basic Alerts and Messages 
There are instances where the Braille Sense U2 QWERTY alerts you to 
events for which you have asked it to notify you. For example, by default, 
the Braille Sense U2 QWERTY checks the Schedule Manager when you 
power on, and notifies you of any appointments scheduled for that day.  
When you are notified of an appointment, you can interact with the 
Schedule Manager as you normally would. To exit the Schedule Manager, 
press "Alt-F4" or "Esc," and you are returned to your previous location.   
If you do not want to be alerted of "today's schedule" when you turn on the 
Braille Sense U2 QWERTY, you can turn off the "Check today's schedule" 
option in the "Global Options" dialog. (See chapter 3) 
When you turn on the Braille Sense U2 QWERTY, you are returned to the 
same location at which you turned the unit off. The Braille Sense U2 
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QWERTY announces the name of the running program and your current 
position or status.  If you turn off the Braille Sense U2 QWERTY while 
using the Word Processor, when you power on, it announces the program 
name, file name, input mode and file protection status.  
When you connect the AC adapter to the Braille Sense U2 QWERTY, the 
Braille Sense U2 QWERTY speaks the message "AC adapter connected." 
When you disconnect it, the Braille Sense U2 QWERTY says, "AC adaptor 
disconnected." 
 

2.2 Concept of the Menu 
 
The menu on the Braille Sense U2 QWERTY provides you with a list of 
programs, actions, or options from which you can select. If a menu item 
has a submenu, selecting it brings up another list of choices. 
Moving among the menu items is very simple. 
 
Press “Alt” to bring up the menu. Press the "Up" scroll key or “Up arrow 
button” to move to the previous item, and press the "Down" scroll key or 
“Down arrow button” to move to the next item. You can also press the 
menu's shortcut key, usually the first letter of the menu name, to quickly 
jump to and execute that menu item. Often menu items can also be 
executed instantly with a hotkey, enabling you to perform the desired action 
without accessing the menus.  
 
Shortcut keys are displayed in parentheses following the menu names. 
Hotkeys generally consist of a modifier such as "Enter," "Space," or 
"Backspace", pressed simultaneously with a letter or dot combination. 
These are displayed following the shortcut keys. 
 
For example, if you are in the Word Processor, and press “Alt”, then press 
"Enter" on "File," you hear "New (n) pull down Enter-n". The word "New" is 
the menu option. You would press the letter "n" to jump to "New" from 
within the "File" menu. Press "Enter-n" to access the "New" document 
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command from anywhere in the Word Processor. The n is the shortcut key 
and "Enter-n" is the hotkey. It is important to note that some hotkey 
commands are global, thus will work from anywhere on the unit, and some 
are program specific. For example, if you want to activate the "new 
document" option in the Word Processor. You cannot press "Enter-n" from 
the "Program" menu to activate this option. You must be in the Word 
Processor for "Enter-n" to activate the "new document" command.  
 
You can also navigate the menus manually. Move to the next menu item by 
pressing "down arrow button" Move to the previous menu item by pressing 
“up arrow button”. To move to the first item in the menu, press "Ctrl-Fn-Left 
arrow key." To move to the last item in the menu, press "Ctrl-Fn-Right 
arrow key" The corresponding menu name is displayed on the Braille 
display, and the menu name is spoken through the TTS (text to speech) 
engine. To repeat the name of the menu item, press "Fn-r"  
 
When you are placed on an item you want to execute, press "Enter". If the 
item you chose has a submenu or dialog, pressing "Enter" opens the 
submenu or dialog. If the item you chose is a command, pressing "Enter 
activates the command. This is referred to as "selection."  
When a menu item activates a submenu, the right direction arrow sign (->)   
is displayed after the name of the corresponding menu on the Braille 
display and the Braille Sense U2 QWERTY announces "pull down" after 
the menu item name. If the menu item is a dialog box, the ellipsis sign (...) 
is displayed after the menu item name on the Braille display. The Braille 
Sense U2 QWERTY also speaks the message, "common dialog." 
 
Let's begin going through the various menus. First, turn the unit on by 
pushing the power switch to the right. Now, bring up the "Program" menu 
by pressing "Win key". The "Program" menu is the main menu of the Braille 
Sense U2 QWERTY. You can access all of the programming, option 
settings, utilities, and help from this menu. The items in the "Program" 
menu are File Manager, Word Processor, Sense Navigation, Address 
Manager, Schedule Manager, E-mail, Media Player, FM Radio, Web 
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Browser, DAISY Player, Bluetooth Manager, Database Manager, Extras, 
Social Networking, Utilities, Global Options, and Help.  
 
The first item in the "Program" menu is "File Manager". If “Down arrow 
button” is pressed, the next menu item is displayed and spoken. Pressing 
“down arrow button” repeatedly, will continue your navigational progress 
down the list of items in the "Program" menu. When you reach the bottom 
of the list, the "Help" menu item is displayed as it is the last item in the 
"Program" menu.  
 
You could also jump quickly to the "Help" menu item by pressing "Ctrl-Fn-
Right arrow key" when "File Manager" is displayed. Press "Ctrl-Fn-Left 
arrow key," and the Braille Sense U2 QWERTY jumps back to the top item 
in the "Program" menu and again speaks and displays "File Manager".  As 
explained above, to execute a submenu or program from the "Program" 
menu, press "Enter". If you are in a submenu, and wish to return to the 
main "Program" menu, press "Esc." 
 
The "Win key" command for accessing the "Program" menu is an example 
of a global hotkey. This means that pressing the "Win key" key takes you to 
the "Program" menu immediately from anywhere on the Braille Sense U2 
QWERTY, whether you are in a submenu, a file, a dialog or an application. 
When you press "Win key", you are always placed at the top of the 
"Program" menu; and File Manager, is displayed and spoken. 
 

2.2.1 Control Symbols  
 
The Braille Sense U2 QWERTY uses several control symbols to note the 
type of information being displayed: examples are list items, menus, and 
edit boxes. These symbols can appear "Before" or "After" the text, or the 
appearance of this information may be set to "off". The way this information 
is displayed is determined by the "Control information" setting in the "Global 
Options" dialog. The default value is set to "Before." Note: In the Web 
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Browser, the control symbols are displayed even if the "Control information" 
is set to "off". 
AS explained above, the control symbol appears before or after the text of 
the control. For example, if "Control information" is set to "before", and you 
bring up the Word Processor's program menu, The Braille Sense displays, 
"MN File (f) pulls down". 
 
The following table shows the types of controls and the symbols that are 
used to indicate them. 
 
 

Name Symbol Comments 
Menu MN It means the menu that has 

submenus. 
Menu item MI It means the menu that does not 

have a submenu. 
List item LI The item name after this symbol 

represents the name of the item 
in any list. 
(Ex: “LI database” or “LI 
sample.txt” in the “file list” of the 
file manager) 

Edit box EB The item name after this symbol 
represents the edit box name. 
You can find the edit box after 
the edit box name. In the web 
browser, the symbol “EB” may 
be followed by an edit box 
without an edit box name. Edit 
boxes that begin with the symbol 
“EB” are one line. 
(Ex: “EB Last name: (cursor)” in 
the address manager program or 
“EB (cursor)”  
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Multi edit box MEB This also represents the edit 
box. But you can type in more 
than one line in the edit box. 
(Ex: “MEB Subject: (cursor)” in 
the e-mail program) 

 
Computer edit 
box 

 
CE 

It means there is an edit box to 
input ASCII Braille. 
The edit box after this symbol 
should allow ASCII Braille to be 
typed in. 
(Ex: “CE To: (cursor) “ in the 
email program) 

Combo box CB It represents the combo box in 
which you can choose an item 
by pressing the up scroll button 
or the down scroll button. 
(Ex: “CB Type: *.*” in the “Open 
dialog box” of the word 
processor program) 

Edit combo box ECB You can choose the desired item 
by pressing the up or down scroll 
button, or by directly typing in the 
item name. 
(Ex: “ECB File name: (cursor) 
“ in the “Open dialog box” of the 
word processor program) 

Prompt button PB PB follows any question in which 
you have to choose “Yes” or 
“No.” You can toggle between 
“Yes” and “No” by pressing the 
“Space” or the “Backspace” 
button.  
(Ex: When you exit from the 
word processor, “PB Save: Yes”)  
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Static box ST ST is followed by the current 
status. 
(Ex: “ST noname.hbl/insert 
mode/write” in the word 
processor program) 

Link LN It means there is a link in the 
web page. 

Anchor ANC It means there is an anchor in 
the web page. 

Radio button 
 

RB 
 

It represents a radio button, 
which allows you to choose an 
item by pressing the up scroll 
button, down scroll button, 
space, or Backspace. Also it 
cycles between items when 
pressing this key. 
(Ex: “RB Attribute: Write” in the 
“Information dialog box” of the 
file manager) 

Radio button 
select 

SRB It means that the radio button is 
selected in the web browser 

Radio button 
unselect 

URB It means that the radio button is 
not selected in the web browser. 

Check box check SCHB It means that the check box is 
selected. 

Check box 
uncheck 

UCHB It means that the check box is 
not selected.  

 
Note: Links, anchors, and radio buttons are controls that are only used in 
the Web Browser.  
 
The symbols enable you to understand what type of input control or menu 
you are working with. For example, if "MN," "MI," or "LI" are displayed, you 
know you can move from one item to the previous and next items by 
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pressing the "Up" and “Down" scroll keys. If "ECB," "EB," "CB," or "MEB" 
are displayed, you know you are in an input area where you must type the 
desired text. If "BT" is displayed, you can press "Enter" to activate the 
"button". 
 

2.3 Using the Function Keys 
 
There are four function keys on the Braille Sense U2 QWERTY. You can 
use these function keys to open the menus, cancel tasks, and move to 
other items.  

As described previously, “Function key" is on the left side bottom of the 

keyboard. "Function key" called as "Fn". When do hotkey combination or 
list transfer, is used. For example, if combined “Fn” and “Up arrow key”, do 
“Page up” and combined “Fn” and “Down arrow key”, do “Page down” and 
combined “Fn” and “Right arrow key”, do “End” and combined “Fn” and 
“Left arrow key”, do “Home”.  
And press “Fn” and “Insert”, “Num lock on/off” function is executed. This 
function is executed, M(0), J(1), K(2), L(3), U(4), I(5), O(6), 7(7), 8(8), 9(9), 
0(*), ;(+), .(.), /(/) are inputted being changed by key in parenthesis. 
 
 

2.4 The AC Power Supply and the Battery Pack  
 
It is often useful to know the remaining battery power on the Braille Sense 
U2 QWERTY so you can determine how much time you have before you 
must change the battery or connect to AC power. If the remaining battery 
power falls below 15 percent, the Braille Sense U2 QWERTY indicates the 
battery power is low.  
 
To check the battery power status, press "Fn-b". The unit displays the 
following 2 items: 
1. Battery power level 
2. Power source (battery, AC power or USB cable) 
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The battery power level represents the percentage of the remaining battery 
power. The power source indicates whether the unit is being operated 
using the battery or the AC power supply. If the battery power level drops 
under 15 percent, the Braille Sense U2 QWERTY displays the battery 
status on the Braille display, and it announces that the battery has less than 
15 percent of its power remaining. If the battery power level falls below five 
percent, the Braille Sense U2 QWERTY gives you a warning indicating that 
your battery power level is under five percent, and the Braille Sense U2 
QWERTY will be automatically turned off in one minute, unless you connect 
it to an AC power supply. 
Let's explore the detachable battery pack. When the Braille Sense U2 
QWERTY is shipped, the battery pack is not installed. This is done to 
prevent damage during shipping. When you insert the battery in to the 
Braille Sense U2 QWERTY for the first time, the unit may display an 
inaccurate battery power level. Before using the Braille Sense U2 
QWERTY for the first time, please charge the battery for at least six hours. 
You may use the unit during the initial charge, however, it is recommended 
if you do, that the unit remain connected to AC power for at least seven 
hours to fully charge the battery.  
When you remove the battery from the Braille Sense U2 QWERTY, make 
sure your unit is turned off; especially when the AC power adapter is not 
connected. If you remove the battery while the unit is on and AC power is 
not connected, you will lose all data stored in RAM, including open 
documents, emails, and contacts or appointments that have not been 
backed up. If you remove the battery, and do not have the Braille Sense U2 
QWERTY connected to AC power, the data stored in RAM remains for 
about 1 hour. To save your RAM data the Braille Sense U2 QWERTY must 
be connected to an AC power adapter or battery pack within an hour; or 
this data is lost. 
 
[Note, when using CD-ROM/external hard drives] 
*When you connect an external CD-ROM drive to the Braille Sense U2 
QWERTY, please use the AC power adapter for the CD-ROM. It takes 
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about one minute for the CD-ROM to be recognized by the Braille Sense.  
*Please avoid using both an external hard disk and a CD-ROM drive with 
the Braille Sense U2 QWERTY at the same time. Or, Braille Sense U2 
QWERTY may be short of power and the unit may shut down. 
 
[Note, when charging via USB cable] 
*Braille Sense U2 QWERTY can be charged via a USB cable. However, 
charging with a USB cable supplies less power to the Braille Sense U2 
QWERTY than does the AC adapter.  While charging Braille Sense U2 
QWERTY via USB, if you use the unit continuously, the battery may not 
charge, or, depending on how much power you are using, the battery may 
even continue to drain. If you want to charge the Braille Sense U2 
QWERTY via a USB cable, it is recommended that you leave the unit 
powered off while charging.  
*If you use a USB cable other than the one shipped with the unit, the Braille 
Sense U2 QWERTY may not recognize external USB devices or may not 
be charged. Please always use the USB cable which is provided with the 
Braille Sense U2 QWERTY. 
 
[Instructions for charging depleted battery] 
*When the battery is completely depleted, though you connect the AC 
adapter to Braille Sense U2 QWERTY, the unit may not immediately wake 
up. After charging a few hours, Braille Sense U2 QWERTY will power up 
normally. If you want to use the Braille Sense U2 QWERTY as soon as you 
begin charging it, remove the battery from the Braille Sense U2 QWERTY 
and connect the AC adapter. After the Braille Sense wakes up, connect the 
battery. And you may use Braille Sense while charging. 
 

2.5 Basic Explanation of Disks, folders, and files 
 
Think of the flash memory on the Braille Sense U2 QWERTY like a big 
bookshelf in a library. You can create partitions on a bookshelf to organize 
books into categories. Think of the "folders" on the Braille Sense U2 
QWERTY as being similar to these categorical partitions. The books in 
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each section can be compared to the "files" on the Braille Sense U2 
QWERTY. You can save files into any folder at your discretion. If you create 
meaningful folder names and properly organize your files into them, it will 
make for easier retrieval of files when you need to access them later. 
When the Braille Sense U2 QWERTY is shipped from the factory, the name 
given to the flash memory in the Braille Sense U2 QWERTY is "flashdisk". 
You can create folders on this "flashdisk" in any way that you prefer. 
You can also expand your available storage by adding additional storage 
devices, such as a Secure Digital card or USB flash drive. The Secure 
Digital card is named, "sd". A USB flash drive appears as "USB." If you 
decide to add any of these memory devices, you can create folders, and 
save files on them just as you can the flashdisk.  
 

2.6 Controlling the Volume, Speed, and Pitch of the 
TTS  
 
You can change the volume, speed, and pitch of the voice used on the 
Braille Sense U2 QWERTY. Press "F6" to increase the volume. Press 
"Shift-F6" to decrease the volume. Press "F7" to increase the speech rate. 
Press "Shift-F7" to decrease the speech rate. Press "F8" to raise the pitch 
and "Shift-F8" to lower it.  
When you press any of the above key combinations, the Braille Sense U2 
QWERTY announces the status of its volume, rate, or pitch. The changes 
in the characteristics of the voice remain in effect until you change them 
again, or a hard reset is performed either manually or due to lack of power 
to the unit for an extended period of time. 
 

2.7 Using Speech and Braille  
 
When using the Braille Sense U2 QWERTY, you can choose to read using 
Braille only or speech only. You can also use both Braille and speech 
simultaneously. However, you cannot turn off both Braille and speech as 
you would have no method of receiving information from the Braille Sense 
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U2 QWERTY. Use "F5" to toggle the speech on and off. Press "F4" to 
toggle the Braille on and off. Please refer to section 3.2.1 in this user 
manual for more information. 
 

2.8 Entering Text (modify) 
 
When you use the word processor on the Braille Sense U2 QWERTY, 
how to Input character in the Braille document is different. Braille Sense U2 
QWERTY keyboard is input type of Braille Keyboard in Braille document. 
For input like Braille keyboard, “F” corresponds to the dot 1 and “D” 
corresponds to the dot 2, “S” corresponds to the dot 3, “J” corresponds to 
the dot 4, “K” corresponds to the dot 5, “L” corresponds dot 6 in the Braille 
Sense U2 QWERTY Keyboard. In order to type capitalization character, 
you need to type dot 6-L in front of the character. 
For example, when you input ‘sea’ in the Braille Document, press “D-S-J” 
corresponds to “s” (dot 2-3-4). Then, press “F-K” corresponds to “e” (dot 1-
5) and press “F” corresponds to “a” (dot 1). 
 

2.8.1 Inputting/searching for Control characters 
Control characters are codes in a character set, which do not in themselves 
represent written symbols in computing. For example, all entries in the 
ASCII table below code 32 such as Form Feed (FF), TAB, and Carriage 
Return (CR). You can input and search for control characters in Braille 
documents. 
 

2.8.1.1 Inputting Control characters 
 
Control characters can only be entered in Braille documents. To enter 
control characters in Braille documents, follow these steps.  
 
(1) From within a Braille document, press "Ctrl-Space". "Control character" 
is announced to alert you to the fact that the next character you enter 
should be a control character.  
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(2) Enter the control character. For example: "l" for Form Feed (FF) or "i" 
for TAB in alphabetical order.  
(3) The control character is entered into the Braille document. 
 

2.8.1.2 Searching for a Control character 
 
You can also search for control characters in Braille documents. To search 
for a control character, follow these steps. 
 
(1) From within a Braille document, press "Ctrl-Space". 
(2) "Text to find" is displayed. 
(3) Press "Fn-Space” and "control character" is announced.  
(4) Enter the control character for which you want to search.  
(5) Press "Enter" to search for the control character. 
 

2.9 Multi Tasking 
 
Unique to the Sense notetakers is their ability to run up to seven tasks at 
once. The ability to run multiple applications simultaneously is referred to 
as multi-tasking. For example, you can work with the Word Processor while 
listening to music, and place calculations into a document at the same time. 
To continue with the example of the Word Processor and Media Player, 
open the Media Player and play a music file. While the audio is playing, 
press the "win key" key to bring up the "Program" menu and launch the 
Word Processor. 
You cannot run more than seven applications at the same time. If you try to 
run a program that is currently running, The Braille Sense U2 QWERTY 
does not open a new instance of the program, but rather, returns you to the 
instance of the program that is already running. For example, while working 
with a document called "Notes" you decide to execute the "File Manager." 
Next, you navigate to a document called "journal" in the file list and press 
"Enter." The Word Processor does not load a second time, but rather, 
"journal" is opened in the same instance of the Word Processor in which 
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"notes" is already loaded. You can switch among multiple open documents 
in a single instance of the Word Processor. Use "Tab" or "shift-tab" to cycle 
forward or backward through the currently open documents. Switching 
documents is explained in more detail in section 4, which covers the Word 
Processor. 
If you have pressed "Win key" to bring up the "Program" menu, or "Fn-F10" 
to open the Task List and you decide not to access a different application, 
you can press "Esc” key to return to your previous location on the unit. To 
switch between currently running programs press "Fn-F10" to open the 
Task List. The Task List shows all the currently running programs in list form. 
To return to any application, simply navigate to it and press "Enter".  
You can use "Alt-tab" to immediately cycle among all running programs 
without opening the Task List. If you are running three programs and are in 
the second program, pressing "Alt" and "Tab" moves you to the third 
program. If you press "Alt-Tab" again, you are placed in the first program. 
In the above case, if you were to press "Alt-F4" to close the currently open 
program, you are then placed in the previous program. However, if there is 
only one program running, pressing "Alt-F4" closes the program and places 
you in the "Program" menu.  
 

2.10 Switching Media Modes(modify) 
 
The media buttons on the front panel perform different functions according 
to the location of the "Media Mode" switch.  
If you slide the "Media Mode" switch to the left-most position, the Braille 
Sense U2 QWERTY announces, "radio mode" and the media buttons 
control operation of the FM Radio. If you place the "Media Mode" switch in 
the center position, the Braille Sense U2 QWERTY says, "DAISY mode" 
and the media buttons control playback of Daisy content. If you slide the 
"Media Mode" switch to the right-most position, the Braille Sense U2 
QWERTY announces, "media mode" and the media buttons control media 
playback. 
It is very important to pay attention to the position of the "Media Mode" 
switch to achieve desired operation of the media buttons. For example, if 
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you are using the Media Player, if the "Media Mode" switch is placed in the 
left-most position, the media buttons on the front panel control operation of 
the FM Radio even though your focus is in the Media Player. More detailed 
explanations of the functions of the Media buttons is given in the FM Radio, 
Daisy Player, and Media Player sections in this manual. 
 

2.11 Switching Key lock(modify) 
 
You can disable the keys on the Braille Sense U2 QWERTY to prevent the 
accidental pressing of keys using the key "Lock" switch on the front panel. 
When the key "Lock" switch is placed in the left-most position, Braille 
Sense U2 QWERTY announces, "all keys locked". This means all keys on 
the unit are disabled including the on/off switch. If the key "Lock" switch is 
placed in the center position, Braille Sense U2 QWERTY says, "top panel 
locked". This means you can continue to use the buttons and switches on 
the front panel (media mode switch, media buttons and on/off switch), 
however, you cannot use any of the keys on the top face of the unit. If the 
key "Lock" switch is placed in the right-most position, Braille Sense U2 
QWERTY announces, "unlocked". This indicates all keys are operational 
(Braille keyboard, media buttons, scroll keys, function keys, Media Mode 
switch and On/Off switch). 
Note: the "RESET" button is always operational, regardless of location of 
the key "Lock" switch. 
 

2.12 Print Spool 
 
The Braille Sense U2 QWERTY has a print spool function. This function 
enables the Braille Sense U2 QWERTY to do other tasks while printing to 
an ink-printer or Braille embosser. For example, if you send data to your 
printer or embosser, you are immediately returned to where you were 
before the print command was executed. If you want to check the Print 
Spool dialog box after you have given the print command, press "Fn-Ctrl-p" 
or “Alt-shift-p”.  A dialog box appears with three controls: a list containing 
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information about files that are being printed, a "Cancel" button, and a 
"Close" button. You can cycle through the three controls by pressing “Tab” 
or "shift-tab." In the information list, you can move among the items by 
pressing “down arrow button” or “up arrow button”. If you open the dialog 
box when nothing is printing, "no items" appears in the list and only the 
"Close" button is available. 
While printing, the information list contains the following: "running program 
name," "printing file name," "printer type," "the number of copies," and 
either "printing" or "ready." For example, let's assume that we are printing 
one copy of "sample.txt" from the Word Processor. The info list displays, 
"program: Word Processor, file: sample.txt, printer, copy: 1, printing." If you 
are using a Braille embosser, "embosser" appears instead of "printer." If 
nothing is printing but, (the printer is waiting), "ready" is displayed instead 
of "printing." If you print something from the E-mail program, 
"emailtemp.txt," is displayed instead of the file name. If you are printing 
from the Address Manager, or the Schedule Manager, the message, 
"prn_ggtimegg.txt" is shown. 
 
If you focus on a file in the info list, pressing "Enter" on "Cancel" cancels 
the printing of that file. If you tab to "Close," and press "Enter" the Print 
Spool dialog box is closed. Pressing "Alt-F4" also closes the Print Spool 
dialog. 
 

2.13 One-Handed Mode 
 
Braille Sense U2 QWERTY provides a One-handed mode for users 
restricted to the use of one hand for Braille input. To turn on one-handed 
mode, Press “Fn-h”. Also turn off one-handed mode, press “Fn-h”, too. You 
can also turn One-handed mode on or off in the "Global Options" dialog.  
When One-handed mode is on, the use the following methods to input text:  
 
When contents of file copy whole 

1) Press the “Ctrl”. Then, “Ctrl” is pressed down. 
2) And press “a”. Then, whole copy is executed. 
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3) “Ctrl” that is pressed down is canceled.  
 
Display power status 

1) Press the “Fn”. Then, “Fn” is pressed down 
2) And press “b”. Then, power status is checked. 
3) “Fn” that is pressed down is canceled. 

 
Switch to next program 

1) Press the “Alt”. Then, “Alt” is pressed down. 
2) Press the “Shift”. Then, “Shift” is pressed down. 
3) Press the “Tab”. Then, program is changed next program. 
4) “Alt” and “Shift” that is pressed down is canceled. 

 
The operation of the scroll keys, function keys, and media buttons remains 
the same as in normal mode.  
If One-handed mode is on, the Braille Sense U2 QWERTY announces this 
each time it is powered on, as well as how to return to normal operation.  
 

2.14 Using Typing Mode 
 
While you are typing in a document, you may wish to turn off the navigation 
keys, especially if you type very fast as you may accidentally navigate 
when you intend to enter text. To turn on "Typing Mode", follow these steps: 
(1) Press "Fn-Ctrl-t", from within a document. 
(2) "Start typing mode" is announced and displayed. 
 
If you press “Ctrl-ESC” while executing the “Typing Mode”, it will be typed 
“Ctrl” and “ESC” instead of executing the “Key help mode”. 
To cancel "Typing Mode", follow these steps: 
1) Press “Fn-Ctrl-t” in the “Typing Mode”. 
2) It shows “End typing mode”. 
 
After canceling the “Typing Mode”, it will execute “Key help mode” when 
you press “Ctrl-ESC”. 
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2.15 Common Hotkeys 
 
1. Bring up the program menu: Win key 
2. Execute a program in the program menu Win key-"shortcut key" (varies 

for each program) 
3. Bring up the Task list: Fn-F10 
4. Switch to previous program: Alt-shift-tab 
5. Switch to next program: Alt-Tab 
6. Bring up the program specific menu: Alt 
7. Exit: Alt-F4 
8. Escape: ESC 
9. Move to the next control in a dialog box: Tab  

10.  Move to the previous control in a dialog box: Shift-tab  
11. Move to the previous character: Left arrow key 
12. Move to the next character: Right arrow key 
13. Move to the previous line/item: Up arrow key 
14. Move to the next line/item: Down arrow key 
15. Move to the beginning of line/item: Fn-Left arrow key 
16. Move to the end of line/item: Fn-Right arrow key 
17. Move to the top of a document or list: Ctrl-Fn-Left arrow key 
18. Move to the bottom of a document or list: Ctrl-Fn-Right arrow key 
19. Move to the previous page or to the first item of the previous 32-item 

group: Fn-Up arrow key  
20. Move to the next page or to the first item of the next 32-item group: Fn-

Down arrow key 
21. Scroll left: Up scroll button 
22. Scroll right: Down scroll button 
23. Move the cursor to each cell or move to an item: The corresponding 

cursor routing key 
24. Read the current item again: Fn-r 
25. Say current time: Fn-t 
26. Display power status: Fn-b 
27. Open the "Global Options": F10 
28. Online help: F1 
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29. Check software version: Fn-v only from the Braille Sense U2 QWERTY 
"Program" menu." 

30. Display Network Status: Fn-n from the Braille Sense U2 QWERTY 
"Program" menu 

31. Increase the voice volume: F6 
32. Decrease the voice volume: Shift-F6 
33. Increase the voice rate: F7 
34. Decrease the voice rate: Shift-F7 
35. Increase the voice pitch: F8 
36. Decrease the voice pitch: Shift-F8 
37. Bluetooth on/off: F9 
38. Wireless LAN on/off: F11 
39. Ethernet port on/off: Fn-F11 
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3. Global options 

 
The "Global Options" on the Braille Sense U2 QWERTY is a large dialog box 
for controlling many preferences/settings. You can access "Global Options" 
by pressing "Win key" to get to the main menu, and then navigate to "Global 
Options" by pressing “down arrow button” or “up arrow button”. Press "Enter" 
to open the "Global Options" dialog. You can also open "Global Options" 
from anywhere on the notetaker by pressing “F10”.  
 
You can navigate among the items in "Global Options" using “up arrow 
button” and “down arrow button” or using the scroll keys.  You can also use 
shortcut keys to quickly move to specific items in the "Global Options" dialog. 
You can toggle an option on or off or cycle through the available values of a 
setting with the "spacebar" or "Backspace" keys. 
 
To save the changes you've made to the "Global Options" settings, press 
"Enter" or tab to the "Confirm" button and press "Enter". When you press 
"Enter" to save the settings, the Braille Sense U2 QWERTY says, "Saved 
options," and you are returned to the place on the notetaker from which you 
entered the "Global Options". To cancel without saving changes, press the 
"Esc" key or "Alt-F4". The Braille Sense U2 QWERTY announces, "Canceled 
saving options".  
 
From the options list, you can also use “Tab” or "shift-tab" to navigate to the 
"Confirm" and "Cancel" buttons. If you want to save your settings, press 
"Enter" on the "Confirm" button. If you do not want to save changes, press 
"Enter" on the "Cancel" button. 
 
Before we go in to detail about each option, let's first go through a brief 
overview of what appears in the "Global Options" dialog. 
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3.1 Global Options Overview 
 
The "Global Options" dialog contains various settings that can be changed in 
the Braille Sense U2 QWERTY.  As stated above, you can open "Global 
Options" from anywhere on the unit by pressing “F10”. The "Global Options" 
dialog contains five groups, making it easy to jump to a particular section in 
the very long list of settings present in the dialog. 
 

1. Braille settings (includes Braille display, Braille cursor, eight dot mode, 
view/input grade, Braille Code and message display time)  

2. Voice settings (includes language, voice, punctuation level, keyboard 
echo, capitalization alert, numbers, abbreviations, voice volume, voice 
rate, voice pitch, and scroll voice) 

3. Display settings (flip LCD display, LCD font size, and video display) 
4. Print settings (includes printer port and print paper size) 
5. General settings (includes audio alerts, play power on/off sound, left 

scroll buttons, right scroll buttons, skip empty lines, control information, 
hide passwords, hot key information, announce shortcut keys, power 
saving mode, power saving kick in, check today's schedule, one-handed 
mode, Automatic spell-check, default document type, Automatically 
synchronize with time server, progress indicator, Bluetooth, wireless 
LAN, Ethernet port, and mass-storage device mode.) 

 
You can navigate among the five groups by pressing "page down or "page 
up”. When you navigate to a particular group, you are placed at the location 
in "Global Options" where that group of options begins. Though the "Global 
Options" dialog is divided into groups for ease of navigation, it is actually one 
long continuous list of settings. As explained above, you can move between 
items in the "list" by pressing "up arrow button" or "down arrow button". You 
can change the setting for each option by pressing "Space" or "Backspace".  
 
Note: in addition to navigating by group, you may also use shortcut keys to 
jump to specific settings in the "Global Options" dialog. However, it should 
also be noted that often, the same shortcut key is used for multiple options. 
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Thus, as is the case when using first letter navigation, pressing a shortcut 
key moves the focus to the first setting that matches the shortcut key, 
pressing the key again moves to the next setting that matches that shortcut 
key. If there are no more settings matching the shortcut key, the Braille 
Sense U2 QWERTY wraps around to the first match. 
 
Many items in "Global Options" also have global hot keys. This means you 
can use this hot key from anywhere on the unit to instantly modify that 
particular setting without bringing up the "Global Options" dialog.   
 

3.2 Global Options in Detail 
 
Let's take a look at each setting in the "Global Options" dialog in more detail.  
 

3.2.1 Braille display 
 
The first item in "Global Options" is "Braille display". When your cursor is 
placed on this option, you can toggle the Braille display on and off by 
pressing "Space". The default setting is "On". Use "b" to quickly jump to the 
Braille display option in the list of items in "Global Options". You can also 
toggle the Braille display on/off from anywhere on the Braille Sense U2 
QWERTY by pressing "F4".  
 

3.2.2 Braille Cursor 
 
Use this setting to define how you want the Braille cursor to appear on the 
Braille display. By default the cursor is set to "Always up". Press "Space" to 
change the cursor to "Blinking," and again to turn the cursor "Off".  
 
Use "c" to jump quickly to this option.  
 
Note that the Braille cursor can appear in 3 different forms: 
1. "Dots 7-8" 
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2. Blinking "dots 7-8" 
3. Blinking "dots 1-2-3-4-5-6-7-8" 
 
The blinking "dots 7-8" is displayed when you are using "overwrite mode" in 
the word processor. The blinking "dots 1-2-3-4-5-6-7-8" appears when you 
are selecting text to denote the end of the selection. 
 
In all other situations, the cursor is displayed as "dots 7-8". 
 

3.2.3 Eight Dot Mode 
 
You can choose to use 6-dot-Braille or 8-dot-Braille mode when entering 
ASCII text. The shortcut key is "e". By default 8-dot-Braille is set to off. 
WHEN your cursor is placed on this option, you can turn on 8-dot-Braille 
mode by pressing "Space". You can toggle this option on/off by pressing 
"F1-DOWN scroll" from anywhere. 
 

3.2.4 View/input Braille Grade  
 
This option lets you choose what grade of Braille you want to use when 
viewing/entering text.  The shortcut key is "g". The available settings are 
Uncontracted Braille, Contracted Braille, and Computer Braille. You can 
cycle among the settings by pressing "Space". You can press "Fn-g" to cycle 
through the Braille grades from any location on the Braille Sense U2 
QWERTY.   
 

3.2.5 Braille Code 
 
The Braille code setting defines the rules by which Braille is translated to text 
and vice versa. The Braille Sense U2 QWERTY offers 2 English Braille 
codes as well as entry of Spanish Braille. Thus the Braille code can be set to 
use "US", "UEBC", (Unified English Braille Code) or "Spanish".  
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The original intent of the UEBC was to explore the possibility of bringing 
together three of the official Braille codes that are used for Braille in English-
speaking countries for various purposes, viz.: literary material (English Braille, 
American Edition), mathematics and scientific notation (Nemeth Code), and 
computer notation (Computer Braille Code).  
 
Choosing "Spanish" allows you to input Braille according to Spanish Braille 
rules, and read documents created in Spanish using Spanish Braille 
translation. 
 
The short cut key used to jump to the Braille code option is "c". The default 
setting is "US". Use "Space" to change to "UEBC" or "Spanish".  
 
Note: If you change the Braille Code option while you are editing Braille in 
the Word Processor, the meaning of the Braille in your current document will 
be changed to reflect the current Braille Code setting. To avoid this problem, 
the Braille Code option should be changed before launching the Word 
Processor. 
 

3.2.6 Message Display Time 
 
This option defines how the Braille Sense U2 QWERTY deals with system 
messages. You can set the unit to ignore system messages, to stand by until 
you press a key, or, if the Braille display is on, you can define how long the 
message remains on the display before automatically disappearing. Use "m" 
to quickly jump to this item in "Global Options".  
 
The available settings are "Stand by," "Ignore", and display times of 1 to 10 
seconds. The default setting is "3 seconds". Use "Space" to increase the 
message display time by one second and "Backspace" to decrease the 
message display time by one second.  If you read the message before the 
display time has elapsed, you can clear the message by pressing any key.  
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Set the unit to standby mode by pressing "Space" until you reach "Stand by". 
In this mode, the message remains indefinitely until you press a key.  If you 
choose "Ignore," messages are ignored and do not appear on the display.  
 

3.2.7 Language 
 
The Braille Sense U2 QWERTY can output speech in both US English and 
Mexican Spanish. You can change the Text-to-Speech (TTS) engine using 
the "Language" setting in the "Global Options" dialog.  
 
The shortcut for jumping quickly to the "Language" setting is "l". Press 
"Space" to toggle the TTS voice between "English" and "Spanish".  
 
Note: you can change the TTS and Braille language from anywhere on the 
unit by pressing "Alt-Ctrl-v". 
 

3.2.8 Voice 
 
This option allows you to toggle the Braille Sense U2 QWERTY voice on and 
off. The shortcut key is "v". By default the voice is set to on. You can change 
the status of the voice by pressing '"Space". You can toggle the voice on and 
off from anywhere on the Braille Sense U2 QWERTY by pressing "F5".  
 

3.2.9 Punctuation Level 
 
Use this setting to choose how you want the Braille Sense U2 QWERTY to 
read punctuation marks. The shortcut key is "p". The available options are 
"All," "Off", "Punctuation," and "Symbol". The default setting is "All", thus, by 
default, and the Braille Sense U2 QWERTY speaks all punctuation marks 
and symbols. Use "Space" to cycle through the four settings. If you select 
"Off", the Braille Sense U2 QWERTY speaks no punctuation marks. When 
the option, is set to "Punctuation", the Braille Sense U2 QWERTY speaks 
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punctuation marks; when the "Symbol" option is chosen it speaks all symbols 
and no punctuation marks.  
 

3.2.10 Keyboard Echo 
 
With this option, you can define what the Braille Sense U2 QWERTY speaks 
as you type. The shortcut key is "k". The setting values are "On with 
characters and words," "On with characters," "On with words," and "Off". The 
default is "On with characters and words," thus each keystroke is announced 
and each word is spoken when "Space" is pressed. If you select "On with 
characters," each keystroke is announced as you type it. If you select the 
"On with words" option, each word is spoken after "Space" is pressed. You 
can cycle through the options by pressing "Space".  
 

3.2.11 Capitalization alert 
 
Use this option to choose how the Braille Sense U2 QWERTY alerts you that 
a character is capitalized, either when typing or when navigating a document 

or edit box by character using “Left arrow key” or “Right arrow key”. The 

shortcut key is "u". The setting values are "Off", "Say cap," and "Pitch". The 
default value is "Pitch". If you select the default, when you encounter a 
capital letter, the pitch of the voice is raised to indicate it. If you select "Off", 
the voice remains the same regardless of upper or lower case. And if you 
select the "say cap," option, "cap" is spoken before the letter to indicate 
capitalization. For example, when you encounter the capital letter "V," Braille 
Sense U2 QWERTY speaks "cap v". 
 

3.2.12 Numbers 
 
This option defines how you want the Braille Sense U2 QWERTY to speak 
numbers. The shortcut key is "n". The default value is "On". If "numbers" is 
set to "On", "2007" is read as "two thousand seven". If "numbers" is set to 
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"Off", numbers are spoken as digits, and "2007" is read as "two zero zero 
seven". You can change the value by pressing "Space". 
 

3.2.13 Abbreviations 
 
You can turn the translation of acronyms on/off on Braille Sense U2 
QWERTY. Use "a",  to jump quickly to the "Abbreviations" option in the 
"Global Options" dialog. If "Abbreviations" is set to "On", when the Braille 
Sense U2 QWERTY encounters "Ala" it speaks "Alabama". But if 
"Abbreviations" is set to 'Off', it speaks "Ala".  
 

3.2.14 Voice Volume 
 
Use this option to set the volume level of the voice on the Braille Sense U2 
QWERTY. The shortcut key is "l”. The volume level can be set using values 
1 to 21, with 1 being the lowest volume level and 21 being the highest. Use 
"Space" to increase the volume by 1 increment, and "Backspace" to 
decrease it.  
 
Ffrom anywhere on the Braille Sense U2 QWERTY, you can increase the 
volume with "F6" and decrease it with "Shift-F6". 
 

3.2.15 Voice Rate 
 
This option controls the rate of the speech on Braille Sense U2 QWERTY. 
The shortcut key is "r". You can set the rate using values 1 to 12, with 1 
being the slowest, and 12 being the fastest. Press "Space" to increase the 
rate of speech by one increment, and "Backspace" to decrease it.  
 
From anywhere on the Braille Sense U2 QWERTY, you can increase the 
speech rate using "F7" and you can decrease it with "Shift-F7".  
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3.2.16 Voice Pitch 
 
Use this option to control the pitch of the voice on the Braille Sense U2 
QWERTY. The shortcut key is "t". The available values are 1 to 10, with 1 
being the lowest pitch and 10 being the highest.  Use "Space" to increase 
the voice pitch one level, and "Backspace" to decrease it.   
 
From anywhere on Braille Sense U2 QWERTY, you can increase the pitch 
by pressing "F8" and decrease it by pressing "Shift-F8". 
 

3.2.17 Scroll Voice 
 
Use this setting to choose whether you want the Braille Sense U2 QWERTY 
to speak while using the scroll buttons as you read. The shortcut key is "s" 
with the default set to "Off". The default setting (Off) means the Braille Sense 
U2 QWERTY does not speak when you use the scroll keys to move through 
a document. Set this option to "On" if you would like to hear the Braille 
Sense U2 QWERTY speak text as you scroll through it. Use "Space" to 
toggle the option on/off.  
 

3.2.18 Flip LCD display 
 
Note: This option is displayed only when Braille Sense U2 QWERTY is 
connected to external LCD device. 
 
The Braille Sense U2 QWERTY gives you the option of viewing the text on 
the LCD screen in normal or reverse orientation. By default, "flip LCD" is set 
to "Off", meaning the text is shown in normal orientation. If the option is set 
to "On", the text is in reverse orientation so that someone across the table 
can view the display in the correct orientation from "/her position. You can 
toggle the value on/off using "Space".  
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This is a useful tool for teachers or parents wanting to view a student's work, 
or for communicating with deaf-blind users.    
 

3.2.19 LCD Font Size 
 
Note: This option is displayed only when Braille Sense U2 QWERTY is 
connected to external LCD device. 
 
Use this setting to change the font size of the text on your LCD. The shortcut 
key is "f". The default is set to 19. The font size can be set using values 12 to 
20. Use "Space" to increase the font 1 size, and "Backspace" to decrease it. 
If you have the font size set to 20, and you increase the font by one size, the 
font wraps around to 12. If your font size is 12, and you decrease the font by 
one size, the font wraps around to 20. 
 

3.2.20 Video Display 
 
You can choose to have the Braille Sense U2 QWERTY display its output on 
a VGA monitor; or rather, a monitor that normally connects to a personal 
computer. The shortcut key is "d" with the default set to "Off". To use a VGA 
monitor, you must connect a VGA cable from the Braille Sense U2 QWERTY 
to the VGA input port on a computer monitor. You can toggle VGA output on 
and off by pressing "Space".  
 

3.2.21 Printer Port 
 
Use this option to define which port is used to send information to your 
printer when printing a document. The shortcut key is "p". The default is set 
to "USB". You can also choose to print via a parallel or Bluetooth printer. Use 
"Space" to cycle among the 3 options. 
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Note: if you want to use a parallel port printer, you must use the included 
USB to parallel adapter and connect the printer to the USB port on the 
Braille Sense U2 QWERTY.   
 

3.2.22 Print Paper Size 
 
This option allows you to select the size of the paper that an ink printer is 
using so the document is scaled correctly when printing. To jump quickly to 
this option, use "s". You can adjust the size by pressing "Space". The 
available sizes are "Letter" (8.5 inches by 11 inches) and "Legal" (8.5 inches 
by 14 inches.) 
 

3.2.23 Audio alerts 
 
Use this setting to choose whether the Braille Sense U2 QWERTY alerts you 
to various events using audio signals. The shortcut key is "a". This option is 
useful if the speech on the Braille Sense U2 QWERTY is turned off. By 
default, "Audio alerts" are turned "On". When "Audio alerts" are on, you hear 
a beeping sound when you type keystrokes that are not acceptable in your 
current context on the Braille Sense U2 QWERTY. If you don't want to hear 
the warning sound, press "Space" to turn "Off" the audio alerts. 
 

3.2.24 Play Power On/Off Sound 
 
Use this option to choose whether you hear the power on/off sound when 
you turn on/off the Braille Sense U2 QWERTY. The shortcut key is "s". The 
default for this option is set to "On".  
If you want the Braille Sense U2 QWERTY to power on/off silently, press 
"Space" to turn "Off" "Play power on/off sound". 
 

3.2.25 Left Scroll Buttons 
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Use this setting to define the operation of the left scroll buttons. The 
available options are "Scroll display", "Move by line", "Move by character", 
"Move by paragraph" and "Move by sentence". Use "Space" to cycle among 
the options.   
 
If you set the value to "Scroll display," the left-scroll buttons scroll by 
previous/next Braille display length. Pressing the left-up scroll button, scrolls 
to the previous Braille display length, and pressing left-down scroll button, 
scrolls to the next Braille display length. 
 
If you set the value to "Move by line", the left-scroll buttons scroll to the 
previous/next line, similar to pressing “up arrow button” or “down arrow 
button” on the Qwerty keyboard.  
 
If you set the value to "Move by character," the left-scroll buttons move to the 
previous/next character on the Braille display, similar to pressing “Left arrow 
key” or “Right arrow key”. 
 
If you set the value to "Move by paragraph," the left-scroll buttons can be 
used to move to the previous/next paragraph, similar to pressing "Ctrl-up 
arrow button" or "Ctrl-down arrow button".  
 
If you set the value to "Move by sentence," the left-scroll buttons scroll to the 
previous/next sentence, similar to pressing "Ctrl-Alt-Left arrow button" or 
"Ctrl-Alt-Right arrow button" on the Qwerty keyboard. 
 

3.2.26 Right Scroll Buttons 
 
This option defines the operation of the scroll buttons on the right side of the 
Braille display. The values are exactly the same as those just described in 
3.2.26 for defining the operation of the left-scroll buttons. .   
 

3.2.27 Skip Empty Lines 
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You can choose to have the Braille Sense U2 QWERTY alert you to a blank 
line by announcing "Blank" as you encounter empty lines while scrolling 
through a document or you can choose to have the unit skip empty lines. 
The shortcut key is "e" and the default is set to "Off".  Use "Space" to toggle 
the option on/off.   
 

3.2.28 Control Information 
 
Use this setting to determine where information appears regarding the type 
of control on which you are currently located, a list item, menu, combo box, 
etc. The short cut key is "i" and the default is set to "After". To toggle "Control 
information" between before, after and off, press "space. 
 
If you select "Before," control information, such as "list item", or "combo box" 
is displayed and spoken before a menu/list item or form control. If you select 
"After," control information is displayed and announced after the item or 
control. If you have control information set to "Off", control information is not 
displayed or spoken. 
 
Note that if you are using the Web browser the control symbols are 
displayed even if the "Control information" option is set to "Off".   
 

3.2.29 Hide passwords 
 
When you enter a password in a computer edit box, The Braille Sense U2 
QWERTY can either display an asterisk, *(dots 1-6) or the actual password 
as you type it.  
 
The short cut key is "p" and the default is set to "On". This means passwords 
are hidden, and thus will be shown using asterisks. To show passwords as 
you type them, use "Space" to toggle this setting to "Off".  
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3.2.30 Hot Key Information 
 
As described previously, hot keys are keystrokes used to immediately 
access or activate an item, such as a menu, or a particular item in a list. Use 
this option to define how hot key information is announced. The short cut key 
is "h" and default is set to “On”. The setting values are “On,” and “Off.” You 
can cycle through each of the options by pressing the “Space”.   
 
If you select "On", the "Open" option in the File Menu of the Word Processor 
is announced, "Open (o) Ctrl-o".  And if you select “Off,” you can’t hear the 
hot key information. 
 

3.2.31 Announce shortcut keys 
 
The "Announce shortcut keys" option lets you choose whether the Braille 
Sense U2 QWERTY speaks the shortcut key for a function. The shortcut key 
for this option is "s" and the default is set to "On". For example, if you press 
"F2" to bring up the program menu in the Word Processor, you may hear, 
"File (f) pull down". In this case, the shortcut key for accessing the Word 
Processor's "File" menu is the letter "f". If you do not wish to hear the 
shortcut keys announced, toggle "Announce shortcut keys" off by pressing 
"Space". 
 

3.2.32 Power Saving Mode 
 
Use this option to set the Braille Sense U2 QWERTY to save power by 
automatically shutting down after a certain period of time. The shortcut key is 
"p". The default setting is set to "On". Use "Space" to cycle through the 
available values: "On", "Off", and "Message". If you never want your Braille 
Sense U2 QWERTY to shut down automatically, set the option to "Off". If 
you set the option to "Message," The Braille Sense U2 QWERTY gives you a 
warning message that says "power on" to remind you the unit is still powered 
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on after 10, 20, or 30 minutes of inactivity (depending on the setting that you 
choose for power saving kick in).  
 
Note: this option is available only when the AC adaptor is not connected to 
the unit. In other words, even if this option is set to "On", if the AC adaptor is 
connected to the unit, the unit does not enter Power Save Mode, even when 
the "Power saving kick in" time has elapsed. 
 

3.2.33 Power Saving Kick In 
 
Use this option to set the time of inactivity before entering Power Save Mode. 
The shortcut key is "k" with the default set to "After 10 minutes". This means 
the Braille Sense U2 QWERTY enters power saving mode when you have 
not used the Braille Sense U2 QWERTY for 10 minutes. Use "Space" to 
cycle through the available settings: 10 minutes, 20 minutes, and 30 minutes. 
 

3.2.34 Check Today's Schedule 
 
In the "Schedule manager" (which you will learn about later), you can keep 
track of your appointments using the Braille Sense U2 QWERTY. YOU can 
set the Braille Sense U2 QWERTY to check today's schedule for 
appointments each time you turn it on. The short cut key for this option is "s". 
To toggle this option on/off, press "Space". 
 

3.2.35 One-Handed Mode 
 
This option allows users with only the use of one hand to use the Braille 
Sense U2 QWERTY in a specific mode adapted for that purpose. The 
shortcut key is "h". The default setting is "Off". Use "Space" to toggle one-
handed mode on/off. For detailed information about one-handed mode, refer 
to "2.14 One-Handed Mode". 
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Note: If this option is set to “On" when you connect a USB keyboard, it is 
automatically turned off when the keyboard is connected. The option returns 
to its previous state when the USB keyboard is disconnected from the unit.  
 

3.2.36 Automatic spell-check 
 
Use this option to set whether the Braille Sense U2 QWERTY automatically 
checks spelling as you type in "multi line edit boxes" in programs such as the 
schedule manager, address manager, e-mail messages, the word processor, 
etc. The short cut key for this option is "c". 
By default this option is set to "Off", thus spelling is not automatically 
checked as you type. Press "Space" to toggle automatic spell checking 
on/off.  
 
If the option is "On", and you enter a misspelled word, Braille Sense U2 
QWERTY emits a beep sound to indicate a misspelling. This beep sounds 
even if audio alerts are turned off. 
 

3.2.37 Default Document Type 
 
This option is used to set the default document type for new documents you 
create using the word processor on the Braille Sense U2 QWERTY. The 
shortcut key for this option is "q". By default, "Braille document" is selected 
as the default file type.  
 
You can choose "Sense document", "Braille document," or "Text document" 
as your default document type.  Press "Space" to cycle through the three 
options. 
 
Note: When you connect a USB QWERTY keyboard to the Braille Sense U2 
QWERTY, this option is automatically set to "Text document". When the 
USB keyboard is disconnected, the default document type is returned to 
whatever it was set to before the USB keyboard was connected. 
 



79 
 

3.2.38 Automatically synchronize with time server 
 
If you have the "Automatically synchronize with time server" option turned on, 
the date and time is synchronize with an internet time server automatically 
each time the Braille Sense U2 QWERTY is connected to internet. Using this 
feature, you can ensure the accuracy of the time on the Braille Sense U2 
QWERTY by synchronizing with an atomic clock via the internet.  
 
The shortcut key is "t". The default setting is "ON". Use "Space" to toggle 
time server synchronization on/off.   
 

3.2.39 Progress indicator 
 
The progress indicator setting defines how the progress of opening a 
document, copying files or opening a webpage is indicated. The shortcut key 
is "p”. You can choose among "Silent," (no progress indication) "Beep," 
(continuous beeps while the task is performed) and "Message" (progress is 
shown as a percentage).  By default, progress indication is set to "Message". 
Press "Space" to cycle through the three settings,  
 

3.2.40 Bluetooth 
 
Use this option to turn Bluetooth on or off. The shortcut key for this option is 
"b". Toggle Bluetooth on/off by pressing "Space". By default, it is set to "Off". 
You can toggle Bluetooth on and off from anywhere on Braille Sense U2 
QWERTY by pressing "F9".  
 
Note: you must turn Bluetooth on to connect to Bluetooth enabled devices. It 
is recommended that you turn Bluetooth off when it is not in use to save 
battery power. 
 

3.2.41 Wireless LAN 
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Use this setting to turn Wireless LAN on or off. The shortcut key for this 
option is "w". You can toggle wireless on/off by pressing "Space". By default, 
it is set to "Off". You can toggle it on and off from anywhere on Braille Sense 
U2 QWERTY by pressing "F11"  
 
Note: you must turn Wireless LAN on before connecting to a wireless 
network or to the internet via a wireless router. It is recommended that you 
turn wireless off when not in use to save battery power. 
 

3.2.42 Ethernet port 
 
Use this setting to turn the Ethernet port on or off. The shortcut key for this 
option is "l". You can toggle Ethernet on/off by pressing "Space". By default, 
it is set to "On". You can toggle it on and off from anywhere on the Braille 
Sense U2 QWERTY by pressing "Fn-F11"  
 
Note: to save battery power, turn this option off when you are not using 
Ethernet connectivity. 
 

3.2.43 Mass-storage device mode 
 
Mass Storage Device Mode enables the drives on your Braille Sense U2 
QWERTY to be viewed as removable storage devices on a PC when 
connected via USB. The shortcut key for this option is "d" with the default set 
to "On". Use "Space" to toggle this option on/off.  
 
If Mass Storage Device Mode is turned off, the Braille Sense U2 QWERTY 
can be connected to the PC as a Windows Mobile device and accessed 
using Microsoft ActiveSync or Windows Mobile Device Center for 
synchronization of calendar and contacts with Outlook. 
 
When you have finished modifying settings in the "Global Options" dialog, 
press "Enter" to save the settings. You can also “Tab” or "shift-tab" to the 
"Confirm" button, and press "Enter". If you do not want to save the settings, 
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“Tab” or "shift-tab" to the "Cancel" button, and press "Enter". You can also 
cancel saving the settings by pressing "Alt-F4" or "Esc". 
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4. File Manager 
 

4.1 Overview 
 
The functionality and structure of the "File Manager" on the Braille Sense U2 
QWERTY are very similar to "Windows Explorer" on a personal computer. 
To run the "File Manager", press "f" from the "program" menu or press 
"Enter" when your cursor is placed on "File Manager".  
The "File Manager" contains 2 basic areas: an "address window" and a "file 
list". When you first open the "File Manager", you are placed in the drive list. 
By default, you are placed on the internal flash drive, named "flashdisk". You 
can use the up and down arrows (“up arrow button” or “down arrow button”) 
or the scroll buttons to navigate the items in the drive list. Press "Enter" on 
the drive you want to open. The Braille Sense U2 QWERTY then displays 
the list of the files/folders on the drive you have opened. 
When you press “Tab” or "shift-tab" on the "file list," you enter the "address 
window". The "address window" contains the path of the current directory or 
file.  
For your convenience, the "File Manager" contains both menus and hot keys, 
allowing you to easily activate items in the program with a single keystroke 
as well as access and select a function through the menus even if you have 
not memorized the associated keystroke. YOU can bring up the menus by 
pressing “Alt”.  
WARNING!! The Braille Sense U2 QWERTY makes it possible to format the 
flashdisk to solve corruption problems and/or start over with a clean internal 
drive. Formatting the flashdisk erases everything on the flashdisk. Be 
extremely cautious when executing this command. If you execute this 
command, you will lose all of your data. You will NOT be able to retrieve this 
data once the command is executed. To format the flashdisk, press and hold 
"Ctrl-Fn-Left arrow key". While holding down "Ctrl-Fn-Left arrow key," quickly 
press and release the reset button. Continue holding "Ctrl-Fn-Left arrow key" 
until you hear the "format start" announcement. 
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4.1.1 Navigating the File List 
 
The "File Manager" contains two kinds of lists: the "file list" and the "menu 
list", or rather, the list of items contained in the "File Manager" menu. The 
menus in the Braille Sense U2 QWERTY wrap. This means, when you reach 
the end of the list of items in a menu, the Braille Sense U2 QWERTY 
automatically brings you back to the top of the list when you press “down 
arrow button”. However, when you reach the end of a "file list," the Braille 
Sense U2 QWERTY remains at the end of the list, even if you press “down 
arrow button”. The following is a list of the keystrokes used for navigating 
lists: 
 
1. Move to previous item: Up arrow key or up scroll button 
2. Move to next item: Down arrow key or down scroll button 
3. Move to the beginning of a list: Ctrl-Fn-Left arrow key 
4. Move to the end of a list: Ctrl-Fn-Right arrow key 
 
The following keystrokes are valid only in a "file list". 
 
1. Jump to folder or file list: Ctrl-Down arrow key 
2. Move between file list and address window: Tab / shift-tab 
3. Enter the selected folder or open the selected file: Enter 
4. Move back a level in the folder structure: Backspace 
5. Jump to the drive list: Shift-Backspace 
6. Move to the previous group of 32 items: Fn-Up arrow button 
7. Move to the next group of 32 items: Fn-down arrow button 
8. Jump to a file or folder by pressing the first character of the folder or file 
name. You must use ASCII characters. 
 

4.1.2 Selecting folders and files 
 
1. Select individual items "Space": * is displayed in front of the item to denote 
its selection. Pressing "Space" again on the selected folder or file cancels 
the selection. 
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2. Continuous selection (“Ctrl-b”): This selects all of the items from the point 
where this command is executed to the item where the cursor is located. * 
appears in front of the selected items. 

3. Select all (“Ctrl-a”): This selects all the files and folders in the current list. 

You can use navigation keys to move among the selected items to check 
their selection status. You can cancel selections or reselect de-selected 
items by pressing "Space". When the "Select All" command is executed, the 
Braille Sense U2 QWERTY says the number of selected files, and * appears 
in front of the selected files on the Braille display.  
 

4.1.3 Cancel / Exit 
 
Cancel (“ESC”): This command will cancel a function. 
Exit (“Alt-F4”): This will cancel or stop a selected function or program. 
 

4.2 Working with Files and Folders 
 
When you open the "File Manager," the list of available drives is displayed. 
Navigate to the drive you wish to access, and press "Enter" to open it. The 
Braille Sense U2 QWERTY displays the list of folders and files on that drive. 
The items in quotation marks are folders, and the items without quotation 
marks are files.  
The items in the list are followed by numbers, such as 1/5 or 2/5. The 
numbers following the items indicate an item's placement in the list and the 
total number of items in the list. For example, "database 1/5," indicates 
"database" is the first folder in a list containing five items. 
 
 
 

4.2.1 Selecting drives 
 
When you open the "File Manager," the first item in the list is "flashdisk". If 
an SD card or USB flash drive is inserted, it also appears in this list. 
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Navigate to and select a drive by using the up and down arrows or the scroll 
buttons. After selecting your desired drive, press "Enter" to open it.  
 

4.2.2 Entering and Exiting Folders 
 
There are several ways to open a folder. You can utilize the menu to open a 
specific folder. 
1) Bring up the menu by pressing “Alt”. Select the "Open" option from the list 
and press "Enter".  
2) You can also press the hot key “Ctrl-o” to activate the "Open" command 
and open the desired folder. 
3) Finally, as described above, you can simply press "Enter" on the selected 
folder. 
To exit the current folder, use the "Backspace" key. You are returned to the 
previous level in the folder structure.  
 

4.2.3 Opening a File 
 
You can open a file by pressing "Enter" on the selected item. You can also 
use “Ctrl-o” to open a file or folder. The Braille Sense U2 QWERTY 
automatically loads the appropriate application or program to open the 
chosen file.  
You can also open a file by using the menu. Press “Alt” to open the menu. 
Then, press the letter "o" or press "Enter" on "Open". 
The Braille Sense U2 QWERTY supports the following file formats:  
 
1. Document files: hbl, brl, txt, pwd, brf, rtf, doc/docx, PDF and unprotected 
EPUB files are supported in the Word Processor.  
2. Web formats: url, and html files are supported by the Web browser.  
3. Media formats: ac3, asf, asx, m3u, mp2, mp3, ogg, pls, wav, wax, wma, 
wmv and flac files are supported by the Media Player.  
4. DAISY books, including those from BookShare, NLS, and Open Library  
are supported by the DAISY player.  
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If you press "Enter" on a file type other than those mentioned above, the 
"Open With" dialog box appears, because the file type is not associated with 
a program. You can also bring up the "Open With" dialog box using the 
menu. By using the "Open With" menu option, you can open the currently 
selected file with a program other than the one originally associated with that 
file type. First, press “Alt” to bring up the menu. Navigate to "Open With," and 
press "Enter". You can jump quickly to this option in the menu by pressing 
"e". You can also open the dialog box by pressing "Ctrl-h" from the file list.  
This dialog box consists of the "Open With" list, the "adopt" list, a "Confirm" 
button, and a "Cancel" button. You can move between these elements by 
pressing “Tab” or "shift-tab". Within the list, you can select the next item by 
pressing "down arrow button" and the previous item by pressing “up arrow 
button”. 
When the dialog box opens, "Open with: Word processor" is displayed. In 
this list, you can select a program, the Word Processor, Media Player, or 
Web Browser. Pressing “down arrow button” selects the next program, and 
“up arrow button” selects the previous program. Once you have selected the 
program with which to open the file type, press “Tab” to move to the "adopt" 
list. If you have selected the Word Processor, pressing “Tab” takes you to an 
additional list called "Open mode". Using this list, you can specify whether 
the file is opened as a Braille file or a text file. Press “down arrow button” or 
“up arrow button” to select one of the two file types, then press “Tab” to 
move to the "Apply to" radio button. Use this radio button, to specify whether 
only the currently selected file or all of the files with the same file extension 
are opened with the specified program. After setting your preference, press 
"Enter" or “Tab” to move to the "Confirm" button, and then press "Enter" to 
apply the settings. If you have specified a program that does not support the 
file type, nothing is displayed or played after the program is launched. 
If you activate the "Open With" menu after focusing on folders that have 
DAISY or media files, the associated program, DAISY or Media Player is 
displayed. If you activate the "Open With" menu, and encounter a folder that 
does not have the DAISY info file (discinfo.html or ncc.html), the DAISY 
Player is not displayed as an associated program. You can play all of the 
files after selecting either the DAISY or Media Player. 
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4.2.4 Send To 
 
You can use this option to copy files and folders to different drives such as a 
flash drive, USB flash drive (also known as USB stick memory), or an SD 
card. After selecting files and folders, open the menu with “Alt”, and choose 
the "Send To" option. When you press "Enter" on "Send To", the Braille 
Sense U2 QWERTY displays the list of drives that you can send your files or 
folders to. You can choose a destination drive by using the up and down 
arrow keys (“up arrow button” or “down arrow button”) or up and down scroll 
buttons. Pressing "Enter" on the desired drive starts the copying of the 
selected files and folders to the selected drive. You can activate the "Send 
To" option by pressing “Ctrl-s” from the file list.  
 

4.2.5 Copy / Move 
 
"Copy" leaves the selected files and folders in their original locations, and 
creates copies of them in your chosen destinations. "Move" removes the 
selected files and folders from their original locations, and moves them to the 
new locations you have chosen. 
Use the copy/move function as follows: 
1. Select the files and folders you wish to copy.  
2. Open the menu, and choose "Copy" from the list to copy the selected files 
and folders. You can execute the "Copy" command directly from the file list 
by pressing "Enter-c". If you want to move the selected files and folders, 
choose "Cut" from the menu. Use "Enter-x" to execute the "Cut" command 
directly from the file list. When the "Copy" or "Cut" command is executed, the 
Braille Sense U2 QWERTY returns to the file list. 
3. Navigate to the destination folder. 
4. Open the menu, and choose "Paste". Press "Enter" on "Paste," and your 
selected files and folders are copied or moved. You can press "Enter-v" to 
execute the "paste" command directly from the file list.  
If the destination folder is the same as the source folder, the Braille Sense 
U2 QWERTY attaches "Copy1" to your original file names. If the same files 
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are copied into the same folder a second time, the Braille Sense U2 
QWERTY attaches "Copy2" to the original file names.  
If your destination folder has the same name as the file you are copying, the 
Braille Sense U2 QWERTY prompts "File xxx already exists. Overwrite? 
Yes". Press "Enter" if you want to replace the file. If you do not want to 
overwrite the file, select "No," and press "Enter". When "No" is selected, the 
"Paste" function is canceled. 
 

4.2.6 Delete Files or Folders 
 
To delete files or folders, navigate to the folders or files you want to delete, 
and select them. Open the menu by pressing “Alt” and choose the "Delete" 
option. Press "Enter" on "Delete" to complete the deletion of the selected 
files and folders. You can also press the letter "d" after opening the menu to 
delete the selected items. You can also delete selected files or folders by 

using hot keys. “Del” is the hotkey assigned to perform the delete function. 

When you delete only one file or one folder, it is not necessary to use the 
select function. Instead, simply navigate to the file or folder you want to 
delete, and use one of the methods previously described to delete the file or 
folder. 
 

4.2.7 Rename 
 
You can change the name of a file or folder by using this function. To change 
the name of a file or folder, move to the file or folder you wish to rename. 
Open the menu by using “Alt” choose "Rename" from the menu list and 
press "Enter", or press "r" to activate the "Rename" function quickly. You can 
also use the hot key "Enter-r" to activate the "Rename" function directly from 
the file list. The Braille Sense U2 QWERTY asks for a new name. On the 
Braille display, "New file (or folder) name: (current file/folder name)" appears. 
You must type the new file/folder name in ASCII characters. Press "Enter" 
after entering a new file name to complete the renaming process.  
You cannot use the following characters in a file name or folder: “|, \, <, 
>, ?, :, *” 
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4.2.8 New Document 
 
Use this option to create a new document. There are several ways to access 
this function. You can open the menu by pressing “Alt”, navigate to "New 
Document" and press "Enter". Or, you can open the menu and press "n". 
The hot key for this option in the "File Manager" is "Ctrl-n".  
When the new document function is activated, the Braille Sense U2 
QWERTY displays "File type: text (txt)". You can create two types of 
documents: text files and Braille files. You can use the down arrow (“down 
arrow button”) to select the "Braille (brl)" file format. When you press "Enter" 
on either "text (txt)" or "Braille (brl)," the Braille Sense U2 QWERTY displays 
"New document name: New Document0.txt" or "New Documen0.brl". "New 
Document0.xxx" is the default file name based on the file type you have 
chosen. The number after the new document increases by one whenever 
you create a new document for which you do not specify a name. You can 
also type in the document name you prefer and press "Enter". The new 
document you named is created. “|, \, <, >, ?, :, *” characters cannot be used 
when creating a file name. 
 

4.2.9 New Folder 
 
Use this option to create a new sub-folder under the current folder. Open the 

menu in the "File Manager" by pressing “Alt” and select "New Folder" from 
the menu list. Press "Enter" on "New Folder" to activate this function. You 

can use the letter "f" to jump the new folder option in the menu. "Alt-f" is the 
hot key that you use to access this feature directly from the file list. 

The Braille Sense U2 QWERTY prompts, "New folder name:,". Enter your 
preferred new folder name in ASCII, and press "Enter". Your new folder is 
created.   
When creating a new folder name, you cannot use the following characters: 
"|, \, <, >, ?, :, *” 
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4.2.10 File Conversion 
 
The "File conversion" function on the Braille Sense U2 QWERTY is similar to 
the "Save As" function in the Word Processor. This feature converts files to 
different file formats. The Braille Sense U2 QWERTY file conversion feature 
supports the following file formats: "Sense Word (hbl)," "Text (txt)," and 
"Braille (brl)". 
The Braille Sense U2 QWERTY can convert a single file or multiple files at 
once to your preferred file format. Select files using the file selection method 
described previously. After selecting the files you want to convert, open the 
menu by pressing “Alt”. Navigate to the "File Conversion" option, and press 
"Enter". You can also use the letter "t” to jump to the file conversion option 
from within the menu. Use "Ctrl-t" to execute the "File Conversion" command 
directly from the file list.   
The Braille Sense U2 QWERTY prompts you to choose the preferred file 
format. Use the up and down arrows (“up arrow button” or “down arrow 
button”) to select the desired file format. When you press "Enter" on the file 
format you want, the Braille Sense U2 QWERTY begins converting files to 
the file format you have chosen. The Braille Sense U2 QWERTY keeps the 
original file names for the files you have converted, except for the file name 
extension which reflects the new file type. If a file with the same name and 
extension already exists, "date" and "time" are added to the file name.  
 

4.2.11 Select All 
 
This feature selects all the files and folders in the current list. You can 
access this feature from the menu, or by using a shortcut key. Press “Alt” to 
open the menu. Press the down arrow (“down arrow button”) to navigate to 
"Select All". Press "Enter" to execute the "Select All" function. You can use 
the letter "a" to jump to and execute "Select All" from within the menu. Use 
"Ctrl-a" to select all the files and folders in the current list without entering the 
menu. When "Select All" is activated, the Braille Sense U2 QWERTY says, 
"x objects selected". The Braille Sense U2 QWERTY then returns to the file 
list.  
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An * appears in front of each file name you have selected. You can cancel 
the selection of a file or folder by pressing "Space". This feature is a 
convenient method for selecting multiple files for copying, cutting, or deleting.  
 

4.2.12 Search for File 
 
Use the "Search for File" function to locate a file or folder for which you know 
all or part of the name, but not the location. You can press "Alt” to open the 
menu and move to "Search for File," and press "Enter". Or use b to jump to 
and execute the search function from within the menu. You can press "Ctrl-f" 
to activate this function directly from the file list. The Braille Sense U2 
QWERTY displays the "file for find" dialog box.  
The dialog box consists of the "edit box for entering the text of the name to 
search", a "combo box to select a drive", "check box enabling to choose 
whether or not to search sub-folders", a "search button", a "cancel button" 
and the results list. You can use “Tab” or "shift-tab" to move through the 
controls. 
When you activate the file search, the unit prompt "File for find:" you are 
placed on the edit box for entering the file name to search". Type all or part 
of the file name and press "Enter". Braille Sense U2 QWERTY searches for 
all files containing the text you entered. When the file search is complete, 
you are placed in the results list.  
You can navigate among the items in the results list with the up and down 
arrows (“up arrow button” and “down arrow button”). If you press "Enter" on a 
file, you are placed on the path where the file is stored and the file search 
dialog box is closed. You can open the file by pressing "Enter" on the file 
name again. 
If you want to search for a file on another drive, after typing the file name,  
press “Tab” to move to the "target disk" combo box. You can press up and 
down arrows (“up arrow button” and “down arrow button”) to navigate to a 
different drive. If you press "Enter" either on a specific drive or on the 
"Search button," Braille Sense U2 QWERTY searches that drive for files 
matching the text you entered in the edit box.  
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The drive list displays all storage devices currently connected to the Braille 
Sense U2 QWERTY. If there are many files in a drive, it can take some time 
to perform a search. While the search is being performed, "searching" is 
displayed to alert you to the fact that the search is active.   
If you want to search the root of a drive excluding sub-folders, press “Tab” to 
move to the "Search sub-folders" check box. Press "Space" to uncheck this 
option, and press "Enter". By default, Braille Sense U2 QWERTY includes 
sub-folders when you search for files.  
 

4.2.13 Sort Files  
 
This option is used to specify the order in which files and folders are 
displayed in the file list. Press “Alt” to bring up the menu. Navigate to "Sort 
Files By," and press "Enter". Or, press (g" from within the menu to jump to 
and execute this option. You can access this feature directly from the file list 
by pressing "Ctrl-g"  
Files and folders can be sorted according to the following: "Name," "Size," 
"Extension," and "Date and Time". You can move among these items by 
pressing “down arrow button” or “up arrow button”. Press "Enter" after 
selecting the sorting criterion, and files and folders are displayed in the 
specified order. If you select "Name" or "Extension," the list is sorted in 
ascending order, and if you select "Size" or "Date and Time," the list is 
sorted in descending order. By default, files and folders in the file list are 
sorted by "Name" with folders appearing at the top of the list, and files 
appearing at the bottom. Once you have chosen how you want your file and 
folder lists sorted, the option is stored so that files are sorted according to 
your preference each time you open the "File Manager". 
 

4.2.14 Set File Info 
 
This item is used to set what kind of information is displayed for each item in 
the file list. Press “Alt” to bring up the menu. Navigate to "Set File Info," and 
press "Enter". Or press "l" to quickly access this item from within the menu. 
You can access this feature directly from the file list by pressing "Ctrl-l"   
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Use this option to select the information to be displayed for each item in a list. 
The available options are, "Name," "Name, Size," and "Name, Size, Date 
and Time". You can move among these items by pressing "down arrow 
button or “up arrow button”. Press "Enter" after selecting the information to 
be displayed, and the file list is updated, showing all the information you 
specified. By default, only names are displayed in the "file list". If you have 
selected "Name, Size," the name and size of files are displayed. However, 
for folders, size is not displayed. This option is stored and remains in effect 
until a hard reset is performed.  
 

4.2.15 Display only Files of Type 
 
This is used to specify what type of files are displayed in the file list. Press 
“Alt” to bring up the menu. Navigate to "Display only Files Of Type," and 
press "Enter". Or press w to quickly access this option from within the menu. 
You can also access this feature directly from the file list by pressing "Ctrl-w"  
Choose which files are displayed by selecting one of the following items: "All 
Files," "Sense Word Files," "MS Word Files," "Text Files," "Braille files," 
"HTML Files," "URL Files," "Media Files," and "Wave Files". You can move 
among these items by pressing “down arrow button” or “up arrow button”. 
Press "Enter" after selecting the file type you want, and only the files of the 
specified type are displayed in the file list. Folders are displayed no matter 
which type you have specified. By default, all files are displayed in the file list. 
This setting remains in effect only until you close the "File Manager," so all 
the files are displayed once again on restart of the "File Manager". 
 

4.2.16 Zip 
 
With this function, you can compress files and folders into a zip file. 
Compressing a file makes the total file size smaller, making it easier to email, 
or to save space on a storage device. To use the "Zip" function, follow these 
steps: 
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1) Select the files or folders you want to compress in the "file list" by using 
one of the methods described previously. 
2) Open the menu by pressing “Alt” or "F2," and press "Enter" on "Zip". Or, 
from within the menu, press "z". You can also activate this function directly 
from the file list by pressing "Ctrl-z". 
3) Braille Sense U2 QWERTY prompts, "Zip filename: (default filename.zip)". 
"Default filename" is the file name that is used for the compressed file if you 
try to compress only one file or folder. If you try to compress several files or 
folders, the default name is the folder name that contains the files and 
folders. 
4) Press "Enter" (or Tab to "Confirm" and press "Enter", and the zip file is 
created in the current directory. If you want to change the name of the zip file, 
you can modify the default by using the cursor keys or type in a new name. If 
you want to cancel, press "Esc" or "Alt-F4". Or, Tab to "Cancel" and press 
"Enter".  
 

4.2.17 Unzip 
 
The "Unzip" function allows you to unzip (or decompress) a zip file, 
regardless of whether it was created on Braille Sense U2 QWERTY or a PC. 
To activate the "Unzip" function, use the following steps: 
1) After selecting a zip file, open the menu with “Alt” or "F2," and press 
"Enter" on "Unzip". Or, press "u" from within the menu. You can also activate 
this function directly from the file list by pressing "Ctrl-u" when placed on a 
zip file. 
2) Braille Sense U2 QWERTY prompts, "Unzip to folder name: (default folder 
name)". The default folder name is the same as the compressed file name. 
For example, if you unzip a file called "test.zip," "unzip folder name: test" is 
displayed. 
3) Press "Enter," or move to "Confirm" by pressing “Tab” and press "Enter". 
The Braille Sense U2 QWERTY unzips the files to the default folder. If you 
want to change the default folder name, you can modify the default folder 
name. Or, you can type a new name. If you want to cancel, press "Esc" or 
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"Alt-F4". You can also move to the "Cancel" button by pressing “Tab”, and 
press "Enter".  
Note: You can also initiate the unzip process simply by pressing "Enter" on a 
zip file. 
 

4.2.18 Information 
 
Use this option to query The Braille Sense U2 QWERTY for information 
about files and folders. The information feature in the "File Manager" 
provides you with information about the file type, file size, the date and time 
of the file or folder's creation, and whether the file/folder is protected. Press 
“Alt” to open the menu. Navigate to "Information" and press "Enter". Use the 
letter "I" to open the "Information" feature quickly from within the "menu". 
"Fn-i" is the hot key for this option. You can use this hot key to access this 
feature directly from the file list.  
The Braille Sense U2 QWERTY displays the information about a file or folder 
in the following order: file type, file size, creation date and time, and attribute. 
You can review this information by pressing the “Tab”.  
1. File type: Displays the file format information, such as "brl file," "doc file," 
or "txt file". When a folder is selected, this area indicates that the item is a 
folder containing x number of files and folders. 
2. File size: displays the size of the selected file or folder. When multiple files 
or folders are selected, this area displays the total size of the selected files 
and folders. 
3. Date and time: Displays the time and date the folder/file was created or 
modified. 
4. Attribute: Displays whether the file is write protected or is writable. You 
can change this attribute by using the up and down arrows (“up arrow 
button” or “down arrow button”) or "space." When multiple files or folders are 
selected, this attribute is not shown. 
5. Confirm: To change the attribute, press "Enter" on "Confirm".  
6. Cancel: To cancel the change, press "Enter" on the "Cancel" button.  
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4.3 Using the Address Window 
 
This edit box lets you type the direct path of the file name you want to open. 
This window also contains the history list for easily accessing recently 
opened files or directories.  
 

4.3.1 Editing 
 
When you are in a file or folder list, you can press “Tab” to navigate to the 
address window. The Braille Sense U2 QWERTY displays the current path 
including the current drive name, such as "flashdisk/download/". When you 
edit the path, use the cursor routing keys to move the cursor to the place 
where you wish to modify the text of the path. When you first enter the 
address window, the cursor is located at the end of the path name.  
The address window is only visible when you are in a file or folder list. When 
you are in the drive list, the address window is not available. 
 

4.3.2 Typing a Path / File Name 
 
When you relocate the cursor with a cursor routing key, the Braille Sense U2 
QWERTY inserts the text at the cursor location. If you know the exact path 
and file name, you can type in the path and file name to open the file with the 
appropriate application. For example, if you type in "flashdisk/download" in 
the address window and press "Enter," the Braille Sense U2 QWERTY 
displays the list of the files in the download folder. If you type "flashdisk/My 
Documents/sample.txt" in the address window, and press "Enter," the Braille 
Sense U2 QWERTY loads the Word Processor, and opens the file 
"sample.txt". When the file is open, you can read or edit the file, "sample.txt". 
 

4.3.3 Opening the History List 
 
The history list contains paths, folders, and files that you have opened 
previously. You can access the history list from within the address window by 
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pressing the down arrow (“down arrow button”). Use the up and down arrows 
(“up arrow button” or “down arrow button”) to review the history list. You can 
also use the scroll buttons to navigate this list. To open a file in the history 
list, press "Enter". The file opens with the appropriate application. (See 
section 4.2.3).  
While navigating the history list, you may type in new path names or file 
names to instantly access a file or folder. 
 

4.4 Network and sharing  
 
The network file sharing function enables you to share files between your 
Braille Sense U2 QWERTY and computers connected to the same network, 
and access files on other computers just as you would files located directly 
on your Braille Sense U2 QWERTY.   
In other words, you can copy files on the Braille Sense from other computers 
on the network, edit files on other computers with the Word Processor or 
even open media files on other devices and play them in the Media Player 
on the Braille Sense U2 QWERTY.  In addition, you can share folders on 
your Braille Sense U2 QWERTY and access them from other computers 
connected to the network.  
You can share files over a network using LAN or WIRELESS LAN. When 
using LAN, once the Braille Sense U2 QWERTY is connected, you can 
easily find and access the shared files of other computers connected to the 
network.  
However, when using wireless LAN, it is only possible to access shared files 
when your Braille Sense U2 QWERTY and the connected computer are at 
the same layer. This means that you can't search for a computer connected 
to router A if you are connected to router B, a wireless LAN sub-connection 
of router A.  
For more detailed information on LAN/WIRELESS LAN configurations, refer 
to the "Setup Internet" section of the "Utilities" chapter in this user manual.  
 

4.4.1 Search for shared computers and add to the network 
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list. 
 
When you open the "File Manager", network is displayed in the drive list. The 
network list consists of the shared folders on computers connected to your 
network that you have added to the network list. From the network list, you 
can open the shared folder, or delete the network location from the list. If you 
have not added shared folders to the network list, this list is empty. To add 
items to the network list, you must search the network for devices, then 
select the shared folders on these devices and add them to the network list.  
To search shared computers connected to the network, Use the "Network 
Connection Setting" dialog to search for computers with shared content. You 
can open the "Setup Network connection" dialog box, by pressing "Alt-e" 
regardless of your position in the File Manager. Or Press “Alt” to open the 
menu and navigate to "Network Connection Setting" and press "Enter".  
The "Network Connection Setting" dialog box contains the following controls: 
 
"Remote name" computer edit box  
"Remote folder" list box  
"Add/Remove" button 
"Cancel" button 
 
When the "Network connection Setting" dialog box is opened using "Alt-e", 
you are placed on the "Computer name" edit box. Type the computer name 
with or without backslashes and press "Enter". 
For example, if the computer name you want to search is "hims", type 
"\\hims" or "hims" and press "Enter". If the shared computer is found, a login 
prompt may be displayed according to the shared computer setting. 
If the computer is running Windows vista or Windows 7, you must enter the 
folder path as shown below.  
Ex) "\\hims\sharing", "hims\music" 
Note: if the shared folder name exceeds 11 characters, it cannot be 
recognized by the Braille Sense U2 QWERTY.  
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If the computer you are trying to access does not have a network user name 
and password specified, type "guest" in the Login edit box and press "Enter". 
If the computer requires a specific network user name and password, make 
sure they are entered correctly. If login is successful, you are placed in the 
Remote Folder list and the folders shared on that computer appear in the list. 
Move to the desired folder in the list and press "Enter" on the "Add" button. 
The network location of the shared folder is added to the network list in the 
File Manager. You may select as many folders as you wish from the Remote 
Folder list and add them to the network list. 
 
Use the following keystrokes to navigate the "Network Connection Setting" 
dialog: 
Move to the next control: "Tab”  
Move to the previous control: "Shift-Tab" 
  
Use the following keystrokes in the Remote Folder list.   
Move to the next item in the list: "down arrow button" 
Move to the previous item in the list: "up arrow button" 
Select current item: Space 
Select all items: Enter-a  
 
Use the "Add" button, to add the selected shared folder from the Remote 
Folder list to the File Manager's network list. From the Remote Folder list, 
press "enter" to exit the "Network connection Setting" dialog box. YOU can 
also cancel using "Alt-F4" or "Esc".  
Once the network locations of the shared folders have been added to the list, 
they are accessible from the "network" option in the File Manager as long as 
you are connected to the network where they reside. In other words, if you 
have added a location for a shared folder on your home network, you cannot 
access this location from your office as you are no longer connected to the 
home network on which the shared folder is located. Also remember that you 
cannot access shared folders on a network if you do not have a wireless or 
LAN connection to that network.  
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4.4.2 Remove Remote folder(modify)  
 
There are 2 ways to remove a remote folder from the File Manager's network 
list: using the "Remove" option in the network list, or via the "Network 
Connection Setting" dialog. 
   
Using the network list: 
Execute the File Manager and choose "network" from the drive list. Navigate 
to the remote folder you want to remove and press "Alt-d".  
You can also access this function using the menu. Press “Alt” to open the 
menu. Arrow down to "Remove this remote folder on network" and press 
"Enter".  
 
Using the "network connection setting" dialog: 
Press "Backspace-e" to open the "network connection setting" dialog. 
Navigate to the remote folder you want to remove. Press “Tab” to navigate to 
the "Remove" button and press "Enter".  
 

4.5 Hot Keys in the "File Manager" 
 
The following is a list of hot keys that can be used in the File Manager 
1. Open: Ctrl-o  
2. Open with: Ctrl-h  
3. Zip: Ctrl-z 
4. Unzip: Ctrl-u 
5. Send To: Ctrl-s 
6. Copy: Ctrl-c 
7. Cut: Ctrl-x 
8. Paste: Ctrl-v  
9. Delete: DEL 
10. Rename: F2 
11. New document: Ctrl-n 
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12. New folder: Alt-f 
13. File conversion: Ctrl-t 
14. Select all: Ctrl-a 
15. Sort files by: Ctrl-g  
16. Set file info: Ctrl-l  
17. Display only files of type: Ctrl-w  
18. Search for file: Ctrl-f 
19. Information: Alt-Enter 
20. Setup Network connection: Alt-e 
21. Remove remote folder on network Alt-u 
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5. Word Processor 
 
When you launch the Word Processor on the Braille Sense U2 QWERTY, it 
places you in a new, blank document. The menu can be opened by pressing 
“Alt”. Don't worry if you can't remember the exact shortcut keys for all of the 
Word Processor functions, as you can activate all the functions of the Word 
Processor via the Word Processor menu. The menu in the Word Processor 
consists of File, Edit, Go To, Read, and Layout. To access these menus, 
press “Alt” in the Word Processor, select a menu item, and press "Enter". Or, 
you can press “Alt” followed by the shortcut for the corresponding menu item.  
For example to open the edit menu, press “Alt” to open the menu, and 
navigate to the Edit menu by pressing up and down arrows (“up arrow 
button” and “down arrow button”) and press "Enter". Or, press “Alt” and press 
"e".  
Before going in to more detail about the Word Processor, it is also important 
to note that while you are anywhere in a document, you can discover your 
location by pressing "Fn-s". In addition, if you are editing a document, and 
turn the Braille Sense U2 QWERTY off, it announces the status when you 
power back on. In the next few sections the features of the Word Processor 
are explained in more detail. The functions of each of the available menu 
items are also explained. 
 

5.1 File Menu 
 
The "File" menu contains the functions that allow you to create new 
documents, open documents saved to a disk, save edited documents, and 
print and emboss. It also contains various option settings. To select the file 
menu, press “Alt”, and press "f". Or, press "Enter" on "File". 
 

5.1.1 New 
 
The new command creates a new, editable document. By default, the name 
of the new document is "noname.brl". The extension, ".brl" is the extension 
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given to documents that are created in Braille on the Braille Sense U2 
QWERTY. It is the same file name that is created automatically when the 
Word Processor opens.  
Note: if you have changed your default document type in the "Global 
Options", the extension may be _TXT or HBLIND, as your default document 
type can be set to Braille, text, or Sense document. 
To create a new document, select "New" from the "File" menu. Or, press 
"Ctrl-n". If "New" is executed while editing another document, you are 
prompted for the file type of the new document: "Sense Document (s)" is 
displayed first. If you press “down arrow button” repeatedly, "Braille 
Document (b)" and "Text Document (t)" are displayed. Select the document 
type you want, and press "Enter". 
"New" refers to creating a new, blank document after closing the document 
that is currently being edited. Closing the document currently being edited 
means that the document is erased from the temporary memory. If a new 
document is created or opened without saving the document currently being 
edited, the Braille Sense U2 QWERTY asks whether to save the current 
document, so that changes to it are not lost. When "Save: Yes" is displayed, 
users can select "Yes" To save the current document or select "No" in order 
not to save the changes. If you press "Space" once more and select 
"Cancel", the Word Processor cancels the new document, and returns to the 
current document. 
  

5.1.2 Open (modify) 
 

The open command opens a document that has already been saved on to 
a disk. Select “Open” on the “File” menu, or press “Ctrl-o.” You can access 
the “File” menu by pressing “Alt”. Then, a dialog box pops up, so that you 
can open a file. The “Open dialog box” is a tool that helps you find 
documents that you want to edit and read. It consists of the “file list” (which 
shows the list of files or folders), “File name” (to type in a file name directly), 
“Type” (which changes the file format when opening a document), a 
“Confirm” button (for confirming the selection), and a “Cancel” button (for 
canceling the selection). In order to move between these controls, press 
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“tab” or “shift-tab.” If the “Open dialog box” is executed, “File name:” is 
displayed first. If “File name:” is displayed, then type in a file name that you 
want to open, and press “Enter.” The Braille Sense U2 QWERTY will look 
for that file in the “/flashdisk/My Documents” folder. If there are files that 
you used recently, you can scroll through them by pressing “Down arrow 
key.” The file names that were opened recently are displayed one by one 
by pressing “Down arrow key.” If the file open that you want to open is 
selected press “Enter” to open it. In order to move to the previous file name 
in the list, press “Up arrow key.” In order to open a file with a different file 
format, press “tab” to move to the file format selection, and then press the 
up arrow or down arrow to select a desired file format. You can find and 
open a desired file from the file list without typing in the file name directly in 
the “File name:” box. Press “tab” several times to move to the “file list,” and 
then select a desired file. You can also move to the “file list” by pressing 
“shift-tab” when you are at the “File name:” dialog box. The files in the “file 
list” have the file format that was selected in “file type.” 
 
You can select a file that you want by using the up and down scroll buttons, 
and you can open the file by pressing “Enter.” If you select a folder and 
press “Enter,” you will see the list of files in that folder.  
 
If you want to access a file that is on a compact flash card, or USB memory 
stick, you can access the file in the “Open” dialog box by first moving to the 
“file list” by pressing “shift-tab. Then, press “Backspace” until you hear the 
USB stick memory or the compact flash card. Then, press “Enter” to open 
the memory.  
The Braille Sense U2 QWERTY will choose the Braille mode depending 
upon the file type. For example, if you press “Enter” to select a file that has 
the extensions hbl or brl, or if you type in a file name with those extensions 
and press “Enter,” the Braille Sense U2 QWERTY will open the selected 
file in Contracted Braille. You will not be able to change the Braille mode in 
these documents. If you press “Enter” to select a file that has the 
extensions of txt or doc, it will open the file in what is currently set in “View 
grade” of “global options”. After the file opens, you can switch the Braille 
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mode, as was explained in section 3.4. If you press “Enter” at the other file 
format, you can select the file format; Braille format, or text format. You can 
toggle between “Braille format” and “Text format” by pressing the 
“Space”. Press “Enter” when the desired format is displayed. If the Braille 
format is selected, the document will be opened in Contracted Braille. And, 
if the text format is selected, the document will be opened in Braille mode 
that is currently set in “View grade” of “global options”. 
 
In the word processor of the Braille Sense U2 QWERTY, it is possible to 
open and work simultaneously with up to 10 files at one time. If you already 
have one document open, and you try to open another document, the 
Braille Sense U2 QWERTY will ask you if you want to save changes to the 
document that is already open. Then, you can save the file. Once you have 
completed saving the document, an open dialog box will appear. However, 
you will still have the two files open. It only seems that you closed one 
without saving it. With the new document open, if you want to go to the 
previous document, you can press “shift-tab.” If you want to go back to the 
other document again, press “tab.” 

 

5.1.3 Save 
 
The save command saves a document to a disk. To use this option, press 
“Alt” to open the "File" menu and execute the "Save" command by pressing 
"Enter" on it, or you can press "s" to quickly jump to and execute it. You can 
also use the hot key, “Ctrl-s” while editing a document. 
If the document has not been saved previously, when you execute "Save", 
"Save as dialog" opens. You can refer to section 5.1.4 for information on how 
to use the "Save as dialog". 
If you execute "Save" after editing an existing document, Braille Sense U2 
QWERTY saves the document with your changes under the same file name 
without opening a dialog. After saving a document, you are returned to 
document editing.  
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When you have several documents open, you can save and close the 
focused document, by pressing "Ctrl-F4". The document is saved and closed, 
and your focus is placed in the previous document in the tab order. 
 
Note: 
1) Though you can open PDF and unprotected EPUB files in the Word 
Processor, they cannot be saved under these file types as editing in these 
formats is not supported. If you save one of these documents, the "Save as" 
dialog opens so that you can save in one of the file types supported by the 
Braille Sense U2 QWERTY.  
2) When saving as "rtf" and "doc", the file formatting is lost as the creation of 
advanced formatting is not supported in the Braille Sense U2 QWERTY.  
 

5.1.4 Save As 
 
The "Save As" option is used to save a document under a different file name, 
in a different location, or as a different file type. To execute this command, 
press “Alt”, and press "Enter" when the "File" menu is displayed. Move to 
"Save As" by pressing “down arrow button”. Then, press "Enter". Or, use the 
hot key, "Ctrl-s", while editing a document. 
If you execute "Save As", the "Save as dialog" is displayed. This dialog is 
almost the same as the "Open" dialog. It consists of "file list", "File name", 
"Type" (representing the file format), a "Confirm" button, and a "Cancel" 
button. When the dialog opens, "File name:" is displayed. You can move 
among the controls by pressing “Tab” or "shift-tab". 
If you execute "Save As" when you are editing an existing document, the 
displayed file name, file format, and the folder are the same as those of the 
existing file. When executing "Save as", on "PDF" and "EPUB", documents, 
the formatting is lost as these files are converted to txt format on opening. 
If you execute "Save" or "Save As" while in a new document, the displayed 
default file name is "noname.brl" and the file path is "flashdisk/My 
Documents/". 
To edit the displayed file name, press the cursor routing key at the position 
you want to edit, and modify it. Or, to create a new file name, simply type in 
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the new file name to overwrite what is currently in the edit box. You cannot 
use the following characters in a file or folder name. “|, \, <, >, ?, :, *” 
To change the file format, navigate to "Type". Move to your desired file 
format by pressing “up arrow button” or “down arrow button”. 
To save a file with a file name that is in the file list, move to the "file list" by 
pressing "shift-tab".  
 

5.1.5 Close Current Document 
 
The "Close Current Document" command allows you to close the currently 
focused document without closing the Word Processor. You can access the 
"Close Current Document" command by pressing “Alt”. Then, press "Enter" 
on the "File" menu. Use the up and down arrows (“up arrow button” and 
“down arrow button”) to navigate to "Close Current Document", and press 
"Enter". Or, you can press "q" in the "File" menu. You can also access this 
function by pressing "Ctrl-F4" while editing a document. Please note that this 
function is not available if you only have one document open. You must have 
at least two or more documents open to execute the "Close Current 
Document" command. 
 

5.1.6 Print 
 
The "Print" command is used to print or emboss the current document. To 
execute this command, press “Alt”, and press "Enter" on the "File" menu. 
Then, move to "Print" by pressing “down arrow button”, and press "Enter", or 
just press "p”. While editing a document, the hot key for printing is "Ctrl-p". 
There are two lower level dialogs for the "Print" option. One is for printing 
with an ink printer, and the other is for embossing in Braille. Remember that 
you can move between the menu items by using “up arrow button” or “down 
arrow button”. 
1. Embossing in Braille 
Open the document that you want to emboss. Press “Alt” to activate the 
menu. Locate "print" in the "File" menu and select "Embosser", or press "b". 
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When you select "Embosser (b)" above, the "Embosser dialog" is opened 
and contains the following items:  
1) Start page number 
This is the first page number to be embossed. The default page number is 
set to 1. You can change the value of the page number, by typing in a new 
value. Press “down arrow button” to move to "End page number"  
 
2) End page number 
This is the last page number to be embossed. The default value is set to 
100000. This means the document is embossed to the end of the document, 
unless the document exceeds 100000 pages. To change the value, input the 
number of the end page. Use “down arrow button” to move the "Number of 
copies").  
 
3) Number of copies 
This option designates the number of copies to be embossed. The default 
value is set to 1. You can change this number by typing your desired number 
of copies. Press “down arrow button” to navigate to "Set Braille format".  
 
4) Set Braille format 
In this option, you can set whether or not the Braille document layout 
settings specified in Braille Sense U2 QWERTY are used when embossing. 
If you set this to "Yes", the document is embossed using the Braille 
document layout settings in Braille Sense U2 QWERTY. If you set it to "No", 
the document is embossed in the format specified in the original document. 
 
5) Confirm / Cancel 
To begin embossing the document, move to "Confirm" by pressing “Tab”, 
and press "Enter". Or, to cancel embossing, move to "Cancel" by pressing 
“Tab”, and press "Enter". 
 
When "Enter" is pressed on "Confirm", "Print: Yes" is displayed. Press 
"Enter" on "Yes", and embossing commences. If you do not want to emboss, 
press "Space" to select "No", and press "Enter". You can also choose to 
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create an electronic Braille file of the document according to the embossing 
preferences. To do this, press "Space" once more to select "Save as file", 
press"Enter", and the current document is saved as a "brl" file. If you've 
chosen to emboss, and there are problems with the Braille printer, the Braille 
Sense U2 QWERTY shows an error message and returns to the open 
document. 
 
2. Print Text 
This option is used when you want to print a document on an ink printer. To 
do so, open the document to be printed and press “Alt”, and press "Enter" on 
the "File" menu. Move to "Print" by pressing “down arrow button” repeatedly, 
and press "Enter". Or just press "p" from the "File" menu. The dialog for the 
"Printer" is almost the same as for the "Embosser". After you input the values 
as in the embosser dialog, press “Tab” and press "Enter" on "Confirm".  
"Print: Yes" is displayed. If "Enter" is pressed, printing commences. If you 
press "Space" to move to "No", and press "Enter", printing is canceled, and 
the Braille Sense U2 QWERTY returns you to the open document. 
Note that the Braille Sense U2 QWERTY is compatible with all HP printers 
(level PCL 3 or higher), and with HP-compatible printers. 
 

5.1.7 Settings 
 
To change your Word Processor preferences, press “Alt”, and press "Enter" 
on "File". Move to "Settings (e)" by pressing “down arrow button” repeatedly, 
and press "Enter" or just press "e” from the "File" menu. While editing a 
document, pressing "Ctrl-e" opens the "Settings" dialog. 
The "Settings" dialog contains the following: the "settings" list, "Default 
folder" button, "Confirm" button and a "Cancel" button. You can move among 
the controls by pressing “Tab” or "shift-tab". And you can move among the 
items in the settings list by pressing “up arrow button” or “down arrow button”. 
The following are the settings that can be changed: 
 
1. View format character (Yes/No): If this option is set to "Yes", all of the 
format characters are displayed. Use "Space" to toggle this option. 
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Formatted characters are marked as "carriage return ($p)", and the "mark 
indicator ($pl)". 
2. Reading unit (Line/Paragraph): Defines the unit of movement when 
pressing “up arrow button” or “down arrow button” while reading a document. 
If this option is set to "Line", “up arrow button” moves up line by line. If this 
option is set to "Paragraph", “up arrow button” moves backward in a 
document paragraph by paragraph. To toggle between "Line" and 
"Paragraph", press "Space". 
3. Read only (Yes/No): If this option is set to "Yes", the document cannot be 
modified. This setting is used to protect the document from any unintentional 
modifications. To change it to "No", press "Space". 
4. Reading mode (Original/Compressed): This option sets the reading mode. 
Original reading mode shows the document in its original format. 
In "Compressed" reading mode, The Braille Sense U2 QWERTY displays 
document content on the Braille display continuously without regard to 
formatting such as carriage returns ($p). To toggle between "Original" and 
"Compressed" reading modes, press "Space". 
5. Auto scroll speed (1~35): This option sets the duration of displaying one 
Braille display length while you are auto scrolling in a document. Thirty-five is 
the fastest scrolling speed. Pressing "Space" increases the scroll speed and 
"Backspace" decreases it.  
6. Automatic save interval (Don't save automatically, 10~60): This option 
defines the automatic save time interval for the file that is currently being 
edited. The setting time can be increased or decreased by 10 minutes if you 
press "Space" or "Backspace" respectively. If you do not wish for the 
document to be saved automatically, choose "Don't save automatically". 
7. Apply settings to all documents (Yes/No): This option allows you to apply 
the current settings to all documents. If "Yes" is selected, the settings apply 
to all documents, if "No" is selected, the settings affect only the document 
currently being edited. To toggle between "Yes" and "No", press "Space". 
 
To change the default save-to folder, move to the "Default folder" button by 
pressing "tab" and press "Enter". You are placed in the "file list". Navigate to 
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the folder or disk you want using normal navigation keys, press "Space" on 
the folder you wish to select, and press "Enter".  
When you are finished setting your preferences, move to the "Confirm" 
button by pressing "tab" and press "Enter". If you do not want to save the 
settings, press "Enter" on the "Cancel" button. Activating the "confirm" or 
"Cancel" buttons performs the operation and returns you to the document 
you are currently editing. 
 

5.1.8 Exit 
 
This command closes the Word Processor. To execute this command, select 
"Exit" from the file menu, or press "Alt-F4". If you have edited the document 
and have not saved the changes, when you select "Exit", you are prompted 
to save the current document. You can select "Yes" or "No" with the 
spacebar and press "Enter" to exit the Word Processor. 
 

5.2 Edit Menu 
 
On the Braille Sense U2 QWERTY, you can edit all files regardless of what 
the view/input grade is set to. The "Edit" menu contains the following items: 
"Start Selection", "Copy", "Cut", "Paste", "Delete", "Delete Blank Lines", "Add 
To clipboard", "Clear Clipboard", "Select All", "Insert From File", "Insert Date", 
"Toggle Insert/Overwrite Mode", and "Check Spelling". To open the menu, 
press “Alt”, and press "Enter" on "Edit". Or, you can press "e" from the menu.  
 

5.2.1 Start Selection 
 
The "Start Selection" command allows you to select a certain portion of text 
that you would like to edit. When you use the "Start Selection" command, the 
cursor appears as blinking "dots 1-2-3-4-5-6-7-8" to indicate what text is 
being selected. When text is selected, you can make changes to only the 
selected text, without affecting the text in the rest of the document. This 
command is especially useful for copying, cutting, and pasting.  
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To select text in a document, place your cursor on the location at which you 
want to start selecting text. Press “Alt” to open the "Edit" menu, and press 
"Enter" on "Start Selection", or you can press "b" in the "Edit" menu to get to 
this option. While editing a document, pressing “Ctrl-b” activates this 
command.  
The end point of the selected text is determined by the location at which you 
place the cursor after setting the start point. For example, if you have typed 
the word, "mother" in a document, and you want to select the word "mother", 
place the cursor on the letter m, activate the "Start selection command", and 
place the cursor directly after the letter rather. The word "mother" is selected.  
 

5.2.2 Copy 
 
After selecting text in a document, press “Alt” to open the menu, and move to 
"Edit" by pressing “down arrow button”. Press "Enter" to open the "Edit" 
menu. Press “down arrow button” to move to "Copy" and press "Enter", or 
press "c" from the "Edit" menu. While editing a document, pressing "Ctrl-c” 
activates this command. 
When you copy the selected text, it is copied to the clipboard. The clipboard 
is the virtual space that is used for storing copied data temporarily. If you 
copy new text to the clipboard, the data in the clipboard that you copied 
previously is erased, and is replaced by the current text selection.  
 

5.2.3 Cut 
 
To cut a selection of text, press “Alt”, and press "Enter" on "Edit". Move to 
"Cut" by pressing “down arrow button” repeatedly, and press "Enter", or 
press "x" from the "Edit" menu. While editing a document, pressing "Ctrl-x" 
activates the "Cut" command. 
The difference between "Cut" and "Copy" is that if you execute the "Cut" 
command, the selected text is moved to the clipboard and the selection is 
removed from the document. The "Copy" command simply copies the 
selection to the clipboard, and the selected text remains in the document. 
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5.2.4 Paste 
 
To paste selected text to the clipboard, press “Alt”, and press "Enter" on 
"Edit". Move to "Paste" by pressing “down arrow button” repeatedly and 
press "Enter", or press "v" from the "Edit" menu. While editing a document, 
press "Ctrl-v" to paste the text from the clipboard to your current cursor 
location. 
 

5.2.5 Delete 
 
To delete selected text, press “Alt”, and press "Enter" on "Edit". Move to 
"Delete" by pressing “down arrow button” repeatedly, and press "Enter", or 
press "d" from the "Edit" menu. While editing a document, you can press 
"Del" to delete selected text.  
 

5.2.6 Delete Blank Lines 
 
To delete blank lines, you must select the area of the document from which 
you want the blank lines to be deleted. Once done, press “Alt”, and press 
"Enter" on "Edit". Move to "Delete blank lines" using “up arrow button” or 
“down arrow button” and press "Enter", or press "l" from the "Edit" menu. To 
delete empty lines while editing a document, press "Alt-e".  
 

5.2.7 Add to Clipboard 
 
To add selected text to the clipboard, press “Alt”, and press "Enter" on "Edit". 
Move to "Add To Clipboard" by pressing “down arrow button”, and press 
"Enter", or press "p”. While editing a document, pressing "Ctrl-Insert" 
activates this command. 
"Add To Clipboard" is almost the same as the "Copy" command. However, 
while the "Copy" command replaces the text copied previously with the 
newly selected text, the "Add To Clipboard" command does not erase the 
previously copied data, but appends the newly selected text to the clipboard. 
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5.2.8 Clear Clipboard 
 
To clear the clipboard, press “Alt”, and press "Enter" on "Edit". Move to 
"Clear Clipboard" by pressing “down arrow button” repeatedly, and press 
"Enter". Or, you can press "e" from the "Edit" menu. Executing the "Clear 
Clipboard" command erases everything on the clipboard. While editing a 
document, you can press "Ctrl-Del" to activate this command. 
 

5.2.9 Select All 
 
The "Select All" command selects all text in a document. To activate this 
command, press “Alt”, and press "Enter" on "Edit". Move to "Select All" by 
pressing “down arrow button” repeatedly, and press "Enter", or press "a" 
from the "Edit" menu. While editing a document, press "Ctrl-a" to activate this 
function. 
 

5.2.10 Insert from File 
 
This command inserts another file in the document you are currently editing. 
To execute this command, press “Alt”, and press "Enter" on the "Edit" menu. 
Move to "Insert from File" by pressing “down arrow button” repeatedly and 
press "Enter", or press "I" from the "Edit" menu. While editing a document, 
pressing “Ctrl-i" activates this function. 
When you use this option, an insert dialog is displayed similar to the "Open" 
dialog. Select file you want to insert, and press "Enter". The selected file is 
inserted at the beginning of the paragraph on which your cursor is located. 
When you execute "Insert from File", if the format of the inserted file differs 
from your current document, the text inserted from the file is converted to the 
file format of the current document.  For example, if you insert "sample.txt" in 
"sample.brf" and save it, the saved file is "sample.brf". 
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Note: If you insert a Braille file in to a text file, the Braille document is back-
translated to text. Though the inserted text appears normally in grade 2, on 
rare occasions you might see differences in the back-translated text. 
 

5.2.11 Insert Date 
 
To insert the date into your document, press “Alt”, and press "Enter" on 
"Edit". Move to "Insert Date" by pressing “down arrow button” repeatedly and 
press "Enter", or press "w" from the "Edit" menu. The current date and time 
"is inserted at your current cursor location. While editing a document, press 
"Ctrl-w" to activate this command. 
 

5.2.12 Insert Time 
 
To use this function, press “Alt”, and press "enter" on "edit". Move to "insert 
time" by pressing “down arrow button” repeatedly and press "enter", or press 
"t" from the "edit" menu. The current time is inserted into your document at 
your cursor location. While editing a document, press "Alt-w" to activate this 
function. 
 

5.2.13 Toggling Insert and Overwrite Modes 
 
There are two ways of editing documents on the Braille Sense U2 QWERTY. 
The first is to insert your text, which pushes back the text after the cursor. 
This is called "Insert mode" because you are simply inserting text. When you 
are in "Insert mode", the cursor displays as "dots 7-8". The second is to 
overwrite text at the cursor location. This is called "Overwrite mode". In 
"Overwrite mode", the cursor displays as blinking "dots 7-8". 
When you start the Word Processor (or open a document), "Insert mode" is 
the default.  You can switch to "Overwrite mode" by pressing "Insert".  To 
return to "Insert mode", press "Insert" again. You can also access this 
function via the menu. Press “Alt”, press "Enter" on "Edit". Navigate to 
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"Toggle Insert/Overwrite Mode" using “up arrow button”, or you can press 
"m" from the "Edit" menu. 
 

5.2.14 Check Spelling 
 
This option is used to check spelling while editing a document. 
To execute the spell checker, do the following: 
 
1) Open the menu by pressing “Alt”. 
2) Move to the "Edit" menu by pressing “down arrow button”. 
3) Press "Enter" on the "Edit" menu. 
4) Press “down arrow button” until "Check Spelling" is displayed. Or, press 
"k" To move to "Check Spelling" directly. 
5) Press "Enter" on "Check Spelling".  
Or, you can open the spell checker by pressing "Ctrl-k" while editing a 
document. 
 
When "Check Spelling" is executed, a dialog is displayed containing the 
following items: 
 
"Range" combo box 
"Custom dictionary" dialog (c) 
"Options" dialog (o) 
"Begin" button (b) 
"Cancel" button 
 
You can move among the controls by pressing “Tab” or "shift-tab". 
The following explains each item in detail: 
 
The "Range" combo box is used to designate the range to be spell checked. 
 
1. Whole document: check the entire document. 
2. Chapter: check the current chapter.  
3. Paragraph: check the current paragraph.  
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4. From cursor to bottom: check from the cursor position to the end of the 
document. 
5. Current word: check only the word under the cursor.  
You can move among the items in the combo box by pressing “up arrow 
button” or “down arrow button”. 
 
When you press "Enter" on the "Custom dictionary" dialog, the following 
items are displayed: 
 
1. List: shows the words that are registered in the custom dictionary. 
(Example: Braille 1/20). If there are no words registered, "no items" is 
displayed. 
2. Add word (Alt-a): press "Enter" on this button, and you are prompted to 
"Add word:". Type the word you wish to add and press "Enter". The new 
word is added and the Braille Sense U2 QWERTY returns to the "Add word" 
button. 
3. Modify word (Alt-m): select the word to be modified from the "list" and 
press "Enter". You are prompted to "Modify word:". Input the correct word 
and press "Enter". The selected word is modified and you are returned to the 
"Modify word" button. 
4. Delete word (Del): select the word to be deleted from the "list" and press 
"Enter". 
5. Close: this command closes the dialog.  
You can move among the items by pressing “Tab” or "shift-tab". 
 
When you press "Enter" on the "Options" dialog, the following items are 
displayed: 
 
1. Always suggest recommended word: if this option is set to "On", the 
Braille Sense U2 QWERTY suggests a word if the word that is encountered 
is not in the dictionary. The default is set to "On". If the option is set to "Off", 
the Braille Sense U2 QWERTY does not recommend a word. To toggle 
between "On" and "Off", press "Space". 
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2. Use main dictionary only: if this option is set to "On", the spell checker 
does not look up any words in the "custom dictionary". It only uses the main 
dictionary. The default value is set to "Off". You can toggle between "On" 
and "Off" by pressing "Space". 
3. Skip an upper-case word: if this option is set to "On", words with only 
upper-case letters are not checked. The default is set to "On". You can 
change it by pressing "Space". 
4. Skip a word which includes an address: if this option is set to "On", the 
words that contain an address are not checked. The default is set to "On". 
You can change it by pressing "Space". 
5. Skip a word which includes numbers: if this option is set to "On", the 
words that include numbers are not checked. The default value is set to "Off". 
You can change it by pressing "Space". 
6. Confirm: if you press "Enter" on "Confirm", the changes that you made 
above are saved, and the Braille Sense U2 QWERTY exits the "Options" 
dialog. 
7. Cancel: if you press "Enter" on "Cancel", the changes that you have made 
above are canceled and the Braille Sense U2 QWERTY exits the "Options" 
dialog. 
 
To move among the option settings, press “up arrow button” or “down arrow 
button”. To move to "Confirm" or "Cancel", press “Tab” or "shift-tab". 
Press "Enter" on the "Begin" button and the Braille Sense U2 QWERTY 
starts to check spelling. If you press "Enter" on the "Cancel" button, the 
"Spell Check" is canceled. 
Once "Spell Check" is executed, the following dialog is displayed: 
 
1. Text window: shows the sentence with the current word to be checked. 
The cursor is located at the word that is to be checked.  
2. Change word edit box: shows the current word to be checked. You can 
input the correct word directly into the edit box.  
3. Suggestions list: if the word to be checked is not in the dictionary, the 
Braille Sense suggests words. You can move among the suggestions by 
pressing “up arrow button” or “down arrow button”. 
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4. Skip once (s): if you press "Enter" on this button when a word is 
encountered that is not in the dictionary, the word is not modified. You can 
also press the "down scroll button" To skip the word. 
5. Skip all (i): if you press "Enter" on this button, all instances of the currently 
focused word are not modified and are automatically skipped throughout the 
spell check range. 
6. Add to custom dictionary (a): if you press "Enter" on this button, the word 
that is currently focused is added to your "Custom dictionary". 
7. Modify once (c): focus on the modified word and select the desired word 
from the "suggestions list" and press "Enter". The currently focused word is 
replaced with your selection from the "suggestions list".  
8. Modify all (m): focus on the modified word and select the desired word 
from the "suggestions list" and press "Enter". All instances of the currently 
focused word are replaced by the suggested word.  
9. Cancel: if you press "Enter" on the "Cancel" button, the "Spell Check" is 
exited.  
 
You can move among the controls by pressing “Tab” or "shift-tab". When the 
spell check is complete, the Braille Sense U2 QWERTY announces, "00 
words checked. 00 misspellings found. 00 words corrected". 
Also remember, you can check the spelling of the current word by pressing 
"Alt-k" while editing a document. A list of suggestions is displayed. Move 
through the list using “up arrow button” or “down arrow button”, and press 
"Enter" to replace the misspelled word with the selected suggestion. 
 

5.3 Go to Menu 
 
To open the "Go To" menu in the Word Processor, press “Alt”, and move to 
"Go To" by pressing “down arrow button”, and press "Enter". Or, you can 
press "g" from the menu. The "Go To" menu contains the following items: 
"Find", "Find Again", "Replace", "Go To Location", "Go to Previous Page", 
"Go To Next Page", "Set Mark", "Go to Mark", "Go To Previous Document", 
and "Go To Next Document". 
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5.3.1 Find 
 
The find function allows you to search for text in a document. Once the text 
is found you are taken to that position in your document. To execute this 
command, press “Alt”, and move to "Go To" by pressing “down arrow button” 
and press "Enter". Move to "Find" by pressing “up arrow button” or “down 
arrow button”, or you can press "f" from the "Go To" menu. While editing a 
document, pressing "Ctrl-f" activates the "Find" command. When "Find" is 
executed, the "Find" dialog is displayed. This dialog consists of "Text to find", 
"Search direction", "Match case", a "Confirm" button, and a "Cancel" button. 
You can move among the fields by pressing “Tab” or "shift-tab". 
1. Text to find 
The first field in the "Find" dialog is "Text to find". In this edit box, you can 
type the text that you want to find. To find the text immediately, press "Enter". 
To set other fields in the dialog, press “Tab” to move to the next field. 
2. Search direction 
The next field is "Search direction". The default direction is "Forward". If you 
would like to change the search direction, press "Space" to toggle between 
"Forward" and "Backward". After you type in the text to be found, and set the 
search direction, press "Enter" To find the text immediately. 
3. Match case 
The next field is "Match case". This field displays only when you execute the 
"Find" command in a text file. This field does not display in Braille files. The 
default value is "No". To change the value, press "Space".  
4. Confirm 
To execute "Find", press "Enter" on "Confirm". You can also execute "Find" 
by pressing "Enter" on "Text to find" or "Search direction". 
5. Cancel 
To cancel the "Find" function, press "Enter" on "Cancel". Or, you can cancel 
the "Find" command by pressing "Alt-F4". 
If Braille Sense U2 QWERTY finds the text you typed, the sentence with the 
text is displayed. If there was no text that matched what you typed, the 
cursor remains in its current location and the Braille Sense U2 QWERTY 
announces "not found". This function saves the text last searched for, as well 
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as the direction, so you can use it again to search for the next occurrence of 
the text. 
When using the find command, the current cursor position is very important. 
If the cursor is located at the beginning of the document, it is necessary to 
select the "Forward" search direction. If the cursor is located at the end of 
the document, it is necessary to select "Backward" as the direction used for 
searching. If you do not choose the correct search direction in regards to the 
text you're looking for and your current position, the text is not found even if it 
is present in the document. 
 

5.3.2 Find Again 
 
To execute the "Find Again" command, press “Alt”. Then move to "Go To" by 
pressing “down arrow button” and press "Enter". Move to "Find Again" by 
pressing “down arrow button” and press "Enter", or press "h" from the "Go 
To" menu. While editing a document, press "Ctrl-f" to activate this command. 
When "Find Again" is executed, "Find Again" looks for the text that was 
searched for in the previous "Find". "Find again" searches in the same 
direction that was used with the last "Find". If you have not yet used the 
"Find" command in the current document, "Find again" is not available.   
 

5.3.3 Replace 
 
To execute this command, press “Alt”, and move to "Go To" by pressing 
“down arrow button”, and press "Enter". Move to "Replace" using “down 
arrow button” and press "Enter", or press "r" from the "Go To" menu. While 
editing a document, pressing "Ctrl-r" activates this function. 
"Replace" opens a dialog that consists of the following fields: "Text to find", 
"Replace with", "Search direction", "Match case", "Replace", "Confirm" and 
"Cancel". You can move among the fields by pressing “Tab” or "shift-tab". 
Each of the controls is described below: 
 
1. Text to find 
Type the text that you want to replace in this field. 
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2. Replace with 
Type the replacement text in this edit box. 
3. Search direction 
The "Search direction" has the same function as the "Search direction" 
explained in section 5.3.1. After you set the search direction, press "Enter" to 
start the replacement of text, or press “Tab” to set the "Match case" or 
"Replace" options. 
4. Match case 
This field displays only when you execute the "Replace" command in text 
files. This field does not display in Braille files. The default value is "No". To 
change the value, press "Space".  
5. Replace 
You may want to replace only one instance of the text you searched for. Or, 
you may want to replace all the instances of the searched text. Choose 
"Once" or "All" according to your preference. You can toggle between the 
two choices by pressing "Space". 
6. Confirm and Cancel 
Pressing "Enter" on "Confirm" starts finding and replacing text. If there is no 
text that matches the text you typed, "Not found" is displayed, and the 
function is canceled. Pressing "Enter" on "Cancel" cancels the "Replace" 
function. 
 

5.3.4 Go to Location 
 
The "Go to Location" command moves quickly to a specific location. You can 
move to a specific page, paragraph, or line. To execute this command, press 
“Alt”, and move to "Go To" by pressing “down arrow button”, and press 
"Enter". Move to "Go To Location" by pressing “down arrow button”, and 
press "Enter". While editing a document, press "Ctrl-g" to activate this 
function.  
When "Go to Location" is executed, the Word Processor says, "Move to 
page number". If you type a number here, the Braille Sense U2 QWERTY 
takes you to the page number that corresponds with the number you type. 
You can also type the letter "f " before the number. This tells the Braille 
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Sense U2 QWERTY that you are looking for a page number, and not a 
paragraph, or, line number. Type the number of the page you want to move 
to without the PLUS sign or minus sign, and press "Enter". The Word 
Processor jumps from the start of the document to the specific page. To 
move forward from your current location, put the PLUS sign in front of the 
number and letter. For example, to move forward five pages type "+f5". To 
move backward from your current location, type the minus sign in front of the 
number and letter.  
You can also use this function to move to a specific paragraph. Select "Go 
To Location" in the "Go To" menu, or press "Ctrl-g". The Braille Sense U2 
QWERTY says, "Move to page number:" Before you type the number of the 
paragraph you want to go to, type "p", then type the number of the paragraph. 
By typing in the letter "p", the Braille Sense U2 QWERTY knows that you are 
looking for a paragraph, and not a page or line. To move forward from your 
current location, type the PLUS sign in front of the number and letter. To 
move backward from your current location, type the minus sign in front of the 
number and letter. If the paragraph number you type is not valid, the Braille 
Sense U2 QWERTY announces, "Move range error". 
You can also use this function to move to a specific line. Select "Go To 
Location" in the "Go To" menu, or press "Ctrl-g". The Braille Sense U2 
QWERTY says, "Move to page number:" Before you type the number of the 
line that you want to go to, type "l", then type the line number. AS when 
jumping by page and paragraph, to move forward from your current location, 
type the PLUS sign in front of the number and letter. To move backward 
from your current location, type the minus sign in front of the number and 
letter.  If the line number you type is not valid, the Braille Sense U2 
QWERTY says, "Move range error". 
You can also go to a specific line number on a specific page. The Braille 
Sense U2 QWERTY enables you to type this information at the same time. 
To do this, press "Ctrl-g", or you can select "Go to Location" in the "Go To" 
menu. Then, when the Braille Sense U2 QWERTY says, "Move to page 
number:" you can type the page number followed by the line number. For 
example, to move to the 3rd line on the 20th page, you would type "20 3", or 
you could type "f20 3".  
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5.3.5 Go to Previous Page 
 
The “Go To Previous Page” command allows you to move to the page that is 
located before the page you are currently on. To execute this command, 
press “Alt,” and move to “Go To” by pressing “Down arrow key.” Then, press 
“Enter” on “Go To.” Move to “Go to Previous Page” by pressing “Down arrow 
key,” and then press “Enter,” or press “Page up” while you are in the 
document. Once you have activated the “Go to Previous Page” function, the 
Braille Sense U2 QWERTY will go directly to the previous page. 
 

5.3.6 Go to Next Page 
 
The "Go To Next Page" command allows you to move to the page that is 
located after the page you are currently on. To execute this command, press 
"Alt", and move to "Go To" by pressing "down arrow key", and press "Enter". 
Move to "Go To Next Page" by pressing "down arrow button", and press 
"Enter". Or, you can press “Page down” while you are in the document. Once 
you have activated the “Go to Next Page” function, the Braille Sense U2 
QWERTY will go directly to the next page. 
 

5.3.7 Set Mark 
 
The "Set mark" command marks a position in the document that you want to 
return to later. To execute this command, press “Alt”, and move to "Go To" 
by pressing “down arrow button” and press "Enter". Move to "Set mark" by 
pressing “down arrow button”, and press "Enter", or press "m" from the "Go 
To" menu. While editing a document, press "Ctrl-m" to activate this 
command. 
Move the cursor to the location that you want to mark, and press "Ctrl-m”. 
The Braille Sense U2 QWERTY says, "Mark name:". To name the mark use 
the letters a through as. While editing a document, the Braille Sense U2 
QWERTY does not show the mark sign unless you have selected "View 
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format character" in "Settings", explained in section 5.1.7. If you have this 
option turned on, the bookmark sign is shown in the document. You can go 
to marked text by using "Left arrow button" or “Right arrow button” and the 
bookmark sign appears, which is "$pl (mark name)". If you move the cursor 
to the mark location in a document, you can see dots 7-8 all through the 
mark sign. This means that the Braille Sense U2 QWERTY deals with the 
marked text as a chunk, but not with each character.  
 

5.3.8 Go to Mark 
 
The "Go to Mark" command finds a mark that has previously been set. To 
execute this command, press “Alt”, and move to "Go To" by pressing “down 
arrow button” and press "Enter". Move to "Go to Mark" by pressing “down 
arrow button”, and press "Enter", or press "j” from the "Go To" menu. While 
editing a document, go to marked text by pressing "Ctrl-j". 
The Braille Sense U2 QWERTY says "Move to mark:". Type the character of 
the mark name that you want to locate, and the Braille Sense U2 QWERTY 
moves the cursor to the marked position. 
 

5.3.9 Go to Previous Document 
 
If you have multiple documents open, you can easily move among them. To 
go to the previous document, press “Alt”, and move to "Go To" by pressing 
“down arrow button”, and press "Enter". Move to "Go To Previous 
Document" by pressing “down arrow button”, and press "Enter". Or, you can 
press "shift-tab" while editing a document.  
 

5.3.10 Go to Next Document 
 
To go to the next document, press “Alt”, and move to "Go To" by pressing 
“down arrow button”, and press "Enter". Move to "Go to Next Document" by 
pressing “down arrow button”, and press "Enter". Or, you can press “Tab” 
while editing a document.  
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5.4 Read Menu 
 
The "Read" menu is used to read specific parts of the document with speech 
and/or Braille. To open the "read menu", press “Alt”, and press "r". The items 
in the "Read" menu are: "Read Selected Text", "Read Beginning Of Selected 
Text", "Read From Beginning To Cursor", "Read From Cursor To End", "Auto 
Scroll", "Read Current Sentence", "Read Current Line", "Read Current Word", 
"Read Current Character", and "Read Status". 
 

5.4.1 Read Selected Text 
 
The "Read Selected Text" command reads the text you currently have 
selected. To execute this command, press “Alt”, and move to the "Read" 
menu by pressing “down arrow button”, and press "Enter", or press "r" to 
open the "Read" menu. Press "Enter" on "Read Selected Text". While editing 
a document press "Alt-b" to activate the "Read Selected Text" function. 
Although you activate this function, the cursor location does not move to the 
selected text. It is simply read aloud, and your cursor remains in its current 
position.  
 

5.4.2 Read Beginning of Selected Text 
 
The "Read Beginning of Selected Text" command allows you to hear the first 
line of the selected text without moving the cursor position. To execute this 
command, press “Alt”, and move to the "Read" menu by pressing “down 
arrow button”, and press "Enter". Move to "Read Beginning Of Selected 
Text" by pressing “down arrow button”, and press "Enter", or press "u" from 
the read menu. While editing a document, press "Ctrl-u" to activate this 
function.  
 

5.4.3 Read from beginning to cursor 
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Using this function, the Braille Sense U2 QWERTY speaks the text in the 
document from the beginning to the current cursor position. To execute this 
command, press “Alt”, and move to the "Read" menu by pressing “down 
arrow button”, and press "Enter". Move to "Read From Beginning To Cursor" 
by pressing “down arrow button”, and press "Enter", or you can press "t" 
from the read menu. While editing a document, press "Alt-g" to activate this 
function. 
If you want to quit this function before you reach the cursor location, you can 
press “Ctrl”. Your cursor will stay where it was when you started this function. 
That is, the cursor will not move to the position to where you stopped the 
function.  
 

5.4.4 Read from Cursor to End 
 
This command reads a document from the current cursor position to the end 
of the document. While the Braille Sense U2 QWERTY is reading the text, 
the cursor remains at the location from which you executed this command. 
However, when reading is completed, the cursor is placed at the end of the 
document. 
To execute this command, press “Alt”, and move to the "Read" menu by 
pressing “down arrow button”, and press "Enter". You can move to "Read 
From Cursor To End" by pressing “down arrow button” and press "Enter", or 
you can press "g" from the "Read" menu. While editing a document, press 
“Fn-Enter" to activate this function. 
If you interrupt speech before reading is completed, you can press "Ctrl", to 
move the cursor to where you stopped reading. 
 

5.4.5 Auto Scroll 
 
The "Auto Scroll" command scrolls the Braille display automatically through 
the document. The speed of the "Auto Scroll" is set in the "Settings" menu, 
located in the "File" menu, explained in section 5.1.7. When using auto scroll, 
no speech is heard as the Braille display scrolls through the document.   



128 
 

To execute this command, press “Alt”, and move to the "Read" menu by 
pressing “down arrow button”, and press "Enter". Move to "Auto Scroll" by 
pressing “down arrow button”, and press "Enter", or press "a" from the read 
menu. While editing a document, you can turn the auto scroll feature on and 
off by pressing the up and down scroll buttons simultaneously. For faster 
scrolling, press "right arrow button". For slower scrolling, press "left arrow 
button". Read a line again by pressing the up scroll button or “Up arrow 
button” Similarly, to skip lines you do not wish to read, press the down scroll 
button or “Down arrow button”.  
 

5.4.6 Read Current Sentence 
 
This function reads the current sentence. To execute this command, press 
“Alt”, and move to the "Read" menu by pressing “down arrow button”. Press 
"Enter" to move to "Read Current Sentence" by pressing “down arrow 
button” and press "Enter". Or you can press "e", from the read menu. While 
editing a document, press "fn-n" to activate this function.   
 

5.4.7 Read Current Line 
 
This function reads the current line. To execute this command, press “Alt”, 
and move to the "Read" menu by pressing “down arrow button”. Then, press 
"Enter". Move to "Read Current Line" by pressing “down arrow button”, and 
press "Enter", or you can press "l" from the read menu. While editing a 
document, press "Fn-c" to activate this function.   
 

5.4.8 Read Current Word 
 
This function reads the current word. To execute this command, press “Alt”, 
and move to the "Read" menu by pressing “down arrow button”. Then, press 
"Enter". Move to "Read Current Word" by pressing “down arrow button”, and 
press "Enter", or you can press "w" from the read menu. While editing a 
document, press "Fn-x" to activate this function.   
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5.4.9 Read Current Character 
 
This function reads the current character. To execute this command, press 
“Alt”, and move to the "Read" menu by pressing “down arrow button”. Then, 
press "Enter". Move to "Read Current Character" by pressing “down arrow 
button”, and press "Enter", or you can press "c" from the read menu. While 
editing a document, press "Fn-z" to activate this function.   
 

5.4.10 Read Status 
 
This function gives you information about your current file. When you 
activate this function, the Braille Sense U2 QWERTY tells you the "file name", 
"edit mode (insert or overwrite)", and "file protection (write or read only)". To 
execute this command, press “Alt”, and move to the "Read" menu by 
pressing “down arrow button”. Then, press "Enter". Move to "Read Status" 
by pressing “down arrow button”, and press "Enter", or you can press "s" 
from the read menu. While editing a document, press "Fn-/(slash)" to 
activate this function.  
 

5.5 Layout 
 
The "Layout" menu contains options for setting the layout for printing on an 
ink printer or embossing on a Braille embosser. The "Layout" menu contains 
the following items: "Braille Document Layout", "Print Document Layout", 
"Braille Paragraph Layout", and "Print Paragraph Layout". The changes 
made in the "Layout" menu are not displayed on the Braille display. To check 
the layout, open the menu by pressing “Alt”, and press "l" to open the Layout 
menu.  
 

5.5.1 Braille Document Layout  
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While editing a document, press “Alt” to open the menu, and select "Layout" 
or press "l", and select "Braille Document Layout". Or, you can press "Alt-F5" 
to open the "Braille Document Layout" dialog while editing a document. 
"Braille Document Layout" is used to set the width and height of the paper for 
embossing as well as other options.  
You can navigate the menu items with “up arrow button” or “down arrow 
button”, and you can move to "Confirm" or "Cancel" by pressing “Tab”. You 
can skip an item by pressing “down arrow button” if you don't want to change 
the default setting. 
You can adjust the following settings: 
 
1. Set characters per line 
This sets the number of Braille characters per line to emboss. The default 
value is set to 32. To change the value, type the number of characters per 
line. Move to the next setting by pressing “down arrow button”. 
2. Set lines per page 
This sets the number of lines per page to be embossed. It includes the line 
on which the page number is printed. For example, if it is set to 26, the 
content of the document is embossed with 25 lines and the page number is 
printed as the 26th line. To change the value, type the number of lines that 
you want to emboss. Move to the next setting by pressing “down arrow 
button”. 
3. Print type 
This sets whether the document is embossed on one or both sides of the 
page. The default value is set to double sided embossing. For single sided 
embossing, press "`space". Move to the next setting by pressing “down 
arrow button”. 
4. Page numbering type 
This sets the numbering type for embossing a document. The default type is 
set to "Double sided". It means that the page number is embossed on every 
page. The setting values are "Double sided", "Odd", "Even", and "None". 
Press "Space" and "Backspace" to change the value. Press “down arrow 
button” To move to the next setting. 
5. Set page numbering 
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This sets the position of the page number when embossing. The selections 
are "Upper right" and "Lower right". The default setting is set to "Lower right". 
Press "Space" To change the setting. Press “down arrow button” To move to 
the next setting. 
6. Header 
This is an edit box in which you can type the text to be embossed as the 
header. To move to the next setting, press “down arrow button”. 
7. Footer 
This is an edit box into which you can type the text to be embossed as the 
footer. After you set your preferences, move to "Confirm" or "Cancel", by 
pressing “Tab”.  
8. Confirm / Cancel 
To apply settings, when "Confirm" is displayed press "Enter". If you do not 
want to change the setting when "Cancel" is displayed press "Enter".  
 

5.5.2 Print Document Layout 
 
This option allows you to set the document layout for printing on an ink 
printer. Press “Alt” to open the menu, and select "Layout" or press "l". Select 
"Print Document Layout". Or, press "Alt-F6" while editing a document.  The 
settings in this menu are applied throughout the document. You can navigate 
the menu items with “up arrow button” or “down arrow button”, and you can 
move to "Confirm" or "Cancel" by pressing “Tab”. You can skip an item by 
pressing “down arrow button” if you do not want to change the default setting. 
The following is a detailed explanation of each setting: 
 
1. Set top margin 
This sets the top margin for ink printing. The top margin is the distance from 
the top of the paper to the first line of the printed paragraph. The default 
value is set to 20mm (about 0.78 inches). To change the default setting, type 
a new value.  
2. Set bottom margin 
This sets the bottom margin for ink printing. The bottom margin is the 
distance from the bottom of the paper to the last line of a printed paragraph. 
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The default value is set to 20mm (about 0.78 inches). To change the default 
setting, type a new value. 
3. Set left margin 
This sets the left margin for ink printing. The left margin is the distance from 
the left edge of the paper to the first text that is printed. The default value is 
set to 20 mm (about 0.78 inches). To change the default setting, type a new 
value. 
4. Set right margin 
This sets the right margin for ink printing. The right margin is the distance 
from the right end of the printed text to the right edge of the paper. The 
default value is set to 20mm (about 0.78 inches). To change the default 
setting, type a new value. 
5. Set page numbering 
This sets the position where the page numbers are printed. The available 
positions are "Upper left", "Upper middle", "Upper right", "Lower left", "Lower 
middle", and "Lower right". To change the setting, press "Space" or 
"Backspace".  
6. Header 
This is used to edit the header printed at the top of each page. Move to 
"Header", and type the text that you want to be printed. 
7. Footer 
This is used to edit the footer printed at the bottom of each page. Move to 
"Footer", and type the text that you want to be printed. 
8. Distance between lines 
This sets the distance between the printed lines. The default value is set to 
150%. The distance can be anywhere from 100% to 300%. If you type a 
value that exceeds this range, the Braille Sense U2 QWERTY says, "Out of 
range. Value too large", and waits for you to type another value. 
9. Confirm / cancel 
To apply the settings, press "Enter" when "Confirm" is displayed. If you do 
not want to apply a setting when "Cancel" is displayed, press "Enter".  
 

5.5.3 Braille Paragraph Layout  
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To open the "Braille Paragraph Layout" dialog, press “Alt”. Then, press 
"Enter" on "Layout", or press "l". Select "Braille Paragraph Layout" and press 
"Enter". Or, you can press "Alt-F7" while editing a document. These settings 
are only applied to the selected paragraph.  
You can navigate between the menu items by pressing “up arrow button” or 
“down arrow button”. Move to the "Confirm" or "Cancel" buttons by pressing 
“Tab”. You can skip an item by pressing “down arrow button” if you do not 
want to change the default setting. 
In this dialog, you can set the following items:  
 
1. Indent first line 
This indents the first line of the paragraph as designated by the number of 
characters. The default value is set to 0. To change this setting, type the 
number of characters to be indented. Press the down scroll button or “down 
arrow button” To move to the next setting.  
2. Indent all lines except the first line 
This indents all the lines of the paragraph, except the first line of the 
paragraph as designated by the number of columns. To indent the text, type 
the number to indent.  
3. Confirm / cancel 
Press “Tab” or "shift-tab" to get to the Confirm and Cancel buttons. To apply 
changes, press "Enter" when "Confirm" is displayed. To exit the settings 
without making changes, press "Enter" when "Cancel" is displayed.  
 

5.5.4 Print Paragraph Layout  
 
You can set the layout of the current paragraph for printing on an ink printer. 
To set "print paragraph layout", press “Alt”. Select "Layout", or press "l" and 
select "Print Paragraph Layout". Or, press "Alt-F8", while you are editing a 
document. This setting applies only to the current paragraph.  You can 
navigate the menu items by pressing “up arrow button” or “down arrow 
button”, and you can move to "Confirm" or "Cancel" by pressing “Tab”. You 
can skip an item by pressing “down arrow button” if you do not want to 
change the default setting. 



134 
 

The following is a detailed explanation of the settings for "Print Paragraph 
Layout:" 
 
1. Set left margin 
This sets the left margin for the current paragraph. The default value is set to 
0mm. To change the setting, type the value of the margin you want. Move to 
the next setting by pressing the down scroll button or press “down arrow 
button”. 
2. Set right margin 
This sets the right margin for the current paragraph. The default value is set 
to 0mm. To change the setting, type the value of the margin you want. Move 
to the next setting by pressing the down scroll button or press “down arrow 
button”. 
3. Indent first line 
This sets the indentation of the first line by the value you select. THIS setting 
is valid for the paragraphs that follow, unless the setting is changed. The 
default value is set to 0. To change the setting, type the number of 
characters to indent. Press the down scroll button or press “down arrow 
button” To move to the next setting. 
4. Indent all lines except the first line 
All the lines in the paragraph, except the first line, are indented by the value 
you select. This setting is valid for the following paragraphs, unless the 
setting is changed. The default value is set to 0. To change the setting, type 
the number of characters to indent. 
5. Alignment 
This sets the alignment type. The default type is set to "Left justified". The 
other options are "Centered" and "Right justified". Press "Space" To change 
the setting. 
6. Set style 
When printing a document with an ink printer, the style of each paragraph 
can be set independently for differing types of text. Style includes "font type", 
"font size", and "text shape". You can select "Text", "Title", "Sub title", 
"Abstract 1", and "Abstract 2" by pressing "Space" or "Backspace". The 
default fonts for each style are listed below. 
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Text: Times New Roman, Font size 11 
Abstract1: Times New Roman, Font size 11, Boldface  
Abstract2: Times New Roman, Font size 14, Boldface  
Sub title: Courier New, Font size 16, Italic, Boldface, Center-aligned  
Title: Times New Roman, Font size 20, Boldface, Center-aligned  
7. Confirm / cancel 
Press “Tab” or "shift-tab" to get to “confirm” and “cancel” buttons.  
To apply the settings, press "Enter" on "Confirm". To cancel without saving 
settings, press "Enter" on "Cancel".  
 

5.6 Keys for Text Scrolling and Deleting 
 
While reading a document, you can use the following commands to read with 
Braille and/or speech. You can move character by character, word by word, 
or paragraph by paragraph. 
 
Previous character: Left arrow key 
Next character: Right arrow key 
Previous word: Ctrl-Left arrow key 
Next word: Ctrl-Right arrow key 
Beginning of line: Fn-Left arrow key 
End of line: Fn-Right arrow key 
Previous sentence: Ctrl-Alt-Right arrow key 
Next sentence: Ctrl-Alt-Left arrow key 
Previous line: Up arrow key 
Next line: Down arrow key 
Next paragraph: Ctrl-Down arrow key 
Previous paragraph: Ctrl-Up arrow key 
Top of document: Ctrl-fn-Left arrow key 
Bottom of document: Ctrl-fn-Right arrow key 
 
Read the current paragraph Fn-v 
Read the current line: Fn-c 
Read the current sentence: Fn-n 
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Read the current word: Fn-x 
Read the current character: Fn-z 
 
Use the following commands to delete various elements of a document 
according to your current cursor position. 
 
Delete the current paragraph: Alt-Del 
Delete the current line: Ctrl-Backspace 
Delete the current word: Alt-Backspace 
Delete the current character: Del 
 

5.7 Cursor Location 
 
While reading a document, you can query the cursor location. To do this, 
press "Fn-s". Your current position is announced in several ways: "Page: xx, 
Line: xx, column: xx, xx%, Paragraph: xx/yy, Line: xx/yy". 
 

5.8 Hot keys in the Word Processor: 
 
1. File menu 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s  
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p  
Settings: Ctrl-e  
Exit: Alt-F4 
 
2. Edit menu 
Start selection: Ctrl-b 
Copy: Ctrl-c 
Cut: Ctrl-x  
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Paste: Ctrl-v 
Delete: Del 
Delete blank lines: Alt-e 
Add to clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del 
Select All: Ctrl-a  
Insert from file: Ctrl-i 
Insert date: Ctrl-w 
Insert time: Backspace-w  
Toggle insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 
 
3. Go to menu 
Find: Ctrl-f 
Find again: F3 
Replace: Ctrl-r  
Go to location: Ctrl-g 
Go to previous page: Page up (Fn-Up arrow key) 
Go to next page: Page down (Fn-Down arrow key)  
Set mark: Ctrl-m  
Go to mark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: Tab 
 
4. Read menu 
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u  
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter 
Auto scroll: up-down scroll buttons 
Read status: Fn-/ 
 
5. Layout menu 
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Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 
 
6. Miscellaneous hot keys 
Move to previous character: Left arrow key 
Move to next character: Right arrow key 
Move to previous word: Ctrl-Left arrow key 
Move to next word: Ctrl-Right arrow key 
Move to the beginning of the line: Fn-Left arrow key 
Move to the end of the line: Fn-Right arrow key 
Move to previous line: Up arrow key 
Move to next line: Down arrow key 
Move to previous sentence: Alt-Ctrl-Left arrow key 
Move to next sentence: Alt-Ctrl-Right arrow key 
Move to previous paragraph: Ctrl-Up arrow key  
Move to next paragraph: Ctrl-Down arrow key 
Move to the beginning of the document: Ctrl-fn-Left arrow key 
Move to the end of the document: Ctrl-fn-Right arrow key 
Read current paragraph: Fn-v 
Read current line: Fn-c 
Read current sentence: Fn-n 
Read current word: Fn-x 
Read current character: Fn-z 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
Confirm current cursor position: Fn-s 
Set view format character: Ctrl-5 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 
Set reading mode: Ctrl-4 
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6. Address Manager 
 

6.1 What is the "Address Manager"? 
 
The "Address Manager" is a program that you can use to keep track of your 
contact information for friends and colleagues, such as company addresses, 
home addresses, e-mail addresses, as well as other information. 
The "Address Manager" consists of two main dialogs: "Add Address" and 
"Search Address". In the "Add Address" dialog you can enter contact 
information, such as names, company addresses, home addresses and so 
on. In the "Search Address", dialog you can look for information that is stored 
in the "Address Manager". You can edit or delete information you find. You 
can also select addresses to be printed using an ink print or Braille printer. 
IN addition, you can connect to a web site by pressing "Enter" on a 
homepage address field if the field contains an address for a web site.  
In the "program" menu, you can start the "Address Manager" by typing "a", 
or by selecting the "Address Manager". Press “down arrow button” or “up 
arrow button” repeatedly in the "program" menu until you arrive at the 
"Address Manager", and then press "Enter" to open it. Before going into the 
details of how to use the "Address Manager", let's discuss the structure of 
address data. 
The address data that is stored in the "Address Manager" consists of a set of 
records. A "record" is a collection of contact information about one person or 
company. Each record contains 23 fields. These 23 fields are: "Last name", 
"First name", "Company name", "Title", "Mobile phone", "Home phone", 
"Home fax", "Company phone", "Company fax", "Home street address", 
"Home city", "Home state", "Home zip code", "Home country", "Company 
street address", "Company city", "Company state", "Company zip code", 
"Company country". "Home e-mail", "Company e-mail", "Home page", and 
"Memo". Thus, one record contains all the information you can keep about a 
person or company. 
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6.2 Starting the "Address Manager" 
 
When you press "Enter" on the "Address Manager" in the "program" menu, 
the Braille Sense U2 QWERTY says, "Search Address", and displays the 
prompt, "Last name:" and the "Search Address" dialog is opened. 
In the "Address Manager", you can use the menus to conveniently browse 
and execute all of the available commands. When you cannot remember the 
exact hot key for the command you want to execute, you can press “Alt” to 
open the menu and access all of the functions there. 
 

6.3 Using "Add Address" 
 
This dialog allows you to enter new addresses in the "Address Manager". To 
use the "Add Address" function, press “Alt” to bring up the "Address 
Manager" menu, then press “up arrow button”, “down arrow button” or the up 
and down scroll buttons to move to "Add Address". Then, press "Enter". Or, 
press "Ctrl-n" directly from in the "Address Manager".  
 

6.3.1 Adding an Address 
 
"Add address" is a dialog that contains a list of 22 input fields, the "Memo" 
field, a "Confirm" button, and a "Cancel" button. In the input fields, you can 
enter the information corresponding to the 22 fields of a record. "Confirm" is 
used to save the information entered, and "Cancel" is used to discard the 
entry. You can move among the input fields, "Memo", "Confirm", and 
"Cancel" by pressing “Tab” or "shift-tab". Among the 22 input fields, you can 
move from one field to the next by pressing the “up arrow button”, “down 
arrow button” or the up and down scroll buttons. Type in the appropriate 
information for each field, and press the down arrow button to move to the 
next field. You do not have to fill in all of the fields. To skip a field, press the 
down arrow (“down arrow button”), and the field is left blank. You are then 
prompted for the information for the next field. 
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When you have entered information in the desired fields, you can save the 
information by pressing “Tab” or "shift-tab" repeatedly to move to the 
"Confirm" button and press "Enter". Or, you can press "Enter" in any field. 
If you don't want to save the information, press “Tab” or "shift-tab" repeatedly 
to move to the "Cancel" button, then press "Enter". 
After you cancel the entry, you are prompted to enter information into 
another record, beginning with the "Last name" field. 
You can use the cursor routing keys to move from one field to the next. 
In any input field, if you press the first cursor routing key to the left, the first 
input field ("Last name:") is displayed and you can type a name. To enter a 
mobile phone number without entering other information, press the 5th 
cursor routing key, then enter the phone number. To jump to the "Home e-
mail" field, the 20th field, press the 20th cursor routing key. 
If you have pressed the 23rd cursor routing key, or any key to the right of the 
23rd key is pressed, you will hear a warning sound because there are only 
23 fields in a record. 
 
You can enter telephone numbers. To type in a dash (-) while typing in a 
telephone number (e.g. 000-000-0000), you should press “-”. 
If you want to put an extension number after any phone number, enter the 
phone number as described above, and then type a comma (,), followed by 
the extension number, as in “000-000-0000,100.”  
When you enter a home page address or an e-mail address, you should 
enter the information using keys. For the @ (at sign), you should press “@.” 
A period in a home page address (or an e-mail address) should be entered 
as “.” A colon (:) can be typed in using “:” and a slash (/) can be typed in 
using “/”. 
By pressing “tab,” you can get to the “Memo” field. You can type in multiple 
lines of text in the “Memo” field. When you want to start a new line of text, 
you should press “Enter.” 
 
When you are done entering information for a record, you can press “tab” 
until you reach the “Confirm” button. Then, press “Enter” on “Confirm.” 
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6.3.2 Setting Add Address Fields 
 
"Set Address Fields" enables you to select one of the 22 fields to be shown 
when you enter contact information. There are 22 fields in a record, but you 
may not want to enter information in every one of the 22 fields. You can use 
"Set Address Fields" to select only the fields that you need. 
To use this function, press “Alt” to bring up the menu, then select "Set 
Address Field", or press "o" then press "Enter". Or, you can press “Ctrl-o” 
from the "Add Address" dialog. 
On the right side of each field name, "used" or "unused" is displayed. The 
default value is set to "used". To toggle the value, press "Space". 
After setting all the fields you want to change, move to the "Confirm" button 
or the "Cancel" button by pressing “Tab” or "shift-tab", then press "Enter" to 
save or cancel the changes. You can also cancel the changes by pressing 
"Esc" or "Alt-F4". 
 

6.3.3 Using "Search Address" in "Add address" 
 
In "Add Address", use the "Search Address" function to jump to another 
record. To use the "Search Address" function, press “Alt” to open the menu. 
Next move to "Search Address", then press "Enter", or press "s". You can 
also press “Ctrl-s” from the "Add Address" dialog. 
If you have entered information in a record before executing "Search 
Address", you are asked, "Save changes? Yes/No".  After you make your 
choice, the "Search Address" dialog is displayed. 
 

6.4 Searching For an Address 
 

6.4.1 Using "search address" 
 
The "Search Address" dialog enables you to search for information stored in 
the "Address Manager". If you execute the "Address Manager" from the 
"program" menu, the "Search Address" dialog is opened automatically. To 
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open "Search Address" from "Add Address", you can either select it from the 
menu, and press "Enter", or press “Ctrl-s” from the "Add Address" dialog. If 
you press "Enter" in the "Search Address" dialog, without typing any text, 
when "Last name:" is displayed, you can browse through all of the records 
that are stored in the "Address Manager". A "record" is a collection of 
information about one person. If more than one record is found, you can 
move to the next record by pressing “down arrow button”. To move to the 
previous record, press “up arrow button”. 
To navigate fields and records in the search result list, you can use the 
following hot keys: 
 
Move to a previous field in a record: Ctrl-Left arrow key 
Move to the next field in a record: Ctrl-Right arrow key 
Move to the first field in a record: Fn-Left arrow key 
Move to the last field in a record: Fn-Right arrow key 
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
Move to the first record: Ctrl-fn-Left arrow key 
Move to the last record: Ctrl-fn-Right arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
 
You can also search records using the other fields. To find records with a 
company name, press “down arrow button” repeatedly until "company 
name:" is heard. Then, type the company name, and press "Enter". The first 
record that has the company name is displayed. 
When you enter text to be searched, you do not have to type the entire 
content of a field. For example, to find a record about "Edward", type in "ed" 
in the "search name" field. Then, all the records whose name field contains 
"ed" is found. 
 

6.4.2 Setting Searching Address Fields 
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This option enables you to select the fields that you want to search. Press 
“Alt” to bring up the menu, and select "Set Address Search Fields". Then, 
press "Enter". Or, you can press “Ctrl-o” from the "Set Address Search 
Fields" dialog. 
To search only the name, mobile phone number, and company telephone 
number fields, move to those fields that you do not want to search by 
pressing “down arrow button” or “up arrow button”, then press "Space" to 
change the value of that field to "unused". By pressing "Space", you can 
toggle the value of a field between "used" and "unused".  
 

6.4.3 Using "Add Address" In "Search Address" 
 
You can also access the "Add Address" command from the "Search 
Address" dialog. To do this, press “Alt” to bring up the menu, then select 
"Add Address". Then, press "Enter". You can also press "Ctrl-n", from the 
"Search Address" dialog.  
 

6.5 Backing up and restoring the address list 
 

6.5.1 Backup Address List 
 
If you perform a hard reset, or if your battery dies, all of the data in the 
"Address Manager" is lost. So, it is very important that you make a backup 
file every time you make a change to the address list. To go to "Backup 
Address List", open the menu by pressing “Alt”. Then, use the up and down 
arrows button, to navigate to "Backup Address List". Then, press "Enter". 
You can also press "u" from the menu to get to "Backup Address List". Or, 
you can press "Ctrl-u" to activate this function directly. 
If you already have a backup file, you are prompted, "Backup file already 
exists. Continue to backup? Yes". If you have made changes to your 
address list, press "Enter" to create a new backup file. To keep the previous 
backup file press “down arrow button”, to move to "No", and press "Enter". 
When you create a backup file in your address list, you will have a new 
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backup file with the extension DAT, and you will have another file with the 
extension BAK created from the previous "address.dat" file). 
 

6.5.2 Restore Address List 
 
To restore the address list after a hard reset, press “Alt” to open the menu, 
and use the up and down scroll buttons to find "Restore Address List". Then, 
press "Enter" on "Restore Address List". Or, you can press "r" from the menu 
to find "Restore Address List". You can also press "Ctrl-r" to activate this 
function, directly. 
If you activate the "Restore Address List" function, and you already have an 
address list, you are prompted, "Address file already exists. Which do you 
prefer? Append". If you press "Enter", the backup address list is appended to 
the current address list. If you press “down arrow button” once and press 
"Enter" on "Overwrite", the new backup file is restored, erasing the old 
backup file. For example, let us assume that you have three records in your 
address list and you have ten addresses in your backup file. If you select 
"Append", you will have 13 records in your address list. In this case, three 
addresses could possibly be redundant. If you select "Overwrite", you will 
have 10 addresses backed up, and the three original addresses are deleted. 
If you don't want to either "Append" or "Overwrite", press “down arrow 
button”, to navigate to "Cancel", and press "Enter". 
 

6.5.3 Setting Backup Options 
 
You can back up your address list manually using the "Backup Address List" 
function. You can also backup your address list automatically using the "Set 
Backup Options". To activate the "Set Backup Options" function, press “Alt” 
to open the menu. Then press “down arrow button” or “up arrow button” 
repeatedly to locate "Set Backup Options". Then press "Enter". Or, you can 
press "e" from the menu to go to "Set Backup Options". You can also 
activate the function directly by pressing "Ctrl-e". 
When you activate this function, a dialog opens. The dialog has three 
controls: "Backup mode" radio button, a "Confirm" button, and a "Cancel" 
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button. You can move among the controls by pressing “Tab” or "shift-tab". To 
move among radio buttons, press “up arrow button”, "Backspace", “down 
arrow button”, or "Space". 
The "Backup mode" has three radio buttons: "Always backup changes when 
exiting", "Manual backup", and "Prompt backup changes when exiting". 
 
1. If you select the "Always backup changes when exiting", a new backup file 
is automatically created when you exit the "Address Manager" if you modify 
the address list or add other information. 
2. If you select the "Manual backup", it does not create a new backup file 
even if there are changes to the address list. In this case, you can only 
create a new backup file using the "backup address list" menu option. 
3. If you select the "Prompt backup changes when exiting", the message 
"Backup changes? Yes" appears when you exit the "Address Manager", if 
you have modified the address list or added other information. If you press 
"Enter" on "Yes", a new backup file is created and the "Address Manager" is 
closed. If you press “down arrow button” once and press "Enter" on "No", it 
will exit without making a new backup file. 
 
You can change the backup mode by pressing "Enter" after focusing on one 
of the three radio buttons. Or, you can press "Enter" on "Confirm" after 
moving to it using “Tab”. The default backup mode is set to "Prompt backup 
changes when exiting. 
 

6.6 Importing and Exporting CSV 
 
"CSV" is the acronym for Comma Separated Value. A CSV file is used for 
the digital storage of data structured in a table form, with the information in 
the various columns separated using commas. The "Address Manager" can 
import a CSV contact file created using MS outlook or some cell phones. 
 
1. "Import from CSV" allows you to import the data from a CSV file in to the 
"Address Manager". 



147 
 

2. "Export to CSV" allows you to export the data of the "Address Manager" 
as a CSV file. 
 

6.6.1 Import from CSV 
 
You can import the data from a CSV file in to the "Address Manager", using 
this function. You can execute this function, from anywhere in the "address 
Manager". 
 

6.6.1.1 Executing Import CSV" 
 
To execute "Import from CSV", follow these steps: 
1) Press “Alt” to open the menu. 
2) Press "down arrow button" to move to "Import from CSV" and press 
"Enter". Or press "c. 
You can also activate this function by pressing "Alt-i". 
 

6.6.1.2 Import from CSV Controls 
 
1. "File name" edit combo box 
2. "Confirm" Button 
3. "Cancel" Button 
4. "Path search" list 
You can move among the controls by pressing "Tab" or "Shift-Tab". 
 

6.6.1.3 Importing a CSV file 
 
To import a CSV file, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow button” or “down arrow button”, to move to "Import from 
CSV" and press "Enter". Or press "C" from the menu. You can activate this 
function directly by pressing "Alt-i". 
3) You are prompted for the "File name". 
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4) Type the name of the file you want to import. For example, to search for 
"address.CSV", type "address" or "address.CSV" in the "File name" edit box. 
5) Press "Shift-Tab" to move to "Path Search" list. Navigate to the folder that 
contains the CSV file. For example, if the CSV file is located in the download 
folder under the flashdisk, press "Enter" on the download folder to open it. 
6) After selecting the folder, press "Enter". Or press "Tab” move to "Confirm" 
and press "Enter". 
7) Import of the CSV file is performed. 
 
If you don't know the file name of the CSV file,  
1) Press "Tab" on the "File name". 
2) Move to "Path search" list. 
3) The "Open File" dialog is displayed. Use normal navigation commands to 
navigate to the CSV file and press "Enter".  
 
To cancel this function, press "Tab" to move to "Cancel" and press "Enter". 
Or press "Alt-F4. 
 

6.6.1.4 Adding the data from the CSV file to the "Address 
Manager" 

 
When the CSV file is imported, "Last name: unused 1/xx" is displayed.  
Structure is like below. 
 
1. Field list address/ Add address 
1) Unused 
2) Field name list of CSV file 
2. "Allow fields in first record" 
3. "Confirm" 
4. "Cancel" 
By pressing "Tab" or "Shift-Tab", you can move among the controls. 
By pressing “up arrow button” or “down arrow button”, you can move among 
the items in "Unused" and "Field name list in the CSV file". 
To add the CSV file data to the "Address Manager", follow these steps: 
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1) On "Last name: unused 1/xx", press “up arrow button” or “down arrow 
button”. Move to the field of the CSV file that you want to import to the "Last 
name" field.  
For example, there might be 5 fields like, "Name", "Company name", "title", 
"Company address" and "Company zip code" in the CSV file. "Last name: 
unused 1/6" is displayed. To import the value of the "Name" field from the 
CSV file, press “down arrow button” and move to "Name". Then Braille 
Sense U2 QWERTY displays "Last name: Name 2/6" on the LCD and Braille 
display. If there is no field value from the CSV file to import, leave the field 
"unused". 
If you set "First name" and "Company name", as "unused" you are prompted, 
"Must select one or more of first name and company name". You must select 
a value from the CSV file for "First name" and/or "Company name". 
2) After setting your preferences, press "Tab" to move to other field such as 
"Group", "Company", and "Title" etc. 
3) Press "Tab", move to "Allow fields in first record". You can change the 
setting, by pressing "Space". When you import the CSV file, you can choose 
whether the data from the CSV file for each field should be imported using 
this option. Some CSV files may contain data that is not equivalent to any of 
the fields in the "Address Manager", or you may simply not wish to import 
certain pieces of information.    
4) Press "Tab", move to "Confirm".  
5) Press "Enter" on the "Confirm" button. 
6) You are prompted, "Address file already exists. Which do you prefer?" 
The default value is "Overwrite". The setting values are "Overwrite" and 
"Add". You can either replace the existing file with the data imported from the 
CSV file, or you may add it to the existing address list. To change the setting 
value, press "Space. 
7) You are returned to "Search Address". 
8) Press "Enter". The data imported from the CSV file should now appear 
among your address records. 
 
To cancel this function, press "Tab” to move to "Confirm" and press "Enter". 
Or press "Alt-F4". 



150 
 

 

6.6.2 Exporting CSV 
 
You can export the data from the "Address Manager" as a CSV file, using 
this function.  
 

6.6.2.1 Executing the "Export To CSV" function 
 
To execute the "Export to CSV" function, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow button” or "down arrow button" and move to "Export to 
CSV". 
3) Press "Enter". Or press "x". 
You can execute this function directly by pressing "Alt-x". 
 

6.6.2.2 Structure of the "Export to CSV" dialog  
 
1. "File name" edit combo box 
2. "Confirm" Button 
3. "Cancel" Button 
4. "File storage" list 
You can move among the controls by pressing "Tab" or "Shift-Tab". 
 

6.6.2.3 How to save as CSV file 
 
To save as CSV file, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow button” or “down arrow button”, to move to "Export to 
CSV". 
3) Press "Enter". Or press "X". 
4) You are prompted, "File name".  
5) Type a file name for the exported data. 
6) Press "Tab", to move to "Confirm".  
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8) Press "Enter". 
The file is saved in the "Flashdisk".  
To cancel this function, press "Tab" to move to "Cancel" and press "Enter". 
Or press "Alt-F4". 
 

6.6.2.4 How to change Save Location 
 
To change the location where the CSV file is saved, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow button” or “down arrow button”, to move to "Export to 
CSV". 
3) Press "Enter". Or press "x". 
4) "File name" is displayed. 
5) Press "Tab", to move to the file list. Use normal file and folder navigation 
commands to choose a different location for saving the CSV file.   
6) Press "Tab" to move to "Confirm". 
7) Press "Enter" on the "Confirm" button. The file is saved in the new location. 
 
To cancel this function, press "Tab" to move to "Cancel" and press "Enter". 
Or press "Alt-F4". 
 

6.7 Commands in the Records Found List 
 

6.7.1 Find again 
 
To search for another name, press "Tab" or "Shift-Tab". The prompt, "Last 
name:" is displayed. You can type the new text for which you want to search. 
Just as in a new search, you can start the search by pressing "Enter".  
 

6.7.2 Opening a home page 
 
If a record has a homepage address or an email address, you can open the 
homepage or send an email. Move to the "Home page", "Home e-mail" or 
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"Company e-mail" field by pressing “up arrow button” or “down arrow button”. 
Then, press "Enter" on "Home page", "Home e-mail" or "Company e-mail". 
If you press "Enter" on a "Home page", the Braille Sense U2 QWERTY 
automatically opens the Web browser program. If you press "Enter" on a 
"Home e-mail" or "Company e-mail", the Braille Sense U2 QWERTY opens 
the "E-mail" program, so that you can send an email to the selected email 
address.  
Before you use this command, please make sure that you are connected to 
the internet. 
 

6.7.3 Editing Addresses 
 
To edit information in a record, find the desired address by using the "Search 
Address" function, then move to the field you want to change by using “Ctrl-
Left arrow key” or the “Ctrl-Right arrow key”. Then, press “Alt” to open the 
"menu", and select "Modify Address". Press "Enter", or you can press "Ctrl-
m", to activate this command directly. You can now enter new information 
the field. When you have modified the information, press "Enter". The Braille 
Sense U2 QWERTY saves the changes, and you are returned to the first 
field of the record. 
To save the changes and exit modify mode, move to "Confirm" by pressing 
“Tab” or "shift-tab", then press "Enter". To exit from modify mode without 
saving the changes, move to "Cancel" by pressing “Tab” or "shift-tab" and 
press "Enter". You can also exit from "Modify Address" by pressing "Esc" or 
"Alt-F4".  
 

6.7.4 Deleting Addresses 
 
To delete the record you are currently reading, open the "menu" by pressing 
“Alt”, and select "Delete Address". Then, press "Enter" or press "d" from the 
"menu". Or, you can press "Del" while viewing the record. You can also 
delete more than one record at a time as follows: 
1. Select the records to be deleted and use the "Delete" command. 
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To select the record that you want to delete, press "Space" when the record 
is displayed. Selected records can be deleted by pressing the "delete" key.  
The records you have selected * symbol to the left of the "last name:" field. 
The Braille Sense U2 QWERTY says, "selected". If you cancel a selection by 
pressing "Space" on a selected record, the / disappears, and the Braille 
Sense U2 QWERTY says, "Canceled selection". 
2. Select all and delete 
To delete all the records in the "Address Manager", press “Alt” to open the 
"menu" and choose "Select All". Then, press "Enter". Next, press “Alt” to 
open the "menu" again, and then select "Delete Address". Then, press 
"Enter". Or, you can press "Ctrl-a" to select all, and press "Del" to delete the 
addresses.  
 

6.7.5 Printing addresses 
 
This option allows you to print the selected records to a Braille printer or an 
ink printer. First, search the records to be printed with the "Search Address" 
command, then select the records that you want to print. To select a record, 
press "Space" on the record to be printed. To select all records in the 
"Address Manager", press "Ctrl-a” or choose "Select All" from the "menu", 
and press "Enter".  
After selecting the records to be printed, press “Alt” to open the "menu", and 
then select "Print Address". Then press "Enter", or press "Ctrl-p" to activate 
this function directly from the “Search Address" dialog.  The Braille Sense U2 
QWERTY prompts you to select a printer. The default selection is "Printer". 
Press "Space" once, and the selection is changed to "Embosser". Press 
"Space" again, and "Cancel" is selected.  Press "Enter" when the option you 
want is displayed. 
 

6.7.6 Saving Addresses to a File 
 
You can also save selected records to a file.  
To save selected records in a document, press “Alt” to open the "menu", 
select "Save addresses As File", then press "Enter". Or, you can press "Alt-
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S" from the "Search Address" dialog after selecting the desired records. The 
"file save" dialog is displayed and you are asked to enter the file name and 
select a file format. After you type the file name, and select one of the 
available file formats, press "Enter" on "Confirm", and the selected record(s) 
are saved. This dialog is the same as the "Save As" dialog in the Word 
processor, except that, here, when you are saving addresses to a file, the 
default file name is not displayed. Refer to section 5.1.4 to learn about the 
"Save As" dialog in the Word processor. 
 

6.8 Synchronizing With Microsoft Outlook 
 
The "Address Manager" can be synchronized with Microsoft Outlook on your 
personal computer to help you keep track of your information. For a more 
detailed explanation of how to connect the Braille Sense U2 QWERTY to 
your computer and use ActiveSync or Windows Mobile Device Center to 
synchronize your contacts with Microsoft Outlook, please refer to chapter 19, 
"Using ActiveSync".  
 

6.9 Hot Keys in the "Address Manager" 
 

1. Move keys for moving from field to field in add address or in the “menu” 
Move to the previous field or menu item: Up arrow key or up scroll button 
Move to the next field or menu item: Down arrow key or down scroll 
button 
Move to the first field or menu item: Fn-Left arrow key 
Move to the last field or menu item: Fn-Right arrow key 
 

2. Move Keys For Moving From Record To Record in the search result list 
Move to a previous field in a record: Ctrl-Left arrow key 
Move to the next field in a record: Ctrl-Right arrow key 
Move to the first field in a record: Ctrl-Fn-Left arrow key 
Move to the last field in a record: Ctrl-Fn-Right arrow key 
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
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Move to the first record: Ctrl-fn-Left arrow key 
Move to the last record: Ctrl-fn-Right arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 

3. Shortcut keys in the “menu” 
Add address: i 
Modify address: m 
Delete address: d 
Select all: a  
Save as a file: t 
Print address: p 
Backup address list: u 
Restore address list: r  
Set backup options: e 
Set address search fields: o 
Import from CSV: c  
Export to CSV: x  
 

4. Hot Keys For The Commands 
Add address: Ctrl-n 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Set backup options: Ctrl-e 
Set address search fields: Ctrl-o 
Import from CSV: Alt-i 
Export to CSV: Alt-x 
 

5. Miscellaneous hot keys 
Cancel: ESC  
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Exit: Alt-F4 
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7. Schedule Manager 
 

7.1 Overview 
 
The "Schedule Manager" is a program used to manage important information 
about appointments, anniversaries, and events. The Schedule Manager can 
also inform you of appointments at a specified time using alarms. You can 
start the "Schedule Manager" from the "program" menu, by pressing the up 
or down arrows (“up arrow button” or “down arrow button”) to move to 
"Schedule Manager". Then, press "Enter". Or, you can press "s" from the 
"program" menu. The "Schedule Manager" has two main dialog boxes: "Add 
Schedule" and "Search Schedule". In "Add Schedule", you can enter 
information for a new appointment. Using "Search Schedule", you can look 
for information about a specific appointment stored in the "Schedule 
Manager", and edit or delete the schedule information.  
 

7.2 Starting "Schedule Manager" 
 
When you press "Enter" on "Schedule Manager", or press "s" from the 
"program" menu, the "Search Schedule" dialog box is displayed so you can 
quickly search for an appointment. You are prompted for a "Find date:" with 
the current date filled in as the default. To add a new appointment or 
schedule, press “Alt” to open the menu. Then, select "Add Schedule", then 
press "Enter". Or, you can quickly open the "Add Schedule dialog" by 
pressing "Ctrl-n" from the "Search Schedule" dialog. As with other programs 
on the Braille Sense U2 QWERTY, you can use menus and shortcut keys in 
the "Schedule Manager".  
 

7.3 Setting time and date 
 
Due to the nature of appointments and schedules, it is very important that 
dates and times are entered correctly to ensure that your schedule is 
accurate and you are alerted to your appointments at the proper times 
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through the "Check Today's SCHEDULE" option as well as the alarms that 
can be associated with appointments in the "Schedule Manager".  
As date and time entry is associated with several programs on the Braille 
Sense U2 QWERTY, such as the "Wake up Alarm", the "time And Date" 
option in the Utilities Menu, and of course the "Schedule Manager", The 
Braille Sense U2 QWERTY provides you with a consistent interface for 
entering time and date information in these dialog boxes. Before we start 
talking about using the "Schedule Manager" we will explain how to enter the 
date and time.  
When you are asked to enter a date and time, you can either type in the date 
and time, or select it using shortcut keys, outlined at the end of this section. 
When you type numbers in date/time, you can use either computer Braille 
(without a number sign) or regular grade 1 Braille (with or without a number 
sign). When entering time, use "hh mm" format, two digits for the hour, and 
two digits for the minute separated by a colon.. For example, use "10 05" to 
enter 5 minutes past 10. You can enter a date in "mm dd yyyy" format, two 
digits for the month, two digits for the day, and four digits for the year, as in 
"09 01 2004", with slashes separating the day, month, and year.  
You may also select the various components of your date and time using 
navigation keys: 
 
1. Date setting keys 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 
2. Time setting keys 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
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Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 

7.4 Adding a Schedule 
 
To add a new appointment, press “Alt” to open the menu. Select "Add 
Schedule", and press "Enter", or press "Ctrl-n" from the "Search Schedule" 
dialog. The "Add Schedule" dialog has a set of input fields, a "Confirm" 
button, and a "Cancel" button. The input fields are "Start date", "Start time", 
"End date", "End time", "Subject", "Location", "Memo", "Alarm time", and "Set 
recurrence schedule". You can move among the input fields by pressing 
“Tab” or "shift-tab". For the "Subject" and "Memo" fields, you can type text, 
and for the "start date", "End date", "start time", "End time" fields, you can 
either type in a date/time, or select it using the shortcut keys described 
above. If you press "Enter" on the "Confirm" button, the schedule information 
is saved. If you press "Enter" on the "Cancel" button, the entry is not saved. 
 

7.4.1 Start date 
 
When you start "Add Schedule", the "Start date" edit box is displayed. To 
use the date displayed, simply press “Tab” to move to the next field. To enter 
a new date, type month/day/year. Press “Tab” to move to the next field. If 
you press "Enter" accidentally after filling in this field, you are prompted, "no 
subject", then the focus moves to the "Subject" field. 
 
Note: The default "Start date" varies in the following 2 ways: 
1. If you have not searched for an appointment, the default start date is 
today's date. 
2. If you have searched for an appointment on a specific date, the default 
start date is the last date you searched. If you search appointments by 
subject, the default start date is today's date.  
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7.4.2 Start time 
 
"Start time" is the second field in the "Add Schedule" dialog. By default, this 
field shows the current time. If you set the time format as "12 hour" in this 
option, the time is displayed in "am/pm" format. Otherwise, the time is 
displayed in 24 hour format. If you have set the time format to "12 hour" 
press "Fn-x" to change between am and pm. After you have entered the time, 
press “Tab” to move to the next field. If you press "Enter" accidentally after 
entering this field, you are prompted, "no subject", then the focus moves to 
the "Subject" field. 
 

7.4.3 End date 
 
The "End date" is the third field in the "Add Schedule" dialog. By default, the 
date is the same date as you set in the "Start date" field. To use this date, 
press “Tab” to move to the next field. To enter a new date, type 
month/day/year. Press “Tab” to move to the next field.  
 

7.4.4 End time 
 
"End time" is the fourth field in the "Add Schedule" dialog. By default, the end 
time is the same time as you set in the "Start time" field. To change the time, 
type the time as hhmm. Press “Tab” to move to the next field.  
 

7.4.5 Subject 
 
"Subject" is the fifth field. Type the subject of an appointment. If you do not 
enter anything in this field, you cannot save the record. If you press "Enter" 
after typing in the subject, the record is saved, leaving the "Location" and 
"Memo" field empty, and the "Alarm time" field set to its default value ("Time 
of appointment"). To move to the next field press “Tab”. 
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7.4.6 Location 
 
In the "Location" field, type location of your appointment. If you press "Enter" 
after typing in the location, the record is saved, leaving the "Memo" field 
empty, and the "Alarm time" field set to its default value ("Time of 
appointment"). To move to the next field, press “Tab”. 
 

7.4.7 Memo 
 
In the "Memo" field, you can enter detailed information about an appointment. 
This is a multi-line edit box, meaning you can type more than one line of text. 
You can use most of the editing commands that are used in the "Word 
processor". Press "Enter" to create a new line. You can leave this field blank 
if you wish. Press “Tab” to move to the next field. 
 

7.4.8 Alarm Time 
 
The "Alarm time" function allows you to set the time when you are notified 
about an appointment. The alarm is set relative to the appointment time. For 
example, you may want the alarm to sound 30 minutes before your 
appointment, so that you are not late. The default value for this field is set to 
"Time of appointment". This means that the alarm sounds at the same time 
as your appointment. You can set the time as when you set the appointment 
time. The time can be set anywhere from one minute to forty-seven hours 
before the appointment. To set the time with shortcut keys, use the following 
commands.  
 
1. Time setting keys 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
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 Move to 1 minute before: Left arrow key 
 
If you attempt to set the time to 0, the Braille Sense U2 QWERTY displays 
the message, "Time of appointment". If you do not want to set an alarm 
when "Alarm time" is set to "Time of appointment", press “up arrow button”. 
"Alarm off" is displayed, and the alarm for this appointment is turned off. 
After setting the "Alarm time", save this appointment by pressing "Enter", or 
by pressing “Tab” to move to the "Confirm" button, and press "Enter". If you 
have set the "Alarm time", it sounds at the specified time even if the Braille 
Sense U2 QWERTY is turned off. To stop the alarm, press "Ctrl". 
 

7.4.9 Setting a recurring Schedule 
 
You can set this option when the schedule you are creating recurs 
periodically. If you clear this check box, the schedule is set to occur once. 
You can check or uncheck this option by pressing "Space". If you have 
unchecked this box, press "Enter", or press “Tab” repeatedly to move to the 
"Confirm" button and press "Enter" to save the schedule. To set a recurring 
schedule, press "Space" then press “Tab” or "Enter" to move to the combo 
box where you can set the recurrence pattern. In this combo box, you can 
select from "Daily", "Weekly", "Monthly" and "Yearly". We will discuss these 
options in more detail in the next section. 
 

7.4.9.1 Daily 
 
If you select "Daily", and press “Tab”, the focus moves to "Recurring interval 
of day" edit box. Here, you can enter the number of days after which the 
appointment recurs. You can type a number between 1 and 999. If you enter 
1, the appointment recurs every day, and if you enter 2, it recurs every other 
day. When you use this option, be sure the difference between the start and 
end date is shorter than the recurring interval value. For example, suppose 
that the appointment starts at 09:00, Feb. 1, 2006, and ends at 12:00, Feb. 2, 
2006. If you set the recurring interval to 1, you receive an error message, 
"The appointment duration should be shorter than the recurring interval". 
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This is because it is logically impossible that the appointment duration is 27 
hours, and the appointment recurs every 24 hours. This rule is applied in the 
same way when you set weekly, monthly, or yearly recurring appointments. If 
you press “Tab” after setting the recurring interval, the "Set recurrence end 
date" check box appears. By default, it's unchecked, which indicates that the 
appointment recurs indefinitely. If you check this box by pressing "Space", 
and press “Tab”, the focus moves to the edit combo box for entering the end 
date. Enter the do 
 

7.4.9.2 Weekly 
 
Press “Tab” to move to the "Recurring interval" edit box, after you set the 
"Recurrence" to weekly. Choose the number of weeks between each 
recurrence. You can type a number between 1 and 999. If you set it to 1, the 
appointment recurs every week, and if you set it to 2, it recurs every other 
week. The restriction on the recurring interval as in "Daily" is applied to 
"Weekly". If the recurring interval is one week, the appointment duration 
should be shorter than one week. Or you receive the error message, "The 
appointment duration should be shorter than the recurring interval". Press 
“Tab” and the focus moves to a list box where you can select the day of the 
week on which the appointment recurs. You can move between the items in 
the list box, by pressing “up arrow button” or “down arrow button”. To select 
or unselect the current item, press "Space". You can make more than one 
selection, thus the appointment recurs on more than one day during the 
week. If you don't select a day, it is set to the today's week day. Press “Tab”, 
and the focus moves to the "Set recurrence end date" check box.  
 

7.4.9.3 Monthly 
 
If you press “Tab” after setting the "Recurrence to monthly", the focus moves 
to the "Recurring type" combo box. You can set the recurring type as "Date" 
or "Day of the week". To move between the two options, use “up arrow 
button” or “down arrow button”. "Date" is used when you want to set an 
appointment recurring on the same day of a month, for example, on the 17th 
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of every month, or every other month. On the other hand, "Day of the week" 
is used when you want to set an appointment recurring on the same week 
and day of the week of a month, for example, on Wednesday of the second 
week of every month. After selecting the "Recurring type", press “Tab” to 
move to the "Recurring interval".  
In this field, you set after how many months the appointment will recur. You 
can type a number between 1 and 999. Press “Tab” and different fields are 
shown depending on what you have selected in "Recurring type". If you set 
the "Recurring type" to "Date", an edit box is shown, where you can type the 
day of the month when the appointment recurs. By default the date set in the 
"Start date" is shown. You can type a number between 1 and 31. If you press 
“Tab” after setting this option, the focus moves to "Set recurrence end date". 
 

7.4.9.4 Yearly 
 
If you set the "Recurrence" to "Yearly", press “Tab” to move to the "Recurring 
type" combo box. You can select either "date" or "day of the week", and you 
can move between them by pressing “up arrow button” or “down arrow 
button”. If you set the "Recurring type" to "Date", you can set the month and 
the day of the month when the appointment recurs. If you set it to "Day of the 
week", you can set the month, the week, and the day of the week when the 
appointment recurs every year. If you press “Tab” after setting "Recurring 
type", the focus moves to the "Month for recurrence" combo box. You can 
select the month of the year by pressing “up arrow button” or “down arrow 
button”. If you press “Tab” here, the focus moves to different fields, 
depending on how you have set the "Recurring type". If you have set the 
"Recurring type" to "Date", the focus moves to "Day for recurrence" edit box. 
You can type a number between 1 and 31. If you press “Tab” the focus 
moves to the "Set recurrence end date" check box. If the "Recurring type" is 
set to "Day of the week", you have to set "recurring week" and "Day of week 
for recurrence".  
 

7.4.10 Confirm 
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If you press "Enter" on the "Confirm" button, the appointment is saved, and 
the "Add Schedule" dialog is closed. 
 

7.4.11 Cancel 
 
If you press "Enter" on the "Cancel" button, the appointment information you 
entered is discarded, and you are returned to the "Add Schedule" dialog 
where you can create a new appointment. You can also cancel the entry by 
pressing "Esc". 
 

7.5 Search Schedule 
 
"Search schedule" is used for searching Appointments that you have entered 
previously. When you start "Schedule Manager", the "Search Schedule" 
dialog is opened. You can also open this dialog from the "Add Schedule" 
dialog, by pressing “Ctrl-s”. Or you can open the menu by pressing “Alt”, and 
press "Enter" on "Search Schedule". 
There are two methods for searching an appointment: "searching by subject" 
and "searching by date". When "searching by subject", you can find a 
schedule using keywords in the subject field. When "searching by date", you 
can find schedules according to a specified date. To toggle the search mode, 
press “Alt” to open the menu and move to "Toggle Search Mode" and press 
"Enter". Or you can execute it by pressing "Ctrl-f" directly. Every time you 
press "Ctrl-f", the Braille Sense U2 QWERTY says, "Search mode: Date" or 
"Search mode: Subject", and the searching mode is toggled. 
The last searching mode you used is saved when you exit the Schedule 
Manager.  
 

7.5.1 Searching by date 
 
This mode searches the schedule using a date you specify. When "Search 
Schedule" is executed in this mode, the Braille Sense U2 QWERTY says, 
"Find date: (current date)". 
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If you press "Enter" here, the Braille Sense U2 QWERTY searches for 
appointments occurring today. To search for another date, you can type the 
date in the format "mm/dd/yyyy", or use the "move by date" hotkeys. If you 
press "Enter" after entering the date, the appointments occurring on the day 
are shown. If there is no appointment on that day, the unit announces, 
"There is no schedule registered". If appointments are present, the first 
appointment on that day is announced in the form of "date, time, and 
subject". If the appointment lasts for more than one day, "continuous 
schedule" is announced. If the appointment recurs, "recurring schedule" is 
announced. If you scheduled more than one appointment for that day, you 
can move among the appointments on that day by pressing “up arrow 
button” or “down arrow button”. To move to the first appointment on a day, 
you can press "Fn-Left arrow key", and to move to the last appointment on 
the day, and if you want to move to the last appointment on the day, press 
“Fn-Right arrow key”. To move to the appointments on another day, press 

“Ctrl-Left arrow key” or “Ctrl-Right arrow key”. The previous/next 

appointment occurring within four months is displayed. To move to the first 
appointment stored in the Schedule Manager, press "Ctrl-Fn-Left arrow key", 
and to move to the last appointment stored in the Schedule Manager, press 
"Ctrl-Fn-Right arrow key". To obtain details  
 

7.5.2 Searching by subject 
 
When the Search Schedule" dialog is opened in this mode, the Braille Sense 
U2 QWERTY says, "Search subject:" Type in the keywords to search and 
press "Enter". All schedules with the keywords are displayed. If you press 
"Enter" without typing text in the "Search subject:" edit box, the Braille Sense 
U2 QWERTY displays all appointments in your Braille Sense U2 QWERTY. 
To move to the next or previous schedule, press “down arrow button” or “up 
arrow button” respectively. Pressing "Fn-Left arrow key" moves to the first 

item in the appointment list, and pressing “Fn-Right arrow key” moves to the 

last item in the appointment list. 
For recurring appointments and multiple day appointments, the Braille Sense 
U2 QWERTY only shows the schedules of the first day if you search the 



167 
 

schedule by subject. For example, if you have an appointment on January 1, 
2007 and it recurs the first day of every month, the Braille Sense U2 
QWERTY shows this schedule on January 1, 2007 only when you search by 
subject. 
Press "Enter" on an appointment to read the details. Press "Esc" to return to 
the appointment list. TO SEARCH other keywords, press “Tab” to move to 
the "Search subject" edit box. 
 

7.6 Modify Schedule 
 
You can modify an appointment that you have previously scheduled. Move 
to the appointment you want to modify. Open the menu by pressing “Alt” and 
press "Enter" on "Modify Schedule", or press the shortcut key "m" from the 
menu. Or you can press its hot key, "Ctrl-m" from the search results list. If 
the appointment is a recurring schedule, a prompt, displaying "Recurrence 
appointment. Open type?" appears. Choose whether you want to modify the 
recurring schedule or the schedule for a specific day. If you select "This 
occurrence", your changes affect the appointment of the day, but the 
recurring appointments on other days are not changed. If you select "The 
series", your changes affect all the recurrences. If you select "Cancel", 
"Modify Schedule" dialog is not opened and you are returned to your last 
position. Make your selection by pressing "Space" or "Backspace". Press 
"Enter" to open the "Modify Schedule" dialog. This dialog contains the same 
controls as in the "Add Schedule" dialog. The only difference is that each 
field has the value entered previously. If you have made changes you wish 
to save, tab to "Confirm" and press "Enter".  
 

7.7 Deleting a Schedule 
 
To delete a schedule, move to the schedule in the search results list. Press 
“Alt” to open the menu, and press "Enter" on "Delete Schedule". Or you can 
press its hot key, "Del" from the search results list. If the selected schedule is 
a recurring schedule, you are prompted, "Recurring appointment. Delete 
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type?" is displayed. You can choose whether you want to delete the 
recurring schedule, or just the appointment for that day. If you select "This 
occurrence", only the current appointment is deleted. If you select "The 
series", all recurrences of the appointment are deleted. You cannot select 
and delete multiple schedules at once. You can delete only the currently 
focused appointment.  
 

7.8 Printing a Schedule 
 
After finding an appointment using the "Search Schedule" dialog, you can 
print an appointment using the "Print Schedule" command. Open the menu 
by pressing “Alt”, and press "p", or select "Print Schedule" and press "Enter". 
Or, from the search results list, press "Ctrl-p". The Braille Sense U2 
QWERTY asks you to specify the beginning date of the appointments to be 
printed. By default, the current date is displayed. If you wish, you can specify 
another date using the entry and navigation procedures described in 7.3. 
Press “Tab” to set the end date of the appointments to be printed. Again, you 
can enter or select a different date than what is displayed. Press "Enter" or 
“Tab”, and you are asked to select the type of printer to use. "Printer" is the 
default setting. Press “up arrow button” or “down arrow button” to move 
between "Embosser" and "Printer". If you have selected the appropriate 
printer type press "Enter" to start printing. Please make sure the Braille 
Sense U2 QWERTY is connected to the printer and that the printer is ready 
to receive information. When printing is complete, the Braille Sense U2 
QWERTY returns to the search results list. 
 

7.9 Saving Appointments as a File 
 
You can save appointments stored in "Schedule Manager" as a document.  
Open the menu by pressing “Alt”, then select "Save Schedule As File", and 
press "Enter". Or press "t" from the menu. Or, from the search results list, 
press "Alt-s". The Braille Sense U2 QWERTY asks you to specify the 
beginning and end dates of the appointments to be saved just as with "Print 



169 
 

Schedule". After setting the beginning and end dates, press "Enter" or “Tab”, 
and you are prompted to enter the name and the format of the file to be 
saved. This dialog is the same as the "Save As" dialog in the "Word 
processor".  
 

7.10 Backing Up and Restoring Your Appointments 
 

7.10.1 Backup Schedule 
 
If you perform a hard reset, or your battery dies, all of the data in the 
Schedule Manager is lost. Thus, it is very important to create a backup file 
each time you change your schedule. To backup your schedule, open the 
menu by pressing “Alt”. Then, use the up and down arrows (“up arrow 
button” or “down arrow button”), to locate "Backup Schedule". Then, press 
"Enter". You can also press "u" from the menu. Or, you can press "Ctrl-u" to 
activate this function directly. 
If you already have a backup file, you are prompted, "Backup file already 
exists. Backup anyway? Yes". If you have made changes to your schedule, 
press "Enter" to create a new backup file. To keep the previous backup file, 
press “down arrow button”, locate "No", and press "Enter" on it. If you make 
a backup file again in the Schedule Manager, a new backup file is created 
with the extension DAT, and another file is created with the extension BAK 
containing your previous backup file.  
 

7.10.2 Restore Schedule 
 
To restore your schedule after a hard reset, press “Alt” to open the menu, 
and use the up and down scroll buttons to locate "Restore Schedule". Then, 
press "Enter". Or, you can press "r". You can also press "Ctrl-r" to activate 
this function directly. 
If you activate the "Restore Schedule" function, and you already have an 
existing schedule, you are prompted, "Schedule file already exists. Which do 
you prefer? Append" or, press “down arrow button” to move to "Overwrite". 
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You can choose to add to or overwrite the current schedule with the backup 
file. If you choose to append, and the backup file contains appointments that 
also exist in your current file, you will have redundant appointments. If you 
choose to overwrite and your current schedule contains appointments the 
backup file does not, these appointments are lost. If you don't want to 
"Append" or "Overwrite", press “down arrow button” once more, locate 
"Cancel", and press "Enter" on it. 
 

7.10.3 Setting Backup Option 
 
You can backup your schedule manually by activating the "Backup 
Schedule" function. You can also backup the schedule automatically by 
activating the "Set Backup Options" function. To activate the "Set Backup 
Options" function, press “Alt” to open the menu. Next press “down arrow 
button” or “up arrow button” repeatedly to locate "Set Backup Options". Then, 
press "Enter". Or, from the menu, you can press "e" to jump directly to "Set 
Backup Options". You can also activate the "Set Backup Options" function 
directly by pressing "Ctrl-e". 
The "backup Options" dialog has three controls, "Backup mode" radio button, 
a "Confirm" button, and a "Cancel" button. You can move among the controls 
by pressing “Tab” or "shift-tab". To move between the radio buttons, you can 
press “up arrow button”, "Backspace", “down arrow button”, or "Space". 
The "Backup mode" has three radio buttons: "Always backup changes when 
exiting", "Manual backup", and "Prompt backup changes when exiting". 
 
1. If you select the "Always backup changes when exiting", a new backup file 
is created automatically if you have modified or added to your schedule.  
2. If you select the "Manual backup", a new backup file is not created, even if 
there are changes to your schedule. If you select this option, you can only 
create a new backup file by using the "Backup Schedule" function. 
3. If you select "Prompt backup changes when exiting", you are prompted, 
"Backup changes? Yes" if you have modified or added to your schedule. If 
you press "Enter" on "Yes", a new backup file is created before exiting the 



171 
 

Schedule Manager. If you press “down arrow button” once, and press "Enter" 
on "No", you exit the Schedule Manager, without creating a backup file.  
 
You can change the backup mode by pressing "Enter" after focusing on one 
of the three radio buttons. Or, press "Tab”, and press "Enter" on "Confirm". 
The default backup mode is set to "Prompt backup changes when exiting". 
 

7.11 Setting Alarm Option 
 
You can open the "Set Alarm Options" dialog by pressing “Ctrl-o”, or by 
pressing "Enter" on "Set Alarm Options" in the menu by pressing “Alt” in the 
"Schedule Manager". This dialog has a list of alarm option fields, a "Confirm" 
button, and a "Cancel" button. Alarm option fields include "Alarm duration", 
"Alarm repeat interval" and "Repeat". You can move between these fields by 
pressing “up arrow button” or “down arrow button”. You can access the 
"Confirm" and "Cancel" buttons by pressing “Tab” or "shift-tab". 
 

7.11.1 Alarm Duration 
 
With this option, you can change the duration of the alarm sound. You can 
set this option to a value that is between 5 and 600 seconds. The default 
value is set to 30 seconds. Enter the number in computer Braille or grade 1 
Braille, without a number sign. Press "Enter" to save the changes, and exit 
from the dialog. To set the "Alarm repeat interval" in the next field, press 
“down arrow button”.  
 

7.11.2 Alarm Repeat Interval Time 
 
When the alarm goes off, if you do not stop it by pressing "Ctrl", the Braille 
Sense U2 QWERTY keeps giving you a notice about the appointment after a 
specified time interval. The "Alarm repeat interval" option allows you to 
change this interval. You can set the value anywhere from 1 to 60 minutes, 
the default value is set to 5 minutes. To change the value, type a number 
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between 1 and 60 in computer Braille, or grade 1 Braille without a number 
sign. Press "Enter" to save the changes, and exit the dialog. Or, if you press 
“Tab”, the Braille Sense U2 QWERTY moves to the "Repeat" edit box. 
 

7.11.3 Repetition Times 
 
The alarm sounds for the amount of time for which you set the alarm 
duration, then stops. If you have not acknowledged the alarm, after a 
specified time interval, the alarm sounds again. 
The "Repeat" field allows you to decide how many times the alarm will sound. 
You can set the value from 1 time to 10 times; the default value is set to 3. 
To change the value, type a number between 1 and 10. Press “Tab”, and 
press "Enter" on the "Confirm" button to save your settings. 
 
An alarm repeats according to the number of times that you set for this 
option and then stops automatically. The Braille display on the Braille Sense 
U2 QWERTY also displays the "date" and "subject" for the alarm. 
 

7.11.4 Confirm 
 
By pressing "Enter" on the "Confirm" button, the settings are saved, and the 
"Set Alarm Options" dialog is closed. 
 

7.11.5 Cancel 
 
If you press "Enter" on the "Cancel" button, or press "Esc" or "Alt-F4", the 
default alarm options are restored and the "Set Alarm Options" dialog is 
closed. 
 

7.12 Synchronizing With Microsoft Outlook 
 
The "Schedule Manager" can be synchronized with Microsoft Outlook on 
your personal computer to help you keep track of your appointments. For a 
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more detailed explanation of how to connect the Braille Sense U2 QWERTY 
to your computer and how to use ActiveSync or Windows Mobile Device 
Center, refer to chapter 19.  
 

7.13 Hot Keys for the Schedule Manager 
 

1. Add Schedule 
Move between fields 
Move to the next field: Tab 
Move to the previous field: Shift-tab 

 
2. Hot keys for the Commands 

Search schedule: Ctrl-s 
Alarm option: Ctrl-o 
Backup schedule: Ctrl-b 
Restore schedule: Ctrl-r 
Setting backup option: Ctrl-e 
Exit: Alt-F4  

 
3. Search schedule 

Hot keys for the commands 
Add schedule: Ctrl-n 
Alarm option: Ctrl-o 
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Toggle search mode: Alt-s 
Exit: Alt-F4 

 
4. Move keys in the search result list 
1)  Move from a appointment to another in the schedule list: 

Move to the previous a in the same day: Up arrow key 
Move to the next appointment in the same day: Down arrow key 
Move to the first appointment in the same day: Fn-Left arrow key 
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Move to the last appointment in the same day: Fn-Right arrow key 
2)  Move from one appointment to another in all the appointments 

registered: 
Move to the previous schedule: Ctrl-Left arrow key 
Move to the next schedule: Ctrl-Right arrow key 
Move to the first schedule: Ctrl-Fn-Left arrow key 
Move to the last schedule: Ctrl-Fn-Right arrow key 

3)  Hot keys for the commands: 
Add schedule: Ctrl-n 
Modify schedule: Ctrl-m 
Delete schedule: Del 
Alarm option: Ctrl-o  
Backup schedule: Ctrl-b 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Save schedule as file: Alt-s 
Print schedule: Ctrl-p 

 
5. Cancel / Exit 
1) Cancel: ESC 

It cancels the current job or setting like the “esc” key on a personal 
computer. 

2) Exit: Alt-F4 
Exit from the schedule manager. It can be used as cancel key for any 
function. 
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8. E-mail 
 
The e-mail program is used to communicate with others by sending 
messages using the Internet. To use the e-mail program, you must have 
your own e-mail account, provided to you by your Internet account provider 
or a free account such as Gmail or hotmail. 
Your e-mail account needs to support POP3 (Post Office Protocol 3) and 
SMTP (Simple Mail Transfer Protocol) to be accessed with the Braille Sense 
U2 QWERTY. You should check with your Internet account provider to make 
sure that your provider supports POP3 and SMTP. 
Before you use the e-mail program, you must configure the Braille Sense U2 
QWERTY to access the Internet, (see section 17.9 "Internet Setup"). 
When checking the "Inbox" in the e-mail program, the menus are different 
from the menus that are used when you are writing an e-mail. Read this 
chapter carefully, before you use the e-mail program on the Braille Sense U2 
QWERTY. 
 

8.1 Executing E-mail and E-mail Account management 
 
To use the e-mail program, you must add your e-mail account information. 
The following sections provide a detailed explanation of how to execute e-
mail, how to add e-mail account information, and how to check, modify, and 
delete this information.  
 

8.1.1 Executing e-mail 
 
To execute the e-mail program, follow these steps: 
 
1) Navigate to "E-mail" in the "program" menu, by pressing “up arrow button” 
and “down arrow button”. 
2) Press "Enter" on "E-mail" or press "E". 
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When you launch the e-mail program for the first time, the Braille Sense U2 
QWERTY says, "You must create at least 1 mail account from the accounts 
manager in the Tools menu". Then, the "Inbox" is opened. The "Inbox" is the 
main window of the E-mail program. When you run the e-mail program for 
the first time, this "Inbox" is empty and the Braille Sense U2 QWERTY 
displays "no items". 
Press "Shift-Tab", and you are placed in the mailbox list.  
 
By default, the Braille Sense U2 QWERTY contains the following mailboxes:  
1) Inbox: received mail that has not been deleted or saved to a different 
folder. 
2) Sent: sent messages you have chosen to store  
3) Outbox: messages waiting to be sent, either when you save mail in 
"Outbox" or sending mail fails. 
 
By pressing “up arrow button” and “down arrow button”, you can move 
among the mailboxes.  
 
If there are e-mail messages in the "Inbox", "Opening inbox." is announced 
and is shown on the LCD display; and "xx% processed" is displayed on the 
Braille display. Once progress has reached 100%, the "Inbox" is opened and 
displays the received e-mail in the message list. Move to "Sent" or "Outbox", 
and press "Enter". If there are any e-mail messages in "Sent" or "Outbox", 
they are displayed in message lists as in the "Inbox".  
 

8.1.2 Managing e-mail account information 
 
In the "Accounts manager", you can manage e-mail account information.  
 
To access the "Accounts Manager", follow these steps: 
1) Press “Alt” to open the menu from the "Inbox" message list. 
2) Pressing “down arrow button”, move to "Tools". Press "Enter" on "Tools". 
Or press "T". 
3) You are placed on "Accounts manager". 
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4) Press "Enter". 
5) "Account name: no items" is displayed. You can also move to this menu 
by pressing "Ctrl-m". 
 
The "Accounts manager" contains the following 6 items. 
1. Accounts list 
2. Information 
3. Add 
4. Modify 
5. Delete 
6. Close 
 
You can move among these items by pressing “Tab” or "shift-tab". You can 
execute each item by pressing "enter" on it. 
To exit the "Accounts manager", move to the "Close" button, and press 
"enter". Or, press "Esc" or "Alt-F4".  
The following is a detailed explanation of each item in the "Accounts 
Manager". 
 

8.1.2.1 Add e-mail Account 
 
To receive e-mail, you must add an e-mail account with which to send and 
receive messages. To add an e-mail account, follow these steps: 
 
1) Press “Alt” to open the menu. 
2) Move to "Tools", by pressing “down arrow button”. 
3) Press "Enter" or press "T". 
4) You are placed on "Accounts manager". Press "Enter". 
5) "Account name: no items" is displayed. You can also jump quickly to this 
dialog from the "Inbox" by pressing "Ctrl-M". 
6) Press "Tab", to move to "Add". 
7) Press "Enter" on the "Add" button or press "A". 
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8) The dialog is opened and "Account name:" is displayed. Type the name 
by which you want to identify the e-mail account: (example, "Gmail" or "work 
e-mail"). 
9) Press “down arrow button”, to move to "Display name". Type the "Display 
name" in the edit box. This name is the name people will see when they 
receive an e-mail from you. 
10) Press “down arrow button”, to move to "Logon username". Type the 
"Logon username" in the computer edit box using computer Braille. (Ex: 
Sense or sense@hims-inc.com). Note: some providers require you to use 
the entire e-mail address as the username, while others may use the part of 
the address before the at-sign. BE sure you type the username correctly for 
your e-mail provider. 
11) Press “down arrow button”, to move to "Password". Type the "password" 
in the computer edit box using computer Braille. Note: the password is 
hidden, and thus displays as asterisks. Be sure to type carefully as you 
cannot review your password.  
12) Press “down arrow button”, to move to "E-mail address". Type your "E-
mail address" in the computer edit box using computer Braille. (Ex: 
sense@hims-inc.com) 
13) Press “down arrow button”, to move to "Incoming POP3 server". Type 
the "Incoming POP3 server" in the computer edit box using computer Braille. 
(Ex: mail.hims-inc.com). Check with your Internet account provider or 
network administrator to find out what you should use as the Incoming POP3 
server.  
14) Press “down arrow button”, to move to "Outgoing SMTP server". Type 
the "Outgoing SMTP server" in the computer edit box using computer Braille. 
Check with your Internet account provider or network administrator to find 
out what you should use as the Outgoing SMTP server.  
15) Press "Tab", move to "Confirm" button. 
16) Press "Enter" on the "Confirm" button. 
17) The Braille Sense U2 QWERTY exits to "Account name list" and shows 
the added account name (Ex: Account name: Braille Sense U2 QWERTY 
1/1). 
18) When you finish adding accounts, press "Alt-F4" to exit to the "Inbox". 
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To move from a setting item (Ex: ID, password) to the previous setting item, 
press “up arrow button”. And, to move to the "Confirm" button or the "Cancel" 
button, press "Tab" or "Shift-Tab". 
If you made a typing error in an item such as account name, ID, or password, 
you can correct the error as follows; 
 
1) To delete the letter where the cursor is located, press "Del". 
2) To delete the letter in front of the cursor position, press "Backspace". 
3) To delete the current line, press "Ctrl-Backspace".  
 
Several of the fields for setting up an e-mail account require you to use 
computer Braille. To type your ID, password, and address, please uses the 
following computer Braille symbols: 
 
Note: many e-mail service providers use secure servers with different port 
numbers. If your service provider requires you to use encryption, you must 
set these options in the "Advanced" dialog explained in section 8.1.2.1.1.  
 

8.1.2.1.1 Signature and Advanced 
 
While adding your account, you can create signature and set advanced 
options in the "Advanced" dialog.  
1) Press “Alt” to open the menu. 
2) Press “down arrow button”, move to "Tools". 
3) Press "Enter" on "Tools" or press "T". 
4) Braille Sense U2 QWERTY displays "Accounts manager".  
5) Press "Enter" on the "Accounts manager".  
6) Braille Sense U2 QWERTY displays "Account name". You can also use 
the hot key, "Ctrl-M" to quickly open this dialog. 
7) Press "Tab”, move to "Add". 
8) Press "Enter" on the "Add" button or press "A". 
9) Press "Tab”, to move to "Advanced". 
be10) Press "Enter" on the "Advanced" button. 
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11) Braille Sense U2 QWERTY displays "Use secure POP3 (POP-SSL)". 
The default value of this check box is unselected. If the POP3 server uses 
"SSL", select the check box by pressing "Space". 
12) Press “down arrow button” to move to "POP3 port number": set to 110 by 
default. Type a different POP3 port number in the computer edit box if your 
provider requires a different port number. Note: if you check "SSL" above, 
the pop port number is automatically changed to 995, as most pop servers 
with SSL require. 
13) Press “down arrow button” to move to "SMTP encryption type". The 
setting values are "None", "SSL" and "TLS". If your Outgoing SMTP server 
uses "SSL" or "TLS", change the value by pressing "Space". 
14) Press “down arrow button” to move to "SMTP port number": set to 25 by 
default. Type a different value in the computer edit box if your provider uses 
a different SMTP port number. Common port numbers are 465 for SMTP 
servers using SSL, and 587 for SMTP servers using TLS.  
15) Press “down arrow button” to move to "SMTP username". If your Internet 
account provider requires you to use a different SMTP username, enter it in 
this computer edit box. 
16) Press “down arrow button” to move to "SMTP password". Type the 
password that corresponds to the above ID. It should be typed using ASCII. 
17) Press “down arrow button” to move to "Use as default send-from 
account" To use the username and password that were set in steps 7 and 8, 
select the check box by pressing "Space". 
18) Press “down arrow button” to move to "Keep mail copies in server". 
When you download e-mail from your e-mail server, you can set the Braille 
Sense U2 QWERTY to keep e-mail messages on the server or delete them 
as they download. Press "Space" to toggle "Yes" and "No", and press "enter" 
if you do not want a copy of the e-mail to remain on the e-mail server. 
19) Press “down arrow button” to move to "Save mail copies in sent mailbox". 
When you send e-mail, you can set whether or not the Braille Sense U2 
QWERTY stores e-mail messages you send in the sent mailbox. Press 
"Space" to toggle "Yes" and "No", and press "Enter". 
20) Press "Tab", move to "Use signature". The default value is "No". To 
attach a signature to your mail, press "Space" to change "No" to "Yes". 
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21) Press "Tab", to move to "Signature".  
22) Press "Enter" on the "Signature" button. 
23) You are placed in the "Signature:" multi edit box. Type the information for 
the signature you want to attach to your e-mails.  
24) Press "Tab", to move to "Confirm".  
25) Press "Enter" on the "Confirm" button. 
26) This saves the signature, and you are returned to the "Signature" button. 
You can cancel by pressing "enter" on the "Cancel" button. 
27) Press “Tab”, and press "enter" on the "Confirm" button. 
 

8.1.2.2 Checking added account list 
 
Use the following steps to view the information about an added e-mail 
account. 
 
1) Press “Alt” to open the menu. 
2) Press “down arrow button” to move to "Tools". 
3) Press "Enter", or press "T" from the menu. 
4) Braille Sense U2 QWERTY displays "Accounts manager". 
5) Press "Enter" on the "Accounts manager". 
6) Press “down arrow button” or “up arrow button” to move to the desired 
account in the account list. 
7) If the desired account is displayed, press "Enter". Or "Tab" to move to the 
"Information" button, and press "enter". 
8) The "Information" dialog is opened, and "Account name: (Added account 
name)" is displayed (Ex: account name: Braille Sense U2 QWERTY). 
9) Press “down arrow button” or “Tab” to read the information for each item. 
Pressing "enter" on the "Close" button returns you to the account list. 
 
IN this dialog you can read all information associated with an e-mail account.  
USE the navigation keys listed below to move among the items in the dialog: 
 
Move to the previous item: Up arrow button 
Move to the next item: down arrow button 
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Move to the first item: Fn-Left arrow key 
Move to the last item: Fn-Right arrow key 
Move to the previous control: Shift-Tab 
Move to the next control: Tab 
 

8.1.2.3 Modifying an e-mail account  
 
Use the following steps to modify the information for an e-mail account.  
  
1) Press “Alt” to open the menu. 
2) Press “down arrow button” to move to "Tools". 
3) Press "Enter" on "Tools" or press "T" 
4) Braille Sense U2 QWERTY displays "Accounts manager". 
5) Press "Enter" on the "Accounts manager". 
6) Press “down arrow button” or “up arrow button” to move to the desired 
account in the account list. 
7) When the desired account is displayed, press "Tab" to move to the 
"Modify" button, and press "Enter". Or, press "m". 
8) Braille Sense U2 QWERTY displays "Account name" and you are placed 
in the "Account name" edit box with the current information filled in. For 
example, "Account name: Braille Sense U2 QWERTY". 
9) The "Modify" dialog is opened. You can now make changes to the 
information presented.  
10) Press “down arrow button”, to move to "Display name" and make any 
changes you wish.  
11) Use “down arrow button” to continue through the dialog, editing any of 
the fields you wish to modify as you navigate them. 
12) When you reach the bottom of the main account settings dialog, press 
"Tab", to move to the "Advanced" button, and press "Enter". Again, use 
“down arrow button” to move through the list of items in this dialog, and 
make changes as necessary. 
13) When you have finished making modifications, press "Tab”, to move to 
"Confirm" and press "Enter". 
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14) You are returned to the main account settings dialog. Press “Tab” to 
move to the "confirm" button, and press "Enter". 
15) When the modification is complete, you are returned to the "account list". 
 
As described, you can move among the items (account name, logon 
username, password...) by pressing “up arrow button” or “down arrow button”. 
You can move to the "Confirm" button or the "Cancel" button by pressing 
“Tab” or "shift-tab". 
For all of the items, the values that were entered previously are displayed. If 
you type new information, the new information replaces the old information. 
To modify part of an item, press the "cursor routing key" at the desired 
position and edit the text. 
If you made a typing error in an item (account name, logon username, 
password...), you can modify it using the following hot keys: 
 
1. Delete the current letter by pressing "Del". 
2. Press "Backspace" To delete the previous letter. 
3. To delete the current line, press "Alt-c".  
 

8.1.2.4 Deleting an E-mail Account 
 
Use the following steps to delete an E-mail account. 
  
1) Press “Alt” to open the menu. 
2) Press “down arrow button” to move to "Tools". 
3) Press "Enter" on "Tools" or press "T". 
4) Braille Sense U2 QWERTY displays "Accounts manager". 
5) Press "Enter" on "Accounts manager". 
6) Press “down arrow button” or “up arrow button” to move to the desired 
account in the account list. 
7) When the desired account is displayed, press "Del". Or, press "Tab" to 
move to the "Delete" button, and press "Enter". 
8) "Are you sure you want to delete the (added account name) account? 
Yes" is displayed. 
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9) Press "enter" To delete it. 
10) The Braille Sense U2 QWERTY deletes the account, shows 
"Successfully deleted", and returns to the "account list". 
 
To cancel the deletion, press "Space" when the "Are you sure you want to 
delete the (Added account name) account? Yes" is displayed. Press "enter". 
Or, press "Esc" or "Alt-F4". 
 

8.2 Receiving and Sending E-mail 
 

8.2.1 Receiving E-mail 
 
The Braille Sense U2 QWERTY is capable of receiving plain text e-mail and 
html e-mail messages. 
 
You can receive e-mail messages by doing the following: 
1) Press “Alt” to open the menu. 
2) Press “down arrow button”, to move to "Message". 
3) Press "Enter" on "Message" Or, press "M". 
4) Braille Sense U2 QWERTY displays "Reply". 
5) Press “down arrow button”, move to "Check for New Mail". 
6) Press "Enter" on "Check for New Mail". Or press "N". 
7) You are presented with the "Account name" list. You can also move to this 
dialog directly from the "Inbox" by pressing "Alt-m". This dialog consists of 
"account list", a "Confirm" button, and a "Cancel" button. 
8) When "Account name: (Added account name x/x)" is displayed, press “up 
arrow button” or “down arrow button” to move to the desired account. 
9) Press "enter" when the desired account is displayed, or press "Tab" to 
move to the "Confirm" button, and press "enter". 
10) The Braille Sense U2 QWERTY displays "There are xx messages to 
receive. Now receiving." "x/you mail received;" "Successfully received x out 
of y message" is displayed. When the e-mail messages are downloaded 
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from the server, the e-mail message list is displayed in the "Inbox" (Ex: 
Subject: (subject of the e-mail received) xx/xx). 
 
If the e-mail size is greater than the Braille Sense U2 QWERTY can handle, 
it announces, "This message is too large to download. Skipping". And the 
Braille Sense U2 QWERTY begins downloading the next e-mail message.  
To cancel the download, press "Tab" to move to the "Cancel" button, and 
press "enter", or you can press "Esc". 
 

8.2.2 Reading the Received E-mail Messages 
 
If you downloaded e-mail from your server, the e-mail messages are listed in 
the "Inbox". Each e-mail in the "Inbox" has the following items. 
 
1. Subject 
2. Date 
3. From (Sender) 
4. CC 
5. Message 
6. Attach (this is displayed only for an e-mail that has one or more attached 
files) 
You can move among the items by pressing "Tab" or "Shift-tab".  
 

8.2.2.1 Subject Control 
 
"Subject" shows the title of the e-mail; "Subject: (subject of the e-mail) xx/yy". 
After the subject of the e-mail, you find "xx/yy", which shows the number (xx) 
of the current e-mail and the total number (yy) of received e-mail messages. 
For example, "11/21" means that the e-mail is the 11th e-mail out of a total of 
21 e-mail messages. 
If there is a file attached to the e-mail, "a Subject: (subject of the e-mail) 
xx/yy" is displayed. The symbol "a (dot 1)" means that the e-mail has an 
attached file. It is displayed as "a (dot 1)" on the Braille display, and it is 
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announced as "1 attachment", which indicates the number of the attached 
files.  
The Braille Sense U2 QWERTY also indicates which e-mail messages have 
been read, and which e-mail messages are unread. E-mail messages that 
have not yet been read have a dash placed in front of the subject. For 
example, let's suppose there is an e-mail with an attachment that has been 
unread. It would appear as coma Subject: (subject of the e-mail) xx/yy. 
You can move among e-mail messages when the subject is displayed, by 
using the following keys; 
 
Move to the next e-mail: down arrow button 
Move to the previous e-mail: up arrow button  
Move to the first e-mail in the Inbox: Ctrl-Fn-Left arrow key  
Move to the last e-mail in the Inbox: Ctrl-Fn-Right arrow key  
 

8.2.2.2 Date Control 
 
"Date" shows the date and time when the e-mail was received; "Date: (date), 
(time) xx/yy". The date is displayed in the following order: day, month, date, 
and year. The time is displayed in the following order: hour, minute, and 
second with the 24 hour system. And, "xx/yy" shows the current number of 
the e-mail and the total number of e-mail messages received. You can also 
move among e-mail messages when the date is displayed using the same 
navigation keys described above.  
The Braille Sense U2 QWERTY also indicates which e-mail messages have 
been read, and which e-mail messages are unread when viewing by date.  
 

8.2.2.3 Sender Control 
 
"From" shows the sender information; "From: (sender's e-mail address) 
xx/yy". The Braille Sense U2 QWERTY also indicates which e-mail 
messages have been read, and which e-mail messages are unread when 
viewing by sender.  
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You can save the e-mail id of the sender to your contacts in the "Address 
Manager" using the following steps: 
 
1) Press "Ctrl-i" when "From: (sender's e-mail address) xx/yy" is displayed. 
2) The "add address" dialog is opened, and "Name: (sender's user name or 
e-mail address)" is displayed. 
3) Type the sender's name, or, if what is automatically filled in is acceptable, 
press “Tab” to move to "Confirm", and press "enter". 
 
When you type the name, you can type it directly without pressing a cursor 
key to designate the input position. Or, you can modify what is already filled 
in, by pressing a corresponding cursor key, and editing the text. If the 
address is saved, and the dialog is closed, the Braille Sense U2 QWERTY 
returns you to the message list, and shows you the "From" item again. 
By saving the e-mail ID using the above method, the name and its e-mail id 
is saved in the Braille Sense U2 QWERTY's "Address Manager". . The 
saved e-mail ID can be used to send a message to that person at a future 
time.  
To cancel saving the e-mail ID, press “Tab” to move to the "Cancel" button, 
and press "enter", or press "Esc". 
 

8.2.2.4 CC Control 
 
"CC" shows the carbon copy recipient. This control is shown if the e-mail has 
a "CC". 
You can save the e-mail id of the carbon copy recipient using the process 
described above for saving a sender's e-mail address. 
 

8.2.2.5 Message Control 
 
"Message" displays the message body of the selected e-mail. You can move 
to a message by pressing “Tab”. Or, you can read a message by pressing 
"enter" when "Subject", "Date", or "From" is displayed. When you press 
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"enter" on the "Subject", "Date", or "From" controls, the entire message is 
automatically spoken. To interrupt reading, press "Ctrl". 
To return to the "Subject" while reading the message, press "Esc". 
When you read the message, all of the navigation and control keys are the 
same as in the "Word Processor". 
 

8.2.2.6 Attachment Control 
 
You can find and download attached files by navigating to "Attach" on 
messages containing attachments. Braille Sense U2 QWERTY displays this 
control only for e-mails which contain attachments. Attachments are 
displayed as, "Attach: (attached file name) xx/yy". The "yy" is the total 
number of the attached files to the e-mail and "xx" is the "xxth" attached file. 
Use the following steps to download attachments: 
 
1) From the body of a message containing attachments, press "Tab" to move 
to the attached files list. 
2) Move to the desired file name in "Attach" by pressing “down arrow button” 
or “up arrow button”. 
3) Press "Space" on the file name you want to download to select it. /is 
displayed in front of the file name. 
4) Press "enter" to download the file. You are prompted, "Attachments will be 
saved to /flashdisk/download. Do you want to change this location? No" 
Press "enter".  
By doing so, the selected file is saved in the "download" folder on the 
"flashdisk". 
 
If you have more than one attachment you want to download, you can press 
"Ctrl-a" to select all attachments in the list, or press space on any number of 
individual files to select them. To download only the currently focused file, 
you can simply press "enter" on it.  
To change the download path:  
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1) When you are prompted, "Attachments will be saved to 
/flashdisk/download. Do you want to change this location?", navigate to 
"Yes" and press "Enter".  
2) You are placed in the file list of the "Downloads" folder on the "flashdisk". 
Use normal file and folder navigation keys as described in the "File Manager" 
section of this manual to locate the folder into which you want to save the 
attachments.  
3) Press "Space" to select the folder in which to save the attachments, and 
press "Enter".  
4) The file is downloaded, and you are returned to your e-mail message. 
 

8.2.2.7 Reading HTML e-mail 
 
If you receive an html e-mail, follow these steps to access the links, etc: 
 
1) Open the message with the Web browser by pressing the hot key, "Alt-o".  
2) Or, you can use the menu: Press “Alt”, move to "Message" and press 
"enter". Navigate to "Open Message In Web Browser" and press "enter".  
The "Web Browser" is launched and you can view the html message in the 
"Web Browser". If the e-mail message contains links, you can visit these 
sites by pressing "Enter" just as you would on any web page, provided your 
Braille Sense U2 QWERTY is connected to the Internet. 
 

8.2.3 Writing e-mail 
 
Use the following steps to create an e-mail message: 
 
1) Press “Alt” to open the menu. 
2) Braille Sense U2 QWERTY displays "File" menu. 
3) Press "Enter" on the "File" menu.  
4) Braille Sense U2 QWERTY displays "Write New Message". 
5) Press "Enter" on "Write New Message". 
6) "To:" is displayed on the Braille display. Pressing "Ctrl-n" opens this dialog 
directly from the "Inbox"..  
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7) Press "shift-tab" to move to the "Account" combo box. Move to the 
account from which you want to send this message by using “up arrow 
button” or “down arrow button”. Press “Tab” to move to the "To:" field. 
8) Type the e-mail address of the recipient, or rather, the person to whom 
you are sending the message. Please type the e-mail address using 
computer Braille. (Ex: sense@hims-inc.com). 
9) Press “Tab” to move to "CC:". 
10) Type the e-mail address of the copy recipient using computer Braille. If 
you do not need to carbon copy a anyone, you can skip to the next step. 
11) Press “Tab” to move to "BCC:". 
12) Type the e-mail address of the blind copy recipient using computer 
Braille. If there is no blind copy recipient, you can skip to the next step. 
13) Press “Tab” to move to "Subject:". 
14) Type the subject of the e-mail message.  
15) Press “Tab” to move to "Message body:" 
16) Type the text of your e-mail message. The input method and the editing 
method are the same as the input and editing method used in the word 
processor. You can also write the message in ASCII, Grade 1, or Grade 2. 
17) When you finish writing the e-mail message, press “Alt” to open the "E-
mail" menu. The "File" menu is displayed again. 
18) Press "enter". 
19) Press “down arrow button” to move to "Send". 
20) Press "enter". You can also send mail directly by pressing “Ctrl-s”.  
21) "Sending…". is displayed, and the e-mail is sent. When the e-mail is 
finished sending, "Successfully sent new message" is displayed. If sending 
fails, the Braille Sense U2 QWERTY displays "Unable to sent message". If 
this occurs, the e-mail is saved in the "Outbox". 
Note: Be sure you have an active Internet connection before executing the 
"Send" command, as you cannot send e-mail without if the Braille Sense U2 
QWERTY cannot access the Internet.  
After sending is completed, or has failed, you are returned to the "Inbox". 
 
To cancel e-mail message creation or sending, press "Esc or "Alt-F4" and 
you are returned to the "Inbox". 
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8.2.3.1 Attaching a File 
 
While you are writing e-mail, you can attach files to your messages. 
Use the following steps to attach a file: 
 
1) While writing e-mail, press “Alt” to open the menu. Braille Sense U2 
QWERTY displays "File" menu. 
2) Press "Enter" on the "File" menu.  
3) Braille Sense U2 QWERTY displays "Attach File". 
4) Press "Enter" on "Attach File". The file list is opened. You can also access 
"attach file" directly by pressing "Ctrl-f".  
5) The default folder for the "file list" is the "upload" folder on the "flashdisk". 
Use normal file and folder navigation keys to locate the file or files you want 
to attach.   
6) Move to the desired file, and press "enter". To attach more than one file, 
move to each file, and press "Space" to select it. * is displayed in front of the 
selected file names. Press "enter" To attach the selected files. 
7) When the selected files are attached, the Braille Sense U2 QWERTY 
announces, "xx attached", and returns to the message body. "xx" is the 
number of the attached files. 
 
If there are files attached to an e-mail, the "Attach" item is displayed in the 
tab order after the "Message body".  
Attachments are displayed as: "Attach: (attached file name) xx/yy (file size)". 
"yy" is the total number of attached files, and "xx" means the "xxth" file out of 
"yy" files. You can move among the attached files by pressing “up arrow 
button” or “down arrow button”. If there is a file in the attached file list you do 
not wish to attach, you can delete it from the list by pressing "Del". 
If you press "Del", “Delete (file name) file? Yes" is displayed. If you press 
"enter", this file is deleted from the attached file list. If you press "Space" to 
switch from "Yes" to "No", and press "enter", your selection is cancelled, and 
the file remains in the attached file list. 
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8.2.3.2 Sending E-Mail to Multiple Recipients 
 
You can type more than one recipient, carbon copy recipient, or blind copy 
recipient. If you type more than one e-mail address in these fields, the same 
e-mail is sent to all of them at once. 
When you input more than one recipient, you must insert a semi-colon or 
comma between the e-mail addresses.  
 
For example, sense@hims-inc.com;hims@hims-inc.com. 
 

8.2.3.3 Searching the Address List 
 
You can add a recipient to "To", "CC", or "BCC" from the address list without 
typing in the e-mail address directly. 
The following are the steps to search for and add e-mail addresses to the 
recipients of a message: 
 
1) Press “Alt” to open the "E-mail" menu from "To", "CC", or "BCC". "File" is 
displayed. 
2) Press "Enter" on the "File" menu. 
3) Press “down arrow button” to move to "Lookup Address". 
4) Press "Enter" on "Lookup Address". "Search for address" is displayed. 
Press "Ctrl-l” to look up an address directly from one of the recipient fields. 
5) Type the last name of the desired recipient at "Search for address", and 
press "enter". Or, press “Tab” to move to "Confirm", and press "enter". 
6) "xx addresses are found" is displayed, and the first item of the found list is 
also displayed. "xx" is the number of the found addresses that have the 
same name in the address list (Ex: HIMS hims@hims-inc.com 1/xx) 
7) Press “up arrow button” or “down arrow button” to move to the desired 
address, and press "enter". You can select more than one address by 
pressing "Space". When you have chosen the addresses you want, press 
"enter". 
8) The selected addresses are inserted in "To", "CC" or "BCC".  
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If you press "enter" without typing in the desired name, all of the addresses 
in your address list are displayed. If there is no matching address, "No 
match". is announced and "Search for address" is displayed again. 
 

8.2.3.4 Saving E-Mail to the Outbox 
 
Messages are saved in the "Outbox" in 2 ways: 
1. The user saves the e-mail to the "Outbox" for later sending. 
2. An e-mail fails to send due to a network error or other reason. 
 
The "Save Mail in Outbox" dialog contains the following: 
1. "File name" edit combo box 
2. "Confirm" Button 
3. "Cancel" Button 
4. "Storage folder" List 
 
You can move among the menu controls by using "Shift-Tab" or "Tab". 
 
Use the following steps to save an e-mail in the outbox: 
1) Press “Alt” after creating the e-mail message. The "File" menu is 
displayed. 
2) Press "enter". 
3) Press “down arrow button” to move to "Save Mail In Outbox". 
4) Press "Enter".  
5) The dialog for saving is opened.  
6) "File name: (subject of writing e-mailgg.txt" is displayed. You can also 
jump to this dialog by pressing "Fn-s" while writing a message. 
7) Press "Enter" on "File name: (subject of writing e-mailgg.txt", or press 
“Tab” to move to the "Confirm" button.  
8) The message is saved as "(subject of writing e-mailgg.txt".  
9) To name the e-mail message, type a file name. Use the same procedure 
as in "Save As" in the "Word Processor". You can also change the path 
where the message is stored. 



194 
 

10) After the Braille Sense U2 QWERTY saves the e-mail message, it 
returns to the previous location. 
 
By following the explanation above, the e-mail message is saved as 
"(subject of writing e-mailgg.txt" in the "flashdisk/email/storage box".  
If you do not input a subject when writing the e-mail, the file is named 
"noname".  
If you choose to save the e-mail in a location other than 
"flashdisk/email/storagebox", you cannot access the e-mail message in the 
"Outbox". Thus, you cannot send the e-mail unless it is returned to the 
"Outbox" storage folder. 
 
While creating a "message", press "Esc" or "Alt-F4” To cancel writing the e-
mail.  
1) The Braille Sense U2 QWERTY displays "Currently writing mail. Save? 
Yes".  
2) To return to the "Inbox" without saving the e-mail, press "Space" to 
change "Yes" to "No", and press "Enter". 
 

8.2.3.5 Saving E-Mail as New Name in the "Outbox" 
 
If you save an e-mail message in the "Outbox", you can save it under a 
different file name. To do this, use the steps described above, but choose 
"Save Draft" from the "File Menu".  
 

8.2.3.6 Sending the E-Mail in the "Outbox" 
 
Use the following steps to send e-mail from the "Outbox": 
1) When the Braille Sense U2 QWERTY displays message list in "Inbox". 
2) Press "Shift-Tab", to move to "Mailbox". 
3) Press “up arrow button” or “down arrow button”, to move to "Outbox". 
4) Press "Enter". 
5) Braille Sense U2 QWERTY displays the message list in the "Outbox".  
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6) Press “up arrow button” or “down arrow button”, to move to the mail 
message you want to send. 
If you want to send all the e-mails in the list: Press "Ctrl-a” to select all. 
If you want to send individual messages, use normal selection commands to 
select them. 
8) Press “Alt” to open the menu. 
9) Press "Enter" on the "File" menu. 
10) Press “up arrow button” or “down arrow button”, to move to "Send" menu. 
11) Press "Enter" on the "Send" menu. 
12) The selected messages are sent. 
 
Press “Ctrl-s” to directly execute the "Send" command. 
If you send all the messages in the "Outbox", no items" is displayed. 
 

8.2.3.7 Setting Default E-mail account 
 
If you have set up more than one e-mail account on the Braille Sense U2 
QWERTY, you can set the default e-mail account for sending messages.  
 
1) Press “Alt” to open the menu from any mailbox but "Outbox". 
2) Press “down arrow button”, to move to "Tools". 
3) Press "Enter" on the "Tools menu" or press "T". 
4) Braille Sense U2 QWERTY displays the "Accounts manager". 
6) Press "Enter" on the "Accounts manager".  
6) Braille Sense U2 QWERTY displays "Account name" list. 
7) Press “up arrow button” or “down arrow button”, to move to the e-mail 
account you want to set as the default.  
8) Press "Tab", to move to "Modify". 
9) Press "Enter" on the "Modify" button or press "m". 
10) Press "Tab", to move to "Advanced". 
1) Press "Enter" on the "Advanced" button. 
12) Braille Sense U2 QWERTY displays the "Use secure POP3 (POP-SSL)". 
13) Press “down arrow button”, repeatedly to move to "Use as default send-
from account SMTP". 
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14) Press "Space" to change the state of the check box to "checked". 
15) Press "Tab", to move to "Confirm" and press "Enter". 
16) You are returned to the "Advanced" button. 
17) Press "Tab", to move to "Confirm" and press "Enter". 
18) Braille Sense U2 QWERTY announces, "Successfully modified account" 
and you are returned to the accounts list. 
 
Braille Sense U2 QWERTY displays "default" on the LCD and Braille display 
next to the default account. 
 

8.3 Major features of E-mail 
 

8.3.1 Deleting E-mail 
 
You can delete e-mail messages individually, or you can select multiple 
messages and delete them simultaneously. 
 

8.3.1.1 Deleting an e-mail 
 
You can delete an e-mail in the mailbox by following the steps below; 
 
1) Press “up arrow button” or “down arrow button” to move to the "Subject" of 
the e-mail you want to delete. 
2) Press "Del".  
3) Braille Sense U2 QWERTY displays "Delete (subject of the selected e-
mail) mail? Yes". 
4) Press "Enter" To delete the e-mail. 
 
To cancel, press "Space" to change "Yes" to "No" and press "Enter". 
You can also cancel e-mail deletion by pressing "Esc" or "Alt-F4".  
 

8.3.1.2 Deleting Multiple E-mail Messages 
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To delete two or more e-mail messages, use the following steps: 
1) Press “up arrow button” or “down arrow button” to move to the e-mail 
"Subject" that you want to delete. You can also select messages from the 
"Date control".  
2) Press "Space" on the e-mail messages you want to delete.  
3) Braille Sense U2 QWERTY displays * in front of the selected e-mail 
subject.  
4) Move to other e-mail messages you want to delete by pressing “down 
arrow button” or “up arrow button”. Press "Space" on each of the messages 
you wish to delete. 
5) Press "Del". 
6) Braille Sense U2 QWERTY displays "Delete xx message? Yes". "Xx" is 
the total number of messages to be deleted. 
7) Press "Enter". 
 
You can also select all messages in the current mailbox by pressing "Ctrl-a", 
or select a contiguous group of messages by pressing "Ctrl-b" to set the 
beginning of the selection, and move your cursor to the last message you 
want to select.  
 
To cancel this function, press "Space" to change "Yes" to "No" on the delete 
prompt and press "Enter". 
Or you can cancel by pressing "Esc" or "Alt-F4". 
 

8.3.2 Reply And Reply All to a Received E-Mail. 
 
When you reply to an e-mail, you can edit or add a message to the original 
message, or add another recipient.  
Example: 
Suppose you received an e-mail with the following information: 
Sender's e-mail address: hims@hims-inc.com 
Subject of the e-mail: Welcome to HIMS 
You could reply to this e-mail using the following steps: 
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1) Press “Alt” to open the menu from "Subject", "Date", or "Message body" of 
a message in the "Inbox". 
2) Braille Sense U2 QWERTY displays "File".  
3) Press “down arrow button” to move to "Message". 
4) Press "Enter".  
5) Braille Sense U2 QWERTY displays "Reply". 
6) Press "Enter" on "Reply". 
7) Braille Sense U2 QWERTY displays "Message body".  
8) The message body already contains the original message body of the 
received e-mail; "--- below Original Message ---. You can also execute the 
"Reply" command directly by pressing “Ctrl-r". 
9) Press "Shift-Tab" to move to "Subject", "BCC"", "CC", and "To".  
10) At "Subject", Braille Sense U2 QWERTY displays "Subject: Re: 
Welcome to HIMS". And, at "To", Braille Sense U2 QWERTY displays "To: 
hims@hims-inc.com". 
11) Press "Tab" to move to "Message body".  
12) Type the text you want to add or edit. 
13) Press "Ctrl-s” to send the e-mail. 
  
 
You can save replies just as you can save new messages in the "Outbox" for 
sending later. 
 
You can reply to an e-mail by using either "Reply" or "Reply To All", as 
Choosing "Reply" sends en e-mail to only the original sender. Choosing 
"Reply To All" sends an e-mail back to the original sender as well as all other 
recipients of the original e-mail.  
To activate the "Reply To All" function:  
 
1) Press “Alt” to open the menu.  
2) Braille Sense U2 QWERTY displays "File". 
3) Press “down arrow button”, to move to "Message". 
4) Press "Enter".  
5) Braille Sense U2 QWERTY displays "Reply". 
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6) Press “down arrow button”, to move to "Reply To All". 
7) Press "Enter" on "Reply To All". You can activate the "Reply To All" 
function directly by pressing "Alt-r". 
8) Braille Sense U2 QWERTY displays "To: (the original sender and all other 
original recipients)" 
9) You can use the same steps to send a message as when using the 
"Reply" function. 
 

8.3.3 Forwarding a Received E-Mail Message 
 
"Forwarding" refers to sending an e-mail you received to another person. 
You can also add to or edit the message and subject. You can also attach a 
file to this e-mail.  
  
Example: 
Let's suppose there is an e-mail message that you received as follows: 
Sender's e-mail address: hims@hims-inc.com 
Subject of the e-mail: Welcome to HIMS 
 
You can forward this e-mail to others using the following method: 
 
1) Press “Alt” to open the menu from the "Subject", "Date", or "Message 
body". 
2) Braille Sense U2 QWERTY displays "File". 
3) Press “down arrow button”, to move to "Message". 
4) Press "Enter" on "Message".  
5) Braille Sense U2 QWERTY displays "Reply". 
6) Press “down arrow button”, to move to "Forward". 
7) Press "Enter" on "Forward".  
8) Braille Sense U2 QWERTY displays "To:". You can activate the "Forward" 
command directly by pressing "Ctrl-f". Input the e-mail address of the new 
recipient, or multiple recipients, using computer Braille. 
9) Press "Tab", to move to "CC", "BCC", and "Subject".  
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10) At "Subject", Braille Sense U2 QWERTY displays "Subject: Fw: 
Welcome to HIMS". 
11) Press "Tab", to move to "Message body".  
12) The original e-mail message is shown following, "----- Forwarded 
Message -----". 
13) Type any additional text you wish to add to the message, or make any 
edits to the forwarded text.  
14) Press "Ctrl-s” to send the e-mail. 
 
When you forward an e-mail, you have all of the same capabilities as when 
writing a new e-mail. Thus, you can add recipients and attach files to the e-
mail you are forwarding just as with a new message. And, as with a new 
message, you can also save to the "Outbox" for sending later.  
 

8.3.4 Saving a Received E-mail as Document. 
 
There may be times when you wish to save a received message as a 
document. You can do this using the following steps: 
1) Press “Alt” to open the menu.  
2) Braille Sense U2 QWERTY displays "File". 
3) Press "Enter" on "File". 
4) Press “down arrow button”, to move to "Save As Text". 
5) Press "Enter" on "Save As Text".  
6) The "save as dialog" is opened. 
7) Braille Sense U2 QWERTY displays "File name: (subject of e-mail under 
readinggg.txt". You can open this dialog directly by pressing "Fn-s". 
8) Press "Enter" on the "File name: (subject of e-mail under readinggg.txt". 
Or press “Tab”, to move to the "Confirm" button, and press "Enter". If you 
wish, you can rename the file using the same method as in the "Save As" 
dialog of the "Word Processor". 
9) You are returned to your previous location.  
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The text file is saved in "flashdisk/My Documents" with the file name 
"(subject of e-mail under readinggg.txt". You cannot change the file format. 
You can read the saved text file in the "Word Processor". 
To cancel "Save As Text", press "Tab" from the "Confirm" button to move to 
"Cancel". And press "Enter". Or, press "Esc" or "Alt-F4". 
 

8.3.5 Printing E-Mail Messages 
 
You may wish to emboss or print an e-mail message. 
To print an e-mail message, do the following: 
 
1) Connect the Braille Sense U2 QWERTY to an ink printer. Make sure to 
use the same printer port set in the "Global Options". 
2) Press “Alt” to open the menu.  
3) Braille Sense U2 QWERTY displays "File". 
4) Press "Enter" on "File". 
5) Press “down arrow button”, to move to "Print E-mail". 
6) Press "Enter" on "Print E-mail".  
7) Braille Sense U2 QWERTY displays "Print type". Press "Alt-p" to activate 
the "print" function directly. 
8) Press "Space" or “down arrow button”, to change the "print type". The 
setting values are "Printer" and "Embosser". 
9) After selecting the "Print type", press "Enter". Or press "Tab”, to move to 
the "Confirm" button, and press "Enter". 
10) The selected e-mail is printed. 
To cancel printing, press "Tab" to move to "Cancel" and press "Enter". Or 
press "Esc" or "Alt-F4". 
 

8.4 Additional features of E-mail 
 

8.4.1 Find 
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The "Find" command is used to search for messages in the current mailbox. 
The "Find" function looks for text that matches the text you enter in "Subject", 
"Date", and/or "From". This function only works in the "Subject", "Date", or 
"From" controls. 
The "Find" dialog consists of the following: 
1. "Find": Edit box for text to search 
2. "Search" radio button 
3. "Direction" radio button  
4. "Confirm" button 
5. "Cancel" button.  
 
In the "Find" dialog, you can move among the five controls by pressing "Tab" 
or "Shift-Tab". The hot key for opening the "Find" dialog is "Ctrl-Shift-f ".  
 
To activate the "Find" function, use the following steps: 
1) Press “Alt” to open the menu.  
2) Braille Sense U2 QWERTY displays "File". 
3) Press “down arrow button”, to move to "Edit".  
4) Press "Enter" on "Edit". 
5) Braille Sense U2 QWERTY displays "Select All". 
6) Press “down arrow button” or “up arrow button”, to move to "Find".  
7) Press "Enter" on "Find". Or press "f".  
8) Braille Sense U2 QWERTY displays the "Find:" edit box for typing the text 
you want to search. 
9) After typing the text, press "Tab" to move to the "Search" radio button. 
You can select among "All", "Subject", "Date", or "From". Choosing "All" 
searches all three fields. You can select an item by pressing “down arrow 
button” or “up arrow button”. By selecting a field, you can search that specific 
field for the text you want to find. 
10) Press "Tab", to move to the "Direction" radio button, containing the 
values "Forward" or "Backward". Pressing “down arrow button” or “up arrow 
button” selects the search direction.  
11) Press "Tab", to move to the "Confirm" button.  
12) Press "Enter" on the "Confirm" button.  
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To cancel, press "Tab" on "Confirm", move to "Cancel". And press "Enter". 
Or, you can press "Alt-F4" or "Esc" anywhere in this dialog to cancel "Find". 
 

8.4.2 Find Again 
 
The "Find Again" command finds the next occurrence of the text according to 
the search text and direction specified in the "Find" dialog. As with "Find", the 
"Find Again" function only works in the "Subject", "Date", or "From" fields. 
To activate the "Find Again" function, use the following steps: 
 
1) Press "Alt" to open the menu. 
2) Braille Sense U2 QWERTY displays "File" 
3) Press “down arrow button”, to move to the "Edit" 
4) Press "Enter" on "Edit".  
5) Braille Sense U2 QWERTY displays "Select All". 
6) Press “up arrow button” or “down arrow button”, to move to "Find Again". 
7) Press "Enter" on "Find Again". Or press "g". 
 
To activate this function directly, press "F3". 
 

8.4.3 Move to Next Unread Message 
 
The "Move To Next Unread Message" option allows you to move to the next 
unread message. If you use this function on the last unread message in a list, 
you are sent to the first unread message in the list.  
 
To activate this function from the "Subject", "Date", or "From" field, 
1) Press “Alt” to open the menu.  
2) Braille Sense U2 QWERTY displays "File". 
3) Press “down arrow button”, to move to "Edit". 
4) Press "Enter" on "Edit". 
5) Braille Sense U2 QWERTY displays "Select all". 
6) Press “down arrow button”, to move to "Move to Next Unread Message". 
7) Press "Enter" on "Move to Next Unread Message". Or press "u”. 
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To use this function directly, press "Ctrl-u". 
 

8.4.4 Copy or Move to Mailbox 
 
You can copy or move an e-mail message to another folder or mailbox in 2 
ways: 
1. You can copy and move e-mails directly from "Mailbox" lists except 
"Outbox". 
 
To copy and/or move an e-mail to another folder, follow these steps: 
1) From a message list, press "Shift-Tab", to move to the "Mailbox" list. 
3) Press “up arrow button” or “down arrow button”, to move to the "Mailbox" 
containing the e-mail you want to copy or move. 
4) Press "Enter". 
5) Braille Sense U2 QWERTY displays the message list. 
6) Press “up arrow button” or “down arrow button”, to move to the e-mail you 
want to copy or move. Press "Space", "Ctrl-b” or "Ctrl-a", to select all or 
multiple messages.  
7) Press “Alt” to open the menu.  
8) Braille Sense U2 QWERTY displays "File". 
9) Press “down arrow button”, to move to "Edit". 
10) Press "Enter" on "Edit". 
11) Braille Sense U2 QWERTY displays "Select All". 
12) Press “down arrow button”, to move to "Copy" or "Move".  
13) Press "Enter". Or active these commands directly, by pressing "Ctrl-c" or 
"Ctrl-x".  
14) Press "Shift-Tab", to move to the "Mailbox" list. 
15) Press "Enter" on the "Mailbox" into which you want to paste the e-mail. 
16) Press “Alt” to open the menu. 
17) Braille Sense U2 QWERTY displays "File". 
18) Press “down arrow button”, to move to "Edit". 
19) Press "Enter" on "Edit". 
20) Braille Sense U2 QWERTY displays "Select All". 
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21) Press “down arrow button”, to "Paste" and press "Enter". Or activate this 
function directly, by pressing "Ctrl-v". 
22) The e-mail is copied or moved to mailbox. 
 
2. You can copy and move e-mails using the "Copy to Mailbox" or "Move To 
Mailbox" commands in the "Edit" menu. 
 
The "move/Copy dialog" contains the following: 
1. "Folder" list. 
2. "Create mailbox" Button 
3. "Delete mailbox" Button 
4. "Rename mailbox" Button 
5. "Confirm" Button 
6. "Cancel" Button 
 
You can move among the controls by pressing "Tab" or "Shift-Tab". And you 
can move among items in the "Folder" list by pressing “up arrow button” or 
“down arrow button”.  
To cancel these dialogs, press "Esc" or "Alt-F4". 
 
To copy and move an e-mail to another folder, follow these steps: 
1) You can select individual e-mails by pressing "Space", select a continuous 
group with “Ctrl-b”, or select all with "Ctrl-a”. Or you can select e-mail using 
the "Select All" or "Start Selection" options in the ""Edit" menu. 
2) Press “Alt” to open the menu. 
3) Braille Sense U2 QWERTY displays "File". 
4) Press “down arrow button”, to move to "Edit". 
5) Press "Enter" on "Edit". 
6) Braille Sense U2 QWERTY displays "Select All". 
 7) Press “down arrow button”, to move to "Copy to Mailbox" or "Move To 
Mailbox". 
8) Press "Enter" on "Copy to Mailbox" or "Move To Mailbox". 
9) Braille Sense U2 QWERTY displays "Folder list". You can active these 
functions directly by pressing "Alt-c" or "Alt-x”. 
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10) Press “down arrow button”, to move to the folder into which you want to 
copy or move messages.  
11) Press "Enter". 
12) The e-mail is moved or copied to the folder. 
13) You are returned to the mailbox from which you activated the "Move" or 
"Copy" command. 
 

8.4.4.1 Creating a Mailbox 
 
You can create additional mailboxes in the "E-mail" folder for sorting and 
storing your messages.  
To create a new mailbox, follow these steps: 
1) Press “Alt” to open the menu from the “Inbox" message list  
2) Braille Sense U2 QWERTY displays "File". 
3) Press “down arrow button”, to move to "Edit" and Press "Enter". Or Press 
"e”. 
4) Braille Sense U2 QWERTY displays "Select All". 
5) Press “up arrow button” or “down arrow button”, to move to "Copy to 
Mailbox" or "Move To Mailbox".  
6) Press "Enter". Or press "Alt-c" or "Alt-x”, to open this dialog directly from 
the message list. 
7) Braille Sense U2 QWERTY displays "Folder" lists. 
8) Press "Tab", to move to "Create mailbox". 
9) Press "Enter" on "Create mailbox". 
10) Braille Sense U2 QWERTY displays "Mailbox name:". Type the mailbox 
name you want to create. 
11) Press "Enter" or press "Tab”, to move to "Confirm" and press "Enter". 
12) Braille Sense U2 QWERTY displays the created mailbox in the "Folder" 
list. The folder is also visible in the "Mailbox" and in the e-mail folder from 
"File manager". 
 

8.4.4.2 Deleting Folder 
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You can't delete "Inbox", "Sent", and “Outbox". However, you can delete 
folders you have created. 
 
To delete a folder, follow these steps: 
1) Press “Alt” to open the menu from the message list of "Inbox". 
2) Braille Sense U2 QWERTY displays "File". 
3) Press “down arrow button”, move to "Edit" and Press "Enter". Or Press "e”. 
4) Braille Sense U2 QWERTY displays "Select All". 
5) Press “up arrow button” or “down arrow button”, to move to "Copy to 
Mailbox" or "Move To mailbox".  
6) Press "Enter". Or press "Alt-c" or "Alt-x”, to activate these commands 
directly. 
7) Braille Sense U2 QWERTY displays the "Folder" list. 
8) Press “up arrow button” or “down arrow button”, to move to the folder you 
want to delete. 
9) Press "Tab”, to move to "Delete mailbox". 
10) Press "Enter". 
11) Braille Sense U2 QWERTY displays "Delete (mailbox name) mailbox? 
Yes". 
12) Press "Enter". 
 
You can also delete the current mailbox by pressing "Del" on the folder you 
want to delete.  
To cancel this function, press "Tab” on "Confirm", to move to "Cancel". And 
press "Enter". 
If you attempt to delete the "Inbox", "Sent", or "Outbox", Braille Sense U2 
QWERTY plays the warning sound to notify you of the error. 
 

8.4.4.3 Changing Folder Mailbox 
 
You can also rename a mailbox. To do this, follow these steps: 
 
1) Open the "Move/Copy to Mailbox" dialog as described in the steps above. 
2) Braille Sense U2 QWERTY displays the "Folder" list. 
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3) Press “up arrow button” or “down arrow button”, to move to the folder you 
want to rename. 
4) Press "Tab”, to move to "Rename mailbox". 
5) Press "Enter". 
6) Braille Sense U2 QWERTY displays "Folder mailbox:" 
7) Type the new name for the folder mailbox.  
8) Press "Enter. Or press "Tab”  to move to "Confirm" and press "Enter". 
If you attempt to rename the "Inbox", "Sent", or "Outbox", the Braille Sense 
U2 QWERTY plays the warning sound to notify you of the error. 
 

8.5 Using the Tools Menu 
 
IN addition to the "Accounts Manager", the "Tools" menu contains options for 
setting path e-mail options.  
 
The "Tools" menu contains the following four items: 
1. Accounts Manager 
2. Set path 
3. Set options 
4. Set spam 
 
The "Accounts Manager" was explained at the beginning of this chapter. The 
other items are explained in detail below: 
 
 

8.5.1 Set Path 
 
"Set Path" sets the default download path where file attachments and e-mail 
are stored. You can set the download path using the following steps: 
 
1) Press “Alt” to open the "E-mail" menu from the "Inbox". 
2) Press “down arrow button”, to move to "Tools". 
3) Press "Enter".  
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4) Braille Sense U2 QWERTY displays "Accounts manager". 
5) Press “down arrow button”, to move to "Set Path". 
6) Press "Enter" on "Set Path".  
7) Braille Sense U2 QWERTY displays "Save attachments path: 
/flashdisk/download". You can open this dialog directly by pressing "Ctrl-p".  
 
"Set Path" contains the following three items: 
1. Save attachments path 
2. Send attachments path 
3. Disk to save mail in 
 
You can move among these items by pressing “down arrow button” and “up 
arrow button”. Each item consists of "Path", "Modify", and "Close". At "Path", 
the default path is displayed. You can move among this information by 
pressing “Tab” or "shift-tab". 
"Set Path" is closed if you press "Esc" or "Alt-F4". Or, you can close it by 
pressing enter on the "Close" button. 
 

8.5.1.1 Set the Save Attachments Path 
 
The default path for downloaded attached files is "/flashdisk/download".  
You can set the download path using the following method: 
 
1) Use the steps described above to access the "Save Path" dialog. 
2) Press "Enter" on "Save attachments path: /flashdisk/download", or press 
"m". Or, press "Tab” " to move to the "Modify" button, and press "Enter". 
3) Braille Sense U2 QWERTY displays "download folder xx/yy". 
Use normal file and folder navigation keys to locate the folder in which you 
want to save attachments. 
4) Press "Space" to select the folder, and press "Enter". If a folder is selected, 
* is displayed in front of the selected folder. 
If you press "Enter" to set the path, the Braille Sense U2 QWERTY shows 
the changed path. For example, if you changed the path to the "My 
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Documents" folder, "Save attachments path: /flashdisk/My Documents" is 
displayed. 
 

8.5.1.2 Set the Send Attachments Path 
 
"Send attachments path" is the path where the e-mail program looks by 
default when you attach a file to an e-mail.  The default path is 
"/flashdisk/upload". You can change this path to a different path using the 
following steps: 
 
1) Open the "Set Path" dialog using the steps described above. 
2) Press “down arrow button”, to move to "Send attachments path: 
/flashdisk/upload". 
3) Press "Enter" or "m" on "Send attachments path: /flashdisk/upload". Or, 
press "Tab", to move to the "Modify" button and press "Enter". 
4) Braille Sense U2 QWERTY displays "upload folder xx/yy" Use normal file 
and folder navigation keys to locate the folder you want to use as the path 
for attachments to be sent.  
5) Press "Space" to select the desired folder, and press "Enter".  
6) Braille Sense U2 QWERTY displays * in front of the selected folder. 
 
If you set the path by pressing "Enter", the Braille Sense U2 QWERTY 
shows the changed path.  
 

8.5.1.3 Set the Disk to save mail 
 
The e-mail messages that are downloaded from your network are saved in 
the "e-mail" folder, located on the "flashdisk". If the size of an e-mail you are 
receiving is so large that it cannot be downloaded and stored in the 
"flashdisk", or you simply want to store your e-mail somewhere else, you can 
save to a different disk using the following steps: 
 
1) Connect the external storage disc to the Braille Sense U2 QWERTY. 
2) Use the steps described above to open the "Set Path" dialog. 
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3) Press “down arrow button”, to move to "Disk to save mail in: /flashdisk". 
4) Press "Enter" or "m" on "Disk to save mail in: /flashdisk". Or, press "Tab", 
to move to the "Modify" button, and press "Enter". 
5) Braille Sense U2 QWERTY displays "flashdisk".  
6) Press “down arrow button” or “up arrow button”, to move through the disk 
list. If you have connected a USB memory stick or SD memory, Braille Sense 
U2 QWERTY displays "USB" or "SD" (SD memory). 
7) Press "Enter" on the desired disk.  
Braille Sense U2 QWERTY displays the changed disk. 
 

8.5.2 Set Options 
 
In "Set Options", you can set whether the "Inbox" is the default folder when 
the "E-mail program is started. This means each time the e-mail program is 
opened, the "Inbox" is displayed. By default this is set to "On".  
To change this option, follow these steps: 
1) Press “Alt” to open the "E-mail" menu from the "Inbox". 
2) Press “down arrow button”, to move to "Tools". 
3) Press "Enter".  
4) Braille Sense U2 QWERTY displays "Accounts manager". 
5) Press “down arrow button”, to move to "Set Options". 
6) Press "Enter" on "Set Options". Or activate this command directly, by 
pressing "Ctrl-o”. 
7) Braille Sense U2 QWERTY displays "Use inbox as default mailbox when 
starting: Yes". If you don't wish to use the "Inbox" as the default mailbox, 
press "Space".  
8) Press "Enter".  
To cancel this function, press "Esc or "Alt-F4. 
 

8.5.3 Spam Settings 
 
When the Braille Sense U2 QWERTY downloads e-mail from the e-mail 
server, there may be a number of e-mail messages that are spam. In this 
case, you can avoid downloading these spam e-mail messages by 
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identifying specified words in the subject or specifying e-mail addresses you 
know are from spammers. 
The spam e-mail messages that are identified by your "Spam Settings" are 
not downloaded into the Braille Sense U2 QWERTY, and remain on the e-
mail server. 
Use the following steps to set spam e-mail filters: 
 
1) Press “Alt” to open the menu from the "Inbox". 
2) Press “down arrow button”, to move to "Tools". 
3) Press "Enter".  
4) Braille Sense U2 QWERTY displays "Accounts manager". 
5) Press “down arrow button”, to move to ""Spam Settings". 
6) Press "Enter".  
7) Braille Sense U2 QWERTY displays "Type: Subject 1/3". You can also 
open this dialog directly by pressing "Ctrl-e". 
 
The "Spam Settings" dialog contains the following 6 items; 
 
1. Type 
2. List 
3. Add 
4. Modify 
5. Delete 
6. Close 
 
You can move among the items by pressing "Tab" or "Shift-Tab".  
To exit "Spam Settings", move to the "Close" button and press "enter", or 
press "Esc" or "Alt-F4".  
"Type" can be set to 1 of 3 options: "Subject", "E-mail address string", and 
"Host". You can move among these options by pressing “up arrow button” or 
“down arrow button”. The "list" is displayed in a different form according to 
the "Type" you choose. 
If you have selected "Subject", the list is displayed as "Subject: (Registered 
word) 1/xx". If you selected "E-mail address string", it is displayed as "E-mail 
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address string: (Registered e-mail address string) 1/xx". It is displayed as "no 
items" if there is no registered word or e-mail address string. 
The following explains how to register, modify, and delete the spam settings. 
 

8.5.3.1 Add As Spam E-Mail 
 
1) Use the steps described above to open the "Spam Settings" dialog.  
2) Press "a" when "Type: Subject 1/3" is displayed. Or, press "Tab" to move 
to the "Add" button, and press "enter". 
3) The "add dialog" is opened and "Subject add:" is displayed. 
4) Type the words, by which you want to identify spam messages and press 
"Enter". Or, press "Tab" to move to the "Confirm" button, and press "enter".  
5) "Successfully added spam data" is announced and you are returned to the 
"list". "Subject: (registered word) 1/1" is displayed. 
 
If there is more than one registered word, you can move among them by 
pressing “up arrow button” or “down arrow button”. 
By adding the word as explained above, if there are any e-mail messages 
that include the words you entered in the subject of the message, the Braille 
Sense U2 QWERTY downloads those e-mails from the e-mail server, but 
deletes them automatically.  
You can also avoid receiving e-mail messages from a specific sender or host 
by registering it. 
The following are the steps to register a sender's e-mail address as spam: 
 
1) Use the steps described above to open the "Spam Settings" dialog. 
2) Press “down arrow button” when "Type: Subject 1/3" is displayed. "Type: 
E-mail address string 2/3" is displayed. 
3) Press "a" or press “Tab” to move to the "Add" button, and press "enter". 
4) The "Add dialog" is opened, and "E-mail address string: (e-mail address)" 
is displayed. The "(e-mail address)" is the sender's e-mail address that was 
focused when you opened the dialog. You can choose to filter by this 
address, or type a different e-mail address in the edit box. 
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5) Press "Enter" on "E-mail address string: (e-mail address)". Or, press "Tab" 
to move to the "Confirm" button, and press "Enter". 
6) "Successfully added spam data" is announced and "E-mail address string: 
(Registered e-mail address) 1/1" is displayed. 
 
When "E-mail address string: (registered e-mail address) 1/1" is displayed, 
you can add another address by pressing "a" or pressing "Tab" to move to 
the "Add" button,  and press "Enter". You can check the registered e-mail 
addresses by pressing “up arrow button” or “down arrow button”. 
To register a specific host as a spam sender, do the following: 
 
1) Use the steps described above to open the "Spam Settings" dialog. 
2) Press “down arrow button” when "Type: Subject 1/3" is displayed to move 
to "Type: Host 3/3". 
3) Press "a" on "Type: Host 3/3", or press "Tab" to move to the "Add" button, 
and press "Enter". 
4) The "Add dialog" is opened, and "Host add: (host address)" is displayed. 
By default, "host address" is the host address that was focused on when you 
executed this command. You can add this host or type a different host in the 
edit box. 
5) Press "Enter" on "Host add: (host address)". Or, press “Tab” to move to 
the "Confirm" button, and press "enter". 
6) The Braille Sense U2 QWERTY says, "Successfully added spam data" 
and shows "Host: (registered host address) 1/1". 
 
When "Host: (registered host address) 1/1" is displayed, you can add 
another host by pressing "a" or pressing "Tab" to move to the "Add" button, 
and press "Enter". You can check the registered host addresses by pressing 
“up arrow button” or “down arrow button”. 
 
To cancel setting spam filters from the "Add dialog", press "Tab" to move to 
the "Cancel" button, and press "Enter". Or, press "Esc" or "Alt-F4". 
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8.5.3.2 Modifying Spam Registration 
 
To modify a spam filter you have set, do the following: 
1) Access the "Spam Settings" dialog as described previously, and navigate 
to the "Type" of spam setting you want to modify by pressing “up arrow 
button” or “down arrow button”.  
2) Press "Tab" to move to the list of registered items in that category.  
3) Navigate to the item you want to modify using “up arrow button” or “down 
arrow button”.  
4) Press "m" or press "Tab" to move to the "Modify" button, and press 
"Enter".  
5) Make the modifications in the edit box. 
6) Press “Tab” to move to the "confirm" button, and press "Enter" to save the 
changes.   
 

8.5.3.3 Deleting Spam 
 
You can also delete an item that has been registered in the spam list.  
1) Access the "Spam Settings" dialog as described previously, and navigate 
to the "Type" of spam setting you want to delete by pressing “up arrow 
button” or “down arrow button”.  
2) Press "Tab" to move to the list of registered items in that category.  
3) Navigate to the item you want to delete using “up arrow button” or “down 
arrow button”.  
4) Press "d" or press "Tab" to move to the "Delete" button, and press "Enter".  
 

8.6. Hot Keys for E-Mail 
 

8.6.1 Hot Keys That Are Used in the Inbox 
 
Call "accounts manager": Ctrl-m 
Check for New Mail: Alt-m 
Write New Message: Ctrl-n 
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Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Open "set path": Ctrl-p 
Open "set option": Ctrl-o  
Open "set spam": Ctrl-e  
Find: Ctrl-shift-f (Only while in a message) 
Find again: F3 (Only while in a message) 
Move to next unread message: Ctrl-u 
Move to mailbox: Alt-x 
Copy to Mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (This is valid only at the "from" item of 
the "Inbox"). 
Delete received e-mail: Del (It is valid only at the "Subject" and "date" item in 
the "Inbox"). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Cancel: Esc 
Cancel and exit from e-mail program: Alt-F4 
 

8.6.2 Hot Keys for Sending E-Mail Including Reply, Forward, 
and Save in the Mail Outbox 

 
Search address list: Ctrl-l 
Attach file: Ctrl-f  
Send e-mail: Ctrl-s 
Save in mail outbox: Alt-s 
Cancel: Esc 
Cancel and exit from e-mail program: Alt-F4 
 

8.6.3 Hot Keys for Reading E-Mail Messages or Writing an E-
mail Message 
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Start selection: Ctrl-b 
Select all: Ctrl-a 
Copy to the clipboard: Ctrl-c  
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in the 
"Inbox"). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-mail in 
the "Inbox") 
Delete:Del (It is not valid when you are reading e-mail in the "Inbox") 
Cancel block: Esc 
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9. Media Player 
 
The Media Player on the Braille Sense U2 QWERTY is a program you can 
use to play audio files as well as listen to the audio for some video file 
formats. The Media Player plays the following formats, ac3, asf, asx, m3u, 
mp2, mp3, MP 4, mpa, mpg, ogg, pls, wav, wax, wma, flac, midi and wmv. 
Note: you cannot see the video for "avi" and "wmv" files, however, you may 
listen to the audio contained in these formats. 
You can control the playing of audio files using either Braille keyboard 
commands or the media buttons on the front panel of the Braille Sense U2 
QWERTY. The Media Player can play back audio recordings and books as 
well as music files. 
 

9.1 Using the media buttons 
 
Near the center of the front panel on the Braille Sense U2 QWERTY is a 
group of 5 buttons with varying shapes. These buttons can be used to 
control the Media Player. Moving from left to right, the buttons are: "Back", 
"Record", "Stop", "Play/Pause", and "Forward". These buttons are used for 
playing and recording music or voice quickly and easily. 
The media buttons can control media playback, DAISY content playback, or 
FM radio operation, depending on the position of the Media Mode switch, 
located to the left of the media buttons. Slide this switch to the right-most 
position, "Media Mode", to control media playback.  
 
If the "Play/Pause" button is pressed while you are using another program on 
the Braille Sense U2 QWERTY, the unit opens the Media Player and begins 
playing the files in the most recently played  list. If there are no files in the 
playlist, the Braille Sense U2 QWERTY says, "There are no items to display". 
"Back", "Stop", and "Forward" are available after audio playback is started.  
Note: As the Braille Sense U2 QWERTY is able to multi-task, initiating audio 
playback with the "Play/Pause" button does not close the program you were 
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running when you pressed it. To return to your former position, press "F2-F3" 
to cycle through the running programs until you reach your former location.  
 

9.1.1 Play/Pause Button 
 
The "Play/Pause" button has a long, rectangular shape. It is the second 
button from the right in the group of media buttons. As explained above, 
pressing the "Play/Pause" button starts playback of the files in the most 
recently played media playlist. A playlist can contain only 1 file, or many files. 
If there is more than one file in the playlist when you press the "Play/Pause" 
button, the Braille Sense U2 QWERTY plays all the files in the list one after 
another. If you press the "Play/Pause" button during playback, audio 
playback is paused. To resume playing, press the button again. If you press 
the "Play/Pause" button while you are in the "Record" dialog, the most 
recently recorded file is played.  
 

9.1.2 "Forward" button and "Back" button 
 
Both of these buttons have a triangular shape. The "Back" button is the left-
most button in the media group and is pointed to the left. The "Forward" 
button is the right-most button in the media group and is pointed to the right. 
If you press the "Forward" button, the next file in the playlist is played, and 
pressing the "Back" button plays the previous file. If you press one of these 
buttons while an audio file is playing, the Braille Sense U2 QWERTY stops 
playing the current file, and jumps to the previous or next file (depending on 
which button you press) and starts playing it. If you press the "Forward" 
button (while the last file in the list is playing, (or the "Back" button (while the 
first file in the list is playing), it has no effect, as there is no file to navigate to.   
 

9.1.3 Record Button 
 
The "Record" button has a circular shape, and is used to record sound using 
the built-in or an external microphone. The "Record" button is located directly 
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to the right of the "Back" button. You can use this button to create a 
recording from anywhere on the unit provided the Media Mode switch is set 
to the right-most position. Pressing the "Record" button once opens the 
"Record" dialog. Press the "Record" button again to start recording. Press 
the "Record" button while you are recording to pause recording. Resume 
recording by pressing the "Record" button one more time. Press the "Stop" 
button, directly to the right of the "Record" button, to stop and save your 
recording. The recorded file is saved in the "flashdisk/media/record" folder.  
 

9.1.4 Stop Button 
 
The "Stop" button has a square shape and a dot on it, and is used to stop 
playback or recording.   If you press "Stop" during audio playback, the next 
time media playback is launched, the Braille Sense U2 QWERTY starts 
playing the first file in the playlist. If you press this button while recording, the 
Braille Sense U2 QWERTY stops and saves the recording. If you press the 
"Stop" button in the "Record" dialog when not recording, the dialog closes. 
 

9.1.5 Using the media buttons in Open File dialog 
 
Press and hold the "Stop" button to open the "Open File" dialog from within 
the "Media Playback" dialog. Press and hold "Stop" again to close the "Open 
File" dialog and return to the "Media Playback" dialog. 
In the "Open File" dialog, the "Play/Pause" button functions the same as 
"Enter". The "Stop" button, "Record" button, "Back" button and "Forward" 
button function the same as "Backspace", "Space", “up arrow button” and 
“down arrow button” respectively. 
Namely, you can navigate up and down by pressing the "Back" and 
"Forward" buttons in a file list; and you can select and unselect items by 
pressing the "Record" button. Press the "Stop" button to move back a level in 
the folder structure. And press "Play/Pause" button to play the selected files.  
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9.2 Braille Keyboard and Extended Keys 
 
You can use the Braille keyboard to perform the same functions as the 
media buttons as well as more advanced features in the Media Player. To 
open the "Media Playback", press "Enter" on "Media Playback", or press m 
from the Braille Sense U2 QWERTY "program" menu. As explained 
previously, you can also open the Media Player by pressing "Play-Pause" 
when the "Media Mode" switch is set to the right-most position. 
The "Media Playback" dialog contains two information tabs: "playback 
information" and "playlist". Press “Tab” or "Shift-Tab" to move between these 
tabs. 
 

9.2.1 Playback Information Tab 
 
The "playback information" tab displays the track number, the file name, and 
the current playback status: (play, pause, or stop). If there are no files in the 
playlist, the Braille Sense U2 QWERTY displays "Title: There are no items to 
display". If you press “down arrow button”, the Braille Sense U2 QWERTY 
displays playback time information.  
First, the elapsed or remaining time is displayed. You can set whether the 
elapsed time or remaining time is displayed, using the "playback settings" 
dialog. If you have selected the "Remaining time" with this option, the - 
(minus sign), is displayed before the time. Next to the elapsed/remaining 
time, the Braille Sense U2 QWERTY displays the total playback time of the 
currently selected file. 
If there are no files in the playlist, "Time: There are no items to display" is 
displayed. 
 

9.2.2 Playlist Tab 
 
The "playlist" tab displays all the files in the playlist. For each file in the 
playlist, it displays the track number, file name, the location of the file in the 
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list, and the total number of files in the list. If there is no file in the playlist, the 
Braille Sense U2 QWERTY displays the message "no items". 
For example, if you had the following track on the Braille Sense U2 
QWERTY: "Track 1 Chopin - Fantasie Impromptu 1/10", "Track 1" indicates 
this file is the first item in the playlist. "Chopin - Fantasie Impromptu" is the 
file name. "1/10" indicates this file is the first of ten files in the playlist.  
 

9.2.3 Hot Keys in the Playback Information and playlist Tabs 
 
The hot keys that can be used in the "playback information" and the "playlist" 
tabs are as follows: 
 

1) Hot keys in the Play Information Tab 
 

Hot key Function 
Down arrow key Move to the next information 
Up arrow key Move to the previous 

information 
Space “Pause” when it is play state 

and “play” when it is pause 
state. 

Enter or x Start playing 
Backspace or c Stop playing 
Alt-Right arrow key or z Play the next file 
Alt-Left arrow key or b Play the previous file 
Ctrl-Fn-Right arrow key Play the last file 
Ctrl-Fn-Left arrow key Play the first file 
Alt-Down arrow key Play the fifth file after the 

current file 
Alt-Up arrow key Play the fifth file before the 

current file 
Ctrl-Right arrow key Move to next position by time 

index and play 
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Ctrl-Left arrow key Move to previous position by 
time index and play 

Ctrl-Up arrow key or Ctrl-
Down arrow key 

Change time index 

Shift-Left arrow key Speed up 
Shift-Right arrow key Slow down 
Shift-Up arrow key Volume up 
Shift-Down arrow key Volume down 
Alt Open menu 
F1 Open help 
Tab/Shift-tab  Move to “play list” tab 
Alt-F4 Exit “Media player” 
 
 

2) Hot Keys in the Play List Tab 
 

Hot key Function 
Down arrow key Move to the next file 
Up arrow key Move to the previous file 
Fn-Right arrow key Move to the last file 
Fn-Left arrow key Move to the first file 
Space Select/resume current file 

(while playing, it is used as 
play/pause) 

Ctrl-b Start selecting files 
Enter Start playing the selected files 
Backspace Stop playing 
Del Delete the selected files in the 

play list 
Alt-Right arrow key Play the next file 
Alt-Left arrow key Play the previous file 
Ctrl-Fn-Right arrow key Play the last file 
Ctrl-Fn-Left arrow key Play the first file 
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Ctrl-Down arrow key Play the fifth file after the 
current file 

Ctrl-Up arrow key Play the fifth file before the 
current file 

Ctrl-Right arrow key Move to next position by time 
index and play 

Ctrl-Left arrow key Move to previous position by 
time index and play 

Ctrl-Up arrow key Change time index 
Shift-Left arrow key Speed up 
Shift-Right arrow key Slow down 
Shift-Up arrow key Volume up 
Shift-Down arrow key Volume down 
Alt or F10 Open menu 
F1 Open help 
Tab/Shift-tab Move to “playback information” 

tab 
Alt-F4 Exit “Media player” 

 
 

9.3 How to Use the Media Player Menu 
 
To open the "Media Playback" menu, press “Alt” while in the "Media 
Playback" dialog. This menu contains five items: "File", "Play", "Record", 
"Position", "Mark" and "Settings". The "File" menu allows you to add or 
delete files in the playlist. The "Play" menu lists all of the commands related 
to playing files. The "Record" menu opens the "Record" dialog which allows 
you to record sound and play it. The "Position" menu contains commands 
related to bookmark and go to position. The "Settings" menu allows you to 
set various Media Player options. 
 

9.3.1 File 
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To use the "File" menu, press “Alt” to open the "Media Playback" menu, then 
press "Enter" on "File", or press "f". A submenu appears, containing "Open 
File", "Open Folder", "Add File", "Add Folder", "Save Playlist", "Save As 
Playlist", "Delete Item", "Open URL" and "Exit". You can move between 
these items by pressing “down arrow button” or “up arrow button”. Press 
"Enter" on the item you want to execute. To return to the Media Player menu, 
press "Esc". To exit the menu, press, "Alt-F4" and you are returned to the 
"Media Playback" dialog. 
 

9.3.1.1 Open File 
 
You can use the "Open File" menu item to add files to the playlist and start 
playing them. If you press "Enter" on "Open File", a dialog opens, similar to 
the "file list" in the "File Manager". You can navigate folders and files just as 
you would in the "File Manager". The files playable in the "Media Playback" 
are those with the extensions, ac3, asf, asx, m3u, mp2, mp3, ogg, pls, wav, 
wax, wma, flac, midi and wmv.  
If you select all the files you want to play, and press "Enter", the Braille 
Sense U2 QWERTY adds the files to the playlist, and starts playing the first 
file. You can select more than one file in the "Open File" dialog by pressing 
"Space" on each of the items you want to add to the playlist. When you have 
selected all the files you want, press "Enter".  
When you open the "Open File" dialog, files in the default folder are 
displayed. The default folder is set to "/flashdisk/media". You can also open 
the "Open File" dialog by using the hot key, “Ctrl-o” directly from the "Media 
Playback" dialog. 
 

9.3.1.2 Open Folder 
 
The "Open Folder" menu item is used to add all of the audio files in the 
selected folders to the playlist. If you press "Enter" on "Open Folder" in "File" 
menu, or press "Ctrl-f" in the "Media Playback" dialog, the "Open Folder" 
dialog is opened. The "Open Folder" dialog is almost the same as the "Open 
File" dialog. The difference is that only folder names which are displayed in 
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the "Open Folder" dialog. When you open the "Open Folder" dialog, the 
default folder name is displayed. The default folder is set to "flashdisk". 
Press "Enter" to display all of the folders in "flashdisk", and press “up arrow 
button” or “down arrow button” to move among the folders. To enter the 
folder under your cursor, (and list any sub-folders contained there) press 
"Enter" on it. Press "Backspace" to move back to the parent folder. To select 
a folder, press "Space" on the folder name. You can select more than one 
folder. Once you have selected all of the folders you want, press "Enter". The 
Braille Sense U2 QWERTY adds all of the supported audio files from the 
selected folders to the playlist and starts playing the first file. 
 

9.3.1.3 Add File 
 
The "Add File" menu item is used to add audio files to the currently playing 
list. If you press "Enter" on "Add File" in the "File" menu, or press "Alt-o" in 
the "Media Playback" dialog, the same dialog that is used for "Open File" is 
displayed. Select all of the files that you want, and press "Enter" (as in the 
"Open File" dialog). The Braille Sense U2 QWERTY adds the selected files 
to the playlist. However the Braille Sense U2 QWERTY does not start 
playing these files. To start playing the files in the playlist, press the 
"Play/Pause" button on the front panel. Or, you can press "Enter" on "play" in 
the "play" menu. A detailed explanation of the "play" menu can be found in 
section 9.3.2. 
 

9.3.1.4 Add Folder 
 
The "Add Folder" menu item is used to add all of the audio files in a selected 
folder to the currently playing list. If you press "Enter" on "Add Folder" in the 
"File" menu (or press "F3" in the "Media Playback" dialog), the same dialog 
that is used for "Open Folder" is displayed. If you select all of the folders you 
want to add, and press "Enter", the Braille Sense U2 QWERTY adds all of 
the supported audio files in the selected folders to the playlist. However, it 
does not start playing the files. You can start playing the files in the playlist 
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by pressing the "Play/Pause" button on the front panel of the Braille Sense 
U2 QWERTY, or press "Enter" on "play" in the "play" menu.  
 

9.3.1.5 Save playlist 
 
The "Save Playlist" menu item is used to save the playlist to a disk drive. To 
access this function, you can press “Alt” to open the "File" menu and execute 
the "Save Playlist" command by pressing "Enter" on it. Or, you can press "s" 
to quickly jump to and execute it from within the menu. You can also press 
"Ctrl-s" from the "Media Playback" dialog. 
If you are saving files to a new playlist, the "Save as playlist" dialog opens.  
If you execute "Save Playlist" after adding files to an existing playlist, the 
Braille Sense U2 QWERTY saves the playlist with the same file name 
without opening the dialog. After saving the playlist, it returns to the "Media 
Playback" dialog. 
 

9.3.1.6 Save as playlist 
 
The "Save As Playlist" menu item is used to save the playlist under a 
different name or in a different location. Press “Alt” to open the "File" menu 
and execute the "Save As Playlist" command by pressing "Enter" on it; or 
you can press "l" to access it quickly. You can also press "Alt-s" from the 
"Media Playback" dialog.  
If you execute "Save As Playlist", the "Save As Playlist" dialog is displayed. 
This dialog consists of "file list", "File name", a "Confirm" button, and a 
"Cancel" button. When the dialog is opened, "File name:" is displayed. You 
can move among the tabs by pressing “Tab” or "shift-tab". The file format of 
playlists saved by the Braille Sense U2 QWERTY is always "m3u". By 
default, playlist files are saved in "/flashdisk/media". 
To create a new file name, type in the new file name. You cannot use the 
following characters in a file mane. "|, \, <, >, ?, :, *". 
To change the location, move to the "file list" by pressing "shift-tab". 
Navigate to the location in which you want to save the playlist, and press 
"Enter". 
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9.3.1.7 Delete Item 
 
To delete a file from the playlist, first, locate the file you want to delete in the 
"playlist" tab by pressing “up arrow button” or “down arrow button” repeatedly. 
Then, open the "Media Player" menu by pressing “Alt”, and press "Enter" on 
"File". Navigate to "Delete Item" by pressing “down arrow button” repeatedly, 
and press "Enter". Or, you can press "Del" on the file you want to delete from 
the playlist. You can select more than one file in the "playlist" tab by pressing 
"Space" on each file to be deleted. * is displayed before each selected item. 
If you press "Space" on a selected item, the selection is canceled and the / 
disappears.  
You can also delete multiple files in a block from the playlist. Press “Ctrl-b” 
on the first file to be deleted. “Ctrl-b” indicates the start of the block. Next, if 
you press “down arrow button” or “up arrow button”, the displayed files are 
selected. After selecting the files you want to delete, press "Del" to delete 
them. 
 

9.3.1.8 Open URL 
 
The "Open URL" menu item is used to play the audio stream from a web 
page. If you press "Enter" on "Open URL" in the "File" menu, or press "Ctrl-i" 
in the "Media Playback" dialog, the "Open URL" dialog is displayed. In this 
dialog, type the web address of an audio stream and press "Enter". The 
Braille Sense U2 QWERTY automatically accesses the audio stream from 
the Internet and begins playing it.  
Note: Please make sure to have an active Internet connection before 
attempting to open an audio stream. 
 

9.3.1.9 Exit 
 
You can exit the "Media Player" by selecting "Exit" in the "File" menu, or by 
pressing "Alt-F4" in the "Media Playback" dialog. The Braille Sense U2 
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QWERTY stops playing (if it is playing a file), and exits to the "program" 
menu. 
 

9.3.2 Play 
 
The "Play" submenu contains all of the commands that can be used to 
control playback. To access this menu, press “Alt” to open the "Media 
Player" menu. Press “down arrow button”. The Braille Sense U2 QWERTY 
displays "Play (p)->". Press "Enter", and the "Play" submenu is displayed. 
You can move among the items in this menu by pressing “down arrow 
button” or “up arrow button”. To return to the "Media Player" menu, press 
"Esc". Press "Alt-F4" To close the menu and return to the "Media Playback" 
dialog.  
 

9.3.2.1 Play 
 
If you press "Enter" on "Play", the Braille Sense U2 QWERTY begins playing 
the files in the current playlist. You can also start playback from the "Media 
Playback" dialog by pressing Space". 
 

9.3.2.2 Previous Track 
 
"Previous Track" is used to play the previous file in a playlist.  You can also 
do this by pressing “z” or “Alt-Left arrow key” in the “Media player” dialog box. 
 

9.3.2.3 Next Track 
 
This item is used to play the next file in the playlist. You can also press “b” or 
“Alt-Right arrow key” in the “Media player” dialog box to do this. 
 

9.3.2.4 Back 5 Tracks 
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Use this command to play the fifth file before the file that is currently playing. 
You can also press “Alt-Up arrow key” in the “Media player” dialog box to do 
this. 
 

9.3.2.5 Forward 5 Tracks 
 
Use this command to play the fifth file after the file that is currently playing. 
You can also do this by pressing “Alt-Down arrow key” in the “Media player” 
dialog box. 
 

9.3.2.6 First Track 
 
Use this command to play the first file in the playlist. You can also do this by 
pressing “Ctrl-Fn-Left arrow key” in the “Media player” dialog box. 
 

9.3.2.7 Last Track  
 
Use this command to play the last file in the playlist. You can also do this by 
pressing “Ctrl-Fn-Right arrow key” in the “Media player” dialog box. 
 

9.3.2.8 Volume Up and Volume Down 
 
These options are used to adjust the audio playback volume. Here, the 
volume level ranges from 0 to 10. You can also adjust the volume level by 
pressing “Shift-Up arrow key (up)” or “Shift-Down arrow key (down)” in the 
“Media player” dialog box. The actual volume level depends on the value of 
“voice volume” that is set in the “global options”. For example, if “voice 
volume” is set to 5, and the volume level in the “Media player” is set to its 
maximum 10, the actual volume is 5. If the volume level in the “Media player” 
is set to 5, the actual volume level is 2.5. 
 

9.3.2.9 Speed Up and Slow Down 
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You can use these controls to adjust the audio playback speed. The speed 
level ranges from 1 to 10. You can also adjust the speed level by pressing 
“Shift-Left arrow key” or “Shift -Right arrow key” in the “Media player” dialog 
box. “Shift -Right arrow key” can increase the audio playback speed, and 
“Shift-Left arrow key” can decrease the audio playback speed. 
 

9.3.2.10 Pause 
 
This item pauses playback of a file. If you activate this command again, the 
Braille Sense U2 QWERTY starts playing again from the position where the 
file was paused. You can also do this by pressing "Space" in the "Media 
Playback" dialog.  
 

9.3.2.11 Stop 
 
This command stops playback of the currently playing file. You can also do 
this by pressing “c” or “Backspace” in the “Media player” dialog box. 
 

9.3.3 Record 
 
This menu item is used to open the "Record" dialog. To open the "Record" 
dialog, press “Alt” to open the "Media Player" menu. Press “down arrow 
button” twice to move to "record (r)", and press "Enter". Or you can press "r" 
from the Media Player Menu. The Braille Sense U2 QWERTY displays the 
"Record" dialog. You can also open this dialog by pressing "Ctrl-r" from the 
"Media Playback" dialog.  
The "Record" dialog contains an "information" tab and five buttons. You can 
move among these by pressing “Tab” or “Shift-Tab”. Activate the buttons in 
this dialog by pressing "Enter" on the button you want to use. You can also 
activate the buttons by typing the character displayed after the button name. 
 

9.3.3.1 Record/Playback Information Tab 
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This tab is displayed only when the Braille Sense U2 QWERTY is recording, 
or when there is a file that has just been recorded.  The information 
displayed in this tab includes: the file name, the current status, and two 
pieces of time information. The file name is the name of the file containing 
the sound that is currently being recorded or played. The current status is 
one of the following: recording, playing, pause, or stop. The time information 
that is displayed first is the elapsed recording time and the elapsed or 
remaining time while playing, (depending on the "Display time" setting in the 
"Playback Settings" dialog, explained in section 9.3.6.2). The final piece of 
time information during recording is the available recording time according to 
the space available on your flashdisk. While playing, the total length of the 
file in time is displayed. You can move between time information and other 
information by pressing “down arrow button” or “up arrow button”. 
 

9.3.3.2 Record 
 
Use this command to start recording. You can also start recording by 
pressing the "Record" button on the front panel of the Braille Sense U2 
QWERTY. While recording, the Braille Sense U2 QWERTY displays the 
"recording information" tab. whenever you start recording the Braille Sense 
U2 QWERTY creates a file. The file is named "record 01.mp3", or "record 
02.mp3" etc. By default, these files are saved in "/flashdisk/media/record". 
You can change the save-to folder and recording file type using the "Record 
Settings" option, explained in section 9.3.6.3. When recording, pause the 
recording by pressing "Tab" to move to the "Pause" button, and then press 
"Enter". You can also pause by pressing the "Record" button on the front 
panel. To resume recording, press "Enter" on the "Continue" button, or press 
the "Record" button again. To stop recording, press “Tab” repeatedly to 
move to the "Stop" button, and press "Enter". 
 

9.3.3.3 Play 
 
This button is used to play the file that has just been recorded. You can also 
start playing the recorded file by pressing the "play" button on the front panel. 
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This function is only available just after you have recorded a file. While 
playing, the "playback information" tab is displayed. To pause or stop playing, 
tab to the desired button and press "Enter".  
 

9.3.3.4 Stop 
 
Use this command to stop recording or playback. If you press "Enter" on 
"Stop" while recording, the Braille Sense U2 QWERTY stops recording and 
shows the "recording information" tab. If you press "Enter" on the "Stop" 
button during playback, the Braille Sense U2 QWERTY stops playing and 
shows the "playback information" tab. You can also stop recording or playing 
by pressing the "Stop" button on the front panel.  
 

9.3.3.5 Pause 
 
Use this command to pause the recording or playing of a file. If you press 
"Enter" on "Pause", or press the "Play/Pause" button on the front panel, 
recording or playing is paused, and the "recording information" or "playback 
information" tab is displayed. 
 
 

9.3.3.6 Continue 
 
Press "Enter" on "Continue" when the current status is "pause", and the 
Braille Sense U2 QWERTY resumes recording or playing. 
 

9.3.3.7 Cancel 
 
If you press "Enter" on "Cancel", the Braille Sense U2 QWERTY stops 
recording or playing, closes the "Record" dialog, and returns to the "Media 
Playback" dialog. If you press "Enter" on "Cancel" while recording, the 
recorded file is not saved. To save the recording and exit the dialog; press 
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"Enter" on "Stop", and then move to the "Cancel" button, and press "Enter". 
You can also use "Esc" or "Alt-F4" to cancel an operation. 
 

9.3.4 Position Menu 
 
ACCESS the "Position" menu to set or delete a bookmark while listening to 
music or an audio file. This menu also lets you jump to a specified time in an 
audio file. 
The "Position" menu contains 7 items: 
 
1. Mark Position 
2. Delete Marked Position 
3. Jump To Marked Position 
4. Go To Time 
5. Go To Percent 
6. Set Start Point 
7. Release Point 
 
You can move between the menu items by pressing “down arrow button” or 
“up arrow button”. To activate a menu item, press "Enter". 
 

9.3.4.1 Mark Position 
 
If you execute this function when you are playing a file, or when a file is 
paused, a bookmark is set. A bookmark marks a specific location, so you 
can return to the exact spot at a later time.  
To execute this function, 
 
1) Press “Alt” and move to "Position" by pressing “down arrow button”. 
2) Press "Enter" on "Position". 
3) Navigate to "Mark Position" by pressing “down arrow button”, and press 
"Enter". 
4) Or, press "Alt" when playing a file, or when a file is paused. 
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9.3.4.2 Delete Marked Position 
 
If you execute this function when you are playing a file, or when a file is 
paused, it deletes the bookmark that was previously created. 
To execute this function,  
 
1) Press “Alt” and move to "Position" by pressing “down arrow button”. 
2) Press "Enter" on "Position". 
3) Navigate to "Delete Marked Position" by pressing “down arrow button”, 
and press "Enter". 
4) Or, you can press "Alt-d" when playing a file, or when a file is paused. 
 
If you execute this function in a file that does not have a bookmark, the 
Braille Sense U2 QWERTY displays, "There is no bookmark in selected file". 
 

9.3.4.3 Jump to Marked Position 
 
If you execute this function when you are playing a file, or when a file is 
paused, it jumps to the position of a bookmark that has already been created. 
To execute this function,  
 
1) Press “Alt” and move to "Position" by pressing “down arrow button”. 
2) Press "Enter" on "Position". 
3) Navigate to "Jump To Marked Position" by pressing “down arrow button”, 
and press "Enter". 
4) Or, you can press "Alt-j" when playing a file, or when a file is paused. 
 
If you execute this function in a file that does not have a bookmark, the 
Braille Sense U2 QWERTY displays, "There is no bookmark in selected file". 
 

9.3.4.4 Go to Time 
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If you execute this function when you are playing a file, or when a file is 
paused, it moves to a time that you specify, and begins playing the file at 
that position. 
To execute this function,  
 
1) Press “Alt” and move to "Position" by pressing “down arrow button”. 
2) Press "Enter" on "Position". 
3) Navigate to "Go To Time" by pressing “down arrow button”, and press 
"Enter". 
4) Or, you can press "Ctrl-g" when playing a file, or when a file is paused. 
5) The Braille Sense U2 QWERTY displays "Go to position: 0 minute". 
6) Type the time you want to go to, and press "Enter". You can jump more 
than an hour using a couple of methods: 
If you wish to type 1 hour and 20 minutes, type the "1", "Space" or “:”, "20" 
sequentially. Also you can input 80 minutes by simply typing "80". If there is 
no "Space" or “:", the input value is dealt with as minutes.  
 
If you type a time longer than the total playback time of the file or playlist, the 
Braille Sense U2 QWERTY displays, "invalid time", and resumes playing 
from the paused location. 
 

9.3.4.5 Go To Percent 
 
In play or pause status, you can move to a specified percentage of a file. 
1) In playing or pause status, press “Alt” to open the menu. 
2) By pressing “up arrow button” or “down arrow button”, navigate to the 
"Position" menu.  
3) Press "Enter". Or press "a" 
4) By pressing “up arrow button” or “down arrow button”, move to the "Go to 
percent" menu item. 
5) Press "Enter". Or press "Alt-p" from the "Media Playback" dialog.  
6) You are prompted "Go to percent: XX".  
7) Enter the percent that you want to move to in the edit box using numbers 
0 to 99. 
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8) Press "Enter".  
9) You are placed at the position in the file matching the percentage you 
entered. 
 

9.3.4.6 Set Start Point 
 
A B repeat mode allows you to play a specific part of an audio file as many 
times as you wish. This can be useful when learning a new language, and 
you need to hear the same information in a file over and over again.  
A B repeat mode requires setting start and end points for repetition. 
 
To set a start and end point, follow these steps: 
1) Press "p" at the position at which you want to set the start point. 
2) Or, press “Alt” and move to "Position" by pressing “down arrow button”. 
Press "Enter" on "Position". Move to "Set start point" by pressing “down 
arrow button” and press "Enter". 
3) The unit announces, "Set start point" and the file continue playing. 
4) To set the end point, press "p" at the point where you want to end the 
section for repetition. 
Or, you can execute A B repeat mode by pressing the "Record button" 
during playback. 
1) Press "Record button" at the position at which you want to set the start 
point. 
2) To set the end point, press the "Record button" again at the point where 
you want to end the section for repetition. 
 
Note: You can only use the "Record button" to perform this function while a 
file is playing. If playback is paused or stopped, the "record button" activates 
the recording function. 
 
After you have highlighted a section of a file using start and end points, A B 
repeat mode allows you to play that specific part of the file as many times as 
you wish. To set how many times a specified section repeat, go to "playback 
settings" under the "settings" menu. 
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9.3.4.7 Release Point 
 
To set a release point, press "Esc". Or, press “Alt” and move to "Position" by 
pressing “down arrow button”. Press "Enter" on "Position". Move to "Release 
point" by pressing “down arrow button” and press "Enter". After stopping 
playback of the specified section, the file continues playing. 
 

9.3.5 Mark 
 
You can insert a mark while listening to music or an audio file. The mark is 
stored even when you exit the program or play another file.  
To use the mark function, press “Alt” and move to "Mark" by pressing “down 
arrow button”. And press "Enter".  
The "Mark" menu has the following submenus. 
 

9.3.5.1 Set Mark 
 
To set a mark while listening to audio, Open the menu, and press "Enter" on 
"Mark". Navigate to "Set Mark" and press "Enter". Or, to activate this function 
directly, press "Alt-m" up to 1000 marks can be inserted into a file. 
The marks are automatically numbered in sequential order.   
 

9.3.5.2 Move to Mark 
 
You can move to the next or previous mark by pressing "V" or "N" 
respectively. You can also move to a mark using the menu. Press “Alt” and 
move to "Mark". And press "Enter". Navigate to the "Previous Mark" or the 
"Next Mark"  item and press "Enter". 
You can also move to a mark using the mark number. 
 
1) Open the menu and press "Enter" on "Mark". Navigate to "Move To Mark". 
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2) Press "Enter" on "Move To Mark". Or press "Alt-j" from the "Media 
Playback" dialog. 
3) Input the mark number in the edit box and press "Enter". 
4) If you input a non-existent mark number, The Braille Sense U2 QWERTY 
displays, "Mark x does not exist" and the edit box is displayed again.   
 

9.3.5.3 Delete Mark 
 
Use the following steps to delete a mark: 
1) Open the menu and press "Enter" on "Mark". Navigate to "Delete mark". 
2) Press "Enter" on "Delete Mark". Or press "Alt-d" from the "Media 
Playback" dialog. 
3) The Braille Sense U2 QWERTY displays: "Enter mark name to delete:". 
Type the number of the mark to be deleted and press "Enter". 
4) If you input a non-existing mark number, an "input error" message is 
appears, and the edit box is displayed again.  
 

9.3.5.4 Mark Manager 
 
You can open the Mark Manager dialog to query mark information for the 
current audio file by pressing "Alt-k". You can also open the dialog using the 
menu. Open the menu by pressing “Alt” and move to "Mark". Press "Enter", 
and navigate to "Mark Manager" and press "Enter". 
The dialog consists of the "mark list", a "Move button", a "Delete button", and 
a "Close button". You can move among the controls by pressing “Tab” and 
"shift-tab". 
All of the marks for the current file appear in the "mark list" with the "name 
and setting time of mark". You can navigate to the other information in the 
list by pressing “up arrow button” or “down arrow button”.  
You can delete a mark in the list by pressing "Del". In addition, you can start 
playback from the specific mark by pressing "Enter" on the mark name or by 
pressing "Enter" on the "Move button"  
 



240 
 

To close the mark manager dialog, press "Enter" on the "Close" button or 
press "Esc". 
 

9.3.6 Settings 
 
Using this menu, you can change settings for recording, playing, and general 
Media player options. To access the "Settings" menu, press “Alt” to open the 
"Media Player" menu. Press “down arrow button” three times to reach 
"Settings", and press "Enter". Or, you can press s from within the "Media 
Player" menu. The "Settings" submenu appears containing four items: 
"Configuration", "Playback Settings", "Record Settings", and "Effect settings". 
 

9.3.6.1 Configuration dialog 
 
If you press "Enter" on the first item, "Configuration", or press "Alt-c" from the 
"Media Playback" dialog, the "Configuration" dialog is displayed, containing 
the following: the "Display title" option, the "Store position of file if longer 
than:", a "Confirm" button, and a "Cancel" button. You can move among the 
controls by pressing “Tab” and "shift-tab". Move among options for a setting 
by pressing “up arrow button” or “down arrow button”. 
The "Display title" option allows you to set whether or not the track title is 
announced when you move to previous/next track. The default value is set to 
"Off".  You can toggle this option by pressing "Space". 
The "Store position of file if longer than:" option allows you to set memory of 
your last position on files longer than the length you specify. The default is 
set to "Off" meaning your last position is never saved. You can set the value 
to 5, 10, 30, or 60 minutes. If you set the value to 30 minutes, your last 
position is remembered for all files longer than 30 minutes. This option can 
be useful if you don't want to save the position for music files, but you want 
to save the position of audio books or podcasts.  
To save the changed settings and exit the dialog, press "Enter". Or move to 
the "Confirm" button by pressing “Tab” repeatedly and press "Enter". To 
cancel saving changes and exit this dialog, press "Esc", or "Alt-F4". You can 
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also press "Enter" on the "Cancel" button to close the dialog without 
changing any options.  
 

9.3.6.2 Playback Settings dialog 
 
If you press "Enter" on "Playback Settings", or press "p" on the "Settings" 
menu, the "Playback Settings" dialog is displayed. In this dialog, pressing 
“Tab” or “Shift-Tab” moves among setting options, "Confirm" and "Cancel". 
The setting options are "Display time", "Repeat", "Playlist", "Shuffle", "Times 
to repeat the specified track", "Set speed", and "Time index". Press “down 
arrow button” or “up arrow button” to move among the various options. You 
can also open this dialog by pressing “Ctrl-s” from the "Media Playback" 
dialog. 
The "Display time" option allows you to set which type of time messages are 
displayed in the "playback information" tab. You can set it to either "Elapsed 
time" or "Remaining time". You can change its value by pressing "Space".  
The "Repeat" option allows you to set whether all files in the playlist are 
played repeatedly. If this option is set to "Yes", all files in the playlist are 
played repeatedly, and if it is set to "No", the Braille Sense U2 QWERTY 
stops playing after playing the last file in the playlist. Again, you can change 
the value of this option by pressing "Space".  
The next option is "Playlist". To play audio files from File Manager, you can 
select multiple files by pressing "Space" and play them by pressing "Enter".  
If the playlist already contains files, this setting allows you to choose whether 
you want to overwrite the playlist or to append the selected files to the 
playlist. The default value is "Overwrite" meaning the playlist is created anew 
with the selected files. If you press "Space", the value is set to "Append" and 
the selected files are appended to the playlist.  
The "Shuffle" option allows you to set the audio playback order. The default 
value is set to "Off" thus, audio files are played in the order they appear in 
the playlist. If you set "Shuffle" to "On", the playlist is reorganized in random. 
If you have just one audio file in the playlist and you switch the option to "On", 
a message "Shuffle mode not available" is displayed. 
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"Times to repeat the specified track" allow you to set how many times you 
wish to repeat, when you execute section repetition. "Times to repeat the 
specified track" You can choose from values 1 to 10 or unlimited. The default 
setting is 3. Pressing "Space" increases the times to repeat the specified 
track and "Backspace" decreases the times to repeat the specified track. 
The "Set speed" option allows you to set the audio playback speed. 
The speed level ranges from 1 to 10. The default setting is 5. 
To change the value, press "Space" or "Backspace". The higher the number, 
the faster the audio playback speed.  
The "Time index" option allows you to set the time by which to jump. The 
default value is set to 1 minute. The values are "5 seconds", "10 seconds", 
"30 seconds", "1 minute", "3 minutes", "5 minutes", "10 minutes", "15 
minutes", "20 minutes", "30 minutes" and "1 hour". You can change the value 
using "Space" or "Backspace".  

Or, you can change the value of the time index by pressing “Ctrl-Left arrow 

key” or “Ctrl-Right arrow key” from the "Media Playback" dialog. Press “/”, to 

hear the current time index. 

After changing the time index, press “Ctrl-Left arrow key” or “Ctrl-Right arrow 

key”, to jump to previous or next position by time index.  
To save your settings and exit the dialog, press "Enter" or tab to the 
"Confirm" button, and press "Enter".  To cancel the changes, and exit the 
dialog, press enter on the "Cancel" button, or press "Esc" or "Alt-F4". 
 

9.3.6.3 Record Settings dialog  
 
If you press enter on "Record Settings" in the "Settings" menu, or press "Alt-
r" from the "Media Playback" dialog, the Braille Sense U2 QWERTY displays 
the "Record Settings" dialog, which contains "Recording type", "Sample rate", 
"Quality", "recording source", "Set folder", "Confirm" button and a "Cancel" 
button. You can move among the controls by pressing “Tab” and "shift-tab". 
And you can move among the options by pressing “up arrow button” or 
“down arrow button”. 
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The "Recording type" allow you to set the default file type of recorded files. 
The default value is set to "mp3". You can toggle between "wav" and "mp3" 
by pressing "Space". 
The next three options are used to control the quality of recorded sound. 
Higher values in "Sample rate" and "Bitrate"/”Bits per channel” mean a better 
quality of recorded sound, as well as a larger file size for recorded files. In 
other words, to record high quality sound, the total time the Braille Sense U2 
QWERTY can record is shortened. On the other hand, if you lower the 
values of these options, the Braille Sense U2 QWERTY can record sound 
longer, but the sound quality may not be as good. You can change these 
values by pressing "Space". When using “mp3”, “Sample rate” is available 
from 16000 Hz to 48000Hz and “Bitrate” value is available from 64K to 320K.  
 When using “wav”, “Sample rate” value is available from 8000Hz to 
44100Hz and “Bits per channel” value is available between 8 bits and 16 bits.   
When you record sound using the external microphone, you must set the 
recording source to "External Mic". When you record audio using the line-in-
cable, you must set the recording source to "Line in". When you record 
sound using internal microphone, set the recording source to "Internal Mic".  
The "Set folder" option allows you to set the default folder where the 
recorded files are saved. The default value is set to "/flashdisk/media/record". 
To specify a different folder, press "Enter" on "Set folder", and a File 
Manager-type dialog is displayed. Select a folder as you would in the "Open 
Folder" dialog.  
Press "Enter" to save your settings, or "Esc" to exit the dialog without saving 
your settings. 
 
Note: the following tables show approximate available recording times when 
recording at various sample rates using both WAV and MP3. The available 
recording time is measured based on a newly formatted, empty flashdisk. 
 
  * Recording type: mp3 

- 48000Hz 320K: 217’h 55’m 

- 44100Hz 192K: 363’h 45’m 
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- 32000Hz 128K: 544’h 48’m 

- 24000Hz 96K: 726’h 25’m 

- 22050Hz 80K: 872’h 27’m 

- 16000Hz 64K: 1089’h 37’m 
 
  * Recording type: wav 

- 44100Hz: 49’h 25’m 

- 22050Hz: 98’h 50’m 

- 11025Hz: 197’h 40’m 

- 8000Hz: 272’h 25’m 
 

9.3.6.4 Effect Settings dialog 
 
Press "Alt” to access the "Media Player" menu. Move to "Settings" and press 
"Enter". Press “down arrow button”, to navigate to "Effect settings", and 
press "Enter". Or, press "Ctrl-e” from the "playlist tab" or "Playback 
information tab". 
The "Effect settings" dialog contains the following: "Bass boost", "Surround", 
"3D Effect", "Reverb", "Echo", a "Confirm" button, and a "Cancel" button. You 
can move between controls by pressing "Tab" or "Shift-Tab". And you can 
move between options by pressing “up arrow button” or “down arrow button”. 
 
The "Bass boost" option is used to emphasize bass sound. Enter a value 
from 0 to 20 in the edit box. The higher the value you enter, the more bass 
sound is heard.  
The "Surround" can bring out ambient sound more distinctly. Enter a value 
from 0 to 100 in the edit box. The higher the value you enter, the stronger 
the surround effect. 
The "3D Effect" can enhance the surround effect. Enter a value from 0 to 100 
in the edit box. The higher the value you enter, the stronger the 3D effect.  
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The "Reverb" option adds reverberation to the audio files you are listening to.  
Enter a value from 0 to 100 in the edit box. The higher the value you enter, 
the stronger the reverb effect.  
The "Echo" option is used to add an echo effect to your audio files. Enter a 
value from 0 to 100 in the edit box. The higher the value you enter, the 
stronger the echo effect.  
To save your settings, press "Enter". To exit the dialog without making 
changes, press "Esc". 
 

9.4 Additional features 
 

9.4.1 Navigational features using the cursor keys 
 
While playing an audio file, pressing a cursor router in the 'Playback 
information tab places you in a position in the audio file related to the 
position of the cursor router you pressed. As there are 32 cursor routers on 
the BRAILLE display, each audio file can be navigated using 32 equal 
regions. If you want to restart playback at the beginning of the file, press 
cursor router 1. If you want to jump to a position near the halfway point, 
press cursor router 16 or 17. If you want to jump to the end of the file, press 
cursor router 32. 
    

9.5 Hot Keys in the Media Player 
 

1) Hot Keys for the Commands for the File Menu 
Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete item: Del 
Open URL: Ctrl-l 
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2) Hot Keys for Commands While in the Playback menu 

Play: Enter, x, Play button 
Previous track: Alt-Left arrow key, z, Previous button 
Next track: Alt-Right arrow key, b, Next button 
Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up arrow 
key) 
Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down arrow 
key)  
Back 5 track: Alt-Up arrow key 
Forward 5 track: Alt-Down arrow key 
First track: Ctrl-Fn-Left arrow key 
Last track: Ctrl-Fn-Right arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key  
Speed up: Shift-Right arrow key 
Slow down: Shift-Left arrow key 
Pause/continue: Space, Play button 
Stop: Backspace, Stop button 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
Delete play list during stop: Del 
 

3) Hot Keys for the Commands in the Record Dialog Box 
Call up the record dialog box: Ctrl-r, Record button 
Record: Record button 
Pause/continue recording: Space, Record button 
Play: Play button 
Pause/continue play: Space, Play button 
Stop: Backspace, Stop button 
 

4) Hot Keys for the Commands in the Position Menu 
Set bookmark: Ctrl-m  
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Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
 

5) Hot Keys for the Commands in the Mark 
Set mark: Alt-m 
Move to mark: Alt-j 
Move to previous mark: V 
Move to next mark: N 
Delete mark: Alt-d 
Mark manager: Alt-k 

 
6) Hot Keys for the Commands in the Setting Menu 

Configuration dialog box: Alt-c 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
Effect settings dialog box: Ctrl-e 

 
7) Hot keys for toggling options. 

Toggle “display time” between “elapsed time” and “remaining time”: t 
Toggle “repeat” between “Yes” and “No”: r  
Toggle “shuffle” between “On” and “Off”: s 
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10. FM Radio 
 
To use the "FM Radio" program on the Braille Sense U2 QWERTY, you 
must connect headphones to the headphone jack on the unit, as the 
headphone cord serves as the antenna, and without it, radio reception will be 
poor to nonexistent.  
From the program menu, use the scroll buttons to navigate to "FM Radio" 
and press "Enter". You can also press "r" to quickly jump to and launch the 
"FM Radio". When the FM Radio program is launched, your Braille Sense U2 
QWERTY announces the radio frequency. If you have used the FM Radio 
program previously, the Braille Sense U2 QWERTY tunes to the frequency 
that you last listened to. 
Note: the frequency range of the FM Radio is 87.5MHz to 108MHz. 
 

10.1 Listening to FM Radio via the internal speakers 
 
When you execute the FM Radio after connecting headphones, sound from 
the radio is directed through the headphones. As previously explained, it is 
necessary to connect the headphones to provide an antenna for radio 
reception. However, there may be times when you wish for the sound from 
the radio to output through the speakers on the Braille Sense U2 QWERTY. 
To listen to the radio through the internal speakers, press "Fn-x", or just X, to 
toggle internal speaker output on/off.  
 
You can also change this option using the menu:  
1) Press “Alt” to open the FM Radio menu, press "Enter" on "File" menu, and 
press "Enter" on "Settings". 
2) Or press "Ctrl-e" to quickly access the "settings" dialog. 
3) "Internal speaker: No" is announced, as the speaker setting is the first 
setting in the dialog. 
4) Press "Space" to change the setting to "Yes" and press "Enter" to apply 
the setting. 
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The radio sound should now output through both the headphones and the 
internal speakers. 
Note: This setting is available only in the FM Radio program. If you exit the 
FM Radio program and you wish to hear the audio output of the Braille 
Sense U2 QWERTY through the internal speakers, you must disconnect the 
headphones. 
You can adjust the radio volume independent of the general volume of the 
Braille Sense U2 QWERTY. The radio volume can be adjusted using "shift -
down scroll button" to lower the volume and "shift-up scroll button" to raise it.  
 

10.2 Frequency control 
 
While listening to the radio, to tune to another frequency, press “Alt” to open 
the menu. Navigate to "Frequency" and press "Enter" to open the 
"Frequency" menu.  
The "Frequency" menu consists of the following items: 
1) Previous Frequency 
2) Next Frequency 
3) Auto Scan Backward 
4) Auto Scan Forward 
5) Go to Frequency 
 
To navigate between these items, press “up arrow button” or “down arrow 
button”. Pressing "Enter" activates the selected item.  
You can also use hot keys from within the radio to quickly execute these 
commands. Press "Ctrl-Left arrow key" to scan forward for the next radio 
station. If you press "Ctrl-Right arrow key", your Braille Sense U2 QWERTY 

autoscans backward. Press “Right arrow key”, to increase the frequency by 

0.1MHz. Press “Left arrow key”, to decrease the frequency by 0.1MHz. 

Press "Ctrl-f" to input the frequency directly. Type the frequency in numbers 
in the edit box and press "Enter" to jump to that frequency. 
In addition to using the Braille keys on the top panel, you can use the media 
buttons on the front panel to control the FM Radio. To control the radio using 



250 
 

the media buttons, the Media mode switch should be moved to the left-most 
position, "FM". After setting the Media Mode switch, pressing the "Back" 
button scans backward, and pressing the "Forward" button scans forward. 
 

10.3 Adding and navigating presets 
 
Use the following steps to add the currently selected frequency as a preset.  
 
1) Press “Alt” to open the menu. Navigate to "Presets" and press "Enter".  
2) Navigate to "Add Preset" and press "Enter". (Use the hot key “Ctrl-s” to 
quickly access this option)  
3) The "add preset" dialog is opened and "Frequency: (current frequency)" is 
announced. 
4) Press "Tab". 
5) You are placed in the "Label" edit box. Type the name by which you want 
to identify the preset. 
6) Press "Tab" to move to "Confirm" and press "Enter". 
 
If you wish to add a frequency other than the one you're currently listening to, 
you may type the number of the frequency you wish to add in the 
"Frequency" edit box of the "add preset" dialog.  

You can navigate your presets by using “Alt-Left arrow key” to move back a 

preset, and “Alt-Right arrow key” to move forward a preset.  

To delete a preset, navigate to the preset and press "Del". Note: when this 
command is executed, the preset is deleted instantly without any warning or 
verification.  
You can also add and delete presets using the Preset Manager dialog. Press 
“Alt” to open the menu, and navigate to "presets" and press "Enter". 
Navigate to the "Preset Manager" and press "Enter". You can also press 
"Ctrl-m" to open the Preset Manager directly. 
The Preset Manager dialog contains the "Preset list", an "Add" button, a 
"Delete" button, a "Modify" button and a "Close" button. You can move 
through the controls by pressing “Tab” and "shift-tab". 
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Pressing "Enter" on the "add" button opens the "add preset" dialog explained 
above. If you wish to change the label of a previously added preset, move to 
the desired preset item in the preset list by pressing “up arrow button” or 
“down arrow button”. Press “Tab” to move to the "Modify" button and press 
"Enter". The "Modify" dialog is opened. The structure of the "Modify dialog" is 
the same as that of the "Add" dialog. The only difference is that the preset 
label and frequency are both filled in for the "Modify" dialog.  
If you want to delete a preset from the preset list, select the desired preset 
and move to the "Delete" button by pressing “Tab” and press "Enter". 
To exit the Preset Manager" dialog navigates to the "Close" button and press 
"Enter" or press "Esc". 
 
You can also use the media buttons on the front panel to add and move 
among presets. 
To use the media buttons, the Media Mode switch should be set to "FM 
radio". 
Press the "record" button for more than 2 seconds, to open the "add preset" 
dialog. To move to the previous preset in the Preset List, press the "Back" 
button for more than 2 seconds. Pressing the "Forward" button for more than 
2 seconds moves to the next preset in the preset list. 
Pressing the "stop" button for more than 2 seconds deletes the selected 
preset. 
 

10.4 Recording from the FM Radio  
 
To record the audio of the radio station to which you are currently listening, 
press “Alt” To open the menu, navigate to "Record (r)" and press "Enter". Or 
use the hot key, "Ctrl-r". The "record" dialog is opened and the Braille Sense 
U2 QWERTY begins recording. 
The record dialog consists of the following controls: 
1. "Record status" status bar 
2. "Pause/Continue" button 
3. "Stop" button  
4. "Cancel" button 
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You can move among these controls by pressing “Tab” or "shift-tab". 
While recording the radio, press "Tab" and press "Enter" on the "Pause" 
button or press "a" to pause recording. The name of this button is changed to 
"Continue". If you activate the "Continue" button or press "g", recording 
resumes.  
To stop the recording, press "s”. Or press "Tab" and press "Enter" on the 
"Stop" button. 
To check the duration of the current recording while recording, press “down 
arrow button”. The unit announces the current recording run time and total 
possible recording time.  
Recorded files are saved in the "flashdisk/media/radio" folder. The files are 
named according to the preset label and frequency. If you are recording a 
radio station that is not in your preset list, the recording is named "radio" 
followed by the frequency. The first recording of a station is numbered 01, 
and each subsequent recording of that station is numbered 02, 03, etc.  
If you stop recording, the record dialog is exited automatically. If you press 
"Enter" on the "Cancel" button or press "c", the recorded file is not saved and 
the dialog is exited.  
Note: while recording, you cannot change the preset or frequency. 
While listening to the radio, you can instantly start recording by pressing the 
"record" button on the front panel. As previously explained, make sure the 
Media Mode switch is set to FM radio mode. If you press the "record" button, 
the record dialog is opened and recording begins.  
If you press the "stop" button on the front panel during recording, recording 
stops and the recorded audio file is saved. If you press the "pause" button 
during recording, the "pause" button is changed to the "continue" button. 
Press the "pause" button again, (now the "continue" button) to resume 
recording. Pressing the "Back" button or the "Forward" button moves among 
the controls in the "record" dialog.  
 

10.4.1 Changing record folder 
 
To change the folder where recorded files are saved, follow these steps: 
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1) Press “Alt” to open the menu and press "Enter" on "File". 
2) Navigate to "Record Settings" and press "Enter". Or use the hot key, "Alt-
s" to open the "Record Settings" dialog.  
3) You are placed on the first item, "Recording type: mp3".  
4) Press “Tab” to move to the "Record folder" setting. 
5) "Record folder: /flashdisk/media/radio" is displayed. Press "Enter". 
6) The list of folders and files in the "Media" folder is displayed. Press 
"Backspace" to move back a level in the folder structure, and press “up 
arrow button” or “down arrow button” to move to your desired folder. 
7) Press "Space" on the folder in which you wish to store recordings and 
press "Enter". 
8) "Record folder: (Changed folder)" is announced. 
9) Press "Tab" to move to the "Confirm" button and press "Enter". 
 
When the recording type is set to “MP3”, the available "Sample rate” values 
range from 16000Hz to 48000Hz and available "Bitrate" values range from 
64K to 320K.    
When the recording type is set to “WAV”,  the available "Sample rate" values 
range from "8000Hz" to "44100Hz" and you can set the "Bits per channel" to 
8 bits or 16 bits.  
 
 To change the sample rate and bit rate, press “up arrow button” or “down 
arrow button” to move to the desired item to be changed. Press "Space" to 
change the value. When you have finished setting your preferences, press 
“Tab” to move to the "Confirm" button and press "Enter". 
 
Raising the values of the sample rate and bit rate produces a higher quality 
recording. However, higher quality recordings, though they have better 
sound, take up greater amounts of storage space. Be sure to set your 
recording values according to your specific quality and space requirements.  
 

10.5 Additional features 
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1. Sensitivity adjustment 
If the Braille Sense U2 QWERTY cannot tune to the broadcast frequency 
you desire, adjust the scanning sensitivity. To adjust the sensitivity, open the 
"Settings" dialog as described in Section 10.1. Press “down arrow button” to 
navigate to "Sensitivity" and press "Space" or "Backspace" to adjust the 
sensitivity. Higher values increase the scanning sensitivity of the radio. If the 
sensitivity is increased, you can fine tune to more frequencies. 
 
2. Mute 
While listening to the radio, press "Space" to mute the audio. Pressing 
"Space" once again unmutes the radio. You can also mute the radio by 
pressing the "stop" button on the front panel, and unmute by pressing the 
"play" button. If mute is activated, the radio is silent, but TTS (text to speech) 
and all other system sounds are heard. 
 

10.6 Hot Keys in the FM Radio 
 

Call up the sets dialog box: Ctrl-e 
Call up the menu: Alt 
Internal speakers on/off: X or Fn-x 
Move to next frequency: Ctrl-Up arrow key 
Move to previous frequency: Ctrl-Down arrow key 
Auto previous frequency: Ctrl-Left arrow key or short press previous button 
Auto next frequency: Ctrl-Right arrow key or short press next button 
Go to frequency: Ctrl-f 
Move to previous preset: Alt-Left arrow key or long press previous button 
Move to next preset: Alt-Right arrow key or long press next button 
Add preset: Ctrl-s or long press record button 
Delete the preset: long press stop button or Delete 
Call up the record dialog box: Ctrl-r 
Record start/pause: short press record button 
Record stop: short press stop button 
Mute on: short press stop button or Space 
Mute off: short press play button or Space 
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Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Record settings: Alt-r 
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11. Web Browser 
 
You can use the "Web Browser" on the Braille Sense U2 QWERTY to read 
pages on the web, as well as to read html documents you have saved to disk. 
In addition, you can download and read books from places such as Web 
Braille, and BookShare. Note: to access these services, you must create an 
account with the service provider.  
To launch the "Web Browser", press "Enter" on the ""Web Browser"" from 
the "program" menu. Or, press "b" from the "program" menu. The Braille 
Sense U2 QWERTY opens the "Web Browser" and connects to the web 
page set as the "home page". Note: the "Web Browser" supports SSL 1.0 to 
3.0. You can also launch the "Web Browser" by using the global hot key for 
opening a web page: Press "Fn-w" from anywhere on the unit. The Braille 
Sense U2 QWERTY, opens up a computer edit box into which you can type 
in the URL you want to go to. When you have entered the web address: 
press "Enter". The "Web Browser" opens, and takes you to the web page 
you requested. 
 

11.1 File 
 
The "File" menu can be accessed by selecting "File" after pressing “Alt”. 
"File" appears on the Braille display. Press "Enter" on "File", to open the 
"File" menu. To move among the menu items, press the up arrow (“up arrow 
button”) or the down arrow (“down arrow button”). The following is a detailed 
explanation of the "Web Browser" "File" menu. 
 

11.1.1 Open URL 
 
Press “Alt” to open the "Web Browser" menu. Move to "File", and press 
"Enter". The first item that is displayed is "Open URL". Press "Enter" to 
access the "Open URL" edit box, or press "Ctrl-i" from anywhere in the 
Browser. The edit box for entering an address is displayed with the address 
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of the current page filled in. Type the web address you would like to access 
in computer Braille such as "www.google.com", and press "Enter". 
When in the edit box, you can view recently accessed web addresses by 
pressing the down arrow (“down arrow button”). Move to the address that 
you want to open using the up arrow (“up arrow button”) or the down arrow 
(“down arrow button”), and press "Enter" on the desired address to open it.  
If the Braille Sense U2 QWERTY cannot connect to the desired web page, 
indicated by displaying progress on the Braille display for an extended period 
of time, press "Esc" to stop connecting, and execute "Open URL" again. You 
can type in the address and try to connect again, or type a different address 
to access. You can stop the "Web Browser" from connecting by pressing 
"Alt-F4. Sometimes, pages can freeze due to network or Internet problems. 
 

11.1.2 Open 
 
"Open" allow you to open locally stored content in the "Web Browser". To 
access "Open", press “Alt” to open the "menu", and press "Enter" on "File". 
Go to "Open" by pressing “down arrow button”, and press "Enter". Or, you 
can press “Ctrl-o” from anywhere in the Browser. The "Open" dialog is 
displayed. 
The "Open dialog" consists of "file list", "File name", "Type", "Confirm" button 
and "Cancel" button. You can move among the controls by pressing “Tab” or 
"shift-tab". When the "Open dialog" is opened, File name" is focused. Type in 
a file name, and then press "Enter" or press "Shift-tab" to move to the file list. 
Select the desired file name, and press "Enter". 
The default folder is "/flashdisk/download". Navigate files and folders as 
explained in the "File Manager". 
There are three types of files in "Type": "all files", "htm", "html". *** is the 
default and means that all types of files are shown in the file list. 
At "Type", press “up arrow button” or “down arrow button” to select the file 
type. 
To check the current path, press "Fn-/(slash)". You can use this command in 
the following dialogs: "Save As", "Add To Favorites", and the "Favorites List". 
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11.1.3 Save As 
 
Use "Save As" to save the currently open document or web page as a 
different file type or store web content on your Braille Sense U2 QWERTY 
for later viewing. This is similar to "Save As" in the word processor.  
To execute "Save As", open the "menu" by pressing “Alt”, and press "Enter" 
on "File". Move to "Save As" by pressing “down arrow button” and press 
"Enter", or press "Ctrl-s" while in the Browser. The "Save As" dialog appears. 
Type in a new file name, and press "Enter" to save the file using a different 
name or format.   
In this dialog, you'll find "File name" edit combo box, "Type" combo box, 
"Confirm" button, "Cancel" button and "file list". You can move among these 
items by pressing “Tab” or "shift-tab". 
To edit the file name that is displayed on the Braille display, press the cursor 
routing key that corresponds with the text that you want to edit. Please 
remember that “:” cannot be used in file names. You have to delete “:” if 
there is one in your file name. 
To select the file name from the existing file name, press "shift-tab" to move 
to "file list". The default folder is "/flashdisk/download". To move back a level 
in the folder structure, press "Backspace". To enter a selected folder or 
select a file, press "Enter" on the folder or file. Press “down arrow button” or 
“up arrow button” To move to the next or previous folder or file.  
You can move from "File name" to "Type" by pressing “Tab”. The available 
file types are htm, html, brl, brf and txt. Use “down arrow button” or “up arrow 
button” to select the file type.  
Press “Tab” to move to "Confirm" and press "Enter" to save. Or, press “Tab” 
again to move to "Cancel" and press "Enter" to cancel "Save As". 
If you do not want to save, you can also press "Esc” or "exit (Alt-F4)". 
 

11.1.4 Page Information 
 
"Page Information" displays how many tables, forms, and controls are on the 
current page. 
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To open "Page Information", press “Alt” to open the "menu", and press 
"Enter" on "File". Move to "Page Information" by pressing “down arrow 
button” a few times, and press "Enter". Or, you can press the letter "I". 
 

11.1.5 Exit 
 
This command terminates the "Web Browser", and returns the Braille Sense 
U2 QWERTY to the "program" menu. You can exit the "Web Browser" by 
pressing "Alt-F4", or by selecting "Exit" from the "Web Browser" file menu. 
 

11.2 Read 
 
Use the "Read" menu to read the web page by various text elements. To 
open the "Read" menu, press “Alt”, and press "Enter" on "Read" or press r 
from the menu. 
The "Read" menu contains 3 items: 
 
1. Read From Beginning To Cursor 
2. Read From Cursor To End 
3. Auto Scroll 
You can move among the menus by pressing “down arrow button” or “up 
arrow button”. To execute an option, press "Enter". 
 

11.2.1 Read from Beginning to Cursor 
 
This function reads the current page from the beginning to the cursor 
location.  
To execute this function, press "Enter" on "Read From Beginning To Cursor" 
in the "Read" menu. Or, you can press "Alt-g" while in a web page.  
To interrupt speech before the Braille Sense U2 QWERTY has finished 
reading to the cursor location, press "Ctrl".  Your cursor is placed at the 
location where you stopped reading. 
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11.2.2 Read from Cursor to End 
 
This function reads the current page from the cursor position to the end of 
the page. 
To execute it, press "Enter" on "Read From Cursor To End" in the "Read" 
menu. Or you can press "Enter-g (1-2-4-5)" while in a web page. 
To interrupt reading before the Braille Sense U2 QWERTY has finished 
reading to the end, press "Ctrl". Your cursor is then placed at the position at 
which you stopped reading.  
 

11.2.3 Auto Scroll 
 
This function scrolls the current page from the cursor to the end of the page 
using the Braille display. 
To execute the "Auto Scroll" function, press "Enter" on "Auto Scroll" in the 
"Read" menu. Or, while in a web page, you can turn the auto scroll feature 
on and off by pressing the up and down scroll buttons simultaneously. For 
faster scrolling, press "Right arrow button". For slower scrolling, press "Left 
arrow button". 
 
 

11.3 Edit 
 
The "Edit" menu is used to select any part of the web page and copy or add 
it to the clipboard for use in other applications such as the "Word Processor" 
or "E-mail". 
To open the "Edit" menu, press “Alt”, and press "Enter" on "Edit" or press "e" 
from the menu. 
 

11.3.1 Start selection 
 
This command cannot be used on the controls in the web page, but can be 
used on the text or in an edit box. This means you cannot set a block when 
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on links, but you can select text chunks on a web page, or an edit box on a 
bulletin board.  
To use this command, navigate to the point at which you wish to start 
selecting text. Press “Alt” and  move to the "Edit" menu by pressing “down 
arrow button” and press "Enter". Navigate to "Start Selection" and press 
"Enter".  
You can also set the starting point of the block by pressing “Ctrl-b” directly. 
 

11.3.2 Copy  
 
Use this command to copy your selection to the clipboard for use in other 
applications. To copy the selected section of the web page, press “Alt”, move 
to the "Edit" menu by pressing “down arrow button” and press "Enter". Move 
to "Copy" by pressing “down arrow button” and press "Enter". Or you can 
copy the selected section by pressing "Ctrl-c" while in a web page. 
 

11.3.3 Add to clipboard 
 
Sometimes, you may wish to copy various sections from a web page all at 
once, in which case, you will not want your last selection erased each time 
you copy a new one. You can use the "Add to clipboard" option to append 
each of your selections to the clipboard. 
To add a selection to the clipboard, press “Alt”, move to "Edit" menu by 
pressing “down arrow button” and press "Enter". Press “down arrow button” 
to move to "Add To Clipboard" and press "Enter". Or you can add to the 
clipboard directly by pressing "Ctrl-Insert".  
 

11.3.4 Copy URL 
 
The "Copy URL" function copies the address of the web page on which you 
are currently located to the clipboard. 
To copy the address of the web page, press “Alt”, move to the "Edit" menu 
by pressing “down arrow button” and press "Enter". Press “down arrow 
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button” to move to "Copy URL" and press "Enter". Or you can copy the URL 
directly by pressing "Alt-d".  
The web address of the page is placed on the clipboard. You can paste it to 
a document, or anywhere you can paste text on the Braille Sense U2 
QWERTY. 
 

11.3.5 Copy Link  
 
The "Copy Link" function allows you to copy a link in the web page on which 
you are located. If you tab to a link, and select the "Copy Link" function, the 
link is copied to the clipboard.  
To copy a link from the web page, press “Alt”, move to the "Edit" menu by 
pressing “down arrow button” and press "Enter". Press “down arrow button” 
to move to "Copy Link" and press "Enter". Or you can copy a link directly by 
pressing "Alt-l".  
 

11.4 Go To 
 
To open the "Go To" menu, press “Alt”, and navigate to "Go To" by pressing 
“down arrow button”. Press "Enter". The menu items are explained in the 
following sections. 
 

11.4.1 Go to Home Page 
 
The first page that your "Web Browser" loads when the "Web Browser" 
opens is called the "home page". You can set your favorite site as your home 
page. When your "home page" is set, your "Web Browser" opens the same 
"home page" every time you execute it. 
The default home page is www.Hims-inc.com. To move to the default home 
page from another web page, press “Alt”, and navigate to the "Go To" menu 
by pressing “down arrow button”, and press "Enter". The first item in the "Go 
To" menu is "Go To Home Page". You can activate "Go To Home Page" by 
pressing "Enter", or by pressing "Alt-h" while in the "Web Browser".  
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11.4.2 Go to Previous Page  
 
The previous page is the page shown just before the current page. For 
example, when the "Web Browser" is activated, the first page that opens is 
the home page. Search for and load the Google web page, www.google.com. 
The Braille Sense U2 QWERTY connects to the Google web page. When 
"Go To Previous Page" is activated, the Braille Sense U2 QWERTY returns 
you to the last position on the previous page (the home page).  
To move to the previous page, press “Alt” to open the "menu", and navigate 
to the "Go To" menu by pressing “down arrow button”, and press "Enter". 
Navigate to "Go To Previous Page" by pressing “down arrow button”, and 
then press "Enter". Or, you can press "Alt-Left arrow button". This command 
is not available on the first page you visit in the "Web Browser", because 
there is no previous page to go to. 
 

11.4.3 Go to Next Page 
 
When you have opened multiple web pages, you can move back and forth 
among the various pages you have visited. For example, when you first open 
the "Web Browser", you connect to your home page. Then, you connect to 
the Google website, and next, you connect to the Lycos website. In this case, 
if you navigate back to Google using the "Go to Previous Page" command, 
the next page from the Google website is the Lycos website.  
To move to the next page, press “Alt” to open the menu, and navigate to the 
"Go To" menu by pressing “down arrow button”. Press "Enter". Move to "Go 
To Next Page" by pressing “down arrow button”, and press "Enter", or you 
can press "Alt" with "Right arrow button". This command is not available on 
the last page because there is no page after the last page to move to. 
 

11.4.4 Go to Previous Heading 
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If you activate the "Go To Previous Heading" function, you can go to a 
heading that is located above your current location. To execute the "Go To 
Previous Heading" function, open the menu by pressing “Alt”, and press 
“down arrow button” repeatedly to move to the "Go To" menu. Press "Enter" 
on "Go To". Then, use “up arrow button” or “down arrow button” to move to 
"Go To Previous Heading", and press "Enter". Or, press "u" from the menu. 
To activate this function directly, press "Alt-b or Ctrl-F3" while in a web page. 
 

11.4.5 Go to Next Heading 
 
If you activate the "Go To Next Heading" function, you can move forward to 
the next heading below your current location. To execute the "Go To Next 
Heading" function, open the menu by pressing “Alt”, and press “down arrow 
button” repeatedly to move to the "Go To" menu. Press "Enter" on "Go To". 
Then, use “up arrow button” or “down arrow button” to move to "Go To Next 
Heading". Press "Enter". Or, press "d" from the menu. You can also activate 
this function directly, by pressing "Alt-F” or “Ctrl-F4" while in a web page. 
 

11.4.6 Go to Previous/Next Text 
 
This item can be used to go to the next or previous chunk of text while 
reading a web page. 
To execute the "Go To Next Text" function, do the following: 
 
1) Open the menu by pressing “Alt”. 
2) Move to "Go To" by pressing “down arrow button”. 
3) Press "Enter".  
4) Press “down arrow button” until "Go To Next Text" is displayed. Or, you 
can press "a" To move directly to "Go To Next Text".  
5) Press "Enter".  
 
Or you can activate the "Go To Next Text" function by pressing "Ctrl-F6" 
while reading a web page.  
To execute "Go To Previous Text", do the following: 
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1) Open the menu by pressing “Alt”. 
2) Move to "Go To" by pressing “down arrow button”. 
3) Press "Enter".  
4) Press “down arrow button” until "Go To Previous Text" is displayed. Or, 
you can press "b" To move directly to "Go To Previous Text".  
5) Press "Enter".  
 
Or, you can activate the "Go To Previous Text" function by pressing "Ctrl-F5" 
while reading a web page.  
 

11.4.7 Refresh 
 
If a web page opens incorrectly due to a network problem, or you know the 
content is updated often, To refresh the current page, press “Alt”, and 
navigate to the "Go To" menu by pressing “down arrow button”. Press 
"Enter". Go to "Refresh" by pressing “down arrow button”, and press "Enter", 
or you can press "Ctrl-r" while in a web page. 
 

11.4.8 History 
 
The "History" is the list of the web page addresses (and their titles) that have 
been visited either by clicking on a link or by typing in the address directly. 
When "History" is executed, the Braille Sense U2 QWERTY displays the 
titles of the web pages in the history list. 
If you have visited a web page such as www.google.com previously, the 
history list on the Braille Sense U2 QWERTY shows you the title of the page 
as, "Google". 
To visit the Google website using the history list, press “Alt” to open the 
"menu", and navigate to the "Go To" menu by pressing “down arrow button”. 
Press "Enter". Go to "History" by pressing “down arrow button”, and press 
"Enter". You can open the history list directly by pressing "Ctrl-h" while in a 
web page.  
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The Braille Sense U2 QWERTY displays the history list. Move to the title of 
the website you want to select by pressing “down arrow button” or “up arrow 
button”. If you want the "History" list to show the web address, instead of the 
title, you can press "Fn-i". If you press “down arrow button”, the display 
shows the title again, rather than the address. After you move to the desired 
website, press "Enter" to connect to it. 
To delete an item from the history list, select the item and press the "Del". 
To delete all the items in the history list, press "Ctrl-a" to select all, and press 
"Del". 
The maximum number of items in the history list is 300. If the list exceeds 
300 items, the oldest item is deleted automatically and the new item is added 
to the top of the list. 
 

11.4.9 Find 
 
This feature is similar to the "Find" function in the word processor. The "Find 
dialog" allow you to find text on the current web page. 
To execute the "Find" command, press “Alt” to open the menu, and navigate 
to the "Go To" menu by pressing “down arrow button”. Press "Enter". Go to 
"Find" by pressing “down arrow button”, and press "Enter", or you can press 
"Ctrl-f" while the "Web Browser" is loaded. 
When "Find" is executed, the dialog containing the edit box for entering text 
and the search direction appears. As in any other dialog, you can press 
“Tab” or "shift-tab" to move from one control to another. Enter the text to 
search for, and select the search direction. Then, press "Enter". The Braille 
Sense U2 QWERTY finds the text, and moves the cursor position to the 
location of the text. 
The default search direction is set to "Forward". This means that the Braille 
Sense U2 QWERTY searches for the specified text from the current cursor 
position to the end of the page. To change the search direction, select 
"Backward", and press "Enter". The selected search direction remains until 
the "Web Browser" is closed, unless you change it. 
 



267 
 

11.4.10 Find Again 
 
The "Find Again" function searches the text again in the direction that you 
have selected. To open "Find Again", press “Alt”, and navigate to the "Go 
To" menu by pressing “down arrow button”. Press "Enter". Move to "Find 
Again" by pressing “down arrow button”. Press "Enter". Or, you can press 
"Ctrl-f", while in a web page. 
"Find Again" finds the text that you have entered in "Find". There is no edit 
box in "Find Again". It simply repeats the search you specified in "Find". 
 

11.4.11 Links list 
 
This function lists all the links on the current page. To activate it, press “Alt” 
and press "Enter" on "Links list" in "Go To" menu. Or execute it directly, by 
pressing "Alt-i". The "Links list dialog" appears. In the dialog, find the 
following controls: "links list", "Focus link" button, "Activate link" button, and 
"Cancel" button. You can move among the controls by pressing “Tab” or 
"Shift-Tab". You can navigate the list of links in the "links list", by pressing 
“up arrow button” or “down arrow button”. 
To move to the selected page in the "links list", press "Enter" Or move to 
"Activate link" button by pressing “Tab” or "Shift-tab" and press "Enter".  
To go to the position of the link on the web page from the "links list", move to 
"Focus link" button by pressing “Tab”, and press "Enter".  
To close the dialog, move to the "Cancel" button, and press "Enter". Or press 
"Alt-F4" or press "Esc". 
 

11.5 Favorites 
 
To open "Favorites", press “Alt”, and move to "Favorites" by pressing “down 
arrow button”, and press "Enter". If there are websites that you frequently 
visit, it is inconvenient to enter the long address each time you want to visit 
the page. In such a case, you can add these website addresses to the 
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"Favorites" list. Then, you can visit the websites by simply selecting the 
address from the "Favorites" list. 
 

11.5.1 Set Current As Home Page 
 
The "home page" is the website that you connect to automatically when the 
"Web Browser" is opened. The user can set any website as the home page.  
To set the "home page", Navigate to the web page you want to set as the 
home page. While the web page is loaded, press “Alt”, and move to 
"Favorites" by pressing “down arrow button”. Press "Enter". "Set Current As 
Your Home Page" is displayed, as it is the first item in the "Favorites" menu. 
Press "Enter". The current website is saved as your home page 
automatically, and the Braille Sense U2 QWERTY says, "Saved as home 
page", and displays the current web page. You can also press “Ctrl-s” to 
activate this function while your desired homepage is loaded.  
 

11.5.2 Add to Favorites 
 
You can add the web page you are currently reading to the "Favorites" list. 
To add the web page to the "Favorites" list, press “Alt”, and move to 
"Favorites" by pressing “down arrow button”. Press "Enter". Move to "Add To 
Favorites" by pressing “down arrow button”, and press "Enter". You can 
activate "Add To Favorites" by pressing "Alt-a" directly from the page you 
want to add. 
"Add To Favorites" is a dialog that contains the following: the current 
favorites list (including the folders and files of your favorites), an edit box for 
the web address, confirm, and cancel. You can move among the controls by 
pressing “Tab” or "shift-tab". 
When you open "Add To Favorites", the edit box is displayed. In this edit box, 
you can type the title of the current web page. The extension name (.URL) is 
attached automatically to the title name.  
To edit the current title name, press the left-most cursor routing key. The 
current title name is displayed on the Braille display. You can press the 
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cursor routing key where you want to edit the text, and modify it. Make sure 
that you do not use “:” in the title name.  
The favorites list is saved in the "/flashdisk/favorites" folder. This folder is the 
default folder. Though you can create sub-folders in the "Favorites" folder, 
you cannot change the default folder to another folder at a higher level. To 
save your favorite to a different folder, navigate folders and files from the 
"Favorites" list using normal navigation keys. 
 

11.5.3 Favorites List 
 
The user can copy, delete, or rename the title of the sites in the favorites list, 
in addition to visiting any web page in the list. 
To open the "Favorites" list, press “Alt”, and move to "Favorites" by pressing 
“down arrow button”. Press "Enter". Move to the "Favorites List" by pressing 
“down arrow button”, and press "Enter". Or, you can press "Ctrl-l" while in a 
web page. The Braille Sense U2 QWERTY displays the Favorites list dialog. 
This dialog contains the following: the favorites list, an edit box for the title, a 
type combo box, a confirm button, and a cancel button. You can move from 
one item to the next by pressing “Tab” or "shift-tab". 
When the "Favorites List" is open, an edit box is displayed. The edit box 
displays the message, "Name:". You can enter the title of one of your 
favorites, and you can open the web page by pressing "Enter"" If there are 
no titles that match what you entered, the Braille Sense U2 QWERTY says, 
"invalid name" and returns to the edit box. If there is a title in the "Favorites 
list", the Braille Sense U2 QWERTY connects to the web page. If you do not 
remember the exact title, you can find it from the "Favorites" list, using the 
method outlined below. 
When the edit box appears, press "shift-tab" To move to the "Favorites list". 
The Braille Sense U2 QWERTY displays the "file list". You can move among 
folders and files by pressing “up arrow button” or “down arrow button”. 
Press "Enter" on the title of the website you want to visit. On this list, folders 
are enclosed by quotation marks. Press "Enter" on a folder to open it.  
In the favorites list, you can view only the files with the selected file format. 
Press “Tab” to move to the "Type" combo box. In the type combo box, there 
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are two file formats; his“*.*” and “url". Press “up arrow button” or “down arrow 
button” to select one. If you select his“*.*” then all types of files are shown. 
 

11.6 Options 
 
Using the "Options" menu, you can set user agent, and change default 
download folder. You can also clear cookies in the "Options" menu. 
To execute the "Options" menu, 
1) Press “Alt” to open the menu. 
2) Move to "Options" by pressing “down arrow button”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page.  
 

11.6.1 Menu Structure and Movement  
 
When you execute the "Options" menu, the following options are available: 
1) "User agent" list 
2) "Show visited links"  
3) "Default download folder"  
4) "Clear cookies" 
5) "Confirm" button 
6) "Cancel" button 
By pressing “up arrow button” or “down arrow button”, you can move among 
the options: User agent, Show visited links, Default download folder and 
Clear cookies. And by pressing "Tab" or "Shift-Tab", you can move among 
controls.  
 

11.6.2 Set User Agent 
 
1) Press “Alt” to open the menu. 
2) Move to "Options", by pressing “down arrow button”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page. 
4) "User agent: Windows CE" is displayed. 
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5) Using "Space", you can select "Windows XP", "Windows CE" or "Pocket 
PC". 
6) After selecting your desired value, press "Enter". 
When web pages are loaded, the Braille Sense U2 QWERTY uses the 
version of the website created for the operating system defined by your user 
agent. 
 

11.6.3 Show visited links 
 
The "Visited link" option allows you to choose whether links you have visited 
previously are labeled as such. The default setting is "On”. Toggle this 
setting "On" and "Off" by pressing "Space". 
 

11.6.4 Changing the Default Download Folder 
  
To change the default folder where downloads are saved, follow these steps: 
1) Press “Alt” to open the menu. 
2) Move to "Options" by pressing “down arrow button”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page. 
4) Pressing “down arrow button”, move to "Default download folder" 
5) The list of files and folders in the "Flashdisk" is displayed. Navigate among 
the drives, files and folders using normal navigation keys. Press "Space" on 
the folder in which you wish to save your downloads. 
7) Press "Enter". 
8) Press "Tab”, to move to the "Confirm" button. 
9) Press "Enter". 
To cancel the change, press "Enter" on the "Cancel" button. Or press "Alt-
F4".  
 

11.6.5 Clear cookies 
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A cookie contains information which can be read in web applications 
whenever the user visits the website. You can clear cookies in the "Options" 
menu in Braille Sense U2 QWERTY by following these steps: 
1) Press “Alt” to open the menu. 
2) Move to "Options", by pressing “down arrow button”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page. 
4) Pressing “down arrow button”, move to "Clear cookies" 
5) Press "Enter" on "Clear cookies". 
6) The unit announces, “Successfully cleared cookies" and cookies are 
cleared. 
 
Pressing "Ctrl-d", clears cookies directly from a web page. 
To cancel clearing cookies, press "Enter" on the "Cancel" button. Or press 
"Alt-F4".  
 

11.7 Read Page 
 
On the web page, there are links, controls, and other various elements, as 
well as text. To read web pages properly, the "Web Browser" should classify 
each element, and notify the user with its information. 
When reading a web page by moving with “down arrow button” or “up arrow 
button”, one element is displayed on one line. The links and controls are 
displayed with their respective symbols so the user can distinguish each 
element. 
 

11.7.1 Moving Among Controls 
 
A control is a link, an edit box, a radio button, or a combo box. These same 
controls are found in Windows on a personal computer. Web pages also use 
various kinds of controls for user input. Each control has different purposes. 
Therefore, the user has to know exactly what type of control is being used. 
For example, in an edit box, the user enters a text string. In a combo box 
and list box, the user should select one of the items listed in the combo box 
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or list box. The Braille Sense U2 QWERTY "Web Browser" uses symbols to 
identify what type of control is used. To move from one control to another 
without reading the text between controls, the Braille Sense U2 QWERTY 
provides the following movement commands: 
 
1. Move to the previous control: "Shift-tab".  
This command moves to the nearest previous control from the current 
position. If there are no more previous controls, the warning sound is heard. 
2. Move to the next control: "Tab" 
This command moves to the next control from the current position. If there 
are no more controls, the warning sound is heard. 
 
When you find controls in web pages, the Braille Sense U2 QWERTY 
displays control symbols ahead of the contents of the control. The following 
is a list of control symbols. 

 
Control name Symbol 
Link LN 
Visited link LNV 
Anchor ANC 
Edit box EB 
Multi edit box MEB 
List Box LB 
Combo box CB 
Radio button select SRB 
Radio button 
unselect 

URB 

Check box check SCHB 
Check box uncheck UCHB 
Button BT 

 
 
1. Link: If you press "Enter" on link, you move to the page that the link is 
referencing. 
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2. Visited link: Alink that you visited previously.  
3. Anchor: If you press "Enter" on anchor, you move to the referenced part of 
the web page. 
4. Edit box: You can start entering the text at the cursor position. After you 
finish entering the text, press “down arrow button” to move to the next item. If 
there is any text in the edit box, it is spoken and displayed on the Braille 
display. 
5. Multi edit box: This is similar to the edit box. It is an edit box that allows 
you to enter multiple lines in one edit box. You can start a new line by 
pressing "Enter". After you finish entering the text, press “Tab” To move to 
the next item. 

6. List box, combo box: To change a selection in the combo box, press “Alt-

Down arrow key” or “Alt-Up arrow key". You can move to the next item by 
pressing “down arrow button”. 
Also it renews a page automatically when you change a selection in a combo 
box. 
7. Radio button, check box: To select or cancel the selection, press "Enter". 
8. Button: If you press "Enter" on a button, you move to the referenced page. 
 

11.7.2 Moving to a Form Field 
 
A "form" is a page that has all of the controls, except the "link" control. The 
edit boxes, buttons, and combo boxes are included in a "form". When you 
navigate some web pages, if there are many links, it is very cumbersome to 
navigate to a form because you have to push too many “Tab” or "shift-tab" 
keys to get to the form fields. In this case, you can use the "move to form 
field" function. 
 
1. Move to the previous form field: Ctrl-F1 
You can move to the previous form field by pressing this key. If there are no 
previous form fields, the Braille Sense U2 QWERTY plays the warning sound. 
2. Move to the next form field: Ctrl-F2 
You can move to the next form field by pressing this key. If there are no 
more form fields, The Braille Sense U2 QWERTY plays the warning sound. If 
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there are no form fields on a web page, the Braille Sense U2 QWERTY says, 
"no control". 
 

11.7.3 Table 
 
At the beginning position of the table, the Braille Sense U2 QWERTY shows 
the table number, and the number of rows and columns on the table. 
For example, there are two large tables (we call these "upper level tables") 
on one web page. Each table has 3 sub tables (we call these "lower level 
tables") with 3 rows and 2 columns on each. In this case, when the Braille 
Sense U2 QWERTY shows the first sub table on the second large table, it 
displays "table 2-1 3 rows, 2 columns". At the end of the sub table, the Braille 
Sense U2 QWERTY displays "table 2-1". 
If the table consists of only 1 row and 1 column, or empty space that has 
only border or background, such tables are not considered tables in the 
Braille Sense U2 QWERTY. 
The Braille Sense U2 QWERTY provides a way to move table by table, and 
cell by cell, in order for the user to comprehend the structure of the table. To 
move cell by cell, the cell position and contents of the cell are displayed. 
However, the position information is only announced with speech. 
For example, if you have move to a cell that is positioned on the second row 
and third column, and the content of the cell is "news", the Braille Sense U2 
QWERTY announces, "row 2 cell 3 news". In this case, "row 2 cell 3" is 
announced with speech only, while "news" is displayed in Braille. 
If a table is included in the cell, the Braille Sense U2 QWERTY announces 
"table cell". If there is not a table in the cell, you hear "empty cell". 
In the "table cell", To move to any cell within the lower level table, press 
“down arrow button” to move to the beginning line of the lower level table.  
Moving by cell is only valid in the table. If this command is executed outside 
of the table, a warning sound is played. 
 
1. Move to the previous table: Ctrl-F7 
Moves to the beginning of the previous table. If there are no previous tables, 
the warning sound is played. 
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2. Move to the next table: Ctrl-F8 
Moves to the beginning of the next table. If there are no more tables, the 
warning sound is played. 
3. Move to the previous cell: Ctrl-Shift-Left arrow key 
Moves to the previous cell. If the current cell is the first cell, it moves to the 
beginning line of the table. If this command is pressed on the beginning line 
of the table, the warning sound is played. 
4. Move to next cell: Ctrl-Shift-Right arrow key 
Moves to the next cell. If the current cell is the last cell, it moves to the end 
line of the table. If it is pressed on the end line of the table, the warning 
sound is played. 
5. Move to upper cell: Ctrl-Shift-Up arrow key 
Moves to the cell in the previous row within the same column. If the current 
cell is on the first row, the warning sound is played. 
6. Move to lower cell: Ctrl-Shift-Down arrow key 
Moves to the cell in the next line, within the same column. If the current cell 
is on the last row, the warning sound is played. 
7. Current cell: Ctrl-Shift-C 
Announces and displays the content of the current cell again. 
8. Move to the previous cell in the upper level table: Ctrl-Left arrow key 
Moves to the previous cell from the current cell that contains the current 
table. If the current table cell is the first cell of the highest level table, it 
shows the beginning line of the table. It does not work on the highest level 
table. 
9. Move to the next cell of the upper level table: Ctrl-Right arrow key 
Moves to the next cell from the current cell that contains the current table. If 
the current table cell is the last cell in the highest level table, it moves to the 
end line of the table. It does not work on the highest level table. 
10. Move to the upper cell of the upper level table: Ctrl-Up arrow key 
Moves to the previous row, within the same column, to the table cell that 
contains current table. If the cell that contains the current table is located on 
the first row of the upper level table, the warning sound is played. It does not 
work on the highest level table. 
11. Move to the lower cell of the upper level table: Ctrl-Down arrow key 
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Moves to the next row, within the same column, to the table cell that contains 
the current table. If the table cell that contains current table is at the last row 
of the upper level table, the warning sound is played. It does not work on the 
highest level table. 
12. Check the position: Fn-s 
Announces the position of the current cell in the table. It shows the position 
in both Braille and voice, such as "table 2-3 row 3, cell 4". 
 

11.7.4 Move to the Frame 
 
1. Move to the previous frame: Ctrl-F9 
Moves to the beginning position of the previous frame. If there are no 
previous frames, the warning sound is played. 
2. Move to the next frame: Ctrl-F10 
Moves to the beginning position of the next frame. If there are no more 
frames, the warning sound is played. 
 

11.7.5 Playback of Streaming Audio Files 
 
While navigating a web page, if you come across a link for a streaming audio 
file, you can simply press "Enter" on it. The Media player program is 
launched with lists of address inside of the streaming file, and the streaming 
audio file on the first address is played. The supported streaming file formats 
are "m3u", "pls", "asf", "asx". 
 
For other formats, if you press "Enter" the "Web Browser" program plays the 
streaming audio file directly. When you play the streaming audio file in the 
"Web Browser", the "Add To Favorites" dialog appears.  You can add the 
streaming address to the "Favorites list" and the streaming file is saved with 
"ASF-WAS at the beginning of the file name.  "ASF" denotes that the link is a 
streaming audio file. 
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While you play a streaming audio file in the "Web Browser", if you exit the 
"Web Browser" program or you lose the internet connection, the streaming 
audio file stops playing. 
You can use the following playback commands in the "Web Browser" while 
playing a streaming audio file. 
 
1. Play: "play" button on the front panel 
2. Stop: "stop" button on the front panel 
3. Turn up the volume: Shift-up scroll button 
4. Turn down the volume: Shift-down scroll button 
 
Playback of a streaming audio file does not stop if you switch to another 
program, unless you press the "stop" button on the front panel after returning 
to the "Web Browser".  
Note: Real Audio files are not supported in the "Web Browser". 
 

11.8 Hot keys in the "Web Browser" 
 
File Menu 
Open URL: Ctrl-l 
Open: Ctrl-o 
Save as: Alt-s 
Information: Alt-Enter 
Exit: Alt-F4 
 
Read Menu 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter  
Auto scroll: Up scroll button-down scroll button 
 
Edit menu 
Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to clipboard: Ctrl-Insert 
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Copy URL: Alt-d 
Copy link: Alt-l 
 
Go to menu 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow key 
Go to the next page: Alt-Right arrow key 
Go to previous heading: Alt-b or Ctrl-F3  
Go to next heading: Alt-f or Ctrl-F4 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
Refresh: Ctrl-r 
Open the history list: Ctrl-h  
Check the address of the selected title in the history list: Fn-i  
Find: Ctrl-f  
Find again: F3  
Links list: Alt-i 
 
Favorites 
Set current as your home page: Ctrl-s  
Add to favorites: Alt-a  
Favorites list: Ctrl-l 
 
Options setting: Alt-o  
Clear Cookies: Ctrl-d 
 
Hot Keys When Playing Audio Files in the Web Browser 
Turn up the volume: Shift-Up arrow key 
Turn down the volume: Shift-Down arrow key 
Play: play button of the front panel 
Stop: stop button of the front panel 
 
Reading Web Pages 
Move between controls 
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Move to the previous control: Shift-tab  
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow key 
Select the previous item in the combo box (list box): Alt-Up arrow key 
 
Moving to the form 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
 
Table navigation hot keys 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow key 
Move to the next cell: Ctrl-Shift-Right arrow key 
Move to the upper cell: Ctrl-Shift-Up arrow key 
Move to the lower cell: Ctrl-Shift-Down arrow key 
Read current cell: Ctrl-Shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow key 
Move to the next cell of the upper level table: Ctrl-Right arrow key 
Move to the upper cell of the upper level table: Ctrl-Up arrow key 
Move to the lower cell of the upper level table: Ctrl-Down arrow key 
Check the current position: Fn-s 
 
Move to frame 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 
Read the current line: Fn-r 
 

11.9 What the "Web Browser" Does Not Support 
 
1. Images are not supported. 
2. Any executable files on web sites cannot be executed. It is because the 
operating system on the Braille Sense U2 QWERTY is different from the 
operating system on a personal computer. 
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3. A web page using flash can be opened, but the flash content may not be 
read. 
Some web pages that use JavaScript cannot be opened. 
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12. DAISY Player 
 
Using the DAISY Player on the Braille Sense U2 QWERTY, you can listen to 
files and read books that use the DAISY format. DAISY is an acronym for 
(DIGITAL ACCESSIBLE INFORMATION SYSTEM). One advantage to 
DAISY books is that you can listen to the audio as well as read the 
associated text with the audio in DAISY books where both text and audio are 
present.  
The Braille Sense U2 QWERTY supports DAISY books that are version 3.0 
or earlier. The DAISY player also supports DAISY content from specialized 
service providers, such as books from NLS, BookShare, and the Open 
library. 
 
The DAISY Player supports the following book types: 
DAISY 2.0/2.02/3.0, DAISY XML/Digital Talking Book. 
ANSI/NISO Z39.86 2002, 2005. 
NLS contents: 3gp, AMR-WB+ 
Bookshare.org DAISY contents. 
NIMAS 1.1  
DRM: supports 2006 PDTB2 authentication.  
archive.org (open library) 
 
Note: To access content from services such as BookShare and the National 
Library Service, you must sign up for these services, meet all eligibility 
requirements, and pay any associated fees if applicable. 
 
 
Registering your Braille Sense U2 QWERTY with NLS: 
As of firmware version 6.2, the Braille Sense DAISY Player supports 
playback of digital talking books from the National Library Service for the 
Blind and Physically Handicapped (NLS) as well as protected DAISY content 
from the Open library (openlibrary.org/archive.org). In order to play content 
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from these services, you must register your Braille Sense U2 QWERTY with 
the National library Service.  
 
Note: the following instructions assume you already have an account with 
the NLS Braille and Audio Reading Download service (BARD). If you do not 
currently have a BARD account, please contact your regional NLS lending 
library or visit: 
https://nlsbard.loc.gov/ApplicationInstructions.html 
 
To register your Braille Sense U2 QWERTY with NLS BARD, follow these 
steps: 
 
1) Log in to your account on the BARD main page. 
2) Choose the "Update Account Settings" link. 
3) Choose the "Add a purchased player" link. 
3) Fill out the form as requested; choose "Sense Notetaker" as the player 
type. 
4) You will receive an email confirming your request to add a purchased 
player. 
6) If there are no problems with your eligibility, within a couple of days, you 
will receive another email confirming your eligibility to add the Sense 
Notetaker to your account. This message also informs you that an email has 
been sent to HIMS to confirm your eligibility. 
7) When HIMS receives the email confirmation of your eligibility, we will send 
an email requesting your key number and notetaker model, including 
instructions for obtaining your key number. 
8) When we receive your key number and notetaker model, we will send the 
key file via email. (The key file is a small file with a .kxo extension.) 
9) Save the attachment, and copy it to the root of your notetaker's flashdisk. 
(Please be sure to copy the .kxo file to the root of the flashdisk. It must not 
be contained in a folder, but must reside at the top level of the flashdisk 
directory.) 
10) Play an NLS book. The key file installs itself on a special protected area 
of the flashdisk. 
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To obtain your key number, follow these steps: 
1) Press "win key" to bring up the main menu. 
2) Press h to access the Help Menu. 
3) Press "I" to bring up the Information Dialog. 
4) Navigate below "Mac Address for wireless LAN". 
5) After the words "Key Number" a 5 or 6 digit number is displayed. 
 
To launch the DAISY Player, follow these steps: 
(1) Press "Enter" on "DAISY Player" in the Braille Sense U2 QWERTY 
"program" menu. 
(2) Or press the shortcut key "d” from the "program" menu.  
(3) When you launch the DAISY Player, all of the drives available on the 
Braille Sense U2 QWERTY are displayed (regardless of whether they 
contain DAISY-formatted files).  
(4) You can navigate the list with “up arrow button” or “down arrow button”. 
You can open a drive containing DAISY-formatted files by pressing "Enter" 
on the drive name.  
(5) After opening the drive, all of the folders on the drive, and any DAISY 
book titles on the drive that you have opened are displayed.  
(6) When you locate a folder containing a DAISY book you want to open, 
press "Space" to select it.  
(7) Press "Enter" to play the book. 
 
If you have DAISY books in a folder on a drive, you can go into the folder by 
pressing "Enter" on it. Make sure that you do not press "Space" on the folder. 
You can navigate the drive by using the same navigation keys used in the 
file manager. Navigate to the folder containing the DAISY book you wish to 
read or listen to. Press "Space" to select the folder, and press "Enter" to play 
the DAISY book. If you only have one DAISY book in the selected folder, it 
automatically starts playing after showing the title. If your selected folder 
contains more than 1 DAISY book, you can play the DAISY book by pressing 
"Enter" on the selected book after navigating the file list with “up arrow 
button” or “down arrow button”.  
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If you replay a book that you have listened to before, playback resumes from 
the location where you last exited. To stop playing a DAISY book, press "Alt-
F4". A prompt box appears asking if you would like to exit the DAISY Player. 
You can select "Yes" or "No" with "Space" or "Backspace" and press "Enter".  
You can also control DAISY playback using the media buttons on the front 
panel. To use the media buttons to control the DAISY Player, the Media 
Mode switch must be set to the center position, "DAISY Mode". You can start 
DAISY playback by pressing the "play" button on the front panel. While 
playing DAISY content, press "play" again to pause playback. PRESS the 
"Back" button to move back 1 navigational element, and press the "Forward" 
button to move forward by 1 navigational element. Use the "Record" button 
to set the navigational element by which the "Back" and "Forward" buttons 
move. Controlling the DAISY Player via the Media buttons is explained in 
further detail later in this chapter.  
Open the DAISY Player menu by pressing “Alt”. The menu contains "File", 
"Document", "Mark", and "Heading". You can navigate the menu items using 
“up arrow button” and “down arrow button”. To activate a menu item, press 
"Enter".  
 

12.1 Components of the DAISY Player 
 
While playing DAISY content, four controls/components are available:  
1) "heading"  
2) "Information"  
3) "Play" 
4) "Pause"  
You can move among the controls using “Tab” and "shift-tab". While playing 
a DAISY book, `heading", shows you a prefixed heading or navigation 
element as well as the text under that element if text exists. In "information", 
you can find the current page, level, phrase, elapsed time, and running time. 
You can move among these items with “up arrow button” or “down arrow 
button”. You can press "Enter" on "Pause" or "Play", to pause or play the 
audio. From anywhere in the four control components, you can toggle 
play/pause by pressing "Space". 
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12.2 File 
 
When in the "File" menu, you can open a new DAISY book, check file 
information on the currently open book, and set voice parameters. You can 
open the "File" menu by pressing “Alt”, and press "Enter" on "File". Or, you 
can press "f" to quickly access the File menu.  
The "File" menu contains:  
1) "Open DAISY"  
2) "Voice Settings"  
3) "Book-Info" 
4) "Exit"  
You can move among these items with “up arrow button” or “down arrow 
button”. You can activate the selected item by pressing "Enter". 
 

12.2.1 Open DAISY 
 
You can open another DAISY book using "Open DAISY". To get to "Open 
DAISY", press “Alt” to open the menu, and press "Enter" on "File". Use 
“down arrow button” to navigate to "Open DAISY" and press "Enter". Or, you 
can use the hot key “Ctrl-o”.  
When you activate "Open DAISY", the drive list is displayed. 
 
You can also open the "Open DAISY" dialog by holding the "Stop" button. If 
you press and hold the "Stop" button again, this dialog is closed and you are 
returned to your previous position. 
The "Play” button performs the same function as "Enter" in the "Open 
DAISY" dialog. The "Stop" button, "Record" button, "Back" button and 
"Forward" buttons perform the same functions as "Backspace", "Space", “up 
arrow button” and “down arrow button” in the "open DAISY" dialog. 
Namely, you can move up and down by pressing the "Back" and "Forward" 
buttons in the "Open DAISY" dialog. And you can select and unselect by 
pressing the "Record" button. Press the "Stop" button, to move back a level 
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in the folder structure, and press the "play" button to play the selected file in 
the "Open DAISY" dialog. 
To use these functions, you must set the Media Mode switch to "DAISY 
Mode". 
 

12.2.2 Voice Settings 
 
In the "Voice Settings", you can set the DAISY Player voice parameters.  
To execute voice settings, follow these steps: 
(1) Press “Alt” to open the menu.  
(2) Move to "Voice Settings", below the "File" menu and press "Enter". Or 
press "s".  
(3) Or, you can directly activate the "Voice Settings" by pressing “Ctrl-s”.  
 
Executing this option opens the "Voice Settings" dialog.  
The dialog contains the following items: 
1) DAISY play Type: (Available when a DAISY book contains both text and 
audio, this option allows you to choose your playback method.) 
2) Voice control 
- Set speed 
- Set volume 
- Set to control information of contents 
3) Confirm 
4) Cancel 
 
You can move among the four controls with "Tab" or "Shift-Tab". In the 
"voice control" tab, you can move among "Set speed", "Set volume" and "Set 
to control information of contents" with “up arrow button” or “down arrow 
button”.  
To cancel this function, press "Esc or "Alt-F4". 
 

12.2.2.1 DAISY play type 
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This option appears when playing text audio DAISY books. You can access 
this option directly by pressing "Ctrl-t". 
The default setting is "Audio". This means the DAISY Player plays audio in 
text audio DAISY. If you set the "Text", it plays the text in text audio DAISY, 
and thus the content is read using the TTS. 
To change the setting value, press “up arrow button” or “down arrow button”. 
After changing the setting value, press "Enter". Or press "Tab", to move to 
"Confirm" and press "Enter". 
 

12.2.2.2 Volume and Speed 
 
You can increase the levels of speed and volume with "Space", and 
decrease them with "Backspace". After setting the levels, press "Enter" to 
confirm your settings. 
Without using the "Voice Settings" menu, you can increase or decrease the 
speed and volume with the following hot keys:. 
  
1. Increase the speed: Shift-Right arrow key 
2. Decrease the speed: Shift-Left arrow key 
3. Increase the volume: Shift-Up arrow key 
4. Decrease the volume: Shift-Down arrow key 
 

12.2.2.3 Set to control information of contents 
 
Use this function when you play NIMAS DAISY content. The default setting 
value is "On". To change the setting value, press "Space" or "Backspace". 
If you set this to "On", the Braille Sense U2 QWERTY displays controls and 
information symbols while playing NIMAS DAISY content. 
NIMAS DAISY controls include "image", "description", "caption", "prodnote, 
and "table". These controls appear on the Braille display as "img" for image, 
"desc" for "description" and "prodnote", "cap" is for "caption", and "tdt for 
"table". 
 



289 
 

12.2.3 Book-Info 
 
Using "Book-Info", you can query the information on the currently playing file.  
Press “Alt” and press "Enter" on "File". Press “down arrow button” repeatedly 
to move to "Book-Info" and press "Enter" on "Book-Info". You can also 
activate "Book-Info" by pressing "Alt-Enter". 
Activating "Book-Info" opens the "Book-Info" dialog. The dialog contains a 
status box with "running time and pages", another status box containing the 
"mark information", and a "Close" button. You can move among the three 
controls with “Tab” or "shift-tab". The first status box contains "Total time", 
"Read time", "Remaining time", "Total pages", "Current page", and 
"Remaining pages". The second status box contains the "Total marks" and 
"Mark page". You can move among the items with “up arrow button” or 
“down arrow button”. If you want to close the dialog, press "Enter" on "Close", 
and you are returned to the currently playing file. 
 

12.2.4 Exit 
 
To exit the DAISY Player, press “Alt”, and press "Enter" on "File". Press 
“down arrow button” repeatedly to move to "Exit" and press "Enter". Or, you 
can press "Alt-F4" to instantly exit the DAISY Player. When you execute the 
"Exit" command, the Braille Sense U2 QWERTY prompts, "Exit DAISY 
Player. Are you sure?" press "Enter" on "Yes", which is the default; or, if you 
do not want to exit, select "No" by pressing "Space", and press "Enter". 
 

12.3 Document Navigation 
 
When in the "Document" menu, you can move by phrase or level while 
playing a DAISY book. To activate the "Document" menu, press “Alt” and 
press "d".  
 
The "Document" menu contains the following items:  
1) "Play/Pause"  
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2) "Previous Phrase"  
3) "Next Phrase"  
4) "Previous Page"  
5) "Next Page"  
6) "Go To Page"  
7) "Move down"  
8) "Move up"  
9) "Set To Prior Level" 
10) "Set To Next Level".  
You can move among these items using “up arrow button” or “down arrow 
button”. To activate a menu item, select the menu item, and press "Enter". 
 

12.3.1 Play and Pause 
 
You can access "Play/Pause" in the menu by pressing “Alt”, and press 
"Enter" on "Document". Then, use “down arrow button” to move to 
"Play/Pause", and press "Enter". You can also activate "Play/Pause" directly 
by pressing "Space". While playing, you can move to the beginning of a 
document by pressing "Fn-Left arrow key". You can move to the last phrase 
by pressing "Fn-Right arrow key". 
 

12.3.2 Move by Phrase 
 
You can access this command in the menu by pressing “Alt,” and then press 
“Enter” on “Document.” Then, use “Down arrow key” to move to “Previous 
Phrase” or “Next Phrase,” and press “Enter.” You can move to the next, 
previous, next fifth, or previous fifth phrase without calling up the menu by 
pressing “Right arrow key”, “Left arrow key”, “Ctrl-Up arrow key”, or “Ctrl-
Down arrow key”, respectively. 
Also you can move to the previous or next phrase directly with a short press 
of the "Back" button or "Forward" button on the front panel. To move by 
phrase using the "Back" and "Forward" buttons, you must set the Media 
mode switch to "DAISY mode". 
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12.3.3 Move by Page 
 
You can access this item in the menu by pressing “Alt”, and press "Enter" on 
"Document". Then, use “down arrow button” to move to "Previous Page", 
"Next Page", or "Go To Page", and press "Enter". You can move to the next 
or previous page directly by pressing "page down" or "page up" during play 
or pause status. You can jump to a specific page by pressing "Ctrl-g". When 
you activate "Go To Page", you are prompted "Move to page number?" Type 
the number of the page that you want to move to in the edit box. Press 
"Enter", and the Braille Sense U2 QWERTY moves you to that page. 
 

12.3.4 Move by Level 
 
You can access this function in the menu by pressing “Alt,” and then press 
“Enter” on “Document.” Then, use “Down arrow key”to move to “Move up” or 
“Move down,” and press “Enter.”Or, you can move up and down without 
calling up the menu by pressing “Alt-Left arrow key” or “Alt-Right arrow key”. 
You can set the level by pressing “Alt-Down arrow key” or “Alt-Up arrow key”. 
Namely, if the level is set to 3, you can move through the level 1, 2 and 3 
and if the level is set to 1, you can move through the level 1 only. 
 

12.3.5 Move by Time Index 
 
You can use this function in the following situations: 
1. While playing an audio DAISY book or in pause status. 
2. While playing audio in an audio text DAISY book or in pause status. 
 
The setting values are "5 seconds", "10 seconds", "30 seconds", "1minute", 
"3 minutes", "5 minutes", "10 minutes", "15 minutes", "20 minutes", "30 
minutes" and "1 hour". 
 

To set previous time index, follow these steps: 
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(1)  Press “Ctrl-Alt-Up arrow key”. Every time you press “Ctrl-Alt-Up 
arrow key”, Braille Sense U2 QWERTY toggles between 30, 10, or 5 
seconds; 1 hour and 30 minutes. 

(2)  Choose the setting value you want. 
 
To set next time index, follow these steps: 

(1)  Press “Ctrl-Alt-Down arrow key”. Every time you press “Ctrl-Alt-
Down arrow key”, Braille Sense U2 QWERTY toggles between 5, 10, 
or 30 seconds: 1 minute, 3 minutes and 5 minutes. 

(2)  Choose the setting value you want. 
 

The moving mode to move by a specified amount of time is as follows. 
1) Move to previous time: Press “Ctrl-Alt-Left arrow key”. If you set “5 

minutes”, it will move to previous position by 5 minutes. 
2) Move to next time: Press “Ctrl-Alt-Right arrow key”. If you set “5 

minutes”, it will move to next position by 5 minutes. 
 

12.3.6 Move by Text Index 
 
You can use this function in the following situations: 
1. While playing a text DAISY book or in pause status. 
2. While playing text in an audio text DAISY book or in pause status. 
 
The setting values are "Phonetic", "Character", "Word" and "Sentence". 
To set previous text index, follow these steps: 
(1)  Press “Ctrl-Alt-Up arrow key”. Every time you press “Ctrl-Alt-Up arrow 
key”, Braille Sense U2 QWERTY toggles between “Sentence”, “Word”, 
“Character” or “Phonetic”. 
(2) Choose the setting value you want. 
 
To set next text index, follow these steps: 
(1) Press “Ctrl-Alt-Down arrow key”. Every time you press “Ctrl-Alt-Down 
arrow key”, Braille Sense U2 QWERTY toggles between “Phonetic”, 
“Character”, “Word” and “Sentence”. 
(2) Choose the setting value you want. 
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To move by the specified text index value, follow these steps: 
(1) Move to previous text: Press “Ctrl-Alt-Left arrow key”. If you set 
“Sentence”, it will move to previous position by sentence. 
(2) Move to next text: Press “Ctrl-Alt-Right arrow key”. If you set “Sentence”, 
it will move to next position by sentence. 
 

12.4 Mark 
 
Using the "Mark" menu, you can insert a mark or jump to a previously 
created mark in a DAISY book. Up to 1000 marks can be inserted into each 
DAISY book. You can open the "Mark" menu by pressing “Alt”, then "m". In 
the "Mark" menu, you will find the following items:  
1) "Previous Mark"  
2) "Next Mark"  
3) "Set Mark"  
4) "Move To Mark" 
5) "Delete Mark"  
You can move among the menu items using “up arrow button” or “down 
arrow button”. 
 

12.4.1 Previous Mark 
 
The "Previous Mark" function allows you to move to a location prior to your 
current position where you have placed a mark. You can access the 
"Previous Mark" function by pressing "Enter" on the "Mark" menu, move to 
"previous mark" by pressing “down arrow button” and press "Enter". Or just 
press "p" to execute the "Previous Mark" command. You can also move to 
the previous mark by pressing "V" while reading DAISY content. 
 

12.4.2 Next Mark 
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The "Next Mark" function allows you to move to a location ahead of your 
current position where you have placed a mark. You can access the "Next 
Mark" function by pressing "Enter" on the "Mark" menu, Navigate to "Next 
Mark" by pressing “down arrow button” and press "Enter". Or just press "n" to 
execute the "Next Mark" command. You can also move to the next mark by 
pressing "N" while reading DAISY content. 
 

12.4.3 Set Mark 
 
You can set a mark anywhere you want while playing a file to note a position 
you would like to return to at a later time. You can set a mark by pressing 
"Ctrl-m" from within a DAISY book. You can also activate this function by 
pressing “Alt”. Then, press "Enter" on "Mark". Use “down arrow button” to 
move to "Set Mark", and press "Enter". Or press "m" when you are in the 
"Mark" menu. The "Set Mark" dialog opens, and you are prompted to "Enter 
mark name:". Enter the number of the mark that you want to insert from 1 to 
1000. 
 

12.4.4 Move to Mark 
 
You can move to the next or previous mark by pressing "V" or "N" during 
play/pause status. You can also move to a specific mark by pressing "Ctrl-j". 
You can access this feature in the menu by pressing “Alt”. You can then use 
“down arrow button” to move to "Mark", and press "Enter". Or, you can press 
"j" when you are in the "Mark" menu. If you activate the "Move To Mark" 
function, you are prompted for the "Mark name to move to:". Type the mark 
name in the edit box. If you have not previously set a mark, you cannot use 
this function.  
 

12.4.5 Deleting a Mark 
 
You can activate the "Delete Mark" function by pressing "Del" during 
playback. You can also activate this function from the menu by pressing “Alt”. 
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Use “down arrow button” to move to "Mark", and press "Enter". Use “down 
arrow button” to move to "Delete Mark", and press "Enter" once more. When 
you activate the "Delete Mark" function, you are prompted to "Enter mark 
name to delete:". Make certain that you want to delete the mark that you 
have entered. If you type a mark name in this edit box, the mark is deleted 
without warning or confirmation. 
 

12.5 Heading 
 
When in the "Heading" menu, you can navigate a document by the available 
text headings, or you can search a heading during DAISY playback. You can 
open the "Heading" menu by pressing "Alt", and press "h".  
 
The "Heading" menu contains the following items: 
1) "Previous Heading" 
2) "Next Heading"  
3) "Scan Heading"  
4) "Read Heading"  
5) "First Heading"  
6) "Last Heading"  
7) "Find Heading"  
8) "Find Again"  
 
You can move among the sub-menu items using “up arrow button” or “down 
arrow button”. 
 

12.5.1 Move by Heading 
 
While playing a DAISY book, you can move heading by heading using hot 
keys. You can move to the next, previous, first, and last heading by pressing 

“Ctrl-F6”, “Ctrl-F5”, “Ctrl-f7”, and “Ctrl-F8” respectively. You can also move to 

the previous or next heading directly using the media buttons on the front 
panel. Before you use this feature, be sure to set the Media Mode switch on 
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the front panel to "DAISY mode". To move to previous or next heading, press 
the "Back" or "Forward" button for about 2 seconds and release it.  
 

12.5.2 Move to Specific Heading 
 
To move to a specific heading, follow these steps: 
1) Press "Ctrl-h" while playing a DAISY book. 
2) The Braille Sense U2 QWERTY displays, "Current Heading: xx Total 
heading: yy. Enter the heading number to move to:". 
3) Type the number of the heading you want to move to. 
4) Press "Enter". 
5) The DAISY book starts playing at the specified heading.. 
 

12.5.3 Find Heading 
 
You can activate the "Find Heading" function by pressing "Ctrl-f". When you 
press this hot key, you are prompted, "Heading to find:" You are placed in an 
edit box into which to type the heading name. The "Find Heading" dialog also 
contains "Search direction:", a "Confirm"button, and a "Cancel"button. You 
can move among the four items with “Tab” or "shift-tab". 
Tab to the "Search Direction" combo box, and press "Space" to toggle 
between forward and backward. Tab to "Confirm", and press "Enter" to 
execute the search.  
 

12.5.4 Scan Heading and Read Heading 
 
While playing a DAISY book, you can read your current heading, or scan the 
headings from your current location to the end of the book. You can scan 
them by activating the "Read Heading" or "Scan Heading" in the "Heading" 
menu or by using the hot keys for these functions. 
You can query the current heading (in the open book, by pressing "Ctrl-w". 
When you activate this function, the current heading name and level are 
displayed. By pressing "Ctrl-n”, you can scan the heading list from the 
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current position to the end of the book. The headings from the current 
position to the end are displayed in a list. Press "Enter" or "Space" on a 
heading in this list to start playback at that position. If you want to cancel the 
"Scan Heading" function, press "Esc" or "Alt-F4", and you are returned to 
your previous location. 
 

12.5.5 Find Phrase 
 
You can also search for a phrase in an open DAISY book.  
Follow these steps: 
1) Press “Alt” to open the menu. 
2) Braille Sense U2 QWERTY displays, "File". 
3) Press “down arrow button”, to navigate to "Heading". 
4) Press "Enter" on the "Heading" menu. Or press "h". 
5) "Previous heading" is displayed. 
6) Press “down arrow button”, to move to "Find Phrase". 
7) Press "Enter" on the "Find Phrase" option. Or press "s". 
You can also open the "Find PHRASE" dialog directly by pressing "Alt-s". 
 
The "Find Phrase dialog" consists of the following: 
1) Phrase to find 
2) Search direction 
3) Confirm 
4) Cancel 
 
You can move among the 4 controls by pressing "Tab" and "Shift-Tab". 
 
Type all or part of the phrase in the edit box. Press "Tab", to move to 
"Search direction". The default setting is "Next". You can choose "Next" or 
"Back". To change the setting value, press "Space". 
After setting the "Search direction", press "Enter". Or press "Tab", to move to 
"Confirm. Press "Enter" on the "Confirm" button. 
Playback starts at the searched phrase. 
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If you want to cancel the "Find Phrase" dialog, press "Enter" on the "Cancel" 
button. Or press "Alt-F4". 
 

12.6 Hot Keys in the DAISY Player 
 

Play  
Play/Pause: Space 
Move to the beginning of document: Fn-Left arrow key 
Move to the last phrase: Fn-Right arrow key 
Increase the speed: Shift-Right arrow key 
Decrease the speed: Shift-Left arrow key 
Increase the volume: Shift-Up arrow key 
Decrease the volume: Shift-Down arrow key 
 
Move by Phrase 
Move to the next phrase: Ctrl-Right arrow key or short press “next” button 
Move to the previous phrase: Ctrl-Left arrow key or short press “previous” 
button 
Move to the next fifth phrase: Ctrl-Down arrow key 
Move to the previous fifth phrase: Ctrl-Up arrow key 
 
Move by page 
Move to the next page: Page down 
Move to the previous page: Page up 
Go to the page: Ctrl-g 
 
Move by level 
Move up: Alt-Left arrow key 
Move down: Alt-Right arrow key 
Set to prior level: Alt-Up arrow key 
Set to next level: Alt-Down arrow key 
 
Move by heading 
Move to the next heading: Ctrl-F6 or long press “next” button 
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Move to the previous heading: Ctrl-F5 or long press “previous” button 
Move to the last heading: Ctrl-F8 
Move to the first heading: Ctrl-F7 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n  
Move to Specific Heading: Ctrl-h 
Find Phrase: Alt-s 
 
Heading 
Find heading: Ctrl-f 
Find again: F3  
Scan heading: Ctrl-n 
Read heading: Ctrl-w  
 
Set mark 
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
 
 
Miscellaneous Hot Keys 
Move to the title list: Shift-Backspace 
Open DAISY file: Ctrl-o 
Voice setting: Ctrl-s 
Set DAISY play type: Ctrl-t 
Check the book-info: Alt-Enter 
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13. Bluetooth Manager 
 
The Braille Sense U2 QWERTY is Bluetooth capable, or rather, you can 
connect the Braille Sense U2 QWERTY to various devices such as 
keyboards, printers, audio devices, and other computers without the need for 
cables. . Bluetooth is the latest in wireless technology and enables wireless 
connectivity via a Personal Area Network (PAN). Unlike a traditional Wireless 
Local Area Network (WLAN), these networks are limited to approximately 30 
feet or less. Bluetooth enables users to exchange various types of 
information over this wireless connection.  
 
To use Bluetooth with the Braille Sense U2 QWERTY, you must first turn the 
Bluetooth option "On" in the "Global Options" dialog. You can also toggle 
Bluetooth on/off from anywhere on the unit using "F9".   
You can use Bluetooth to transfer files from the Braille Sense U2 QWERTY 
to a computer, use your computer's Internet connection, or use the Braille 
Sense U2 QWERTY as a wireless Braille display for a computer or smart 
phone. Note: to use the Braille Sense U2 QWERTY as a wireless Braille 
display, you must be running a screen readers such as Window-Eyes, 
Supernova, or VoiceOver. Please note that Bluetooth is an evolving standard, 
and the functionality may vary , depending on the operating system that you 
are using. 
The Braille Sense U2 QWERTY uses the built-in Bluetooth Manager 
program to manage Bluetooth functionality. You can access the Bluetooth 
Manager in several ways. To access Bluetooth Manager from the program 
menu, press “up arrow button” or “down arrow button” to navigate to 
Bluetooth Manager, or press "Space" until you reach Bluetooth Manager. 
When your cursor  is placed on Bluetooth Manager, press "Enter" to activate 
it. You can also press "l" to jump to and open the Bluetooth Manager from 
the "program" menu.  
 

13.1 Bluetooth Device List 
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When the Bluetooth Manager is activated, it begins scanning for other 
Bluetooth devices that are in range, and the services available from the other 
Bluetooth devices. For example, if you have a computer with Bluetooth 
enabled nearby, the Braille Sense U2 QWERTY attempts to find it. It may 
take 30 to 40 seconds to discover all of the Bluetooth devices in range. The 
Braille Sense U2 QWERTY announces and displays, "Scanning for devices. 
Please wait...". Progress beeps are heard during the scanning process, and 
full cells are filled in on the Braille display to indicate scanning progress.  
When a Bluetooth device is detected, the Braille Sense U2 QWERTY 
announces "found (Bluetooth device name)". Note: while the Braille Sense 
U2 QWERTY is scanning for Bluetooth devices, it cannot respond to key 
presses. In addition, you may not cancel the scan once it has begun, but 
must wait for its completion before the Braille Sense U2 QWERTY returns to 
normal operation.   
If Bluetooth is turned "Off", or if the Braille Sense U2 QWERTY does not 
recognize the Bluetooth radio, the Braille Sense U2 QWERTY announces, 
"Bluetooth not activated", and  exits the Bluetooth Manager. 
 
When the scanning process completes, you are placed in the Bluetooth 
Device List. If the Braille Sense U2 QWERTY has found other Bluetooth 
devices in range, they are displayed as "device name (untrusted (or trusted)) 
xx/yy" where xx is the number at which the device appears in the list, and yy 
is the total number of devices. "Trusted" indicates that the service has been 
authenticated, "untrusted" indicates the service has not been authenticated. 
If there are no other Bluetooth devices in range, the Braille Sense U2 
QWERTY announces, "no items". You can press “up arrow button” or “down 
arrow button” to move through the list. To select a device from the list, press 
"Enter" on the device name. 
If the Bluetooth device is trusted, settings for connecting the device are 
automatically saved in the Braille Sense U2 QWERTY. If you want to delete 
this information, press "Del" on the Bluetooth device name in the Bluetooth 
Device List. The Braille Sense U2 QWERTY announces, "Device settings 
removed". Removal of the settings applies only to the current device. 
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From the Bluetooth Device List, you can access the menu by pressing “Alt” 
or by pressing "F2". The "Bluetooth Device List menu" contains "Rescan For 
Devices", "Device Name", "Delete Pair Information", and "Exit". You can 
navigate among the menu items using “up arrow button” or “down arrow 
button”. 
The first menu item is "Rescan For Device". This option initiates a new scan 
for other Bluetooth devices. To activate this item, press “Alt” and press 
"Enter" on "Rescan For Device". You can also access this option by pressing 
"r" from within the Bluetooth Device List menu, or you can activate it directly 
by pressing "Ctrl-r". 
You can access the next item in the menu by pressing “Alt” and “up arrow 
button” or “down arrow button” until you reach "Device Name", and press 
"Enter". You can also press "n" from within the menu to activate the "Device 
Name" option. You can access it directly by pressing "Ctrl-n".  
This item allows you to specify the device name given to the Braille Sense 
U2 QWERTY. The default name for the Bluetooth device name is 
"BrailleSenseU2".  When you activate this option, you are placed in a 
computer edit box that contains your current device name. To modify the 
name, type the new name and press "Enter". After entering the new name, 
you should close all programs and reset the Braille Sense U2 QWERTY by 
pressing the "Reset" button on the rear panel of the unit. To cancel your 
changes, press "Esc". You are returned to the Bluetooth Device List. 
The next menu item is "Delete Pair Information". This item allows you to 
remove the connection settings for the current device. To activate this item, 
press “Alt” and press "Enter" on "Delete Pair Information". You can also 
access this option by pressing "d" from within the menu, or you can activate 
it directly by pressing "Del". 
The next item in the Bluetooth Device List menu is the “Exit” item. This item 
will exit the Bluetooth manager program. To activate this item, press “Alt” 
and then press “Up arrow key” or “Down arrow key” to navigate to “Exit.” 

Then, press “Enter” on “Exit.” You can also access the item while in the 

menu by pressing “z” while you are in the Bluetooth Device List menu or at 
any time without calling up the menu by pressing “Alt-F4.” 
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13.2 Bluetooth Service List 
 
When you locate a Bluetooth device to which you'd like to connect, press “up 
arrow button” or “down arrow button” to navigate to the device in the 
Bluetooth Device List, and press "Enter" on the device name. The unit 
announces, "Scanning for services. Please wait…". Please note The Braille 
Sense U2 QWERTY does not respond to key presses during the scanning 
process.  
The Braille Sense U2 QWERTY supports the following Bluetooth services: 
LAN, FTP, ActiveSync, Serial port, USB port, headset, and Bluetooth DUN. 
To access any of these functions, be sure that the remote Bluetooth device 
is in Discoverable mode, and that the service you wish to access is enabled 
on that device. It is possible to have certain services enabled on your remote 
Bluetooth device, while disabling others. For example, you could have LAN 
and FTP enabled, while having ActiveSync and Serial Port disabled. The 
Braille Sense U2 QWERTY only sees and displays services which are 
enabled on your remote device, even if others are available.  
When the Braille Sense U2 QWERTY has found all of the available services, 
the services are displayed in a list in the following format: "service name 
xx/yy" where xx is the number at which the service appears in the list, and yy 
is the total number of available services. You can move through the available 
services by pressing “up arrow button” or “down arrow button”. Press 
"Backspace" to return to the Bluetooth Device List. 
From the Bluetooth Service List, you can access the menu by pressing “Alt” 
or by pressing "F2". The "Bluetooth Service List menu" contains "Device 
Name", "Open FTP", "Disconnect" and "Exit". You can navigate the menu 
items using “up arrow button” or “down arrow button”. 
The "Device Name" and "Exit" options in the "Bluetooth Service List" menu 
are the same as those in the "Bluetooth Device List" menu.  
The "Open FTP" menu item allows you to quickly open a direct FTP 
connection with a remote Bluetooth device without accessing the Device and 
Service lists. However, you must have connected the FTP service previously 
for the Braille Sense U2 QWERTY to allow you to transfer files. If you have 
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not connected the FTP service, and you activate this function, the unit 
announces, "FTP service disconnected".  
You can access "Open FTP" by pressing “Alt” then use “up arrow button” or 
“down arrow button” to navigate to "Open FTP" and press "Enter". The 
Braille Sense U2 QWERTY says, "Connecting service". You can also 
activate it by pressing "t" from within the menu, or by pressing "Ctrl-t" directly 
from the Bluetooth Service List. Connecting various Bluetooth services is 
covered in more detail later in this chapter. 
The "Disconnect" menu item allows you to disconnect services with other 
Bluetooth devices. You can access this item by pressing “Alt” and “up arrow 
button” or “down arrow button” to navigate to "disconnect". Press "Enter" to 
activate it. You can also activate this item from within the menu by pressing 
"d". Or you can activate it directly from the Bluetooth Service List by pressing 
"Ctrl-d". 
To disconnect a service, press “up arrow button” or “down arrow button” to 
navigate to the service in the Bluetooth Service List and execute the 
"Disconnect" command. 
If there are no services connected and you activate this function, the unit 
says, "There is no service connected". 
 

13.2.1 Connecting  a Service 
 
To authenticate a service and connect to it, press "Enter" on the service. The 
Braille Sense U2 QWERTY announces, "Connecting service". You are then 
prompted for a "PIN code:" You must use ASCII characters when you type 
the pin code. This edit box only appears when you have not previously 
connected to a service, and a pin code is required by the device. You can 
exit the edit box or delete text you have typed by pressing "Alt-F4", and you 
are returned to the Bluetooth Service List. 
When you finish typing the pin code, press "Enter". The unit announces, 
"Please wait for authentication". If the remote device is setup correctly, and 
has not been set up to allow this device to always connect, the remote 
device also asks for a pin code. Please be sure to enter the same pin code 
on both devices. If the remote Bluetooth device pin code matches the pin 
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code on the Braille Sense U2 QWERTY, the service should authenticate. If 
connection is successful, the unit announces, "PIN code authentication 
accepted".  
You are then prompted, "Please wait. Access permission". If the remote 
Bluetooth device does not give access permission, the unit says, 
"Connection failed", and you are returned to the Bluetooth Services List. If 
the remote Bluetooth device gives you access permission, the Braille Sense 
U2 QWERTY says "Connection succeeded". If the connection succeeds, 
"Connected" is displayed after the service in the Bluetooth Service List. 
Some services may be connected without inputting a pin code depending on 
the Remote Bluetooth device settings. 
When you are connected to a service, you can press "Ctrl-d" to disconnect 
the service. The Braille Sense U2 QWERTY says, "Service disconnected", 
and you are returned to the Bluetooth Service List.  
If you connect to the FTP service, a list of files and folders on the remote 
Bluetooth device is displayed. The rest of this chapter discusses each 
service in detail. 
 

13.2.2 LAN Service 
 
You can use the LAN service to access the Internet via your computer's 
Internet connection. If you connect this service, you can use the Web 
browser and email program, as if you were connected to the Internet via 
Ethernet or wireless LAN. Before you can connect to the LAN service on a 
remote Bluetooth device, the device must be configured for Internet 
Connection Sharing (ICS). If ICS is not properly setup, you cannot connect 
to the Internet using the LAN service. For information on how to setup ICS 
for your remote Bluetooth device, please refer to the documentation that 
came with your Bluetooth adapter. Setting up ICS requires knowledge of 
network architecture, so it may be a good idea to contact a local network 
technician or your network administrator for help with setting up ICS. 
 

13.2.3 FTP Service 
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This service works similarly to using FTP on the Internet. It allows you to 
transfer folders and files to and from the remote Bluetooth device. When 
referring to the FTP service, we will refer to the file/folder list on the remote 
Bluetooth device as the "remote folder list" and the file/folder list on the 
Braille Sense U2 QWERTY as the "local folder list". 
After you have successfully connected to the FTP service, the Bluetooth 
Manager places you in the remote folder list. The remote folder list displayed 
is determined by the remote Bluetooth device. Typically, this folder is called 
the Bluetooth Exchange Folder, but you should check your remote Bluetooth 
device documentation for definitive information.  
You can interact with the remote folder list in much the same way as you 
interact with files and folders in the File Manager. With the FTP service, you 
can perform the following functions: 
1. Copy 
2. Paste 
3. Send To 
4. Retrieve File 
5. New Folder 
6. Delete File/Folder 
7. Open Local Folder. If you press "Enter" on this option, you are taken to the 
local folder list. If you are in the local folder list, this menu option changes to 
"Move to remote folder". 
8. Select All 
9. Information 
 
In the next few sections, we will discuss the various FTP functions. Please 
note that while sending data to and from the remote Bluetooth device, the 
remote Bluetooth device may still need to give access permission to the 
Braille Sense U2 QWERTY. Please consult the documentation for the 
remote Bluetooth device for details. 
 

13.2.3.1 Copy and Paste 
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These functions allow you to copy and paste files between the local folder 
and the remote folder. 
Use the following steps to copy files from a local folder to the remote folder: 
 
1) From the remote folder list, press “Alt” to open the FTP menu. Press “up 
arrow button” or “down arrow button” to navigate to "Open Local Folder", and 
press "Enter". You can also press "o" while in the menu, or you can press 
“Ctrl-o” to open the local folder directly from the remote folder list. After 
activating this function, the unit says, "Opening Local Folder", and you are 
placed  in the Disk list that appears in File Manager. You are placed on 
"flashdisk" by default, but if you have an SD card or USB memory stick 
inserted, you can navigate to them by pressing “up arrow button” or “down 
arrow button”. 
2) As when navigating in the File Manager, you can access a disk by 
pressing "Enter" on it. Use the same navigation keys as in the File Manager 
to navigate the local folder. Note that you cannot select folders. You can only 
select files. If you try to select a folder, the Braille Sense U2 QWERTY says, 
"Deactivated". 
3) Once you have selected files by pressing "Space", you can copy them by 
pressing “Alt”, and navigate to "Copy" by pressing “up arrow button” or “down 
arrow button”, and press "Enter". Or, you can press "Ctrl-c".  
4) After you have activated the copy command, Braille Sense U2 QWERTY 
announces, "Copying" and "Open Remote Folder". You are then returned to 
the remote folder list. 
5) In the remote folder list, navigate to the folder where you want to paste the 
file. Press "Ctrl-v". Or, you can press “Alt”, and use “up arrow button” or 
“down arrow button” to navigate to the "Paste" function, and press "Enter". If 
the file is larger than 300 KB, progress messages are spoken each time an 
additional 10% is completed. If the file is less than 300 KB, only progress 
beeps are heard.  
6) When the file is pasted successfully, the Braille Sense U2 QWERTY 
displays the message, "xxx file pasted", where xxx is the name of the file. If 
the file is not pasted successfully, "xxx file not pasted" is displayed. After the 
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file is pasted successfully, the unit also announces, "Paste completed", and 
you are returned to the remote folder list. 
 
Use the following steps to copy a file from the remote folder list to the local 
folder list: 
 
1) Navigate the remote folder, just as you would in the File Manager. For 
information on how to navigate the File Manager, please refer to chapter 4 in 
this manual. 
2) Select the files that you want to copy by pressing "Space", you can open 
the FTP menu by pressing “Alt”, and use “up arrow button” or “down arrow 
button” to navigate to "Copy", and press "Enter". You can also activate this 
function by pressing "Ctrl-c". Note that you can only copy files, you cannot 
copy folders, to send to the local folder. 
3) After you have activated the "Copy" function, the Disk list appears as it 
does in the File Manager. You are placed on "flashdisk" by default. However, 
if you have an SD card or USB memory stick inserted, you can navigate to 
those disks by pressing “up arrow button” or “down arrow button”.  
4) After entering a disk, open the menu by pressing “Alt”. Then, move to 
"Paste" with “up arrow button” or “down arrow button”, and press "Enter". 
You can also activate this function by pressing "Ctrl-v". If the file is larger 
than 300 KB, progress messages are spoken each time an additional 10% is 
completed. If the file is less than 300 KB, only progress beeps are heard.  
5) When the file is pasted successfully, Braille Sense U2 QWERTY displays 
the message, "xxx file pasted", where xxx is the name of the file. If the file is 
not pasted successfully, "xxx file not pasted" is displayed. After the file is 
pasted successfully, the unit also announces, "Paste completed", and you 
are returned to the local folder list. 
 

13.2.3.2 Send To 
 
This function allows you to send files from the local folder list to the remote 
folder list. Note: this option is only available in the local folder list. This is very 
similar to the copy and paste function with a couple of notable differences. 
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One difference is that you do not have to paste the file to the remote folder. It 
is done as soon as you activate the "Send To" function. ANOTHER 
difference is that when you activate this function, the file can only be sent to 
the root of the remote folder list. To copy a file using the "Send To" function, 
follow these steps: 
 
1) Press “Alt” from the remote folder list to open the menu. Then, press “up 
arrow button” or “down arrow button” to move to "Open Local Folder", and 
press "Enter". You can also activate this function directly from the "remote 
folder list" by pressing “Ctrl-o”. 
2) After you have activated the "Send To" function, the disk list appears as it 
does in the File Manager. You are placed on "flashdisk" by default. However, 
if you have an SD card or USB memory stick inserted, you can navigate to 
those disks by pressing “up arrow button” or “down arrow button”. Please 
refer to chapter 4 in this manual for information on file and folder navigation. 
3) Select a file by navigating to it and pressing "Space". Note: you can select 
only files; folders cannot be selected. 
4) After you have selected a file, press “Alt”, and press “up arrow button” or 
“down arrow button” to move to "Send To", and press "Enter". Or, you can 
press “Ctrl-s” to activate the "Send To" function directly. 
5) As with copying and pasting, progress beeps are heard during the send 
process. If the file is larger than 300 KB, progress messages are spoken 
each time an additional 10% is completed. If the file is less than 300 KB, only 
the progress beeps are heard. When the transfer is complete, the unit 
announces, "xxx file sent", where xxx is the name of the file. If the file does 
not transfer, the unit says, "xxx file not sent". When all selected files are 
transferred, the Braille Sense U2 QWERTY announces, "Successfully sent", 
and you are returned to the remote folder list. 
 

13.2.3.3 Retrieve File 
 
The "Retrieve File" function allows you to retrieve a file from the remote 
folder list, and move it to the local folder. This function is only available from 
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the remote folder list. When using this function, all retrieved files are saved 
to the "flashdisk/download" folder. Use the following steps to retrieve a file:  
1) Navigate the remote folder list using the same commands as in the File 
Manager (see chapter 4).  
2) PRESS "Space" to select the file you want to retrieve. Note that you can 
select only files, not folders. 
3) After selecting the file, press “Alt” to open the menu, and use “up arrow 
button” or “down arrow button” to move to "Retrieve File", and press "Enter". 
You can also activate this function directly by pressing "Ctrl-r". 
4) As with copying and pasting, progress beeps are heard. If the file is larger 
than 300 KB, progress messages are also spoken each time an additional 
10% is completed. If the file is less than 300 KB, only progress beeps are 
heard. When the transfer is complete, the unit announces, "xxx file retrieved", 
where xxx is the name of the file. If the file does not transfer, Braille Sense 
U2 QWERTY says, "xxx file not retrieved". When all of the selected files are 
transferred, the message "Retrieve completed" is spoken, and you are 
returned to the remote folder list. 
 

13.2.3.4 New Folder 
 
The "New Folder" function allows you to create a new folder in either the 
local folder list or the remote folder list. Use the following steps to create a 
new folder:  
 
1) With the FTP service connected, from either the local or remote folder list, 
navigate to the folder in which you want to create a new folder. Move 
between the "remote folder list" and "local folder list" by pressing “Ctrl-o”. 
Use normal folder and file navigation commands to move among the items in 
the folder list.  
2) Press “Alt” to open the menu, and use “up arrow button” or “down arrow 
button” to navigate to "New Folder", and press "Enter". Or, you can activate 
the "New Folder" function directly from the folder list by pressing "Ctrl-f".  
3) An edit box appears and the unit prompts, "New folder name:". Type the 
new folder name using ASCII characters, and press "Enter". If the folder is 
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created successfully, the Braille Sense U2 QWERTY says, "xxx folder 
created", where xxx is the name of the folder. You are then returned to your 
previous location: either the remote or local folder list. 
4) To cancel the folder creation, press "Alt-F4", and you are returned to the 
previous list. 
 

13.2.3.5 Delete File/Folder 
 
This function allows you to delete files or folders from the remote or local 
folder list. Note that if a folder contains sub-folders, you cannot delete the 
folder. To delete a file or folder, do the following:  
 
1) With the FTP service connected, navigate to the local or remote folder list, 
and select the file(s) or folder(s) you want to delete using "Space". You can 
move between the "remote folder list" and "local folder list" by pressing “Ctrl-
o”. 
 
2) After selecting the file(s) or folder(s) you want to delete, press “Alt”, use 
“up arrow button” or “down arrow button” to move to "Delete File/Folder", and 
press "Enter". You can also activate the "Delete" function directly by pressing 
"Del". 
3) If the file(s) or folder(s) are deleted successfully, "Delete completed" is 
spoken. 
 

13.2.3.6 Information 
 
This function allows you to obtain information about files or folders located in 
the remote or local folder list. You can obtain file or folder information by 
following these steps: 
 
1) With the FTP service connected, navigate to the local or remote folder list, 
and select the file or folder about which you want information.  
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2) Press “Alt” to open the menu, use “up arrow button” or “down arrow 
button” to move to "Information", and press "Enter". Or, you can activate the 
"Information" function directly from the folder list by pressing "Ctrl-i". 
3) The "Information dialog box" appears. The dialog box contains "Type", 
"Size", "Date", "Attribute (except for folders)", and "Close". You can move 
among these controls by pressing “Tab” or "shift-tab". If you select multiple 
files, the "Information" dialog displays the number of selected files and  total 
size. 
 

13.2.4 ActiveSync Service 
 
This service offers the same functionality as connecting the Braille Sense U2 
QWERTY to a computer via USB and using ActiveSync. If the connection to 
the ActiveSync service is successful, you will hear the chime indicating 
ActiveSync is successfully connected. As with all of the Bluetooth services, 
the remote Bluetooth device may need to authorize the Braille Sense U2 
QWERTY. You are then returned to the Bluetooth Service list. As with using 
ActiveSync via USB, you can copy and paste files from the Braille Sense U2 
QWERTY from the remote Bluetooth device to the Braille Sense U2 
QWERTY and vice versa. 
 
To disconnect the service, press "Ctrl-d" from the Bluetooth Manager. The 
Braille Sense U2 QWERTY says, "Service disconnected", and you are 
returned to the Bluetooth Service list.  
You cannot use ActiveSync via USB and Bluetooth at the same time. If the 
remote Bluetooth device is connected via USB and using ActiveSync, you 
must terminate the USB ActiveSync connection on the remote Bluetooth 
device in order to use the ActiveSync service via Bluetooth. 
 

13.2.5 Serial Port 
 
If you connect this service, you should not connect to other Bluetooth 
services. The Serial Port service allows you to use your Braille Sense U2 
QWERTY as a wireless Braille display via Bluetooth. Note: you must be 
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using Window-Eyes, SuperNova, VoiceOver, or another compatible screen 
reader to use the Braille Sense U2 QWERTY as a wireless Braille display. 
To use the Braille Sense U2 QWERTY as a wireless Bluetooth display with 
Window-Eyes or iPhone or iPad, please reference the following sections.  If 
you are using another screen reader than those addressed below, please 
contact HIMS by e-mail at support@hims-inc.com.  
 

13.2.5.1 Setting up the Braille Sense U2 QWERTY to Work as a 
Bluetooth Braille Display with Window-Eyes 

 
The following steps will walk you through setting up the Braille Sense U2 
QWERTY to work as a Bluetooth Braille display with the Window-Eyes 
screen reader from GW Micro. These instructions assume that you already 
have Bluetooth installed on your computer. The following instructions also 
assume that you are running Window-Eyes 5.5, or higher, and at least 
Windows XP, Service Pack 2. Before you begin, make sure that your Braille 
Sense U2 QWERTY is turned on. Although it may not be necessary, you 
should close all running applications on the Braille Sense U2 QWERTY, and 
be placed in the Program menu for best results. If you have more than one 
Braille Sense U2 QWERTY, make sure that only the Braille Sense U2 
QWERTY that you want to configure is turned on. 
 

13.2.5.2 Setting up the Computer 
 
1) Navigate to the Bluetooth icon in the System Tray. You may do this in 
Windows XP by pressing "windows key-b", and use the Right or Left Arrow 
Keys until you reach the Bluetooth icon. Then, press the "context menu key". 
Note that if you don't have the Bluetooth icon in the System Tray, you may 
have to change the settings for the Bluetooth icon to appear. Go to the 
Windows Control Panel, Bluetooth Devices, Options, and check the check 
box that says "Show the Bluetooth Icon in the Notification Area". 
2) Press the "up or down arrow" keys until you get to "Open Bluetooth 
settings". 
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3) Press "Enter". 
4) Select the Device tab control. You may need to press Ctrl-Tab in order to 
select this tab control. 
5) Tab to the Add button. 
6) Press "Enter". 
7) Press "Space" to check the checkbox for "My device is setup and ready to 
be found". 
8) Press enter". 
9) The XP machine will find the Braille Sense U2 QWERTY, and it will be 
called "Windows CE". Remember that the Braille Sense U2 QWERTY must 
be turned on in order to be found as mentioned above. If you forgot to turn 
the Braille Sense U2 QWERTY on, leave it turned on, exit the Bluetooth 
settings, and start at step number 1 above. 
10) Press the "down arrow" key to focus Windows CE. 
11) Tab to the Next button. 
12) Press "Enter". 
13) Press "down arrow" to focus the radio button, "Let me choose my own 
passkey". Focus will automatically be put in the edit box, and you may hear a 
tool tip that says, "We recommend using a passkey that is 8 to 16 digits long". 
You should type your passkey here. For example, you might type, "1111". 
14) Press "Enter". Windows will then begin exchanging the passkeys, and a 
new dialog will appear on the computer. 
15) The Braille Sense U2 QWERTY will then ask for the passkey by saying, 
"Computer Edit Box PIN code:" Using the same passkey that was typed in to 
the computer, type in the same passkey on the Braille Sense U2 QWERTY 
and press "Enter" on the Braille Sense U2 QWERTY. 
16) The computer should display the message, "Found new hardware" and 
the final dialog should appear on the computer. Remember that you can 
press "ctrl-shift-w" to have the entire dialog read using Window-Eyes. The 
dialog should display that the Bluetooth device was successfully set up. It is 
very important to note the COM ports for the outgoing COM port and the 
incoming COM port. For example, the outgoing COM port may be COM 5, 
and the incoming COM port may be COM 6. Do not be surprised if your 
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COM ports are not set to COM 5 and COM 6. The COM ports used can vary 
from computer to computer. 
17) Press “Tab” to get to the Finish button, and press "Enter" to activate it. 
18) You will then be taken back to the Bluetooth device settings dialog. 
Press Ctrl-Tab twice to focus the COM ports tab control. 
19) Press “Tab” to get to the list of COM ports, and press the Down Arrow to 
move through the list of COM ports to make sure that they match the COM 
ports that were mentioned when you completed the Bluetooth device wizard. 
You should hear your first COM port, then the direction, and the name. After 
you press "down" Arrow again, you should hear the next COM port, the 
direction, and name. For example, when you press the "down arrow" key the 
first time, you might hear, "COM 5 Outgoing Windows CE Blue Tooth Serial". 
When you press the "down arrow" key a second time, you might hear, "COM 
6 Incoming Windows CE". 
20) Tab to the OK button, and press Enter. 
You have now setup the Braille Sense U2 QWERTY and the computer. 
However, you must properly setup Window-Eyes in order to use the Braille 
Sense U2 QWERTY as a Bluetooth Braille display. 
 

13.2.5.3 Setting up Window-Eyes 
 
1) Press "ctrl-backslash" to open the Window-Eyes Control Panel. 
2) Press "alt-f" to open the File menu. 
3) Press the "up arrow", or "down arrow" to move to Select Braille Display, 
and press "Enter". Or, just press B to open the Select Braille Display dialog 
without using the Arrow Keys. 
4) Press the "down arrow" or the letter b until you hear Braille Sense U2 
QWERTY. 
5) Press “Tab” to get to the COM port list box 
6) Select the COM port that was given as the outgoing COM port when you 
setup the computer to interact with the Braille Sense U2 QWERTY via 
Bluetooth. 
7) Press "Enter" 
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Now that you have set up Window-Eyes, you need to return to the Braille 
Sense U2 QWERTY to finish the setup.  
 

13.2.5.4 Setting up the Braille Sense U2 QWERTY 
 
1) Press "Win key" to get to the Program menu. 
2) Press “up arrow button” or “down arrow button” to get to the Utilities menu, 
or just press the letter u". 
3) Press "Enter". 
4) Press “up arrow button” or “down arrow button” to get to Terminal for 
screen reader, and press" enter". 
5) Press “up arrow button” or “down arrow button” to get to Bluetooth Serial 
Port, and press "Enter". 
The Braille Sense U2 QWERTY should be connected as a Bluetooth Braille 
display. To exit Terminal Mode, press "Alt-x". Please note that "Win key" on 
the Braille Sense U2 QWERTY still takes you to the Program menu as you 
can continue to multi-task while in Terminal Mode. This enables you to use 
the applications on the Braille Sense U2 QWERTY at the same time, and be 
able to switch back to using the Braille Sense U2 QWERTY as a Bluetooth 
Braille display. 
 

13.2.5.5 Using Braille Sense U2 QWERTY as a Braille display 
with iPhone, iPad, or iPod 

 
Use the following instructions to connect the Braille Sense U2 QWERTY as a 
Bluetooth Braille display with your iPhone, iPad, or iPod. Note: You must be 
running IOS 4.2 or higher on your i-device in order to use the Braille Sense 
as a Bluetooth Braille display with VoiceOver. These instructions refer to the 
iPhone, however, they apply to all compatible i-devices: iPhone 3Gs and 
higher, iPad, and iPod Touch 3G and later. 
 
On the Braille Sense U2 QWERTY: 
1) Turn Bluetooth on using "F9". 
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2) From the Program menu, press u to access the "Utilities" menu, then 
press s to execute Terminal for Screen reader.  
3) Choose "Bluetooth Serial" as your connection type and pres "Enter". 
4) Braille Sense U2 QWERTY displays "connecting" soon followed by 
"Terminal Mode" 
 
On the I-Phone: 
1) Navigate to Settings/General/Accessibility/VoiceOver/Braille. 
2) If Bluetooth is not activated on the I-Phone, it will prompt you to do this. 
WHEN Bluetooth is activated, the I-Phone searches for devices. 
3) The Braille Sense U2 QWERTY should appear in the list of available 
Braille devices. 
4) Double tap the "Braille Sense U2 QWERTY" in the Braille devices list. 
5) You are asked for a pin code. Enter any 4 digit code of your choosing. 
6) Double tap the "Pair" button. 
   
Returning to the Braille Sense U2 QWERTY: 
The Braille Sense U2 QWERTY asks for a pin code. Enter the same pin 
code you entered into the iPhone and press Enter. 
 
You should hear a chime on the iPhone, and the text displayed on the 
iPhone should appear on the Braille display of your Braille Sense U2 
QWERTY. 
 
For information on operating the iPhone using the Braille Sense as a Braille 
Terminal, please refer to Apple's accessibility website at 
www.apple.com/accessibility  
 
To exit "Terminal for Screen reader" press "Alt-x". 
 

13.2.6 Bluetooth keyboard service 
 
You can use this service to connect a Bluetooth keyboard to your Braille 
Sense U2 QWERTY.  
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Before you try to use this service, please be sure the Bluetooth keyboard is 
turned on and in Bluetooth range. 
Use the following steps to connect to a Bluetooth keyboard: 
1) Navigate to the Bluetooth keyboard  in the Bluetooth Device List and 
press "Enter".  
2) "Keyboard" should be displayed in the list of available services.  
3) Press "Enter" on the "Keyboard" service. 
4) If the keyboard requires a PIN code you are prompted to enter it. Some 
devices do not require a PIN code, in which case, you are not prompted to 
enter one.  
5) IF you are prompted, input the  PIN code on the Braille Sense U2 
QWERTY and press "Enter". If the keyboard requires a PIN code, you must 
also input the PIN code on the Bluetooth Keyboard. (You should be able to 
locate PIN code information for the Bluetooth keyboard in the documentation 
that came with it.) 
 

13.2.7 Bluetooth Printer service 
 
You can use this service to print documents from the Braille Sense U2 
QWERTY via a Bluetooth enabled printer.  
Follow these steps to connect to a Bluetooth enabled printer: 
1) Press "F9" to turn on Bluetooth. 
2) Execute "Bluetooth" Manager from the "Program" menu. 
3) The Braille Sense U2 QWERTY scans for Bluetooth devices.  
4) Press “up arrow button” or “down arrow button” to navigate to the 
Bluetooth enabled printer in the Bluetooth Devices List. 
5) Press "Enter". 
6) The Braille Sense U2 QWERTY scans for available services. 
7) PRESS “up arrow button” or “down arrow button” to navigate to the 
"Printer" service. 
8) Press "Enter"  
9) The printer should connect to Braille Sense U2 QWERTY. 
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13.2.8 Using Multiple Services  
 
You can use the LAN, FTP, and ActiveSync Bluetooth services 
simultaneously. However, if you plan to use any of these services at the 
same time, you should connect the FTP service before connecting the LAN 
and ActiveSync services. If you do not connect the FTP service first, you 
may experience problems. If you are using the Serial  
Port service, you should not connect to any other Bluetooth services. 
 

13.3 Hot keys in Bluetooth Manager 
 

Scanning Bluetooth device: Ctrl-r 
Connecting device: Enter on the device name 
Connecting service: Enter on the service name 
Disconnect service in Bluetooth service list: Ctrl-d  
Move to Bluetooth device list in service list: Backspace 
Remove device setting in Bluetooth device list: Del  
 
1) FTP service 
Open local folder/move remote folder: Ctrl-o  
Copy: Ctrl-c 
Paste: Ctrl-v  
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 
Delete file/folder: Del 
Information: Ctrl-i 
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14. Database Manager 
 
The "Database Manager" is a program which can be used to create a 
database in the form that you specify. You can use the "Database Manager" 
to add records and search for data in your records.  
 
Database Terminology 
A table contains at least one record, and a record consists of at least one 
field. You can specify attributes for each of the fields. In other words, a 
record is made up of a group of one or more fields, and a table is made up of 
one or more records. 
 
When the "Database Manager" is started, it checks whether or not a table 
has been created. If no table has been created, a "Table Manager" dialog 
appears to take you through the process of creating a new table. If there is at 
least one table created, the "Search Records" dialog appears and the 
"Search" edit box is focused, so that you can search for data. To close the 
program while adding or searching a table, press "Alt-F4". Or you can use 
the menu. Press “Alt” to open the menu. Move to "Exit" by pressing “up 
arrow button” or “down arrow button” (or up or down scroll button) repeatedly, 
and press "Enter". Or you can type "z" from the menu. 
The general navigation keys for the ""Database Manager"" are as follows. 
1. Moving among controls 
Move to the previous control: Shift-Tab 
Move to the next control: Tab  
2. Moving in a list box 
Move to the previous list item: Up arrow button or up scroll button 
Move to the next list item: down arrow button or down scroll button 
3. Changing the selection in a prompt box 
Select the next value: down arrow button, Space or down scroll button 
Select the previous value: Up arrow button, Backspace or up scroll button 
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The menu in the "Database Manager" consists of the following items. You 
can open this menu by pressing “Alt”. 
 
1. Table Manager: Create, delete, and modify tables, records, and their fields. 
When you start the "Database Manager" for the first time, the "Table 
Manager" dialog appears. 
2. Add record: Add records to the current table. 
3. Search records: Search records in the current table. You can also search 
each field in the table. 
4. List of records found: Use this menu item to navigate a list of records 
found in the table by the previous search. You can delete or modify each 
record in the list. If you have not performed a search before you using this 
function, the message, "no items", is displayed. 
5. Setting backup options: Select the method for backing up the database. 
6. Backup database: Backup all database files used in the "Database 
Manager". 
7. Restore database: Restore the previously backed up database files.  
8. Exit: Used to close the "Database Manager". 
 
These menu items are explained in detail in the sections below. 
 

14.1 Table Manager 
 
Use the "Table Manager" dialog to create, delete, or modify a table. This 
dialog contains the following controls. 
1. Table name list: Displays the name of created tables, and their order in 
the list. 
2. Add table button: Use this option, to create a new table. 
3. Modify table button: Use this option, to change the name of a table, or 
modify the structure of the table, by adding or deleting fields. 
4. Delete table button: Use this option, to delete the table that you have 
selected in the table name list. 
5. Set default table button: Use this option, to set the table that opens by 
default when you run the program. 
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6. Close button: After closing the "Table Manager" dialog, and returns you to 
your previous position in the program. When there is no table created, if you 
press "Enter" on the "Close" button, the "Database Manager" program is 
closed. 
Move among these controls by pressing “Tab” or "shift-tab". 
 

14.1.1 Add Table 
 
"Add table" is a dialog for creating a new table. This dialog contains "Table 
name" edit box, "created fields" list, "Add field" button, "Modify field" button, 
"Delete field" button, "Previous field" button, "Next field" button, "Confirm" 
button and "Cancel" button. Move among these controls by pressing “Tab” or 
"shift-tab". 
Suppose you want to create a table called "address book" which contains 4 
fields: name, telephone, address, and memo. Create this table as follows. 
 
1) In the "Table Manager" dialog, press “Tab” to move to the "Add table" 
button, and press "Enter". Or just press "a" from the dialog. 
2) The "Add Table" dialog appears, and the "Table name" edit box is focused. 
3) Type "address book" and then press “Tab”. 
4) The "created fields" list is focused. As you have not yet added fields, "no 
items" is displayed in the list. As you add fields to this table, they are added 
to this list box. 
5) Press “Tab” to move to the "Add field" button, and press "Enter". Or press 
the shortcut key, "a". 
6) The "Add field" dialog is opened, and the "Field name" edit box is focused. 
7) Type "name" and press “Tab”. 
8) The "Field type" combo box is focused. Press “down arrow button” or “up 
arrow button” to move to "edit box", and press “Tab”. 
9) The "Set primary key" check box is focused. To set the current field as the 
primary key, press "Space" to check it. 
10) Press “Tab” to move to the "Confirm" button, and press "Enter". Now, the 
"name" field has been added to the "address book" table. 
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To cancel adding the field, press “Tab” once more to move to the "Cancel" 
button, and press "Enter". If you have added a new field, you get a message 
saying that a new field has been added. The "created fields" list is shown 
again. Now, "name" field appears in the list, with the form, "name (edit box, 
pri) 1/1". Since only one primary key exists in a table, if you have set a field 
as the primary key, the "Set primary key" check box is not shown in the "Add 
field" dialog when you add another field.  
Add the "telephone", "address", and "memo" fields by repeating steps 5 
through 10 above. Note that you may want to set the "Field type" of the 
"telephone" field to "number", "address" to "edit box", and "memo" to "multi 
line edit box". Once you have added all of the fields you wish to add, press 
“Tab” to move to the "Confirm" button, and press "Enter". 
To change the name of a created field, move to the field name you want to 
change in the "created fields" list. Press "m" or “Tab”, and enter on the 
"Modify field" button. "Field name: (selected field name)" is displayed. Type 
the new name for the field and press "Enter". Though you can change the 
name of a field, it is not possible to change the properties of a field once it is 
created. 
To delete a created field, press “up arrow button” or “down arrow button” 
repeatedly in the "created fields" list to move to the name of the field you 
want to delete. Press “Tab” repeatedly to move to "Delete field" button and 
press enter or press "d", to activate the shortcut key for the "Delete field" 
button. You may also press “Tab” repeatedly to move to the "Delete field" 
button and press "Enter". 
To change the placement of a field in your table, move to the field that you 
want to change in the "created fields" list. Press "p" or "n". Or press “Tab” 
and enter on the"Previous field" button or "Next field" button to change the 
location of the current field. 
The "Add Table" dialog is closed, and the "table name" list box is shown 
again. The newly created table is added to this list, and "address book 1/1" is 
shown in the list. To close the "Table Manager" dialog, press “Tab” to move 
to the "Close" button, and press "Enter". Or press "Alt-F4" to close the dialog. 
Then, the "Search Records" dialog is opened, and the "name" field, the first 
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field of the "address book" table, is shown. Here, type the name you want to 
search for. 
 

14.1.2 Modify Table 
 
"Modify table" is used to modify the name or structure of a created table. It 
contains the same controls as in the "Add Table" dialog. To modify a table, 
press “Alt” to open the menu, and press "Enter" on "Table Manager". Or 
press the hotkey for "Table Manager", "Ctrl-t". When the "Table Manager" 
dialog is opened, the "table name" list is focused. Press “up arrow button” or 
“down arrow button” to move to the table that you want to modify, and press 
"m", the shortcut key for the "Modify table" button. Or press “Tab” repeatedly 
to move to the "Modify table" button, and press "Enter". The "Modify Table" 
dialog appears. This table is the same as the "Add Table" dialog. The only 
difference is that the "Table name" edit box, and "created fields" list contain 
the information already stored in the table. You cannot change the name of a 
table. 
To add additional fields, press “Tab” to move to "Add field" and press "Enter". 
Type the new field name and press "Enter". To delete an already created 
field, press “up arrow button” or “down arrow button” repeatedly in the 
"created fields" list to move to the name of the field you want to delete. Press 
“Tab” repeatedly to move to the "Delete field" button and press enter or 
press "d", to activate the shortcut key for the "Delete field" button. You can 
also press “Tab” repeatedly to move to the "Delete field" button and press 
"Enter". 
To change the order of a field in  your table, move to the field that you want 
to change in the "created fields" list. Press "p" or "n". Or press “Tab” and 
enter on the "Previous field" button or "Next field" button. 
To change the name of a created field, move to the field name you want to 
change in the "created fields" list. Press "m" or “Tab”, and enter on the 
"Modify field" button. "Field name: (selected filed name)" is displayed. Type 
the new name for the field and press "Enter". 
Though you can change the name of a field, it is not possible to change the 
properties of a created field. 
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14.1.3 Delete table 
 
Use this option to delete a table. To delete a table, Press “Alt” to open the 
menu, and press "Enter" on "Table Manager". Or press "Ctrl-t", the hot key 
for opening the "Table Manager". When the "Table Manager" dialog is 
opened, the "Table name" edit box is focused. In this list box, move to the 
name of the table you want to delete by pressing “down arrow button” or “up 
arrow button” repeatedly, and press "d", the shortcut key for the "Delete 
table" button. Or press “Tab” repeatedly to move to the "Delete table" button, 
and press "Enter". You are prompted, "Delete table? Yes". To delete press 
"Enter". To cancel, press "Space" to select "No", and press "Enter". 
 

14.1.4 Set Default Table 
 
When you set a table as the default table, each time the "Database 
Manager" is started, this table is displayed and you are placed in the search 
dialog. If you have created more than one table and you use one of them 
more frequently than the others, it may be convenient for you to set this table 
as the default table. If no table is set as the default table, the last table used 
is displayed when opening the "Database Manager".  
To set a table as the default table, press “Alt” to open the menu, and press 
"Enter" on table manager. You can also press "Ctrl-t", the hot key for 
opening the "Table Manager". The "Table Manager" dialog appears, and the 
"table name" list is focused. In this list, press “down arrow button” or “up 
arrow button” repeatedly to move to the name of the table you want to set as 
the default table. Then press "s", the shortcut key for the Set default table" 
option. Or press “Tab” repeatedly to move to the "Set default table" button 
and press "Enter". Or simply press "Enter" on the name of the table in the 
"table name" list. The Braille Sense U2 QWERTY announces that the table is 
set as the default table, and the "Table Manager" dialog is closed. 
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14.2 Add Record 
 
 Use this option to add information to a table that you have created. When 
the "Database Manager" is started, the "Search Records" dialog is opened. 
To open the "Insert a New Record" dialog, press “Alt” to open the menu, and 
press "Enter" on "Insert a New Record". Or press "Ctrl-n" from the dialog.  
Think of a record as a collection of information (fields) for an object (record). 
Let's consider the "address book" table you created in the previous section. 
YOU can add records to this table using the method described below: 
1) Press “Alt” to open the menu, and press "Enter" on "Insert a New Record". 
Or press "Ctrl-n" from the records list. 
2) The "name" field, the first field in the "address book" table, is shown. Type 
the name of the person for whom you want to create a record, and press 
“Tab”. 
3) The "telephone" field is focused. Type the person's phone number. Since 
this field is a "number" field, a limited set of characters including numbers 
and hyphen is available. Enter a number without the number sign. If you 
press "Space" instead of “-” (hyphen), the hyphen is entered. 
4) Press “Tab” to move to the "address" field. Type the address. 
5) Press “Tab” to move to the "memo" field. Since this field is a "multi edit 
box", you can type multiple lines of text. To start a new line, press "Enter". 
6) Press “Tab” to move to the "Confirm" button. If you press "Enter", the 
record is added to the table. If you do not want to save the record you have 
created, press “Tab” once more to move to the "Cancel" button, and press 
"Enter". Or press "Esc". 
If you have added a record, the "name" field is focused again so you can add 
another record.  
To go back to the "Search Records" dialog, press “Ctrl-s”. To open the 
"Table Manager" dialog, press "Ctrl-t". If you open these dialogs while 
entering a record, you are asked to save the record. Select "Yes" or "No" by 
pressing "Space" or "Backspace", and press "Enter". If you select "Yes", the 
record is saved, and if you select "No", it is not saved and the specified 
dialog is opened. If you select "Cancel", the dialog is not opened. 
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14.3 Search Records 
 
Once you have added records, you will likely want to access this information 
in an efficient manner. To search for information in your records, use the 
"Search Records" dialog. To open the "Search Records" dialog, press “Alt” 
and press "Enter" on "Search Records". Or press “Ctrl-s”. The "Search 
Records" dialog is opened, and the first field of the table is focused. Type the 
text that you want to search for.  
Using the Address Book example, the focused field is the "name" field. Thus, 
type a person's name in the edit box to look up "/her  record. If you have 
several records under the same name, you may wish to further specify the 
record you are looking for. To search for records using content from more 
than one field, press “Tab” to move to another field. Type the text to search 
for in this field, and press "Enter".  
The "List of Records Found", or rather, records that matched your search, is 
opened. In the "List of Records Found", each record is shown in the following 
form. "(the name of the first field) : (other information in the record) xx/yy". 
"yy" is the total number of records found, and "xx" is the order of the current 
record in the list. If no record is found, you are informed, "No records found", 
and the current field is shown again, so you can type another search queery. 
Move through the "List of Records Found" as follows. 
 
1. Move by records 
Move to the next record: Down arrow key or down scroll button 
Move to the previous record: Up arrow key or up scroll button 
Move to the last record: Ctrl-Fn-Right arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 
2. Move between the fields in a record 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to the last field: Fn-Right arrow key 
Move to the first field: Fn-Left arrow key 



328 
 

 
From the "List of Records Found", to search for new text, press “Ctrl-s” to 
open the "Search Records" dialog again. Type the new text you want to 
search for and press "Enter". 
 
To delete a record, press “up arrow button” or “down arrow button” to move 
to the record, and press "Del" from any of the fields in the record. You are 
asked if you really want to delete the record. Select "Yes" or "No" by 
pressing "Space" or "Backspace". If you press "Enter" after selecting "Yes", 
the record is deleted, and if you select "No", the deletion is canceled.  
To search for records in another table, press "Ctrl-t" to open the "Table 
Manager" dialog, and press "Enter" on the name of the table you want to 
open. 
To change the content of a record, select the record by pressing “up arrow 
button” or “down arrow button” repeatedly. And press "Ctrl-m" from any field 
in the record. The same dialog as the "Insert a New Record" dialog is 
opened. To change the content of a field, move to the field by pressing “Tab”, 
type the new content, and press "Enter". To save the modifications, press 
"Enter" after typing new content for all the fields you want to change. Or 
move to the "Confirm" button by pressing “Tab” repeatedly, and press 
"Enter". To cancel modification of the record, press “Tab” once more to move 
to the "Cancel" button and press "Enter". 
 

14.4 List of Records Found 
 
The "List of Records Found" appears when the queery you typed in the 
"Search Records" function produces results. While using the "Insert a New 
Record" or "Search Records" dialog, to go to the "List of Records Found", 
press “Alt” to open the menu, and press "Enter" on "List of Records Found". 
Or  press "Ctrl-r". 
 

14.5 Setting Backup Options 
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You can backup your database file, manually using the "Backup Database" 
function. You may also backup your database file automatically by using the 
"Set Backup Options". To activate the "Set Backup Options" function, press 
“Alt” to open the menu. Press “down arrow button” or “up arrow button” 
repeatedly to move to "Set Backup Option". Press "Enter". Or, press "e" from 
the menu to go to "Set Backup Option". You can also activate the function 
directly by pressing "Ctrl-e". 
The "Backup Options" dialog has three controls: "Backup mode" radio button, 
a "Confirm" button, and a "Cancel" button. Move among the controls by 
pressing “Tab” or "shift-tab". To switch among the radio buttons, press “up 
arrow button”, "Backspace", “down arrow button”, or "Space". 
The "Backup mode" has three radio buttons: "Manual backup", "Always 
backup changes when exiting", and "prompt to backup changes when 
exiting". 
 
1. If you select the "Manual backup", it does not create a new backup file 
even if there are changes in the database. In this case, you can only create 
a new backup file by using the "Backup Database" menu. 
2. If you select the "Always backup changes when exiting", a new backup file 
is automatically created  on exit if you modify or add to the database.  
3. If you select the "Prompt to backup changes when exiting", if you have 
modified or added to the database, you are prompted, "Backup changes? 
Yes" when you exit the "Database Manager". If you press "Enter" on "Yes", it 
automatically creates a new backup file and exits the "Database Manager". If 
you press “down arrow button” once and press "Enter" on "No", it exits 
without creating a new backup file. 
 
To change the backup mode, press "Enter" after focusing on one of the three 
radio buttons. Or, press "Enter" on "Confirm" after moving to it by pressing 
“Tab”. The default backup mode is set to "Prompt to backup changes when 
exiting". 
 

14.6 Backup Database 
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If a hard reset  is performed, or if your battery dies, all of the data in the 
"Database Manager" is lost. Thus, it is very important that you create a 
backup file every time you make a change to the Database file. To go to 
"Backup Database", open the menu by pressing “Alt”. Use “up arrow button” 
or “down arrow button”, to locate "Backup Database". Press "Enter". You can 
also press "u" from the menu to get to "Backup Database". Or, press "Enter-
u" to activate this function directly. 
If you already have a backup file, you are prompted, "Backup changes? Yes". 
If you have made any changes to your database file, press "Enter" to create 
a new backup file. To keep the previous backup file, press "Space", to 
navigate to "No", and press "Enter" on it. When you create a backup file in 
your "Database Manager", a new backup file with the extension SDF is 
saved. The name of the backup file is "UserDatabase.sdf" 
 

14.7 Restore Database 
 
To restore the database file after a hard reset, press “Alt” to open the menu, 
and use the up and down scroll buttons to locate "Restore Database". Press 
"Enter". Or, press "r" from the menu. You can also press “Ctrl-o” to activate 
this function directly. 
If you activate the "Restore Database" function, and you already have a 
database file, you are prompted, "Database file already exists. Restore? 
Yes". If you press "Enter", the backup database file is restored to the current 
database file. To cancel, press "Space" and press "Enter".  
 

14.8 Hot Keys for "Database Manager" 
 

Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r  
Setting backup option: Ctrl-e  
Backup database: Ctrl-u  
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Restore database: Ctrl-o 
 
1. Move by controls 

Move to the next control: Tab  
Move to the previous control: Shift-Tab  

2. Move in a list box 
Move to the next list item: Down arrow key or down scroll button 
Move to the previous list item: Up arrow key or up scroll button 

3. Select your answer in the prompt box 
Move to the next answer: Space or Down arrow key 
Move to the previous answer: Backspace or Up arrow key 

4. Move in the “list of records found” 
Move to the next record: Down arrow key or down scroll button 
Move to the previous record: Up arrow key or up scroll button 
Move to the last record: Ctrl-Fn-Right arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to the last field: Fn-Right arrow key  
Move to the first field: Fn-Left arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
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15. EXTRAS 
 

15.1 Games 
 

15.1.1 Sense Dice game 
 
Ever been at a party and wanted to play "Quarters", but had no dice? You 
don't need to worry about such things anymore. With Braille Sense U2 
QWERTY you always have virtual dice with you anywhere, any time! 
 

15.1.1.1 Executing the Dice Game 
 
1) The Dice Game is located in the "Extras" menu under the main menu. 
Press enter on "Extras" or press "X" from the main menu.  
2) Press "C" or move to "Sense Dice Game" by pressing "Del" and press 
"Enter" to start the game. 
 

15.1.1.2 How it works 
 
When the game starts, a cute little tune is played followed by the 
announcement, "Select the number of dice". You can select 1, 2, or 3 dice 
using “up arrow button” and “down arrow button” and press "Enter".   
 
The number of dice selected is announced, and a popping sound is heard for 
each die you selected. 
Press "Enter" to roll the dice, or gently shake your Braille Sense U2 
QWERTY, and the accelerometer recognizes your motions and activates the 
dice roll.  
A sound is heard to indicate the rolling of the dice, and after a couple of 
seconds, the result is displayed. 
After the result is displayed, the Braille Sense U2 QWERTY announces, 
"Press Space to go on". If you press "Space", you will hear the dice selection 
announcement and sound once again, and you can repeat the dice roll.  
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You can also press "Esc" to return to the "Dice Selection" list and choose a 
different number of dice to roll. 
Press "Alt-F4" to exit the game.  
 

15.1.2 Sense Brain Game 
 
The Sense Brain Game contains 4 different games. You can play anywhere, 
any time and train your brain to be sharper and quicker. Have fun and be 
smarter. 
 

15.1.2.1 Executing the Sense Brain Game  
 
1) The Sense brain game is located in the "Extras" menu under the main 
"program" menu. To enter the "Extras" menu, press enter on "Extras" or 
press "x" from the "program" menu. 
2) To start the Sense Brain Game, press "Enter" on "Sense Brain Game" or 
press "r". 
 

15.1.2.2 Game menu 
 
There are 5 items in the Sense Brain Game menu: 4 games (Memory game, 
Reverse game, Chase a criminal, and Multiplication table) and "View 
ranking". To start playing a game, press enter on a game you want to play. If 
you want to view your past scores, you can access them under "View 
ranking". 
 

15.1.2.3 Playing a Game 
 
When you start each game, an opening song is played followed by 
instructions for playing. Press "Enter" to start the game or press space to 
repeat the instructions. 
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15.1.2.4 Memory game 
 
When the game starts, a group of numbers and letters is announced.  For 
example, at level 1, groups of 3 letter-number combinations are spoken. 
Make sure to memorize these letters and numbers in the order they are 
spoken. 
You are then prompted, "Type the answer", at which time you must write the 
numbers in the order they were given to you and press enter. If the answer is 
correct, The Braille Sense U2 QWERTY applauds you, and you are allowed 
to proceed to the next set of letters and numbers. If the answer is incorrect 
or you take too long to enter the answer, the buzz of failure sounds and the 
game is over. You must type the answer within 10 seconds to avoid the 
despicable buzz and a constructive warning that you may be losing your 
mind.  
When the game is over, your score is announced. If your score ranks 
between 1 and 5, you are asked to "Type your ID". Write your name and 
press enter to record your score. (You can view your recorded scores under 
"View Ranking" in the Sense Brain Game menu. Or press "Esc or "Alt-F4" to 
ignore this dialog. 
Finally, you are asked, "Do you want to play again?" Press enter on "Yes" to 
play the game again. Or press enter on "No" to return to the game menu. 
 

15.1.2.5 Reverse game 
 
This game is similar to the memory game, but as its name denotes, in 
"reverse". When you are prompted to "Type the answer", write the numbers 
and letters in reverse order and press "Enter". If the answer is correct, you 
are applauded and honored with a new challenge. If the answer is incorrect  
or you're too slow, the buzz of shame sounds and the game is over.  
 

15.1.2.6 Chase a criminal 
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When the game starts, you hear the sound of footsteps. A thief is hidden in a 
10-story building. A policeman says on which floor the thief is hiding. But, 
any smart thief won't stay in one place too long, and your job is to catch him. 
As the criminal runs up and down the stairs, the policeman says, "Up" and 
"down" repeatedly to let you know how many floors the criminal is traversing. 
Listen carefully and type the floor on which the thief has chosen to hide 
again. When you are asked to type the answer, type the number of the floor 
on which the thief stowed himself within 10 seconds. Be sure to think fast, or 
that droning buzz reminds you that your brain is failing and the patronizing 
policeman complains that you are interrupting his inspection.   
 

15.1.2.7 Multiplication table 
 
When the game starts, you are given a set of numbers. Level 1 starts you off 
with two. Multiply these numbers.  
When you are prompted to, "Type the answer", type the result and press 
"Enter". If the answer is correct, your math genius continues to be 
challenged. If the answer is incorrect, or you take too long to enter it, the 
pretentious buzz is heard, and the Braille Sense U2 QWERTY helpfully 
suggests you may wish to master the simplicity of addition before attempting 
the complexity of multiplication.    
 

15.1.2.8 View ranking  
 
Enter the "View Ranking" menu to view your scores for any of the brain 
games described above. Press "up arrow button" or "down arrow button" to 
navigate among the games, and press enter on the name of the game on 
which you want information. 
The ranking list is displayed. It shows rank, name and score. Press space to 
view the next record. To return to the "View ranking" menu, press enter. 
 

15.2 Sense Dictionary 
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The Sense Dictionary is an add-on piece of software for the Sense 
notetakers available for purchase from HIMS. The basic package includes 
the New Oxford Mexican Dictionary, and the Concise Oxford American 
Thesaurus. You can also purchase the following additional bilingual 
dictionaries: the Concise Oxford Paravia Italian Dictionary, the Concise 
Oxford Hachette French Dictionary, the Concise Oxford Spanish Dictionary, 
and the Oxford Essential Arabic Dictionary. 
 
Note: If you have not purchased the dictionary package containing the 
dictionary data and license key, pressing "Enter" on the Sense Dictionary 
option in the "Extras" menu results in the message, "Authentication failed". 
For pricing and purchasing information, please contact HIMS, Inc. Call us by 
phone at 888-520-4467, or e-mail sales@hims-inc.com. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



337 
 

 
 



338 
 

16. Social Networking 
 
A social networking service is an online service, platform, or site that focuses 
on building and reflecting of social networks or social relationships among 
people who share interests and/or activities.  
 
To access the Social networking services on the Braille Sense U2 QWERTY, 
follow these steps: 
(1) Make sure The Braille Sense U2 QWERTY has an active Internet 
connection, as all of the services in this menu require online access. If you 
do not currently have an active Internet connection, you can set 1 up using 
the "Setup internet" dialog in the "Utilities" menu. Note: To set up an Internet 
connection, you must have Internet access available via a Wi-Fi network or 
LAN connection.  
(2) Press the short cut key, "c" from the "program" menu. Or use the 
navigation keys to move to "social networking" and press "Enter".  
 

16.1 Available Social Networking services 
 
The Social networking menu on the Braille Sense U2 QWERTY provides 
access to the following services: 
1) Twitter (t) 
2) Google talk (g) 
3) Msn messenger (n) 
 
Accounts for these services should be created via the websites for each 
service before attempting to use the service on the Braille Sense U2 
QWERTY.  
For Twitter: please visit www.twitter.com. 
For GoogleTalk: go to www.google.com. 
For MSN Messenger: visit www.msn.com. 
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In the "Social Networking" menu, you can navigate among the programs by 
pressing “up arrow button” or “down arrow button”. To open a program, 
press "Enter" on the program or type the shortcut key associated with the 
program.  
 

16.2 Twitter 
 
"Twitter" is a micro-blogging service that allows you to post messages in real 
time to those who follow you and read the posts of friends and family as well 
as news sites and other organizations that wish to post information for public 
reading.  
You can also send and receive replies to your posts, repost tweets from 
others, send direct messages to those who follow your tweets, and easily 
search and retrieve tweets by adding them to your favorites.  
 
To launch "Twitter", follow these steps: 
1) From the main menu, press "c" or navigate to "Social Networking" using 
“down arrow button” and press "Enter".  
2) Press "t" or move to "Twitter" and press "Enter". 
 

16.2.1 Twitter Terminology 
 
1) Tweet: A message posted in "Twitter". It is similar to posting on a 
message board. The difference is, there is no space to write a title.  
2) Tweets allow you to post 140 characters regardless of language. A tweet 
can also contain a URL.  
3) Mention: When you repost someone's tweet, reply to someone's tweet, or 
mention them in a tweet of your own.  
4) Reply: to answer a tweet, by a specific user.  
5) Follow: to follow other users. You can subscribe to other user's tweets 
thus, you are following them. 
6) Followers: other users who follow you, or rather, who subscribe to your 
tweets.  
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7) Unfollow: to stop following another user. 
8) Retweet: to deliver another user's tweet to your followers by reposting it. 
Abbreviated using "RT".  
9) Friend: users who follow each other.  
10) DM: Direct Message to or from a specific user. You can only send a 
"Direct Message" to someone who follows you. "Note: direct messages are 
private, thus can only be seen by those who exchange them. 
11) Timeline: a list of tweets in the order they were posted. 

 
16.2.2 Accessing "Twitter" 

 
To use the "Twitter" program, you must create a "Twitter" account. Visit the 
"Twitter" web site at www.twitter.com to create an account. If you already 
have a "Twitter" account, you can use the "Twitter" program after logging in 
To use "Twitter", the Braille Sense U2 QWERTY needs to be connected to 
the Internet. Please be sure you have an active Internet connection before 
starting Twitter.  

 
16.2.2.1 Sign In 

 
When you launch "Twitter", the "Sign In" dialog appears. Move to the next 
control by pressing "Tab" or to the previous control by pressing "Shift-Tab".  
 
The "Sign In" dialog consists of the following: 
 
1) ID: a computer edit box, for typing a "Twitter" account Id.  
2) Password: a computer edit box, for typing your "Twitter" password. 
3) Automatically set the time from the Internet: a check box, to set whether 
the Braille Sense U2 QWERTY Time is synchronized to an Internet Time 
Server. The default is "checked". 
4) Remember me: a check box, to choose whether you save your "Id". The 
default is "Uncheck".  
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5) Save password: a check box, to choose whether you save your 
"password". The default is "Unchecked". 
6) Auto Sign In: a check box, to choose whether you automatically sign in to 
"Twitter" when the program is launched. The default is "Unchecked". Note: to 
use the Auto Sign In function, "Remember me" and "Save Password" check 
boxes must be checked.  
7) Sign In: button, to log in to Twitter 
8) Cancel: button, to cancel log in and exit the "Twitter" program. 
 
To sign into Twitter: 
 
1) When the "Sign In" dialog appears you are placed in the "ID" computer 
edit box. Type your Twitter "Id". Note: the "Id" must be typed using computer 
Braille. 
2) Press "Tab" to move to the "Password" computer edit box. Type your 
Twitter password. Again, you must use computer Braille.  
3) To save "Id" and "password", press "Space" to check both the "Remember 
me" check box and "Save password" check box. 
4) To automatically sign in to "Twitter", when the program opens, press 
"Space" to "check" the "Auto Sign In" check box.  
5) Press "Enter". Or move to the "Sign In" button using "Tab", and press 
"Enter" 
6) Braille Sense U2 QWERTY displays, "Connecting" and tries to sign in to 
"Twitter". If sign-in is successful, "Refreshing Home Timeline" is displayed. In 
a couple of seconds, the list of tweets in your home timeline is displayed. If 
the Braille Sense U2 QWERTY is not connected to the Internet, you are 
prompted, "Please check your internet connection" and you are placed back 
in the "Id" computer edit box. 
 

16.2.2.2 Sign out and Exit 
 
"Sign Out" allow you to sign out of the current Twitter account without closing 
the program. After you sign out, you are returned to the "Sign in" dialog. 
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Press the hot key, "Ctrl-g" to sign out of the current Twitter account, or press 
"Enter" on the "Sign out" option located under the "File" menu.  
To exit the "Twitter" program, press "Alt-F4" or press "Enter" on the "Exit" 
option located under the "File" menu.  
 

16.2.3 Main "Twitter" dialog 
 
If sign-in is successful, you are placed in the main "Twitter" dialog. The main 
"Twitter" dialog consists of 10 controls. Move among the controls using "Tab" 
or "Shift-tab". 
The main "Twitter" dialog contains the following items: 
 
1) Timeline: or list of tweets by those you follow in the order they were 
posted. 
The Timeline displays "User: Tweet" as follows. 
himsintl: Holiday greetings from HIMS International. 
 
In the case of a Mention, the tweet is displayed as "Sender ID: @ receiver Id, 
Tweet" as follows.  
Kimjk:@himsintl Greetings from HIMS International." 
 
A "Retweet", is displayed as "Retweeter Id: RT @ original writer Id: Tweet" 
as follows. 
Bill:RT:@robin: Happy birthday!!. 
 
Use the following navigation keys in the Timeline. 
Move to the next tweet: down arrow button  
Move to the previous tweet: up arrow button 
Move to the first tweet in the current list: Ctrl-Fn-Left arrow key 
Move to the last tweet in the current list: Ctrl-Fn-Right arrow key 
Move up 32 tweets: Page up button 
Move down 32 tweets: Page down button 
 
2) Time: Displays the date and time of the focused tweet.  
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For example, "Friday, January 1, 2011, 3:00 pm" 
 
3) Next list: Pressing "Enter" on this button loads the next group of 32 tweets. 
You can also press the hot key, "Ctrl-n" to load the next list.  
4) Refresh button: Press "Enter" on this button to refresh the Timeline to 
reflect any new tweets posted since you opened "Twitter", or performed your 
last refresh. You can also refresh your timeline by pressing "Ctrl-r".  
5) Tweet button: This button opens the "Tweet" dialog, and places you in the 
edit box where you can write a tweet. You can also open the "Tweet" dialog 
by pressing "Ctrl-t".  
6) Reply button: Use this button to reply to the focused tweet. You can open 
the "Reply" dialog by pressing "Ctrl-y".  
7) Remove button: Press "Enter" on this button when focused on one of your 
own tweets to delete a tweet that you posted. You can also remove the tweet 
by pressing "Del". This button appears, only when one of your own tweets is 
focused. When another user's tweet is focused, this button does not appear. 
8) Retweet button: Use this button to repost another user's tweet. You can 
retweet another tweet by pressing "Ctrl-e". The "Retweet" button does not 
appear when one of your own tweets is focused. 
9) Add to Favorite button: Add the focused tweet to your "Favorites" list. You 
can also add the tweet to your favorites by pressing "Ctrl-v".  
10) Tweet Information: Use this button to view detailed information for the 
focused tweet. You can also view tweet information by pressing "Alt-i".  
 

16.2.4 Timeline 
 
The Twitter program on the Sense notetakers allows you to access a Variety 
of Timelines. In the main "Twitter" dialog, the Timeline displays tweets 
according to the Timeline you have chosen. You can use hot keys to quickly 
bring up the Timeline you desire, whether it is your home timeline, all tweets 
that mention you, or the timeline for a specific user. 
 

16.2.4.1 Available Timelines 
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1) Home Timeline: Your "Home Timeline" is displayed when you sign in to 
"Twitter".  
All tweets by those you follow are posted here. The hot key to access your 
"Home Timeline" is "Ctrl-h" from anywhere in "Twitter". 2) Friend Timeline: 
This displays all tweets, excluding "Retweets". 
The hot key for accessing your "Friend Timeline" is "Ctrl-f".  
3) User Time line: This displays only the tweets posted by a specified user.  
Use the hot key "Ctrl-u" to access the user timeline. After pressing the hot 
key, "Ctrl-u", an edit box appears in which to type the name of the user 
whose timeline you want to access. Press "Enter" to refresh that user's 
timeline.  
4) Current User Timeline: Displays timeline for the user of the currently 
focused tweet. The hot key is "Alt-u".  
5) Mention Timeline: Displays Tweets that mention you, either in reply, 
retweet, or because another user simply mentioned you in his or her tweet. 
The hot key is "Ctrl-m".  
6) Retweet By Me: This timeline contains other users' posts you have 
reposted. The hot key is "Alt-b".  
7) Retweet To Me: This timeline displays tweets reposted by those you 
follow. The hot key is "Alt-t".  
8) Retweet Of Me: Displays tweets you have posted which have been 
reposted by your followers. The hot key is "Alt-o".  
 
YOU can also access the various timelines from the "Timeline" menu in the 
"Twitter" program menu.  

 
16.2.4.2. Refresh 

 
Refresh is a function to renew the list of tweets in the current timeline. When 
you activate this command, Braille Sense U2 QWERTY loads any new 
tweets posted since you opened Twitter or last refreshed the timeline. The 
tweets are arranged in chronological order from newest to oldest. 
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You can refresh a timeline by pressing the hot key "Ctrl-r". Or Press "Tab" 
from the main "Twitter" dialog to move to the "Refresh" button and press 
"Enter". 
 

16.2.4.3 Load Next list 
 
Use this function to load the next list of 32 tweets. Each time you active the 
"Next List" command, the next 32 tweets are added to the current list. The 
list continues to accumulate until you perform a refresh.  
To load the "Next List", use the hot key, "Ctrl-n", or tab to the "Next List" 
button and press "Enter". 
 

16.2.5. Managing "Tweets" 
 

16.2.5.1 Tweet 
 
This command allows you to post a message to the "Twitter" server so that 
your followers can access it next time they log in. 
To open the "Tweet" dialog, press the hot key, "Enter-t" from the main 
"Twitter" dialog, or move to the "Tweet" button using "Tab" and press "Enter". 
Or, you can open the menu and select "Tweet" from the "Tweets" menu.  
The "Tweet" dialog consists of 4 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) Tweet? : An edit box in which to write a tweet.  
2) Characters: A status bar displaying the current number of characters used 
and maximum characters. For example, "Characters: 0/140T". 
3) Tweet: A button used to post the tweet.  
4) Cancel: button used to cancel the posting of a tweet.  
  
To post a tweet, when the "Tweet" dialog is opened, type the message you 
want to post, and press "Enter", or tab to the "Tweet" button and press 
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"Enter". Your time line is then refreshed, and you are returned to the list of 
tweets in your home timeline. 
 

16.2.5.2 Remove Tweet 
 
If you post a tweet that contains mistakes, or about which you change your 
mind on posting, you can remove it. To do this, navigate to the tweet you 
wish to remove and press "Del" or tab to the "Remove" button and press 
"Enter". You are asked if you are sure you want to remove the tweet. Press 
"Enter" to continue with the removal. To cancel removing the tweet, press 
"Space" to change the button to "No" and press "Enter".  
 

16.2.5.3 Retweet 
 
"Retweet" is used to repost a tweet you have received so that those who 
follow you can see it. You may wish to repost a tweet containing an 
important notification, or something fun you wish to share with others.  
 
To retweet a post, locate the post you want to retweet, and press "Ctrl-e". If 
the retweet is successful, the unit announces Tweet completed" and you are 
returned to your timeline. 
 

16.2.5.4 Mention 
 
"Mention" is a tweet in which another user is mentioned, either because you 
are retweeting one of his or her posts, replying to him or her, or because 
you've simply chosen to mention the user in a tweet you are posting. To 
mention a specific user in one of your tweets, use an at-sign in front of the 
user ID when typing it in your tweet.  
The below examples show tweets containing mentions.  
 
Example 1: @Robin Hello, teacher, good to see you on Twitter. 
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Example 2: @Bill and @Robin will be featured on the technology show this 
evening". 
Example addresses a specific user. Example 2 mentions 2 specific users 
and identifies their inclusion on an upcoming technology show.  
 

16.2.5.5 Reply 
 
A "Reply" is simply a reply to a posted tweet. To reply to a tweet, navigate to 
the tweet to which you want to reply, and press "Enter-y(1-3-4-5-6)" or tab to 
the "Reply" button and press "Enter". 
Or, from the menu, select "Reply" in the "Tweets" menu. 
 
The "Reply" dialog contains the same 4 controls as does the "Tweet" dialog. 
Move among the controls by pressing "Tab" or "Shift-tab". 
  
When the "Reply" dialog opens, you are placed in an edit box in which to 
enter the reply post. The user ID of the person you are replying to is already 
filled in with an at-sign preceding it. When you finish typing your reply, press 
"Enter", or tab to the "Tweet" button and press "Enter". If the reply is 
successful, "Tweet completed" is announced and displayed.  
 

16.2.5.6 Tweet Information 
 
The "TWEET Information" dialog provides 2 functions. If the tweet contains a 
link, you can open the link in the "Web Browser". You can also use the 
"Tweet Information" dialog to copy the content of a tweet.  
To open the "Tweet Information" dialog, press "Enter" on the desired tweet.  
The "Tweet Information" dialog consists of 3 controls. Move among the 
controls by pressing "Tab" or "Shift-tab".  
 
1) Content: contains the content of the posted message.  
2) URL: A list containing the various URL's included in a tweet. Using “down 
arrow button” or “up arrow button”, select the URL you want to open and 
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press "Enter". The "Web Browser" is automatically launched and you are 
taken to the web address of the URL.  
3) Close: A button to close the "Tweet Information" dialog and return to the 
Timeline. You can also use  "Esc" To close the dialog.  
 
 
Use the following hot keys in the "Content" box. 
1) Start selection: Ctrl-b  
2) Select all: Ctrl-a 
3) Copy: Ctrl-c 
 

16.2.5.7 Add to Favorites 
 
"Add to Favorites" is a function to add a specific tweet to your "Favorite List". 
You can later access your favorite tweets quickly by bringing up the "Favorite 
list".  
 
To add a tweet to your favorites, navigate to the tweet you want to add, and 
press "Enter-v", or tab to "Add Favorite" and press "Enter". You can also 
execute this command from the "Tweets" menu. If the addition is successful, 
the unit displays, "Completed" and you are returned to your timeline. 
 

16.2.5.8 Favorite List 
 
You can view your favorite tweets by opening the "Favorite list" dialog. To 
open the "Favorite List" dialog, press "Ctrl-l" or, from the menu, select 
"Favorite List" from the "Tweets" menu. The "Favorite List" dialog contains 4 
controls. Move among the controls by pressing "Tab" or "Shift-tab".  
 
1) Favorite list: list of tweets you have added to the "Favorite List" from 
newest to oldest. 
2) Next list: Used to access the next 32 favorites in the list. Press "Ctrl-n" or 
"Enter" on the "Next List" button. 
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3) Remove: A button to delete the focused favorite. You can also press "Del" 
to delete the favorite.  
4) Close: Closes the "Favorite List" dialog and returns you to your previous 
position. You can also use "Esc" to close the "Favorite List.. 
 

16.2.6. Managing Followers and following 
 

16.2.6.1 Follow User 
 
This command is used to start following the tweets of another user. To open 
the "Follow User" dialog, press "Alt-a". Or you can activate "Follow User" 
from the "Follow" menu.  
The "Follow User" dialog consists of 3 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) Follow User id?: An edit box in which to enter the username of the person 
or organization you wish to follow. 
2) Confirm: A button to confirm or execute following the user.  
3) Cancel: A button to cancel following the user.  
 
When the "Follow User" dialog is opened, type the Twitter ID of the user you 
want to follow in the edit box and press "Enter". If the Braille Sense U2 
QWERTY is able to locate the user and follow them, the unit displays, 
"Follow complete" and returns you to your previous position. 
 

16.2.6.2 Following 
 
"Following" gives you a list of those users you follow on Twitter.  
To open the "Following" dialog, press "Alt-l", or choose "Following" from the 
"Follow" menu.  
"Following" consists of 5 controls. Move among the controls by pressing 
"Tab" or "Shift-tab".  
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1) Following: A list of those you follow on Twitter. 
2) About me: A status box displaying the self introduction of the focused user. 
3) Next list: Loads the next 32 users you follow. You can also load the "Next 
List" by pressing "Enter-n". 
4) Remove Follow: A button to remove the user from the list of those you 
follow, or rather, a button to stop following a user. You can also press "Del" 
to delete the focused user from your "Following" list. 
5) Close: A button to close the "Following" dialog. You can also use "Esc" to 
close the dialog and return to your previous position. 
 

16.2.6.3 Followers 
 
"Followers" is a list of Users who follow your tweets. 
To open the "Followers" dialog, press the hot key, "Alt-e", or select 
"Followers" from the "Follow" Menu.  
The "Followers" dialog consists of 5 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) Followers: A list of those who follow your tweets. 
2) About me: A status box displaying the self introduction of the focused user. 
3) Next list: a button to load the next 32 followers in the list. You can also 
load the "Next List" by pressing "Enter-n". 
4) Follow User: A button to start following the focused user. 
5) Close: A button to close the "Followers" dialog. You can also close the 
dialog by pressing "Esc".  
 

16.2.7. Using Direct Messages 
 
THE direct Message function allows you to send and receive Direct 
Messages to and from a specific user. Direct messages can only be seen by 
those who exchange them. You can only exchange direct messages with 
those who follow you.  
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16.2.7.1 Send Direct Message  
 
Use the "Send Direct Message" dialog to send a "Direct Message" (DM) to 
one of your "followers". To open the "Send Direct Message" dialog, press 
“Ctrl-s”, or select "Send Direct Message" from the "Tweets" menu. The 
"Send Direct Message" dialog consists of 6 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) Followers: The list of those who follow you. Select a user from this list to 
send a direct message to that person. 
2) Next list: loads the next 32 followers in your list. Press "Ctrl-n" or "Enter" 
on this button to load the next list. 
3) Message: An edit box in which to type the message you wish to send. 
When done, you may press "Enter" to send the message and return to the 
"followers" list. 
4) Characters: A status bar displaying current characters and maximum 
characters: for example, "Characters: 0/140T". 
5) Send: A button used to send the direct message. Press “Ctrl-s” or "Enter" 
on this button to send your message and return to the "followers" list.  
6) Close: use this button to close the dialog without sending a message. You 
can also use "Esc" to close the dialog. 
 
 

16.2.7.2 Accessing Received Direct Messages 
 
This function allows you to view Direct Messages you have received from 
those you follow.  
To open the "received messages" dialog, press "Alt-r" or select the 
"Received Direct messages" item located in the "Tweets" menu.  
The "Received Direct Messages" dialog consists of 4 controls. Move among 
the controls by pressing "Tab" or "Shift-tab".  
  
1) Received Direct Messages: A list of the messages you have received, 
shown from newest to oldest. Messages are displayed as "ID: message" 
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2) Next list: Loads the next 20 messages in the list. Press "Ctrl-n" or press 
"Enter" on the button to load the next list. 
3) Reply: Use this button to compose a reply to the focused message. You 
can also open the "Reply" dialog by pressing "Ctrl-y".  
4) Close: A button to close the "Received Direct Messages" dialog and return 
to your previous position. You can also use "Esc" to close the dialog. 
 

16.2.7.3 Sent Direct Messages 
 
"Sent Direct Messages" is a dialog displaying the "Direct Messages" you 
have sent to users who follow you. 
To open the "Sent Direct Messages" dialog, press "Alt-m" or select the "Sent 
Direct Messages" item located in the "Tweets" menu.  
The "Sent Direct Messages" dialog contains 3 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
  
1) Sent Direct Messages: A list of messages you have sent to users who 
follow you, displayed from newest to oldest. "Direct Messages" are displayed 
as "Sender Id: Message". 
2) Next list: Loads the next 20 messages in the list. Press "Ctrl-n" or "Enter" 
on this button to load the next list. 
3) Close: Use this button to close the "Sent Direct Messages" dialog and 
return to your previous position. You can also use " Esc" to close the dialog.  
 

16.2.8. Using Search functions 
 
The "Search" function in the "Twitter" program allows you to search 
registered users as well as words contained in tweets posted to the public 
timeline. 
It also offers a "Save Search" function to save words used frequently. 
 

16.2.8.1 Global Search 
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The "Global Search" launches a search for entered text among all "Twitter" 
timelines. You can also follow the user of a tweet in the results of your 
"Global Search".  
To open the "Global Search" dialog, press "Ctrl-f" or select the "Global 
Search" item from the "Search" menu.  
The "Global" search dialog contains 6 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) Search word?: An edit box into which you can enter the word for which 
you want to search. 
2) Next list: Loads the next 20 results in the list. You can load the "Next list" 
by pressing "Ctrl-n" or press "Enter" on the button. 
3) Search results: A list containing the results of your search, such as "User 
Id: Self-introduction". The "Search result" button appears only when there 
are results to display. 
4) Follow User: Select this button to follow the focused user. The "Follow 
User" button appears only when there are search results displayed. 
5) Confirm: Use this button to execute a search.  
6) Cancel: This button closes the "Global Search" dialog and returns you to 
your previous position. You can also cancel by pressing "Esc".  
 
Use the following steps to search for and follow a user. 
(1) Open the "Global search" dialog and you are placed in the "Search word" 
edit box. Type your desired search term.  
(2) Press "Enter", and "Searching" is displayed. 
(3) If the search is successful, search results appear. If no results match your 
search, "No search results" is displayed and you are returned to the "Search 
word" edit box. 
(4) In the search results list, navigate to user whom you want to follow, by 
pressing “down arrow button” or “up arrow button”. 
(5) Press "Alt-a" to follow the focused user. 
 

16.2.8.2 User search 
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"User search" lets you specifically search for entered words among users' 
profiles, id's, and names registered on Twitter. 
To open the "User Search" dialog menu, press "F3" or select the "User 
Search" item located in the "Search" menu. It is similar to the "Global search" 
dialog. 
The "User Search" dialog consists of 6 controls. Move among the controls by 
pressing "Tab" or "Shift-tab".  
 
1) Search word?: An edit box into which you can enter the term for which 
you want to search. 
2) Next List: Loads the next 20 results in the list. You can load the "Next list" 
by pressing "Ctrl-n" or "Enter" on this button. 
3) Search results: a list of results matching your search. Results appear as, 
"User Id: About me". The "Search results" button appears only when there 
are search results to display.  
4) Follow User: Use this button to follow the focused user. The "Follow User" 
button appears only when there are search results. You can also press "Alt-
a" to follow the focused user. 
5) Confirm: Use this button to execute a search. 
6) Cancel: This button closes the "User Search" dialog and returns you to 
your previous position. You can also use "Esc" to close the dialog. 
  

16.2.8.3 Using the "Search word list" dialog 
 
The "Search word list" saves words frequently searched for and help you 
search tweets and User Id's quickly.  
To open the "Search word list" dialog, press "Alt-w" or select the "Search 
word list" item from the "Search" menu.  
The "Search word list" dialog consists of 6 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) Word list: a list of your saved search words. 
2) Global search: Use this button to search tweets for the focused word. 
3) User search: Use this button to search user profiles for the focused words. 
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4) Add search word: Use this button to add a new word to the list. 
5) Remove search word: Delete the focused word from the list using this 
button. 
6) Close: This button closes the "Search word list" dialog and returns you to 
your previous position. You can also use " Esc" to close the dialog.  
" 
Use the following steps to add a word to the "Search word" list: 
(1) From the "Search word list" dialog, press "Enter-a" 
(2) "Save Search?" edit box appears.  
(3) Type the word you wish to add to the list and press "Enter". 
(4) When the entered word is saved, "save completed" message is displayed. 
 
Use the following steps to delete a word from the "Search word list": 
(1) Navigate to the word you want to delete from the list using “down arrow 
button” or “up arrow button”. 
(2) Press "Del". Or tab to the "Remove Search word" button and press 
"Enter". 
(3) "Do you want to delete? Yes" message appears, if you press "Enter", the 
word is deleted. To cancel deletion, toggle the option to "No" using "Space" 
and press "Enter". Or press "Esc". After canceling, you are returned to the 
"Search word list". 
  

16.2.9. Additional Function 
 

16.2.9.1 Viewing and Editing Personal Information 
 
The "Personal Information" dialog allows you to check and edit your personal 
account information. 
To open the "Personal Information" dialog, press "Ctrl-I" or move to the 
"Personal Information" item in the "File" menu and press "Enter". 
 
The "Personal Information" dialog contains the following items. Move among 
the controls by pressing "Tab" or "Shift-tab". 
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1) Name 
2) ID 
3) Homepage 
4) About me 
5) Follow count 
6) Follower count 
7) Edit 
8) Close 
 
In the "Personal Information" dialog, you can edit name, homepage, and 
"about me". Use the following steps to modify your personal information.  
(1) When the "Personal Information" dialog is open, move to the "Edit" button 
by pressing "Tab". 
(2) Press "Enter". You can now modify your personal information using the 
edit boxes displayed: Name EB, Homepage CEB, About me EB. This dialog 
also contains a Save button, and a Close button. 
(3) Type the desired information in the edit boxes. Note: Homepage 
information must be entered using computer Braille. 
(4) Press "Enter" on the "Save" button and a "Refreshing user information" 
message is displayed.  
(5) If the modification is successful, "Save complete" is displayed and you 
are returned to your previous position. 
 

16.2.9.2 Save Current Timeline 
 
The "Save Current Timeline" allow you to save the current timeline as a text 
file. To open the "Save Current Timeline" dialog, press "Alt-s" from the 
"Tweet" dialog or press "Enter" on the "Save Current Timeline" menu item 
located in the file menu.  
The "Save Current Timeline" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
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1) File name: A combo edit box, in which to enter your desired file name. 
The default is "Timeline name current date". For example, "Home Timeline 
20110310". 
2) Confirm: Press this button to save the current timeline.  
3) Cancel: Use this button to exit the "Save Current Timeline" dialog and 
return to the "Tweet" dialog.  
4) File List: A file browser control in which you can change the storage path. 
If you do not change the storage path, the file is automatically stored in the 
"My Documents" folder in the flashdisk. 
 
 

16.3 Google talk 
 
Google Talk is a messaging service that allows you to text or voice chat in 
real time with other Google Talk users as well as easily and quickly send 
files to your Google Talk contacts.  
To launch Google Talk, do the following:  
1) From the main menu, press "c" or move to "Social Networking" using 
“down arrow button” and press "Enter".  
2) Press "g" or move to "Google Talk" and press "Enter". 
 

16.3.1 Before you launch Google Talk 
 
To use the Google Talk service, you must have a Gmail account. If you do 
not have a Gmail account, visit the Gmail website (http://gmail.google.com) 
and create a Gmail account. If you have a Gmail account registered, you can 
use your Gmail ID and password to log into Google Talk.  
You must also have an active connection to the Internet to use Google Talk,  
  

16.3.1.1 Sign In 
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When you launch Google Talk, the "Login" dialog appears. The "Login" 
dialog consists of 7 controls. Move among the controls by pressing "Tab" or 
"Shift-tab". 
 
1) E-mail: A computer edit box in which to enter your Gmail address. 
2) Password: A computer edit box to input your Gmail password.  
3) Remember me: A check box for choosing whether or not to save your 
user ID. The default is set to "Uncheck". You can check the box by pressing 
"Space". 
4) Save password: This is a check box for choosing whether or not to save 
your password. The default is set to "Uncheck". You can check the box by 
pressing Space".  
5) Auto Sign In: This is a check box for choosing whether or not to sign in 
automatically. 
If you check this box, the program will sign you in automatically when you 
open it using the registered e-mail account. Note: to use this function, you 
must check the "Remember me" and "Save password" check boxes. If you 
do not check these boxes, the auto sign in function will not work. 
6) Sign in: A button to initiate log in to Google Talk.  
7) Cancel: This button cancels login and closes the Google Talk program. 
 
  
Once you are logged in to Google Talk, the contact list appears. The contact 
list is displayed in Braille as "(Status) ID XX/YY" and "chat name, status, 
XX/YY" is announced. "YY" represents the total number of contacts and "xx" 
refers to the placement of the current contact in the list. When a contact is 
online, the status is displayed as "NLN". When a contact is offline, the status 
is displayed as "FLN". If a contact is Idle, the status is displayed as "idle".  
 
Use the following keys to navigate the "contacts list" dialog. 
Move to the previous contact: Up arrow button  
Move to the next contact: down arrow button 
Move up 32 items in the contact list: Page up button 
Move down 32 items in the contact list: Page down button 
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Move to the first item in the contact list: Ctrl-Fn-Left arrow key  
Move to the last item in the contact list: Ctrl-Fn-Right arrow key  
 

16.3.1.2 Sign Out & Exit 
 
Use the "Sign Out" function to sign out of the current account without closing 
the Google Talk program. When you sign out of the current account, you are 
returned to the "Sign in" dialog where, if you wish, you may log in with a 
different Google account. You can execute "Sign Out" by pressing "Ctrl-l" or 
by pressing "Enter" on "Sign Out" from the "File" menu.  
To exit the Google Talk program, press "Alt-F4" or press "Enter" on "Exit" in 
the "File" menu.  
  

16.3.2 Managing Contacts 
 
When you log in to Google Talk, your contact list appears. When you use 
Google Talk for the first time, your contact list is empty. The sections below 
describe how to add, delete, and interact with contacts.   
 

16.3.2.1 Add Contact 
 
Use the "Add Contact" function to add a new contact to your contact list.  
To open the "Add Contact" dialog, press "Alt-q or open the menu by pressing 
F2, navigate to the "Contact" menu, "Contact" and press "Enter" on "Add 
Contact".  
  
The "Add Contact" dialog consists of 3 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) E-mail: A computer edit box, into which you can input the e-mail address 
of the user you want to add.  
2) Confirm: A button to save the new contact to your contact list. You can 
also press "Enter" after typing the e-mail address to add the contact.  
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3) Cancel: Use this button to close the "Add contact" dialog and return to 
your contact list. 
  
  
After you add a contact, the contact displays as "off-line" until he or she 
accepts your contact invitation.  
After the contact accepts your request, the contact's status is reflective of his 
or her actual status.  
 

16.3.2.2 Delete Contact 
 
Use the "Delete Contact" function to delete a contact from your contact list. 
When you delete a contact, the user can no longer send you messages or 
see your status. 
To delete a contact, do the following: 
 
1) Navigate to the contact you want to delete in the contact list.  
2) Press "Del" or press "Enter" on "Delete Contact" from the "Contact" menu.  
3) You are prompted, "Do you want to delete XXX in the contact list? Yes". 
"XXX" is the user ID to delete. If you press "Enter", the contact is deleted.  
To cancel deletion of the contact, press "Space" to change to "No" and press 
"Enter". Or press "Esc" to cancel deletion. After canceling deletion, you are 
returned to the contact list. 
 

16.3.2.3 Block Contact 
 
You can block a contact in your "Contact list" from sending messages to you 
or seeing your status. Block is different from delete in that after blocking a 
contact, the contact ID remains in the Block list. When you delete a contact, 
the contact ID disappears from the contact list completely, yet the person 
may send you future contact invitations.  
 
To block a contact, do the following: 
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1) Navigate to the contact you want to block in the contact list.  
2) Press "Alt-b" or press "Enter" on "Block Contact" from the "Contact" menu.  
3) You are prompted, "Block XXX? Yes". "XXX" is the user ID to block. If you 
press "Enter", the contact is blocked.  
To cancel blocking the contact, press "Space" to change to "No" and press 
"Enter". Or press "Esc" to cancel blocking the contact. You are then returned 
to the contact list. 
 

16.3.2.4 Manage Block List 
 
The Block list contains the contacts you have blocked. You are able to 
unblock contact that you have blocked using this list. 
To open the "Manage Block list" dialog, press "Alt-m" or press "Enter" on the 
"Manage Block list" item in the "Contact" menu.  
  
The "Manage Block list" dialog consists of 3 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) E-mail: A list displaying the e-mail addresses of your blocked contacts.  
2) Unblock: this button unblocks the focused contact.  
3) Cancel: A button to close the "Block contact"  dialog and return you to 
your previous position. 
 

16.3.2.5 Contact Information 
 
Use the "Contact Information" function to display the on-line ID and E-mail of 
the selected contact and the contact request status. To open the "Contact 
Information" dialog, navigate to the contact in the list you want to view using 
“up arrow button” or “down arrow button” and press "Ctrl-I". Or you can open 
the menu and press "Enter" on "Contact Information" from the "Contact" 
menu.  
The "Contact Information" dialog consists of 2 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
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1) Contact Information: A Status area containing several pieces of 
information about the contact. Move to each item using “up arrow button” or 
“down arrow button”. 
 
A. Display name: Displays on-line ID set on the "My Status Options". 
B. E-mail: Displays E-mail account.  
C. Chat: Displays whether chat is "Enabled" or "Disabled". 
D. File sharing: Displays whether it is possible to send/receive files with this 
contact.  
E. Voice Chat: Displays whether voice chatting is possible.  
F. Status contact: Displays current contact request status such as 
"acceptance" or "standby".  
2) Close: A button to close the "View Contact Information" dialog and return 
you to the "Contact" list. 
 

16.3.2.6 Manage Contact List 
 
When you log into “Google Talk”, if you have pending contact requests 
dialogs pop up asking whether you accept each invitation.  All unanswered 
contact requests appear and can be acted on in the "Manage Contact List". 
Access the "Manage Contact List" to accept or reject pending contact 
requests.  
To open the "Manage Contact List" dialog, Press "Ctrl-p" or Press "Enter" on 
"Manage Contact List" from the "Contact" menu. 
The "Manage Contact List" dialog consists of 4 controls.  
1) E-mail: A list displaying user ID's of those requesting you to add them as a 
contact. 
2) Accept: A button to accept the focused user ID as a contact.  
3) Reject: A button to reject the focused user ID as a contact.  
4) Close: A button to close the dialog and return to the ""contact" list. 
  
 

16.3.3 Start Chat 
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Use the "Start Chat" function to open a conversation window through which 
you can send and receive text messages with the focused contact in your 
"Contact" list.  
To send a message to the focused contact, press “Ctrl-s” or navigate to the 
desired user ID, using “up arrow button” or “down arrow button” and press 
"Enter". Or open the "Actions" menu, and press "Enter" on the "Start Chat" 
option.  
 
 
The "Chat" dialog consists of 2 controls. Move among the controls using 
"Tab" and "Shift-tab" 
1) Input: An edit box into which to type your message.  
2) History: A read only edit combo box to view messages sent and received 
in chronological order. Messages are displayed as "Writer ID: message 
content".  
  
Use the following navigation keys in the "History" list. 
Move to the previous message: “up arrow button” 
Move to the next message: “down arrow button” 
Move to the first message: "Ctrl-Fn-Left arrow key" 
Move to the last message: "Ctrl-Fn-Right arrow key" 
 
To move to the "Contact list" while in a "Chat", press "Ctrl-t". Or choose 
"Contact list" from the "Actions" menu. If you select another contact from the 
"Contact list" and press "Enter", a new "Chat" window is opened.  
  
When multiple chat windows are opened, you can move among them using 
the following hot keys: 
Move to previous "Chat" window: "Ctrl-Shift-Tab key" 
Move to next "Chat" window: "Ctrl-Tab key" 
You can also move among chat windows by choosing the "Move to Next 
Chat" or "Move to Previous Chat" options from the "Actions" menu.  
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While in your "Contact list", you can press "Ctrl-t", to return to the most 
recently used "Chat" window. Or press "Enter" on the "Move to Recent Chat" 
option in the "Actions" menu.  
To exit "Chat" windows, press "Alt-F4” or "Esc" 
 

16.3.4 Start Voice Chat 
 
Use the "Start voice chat" function to start a real time voice conversation with 
a contact in your contact list. Unlike text chat, it is only possible to converse 
with one contact at a time using voice chat. However, you can send and 
receive text messages while having a voice conversation.  
Use the following steps to request a voice chat with one of your contacts: 
 
(1) Navigate to the contact in your list with whom you wish to have a voice 
chat, and press "Ctrl-h". Or press "Enter" on the "Start Voice Chat" item in 
the "Actions" menu. 
(2) The "Chat" window is opened, and "Calling" is displayed and a ringing 
sound is heard as the contact is alerted to the incoming chat request. The 
voice chat starts immediately, after the contact accepts your chat request. 
You can request a voice chat from the text "Chat" window as well as from the 
contact list.  
If you press "Enter" on "Cancel" (Esc while the "calling" message is 
displayed, you are returned to your previous position, and the voice chat 
request is canceled.  
 
When you receive a voice chat request, you can accept or reject as follows. 
(1) When you receive a request to start a voice chat, you are prompted, 
"calling from XXX? Accept question button". "XX" refers to the user 
requesting the voice chat.  
(2) Press "Enter" to accept the request and start the voice conversation. To 
reject the request, press "Space" to change the button to "Reject" and press 
"Enter". After rejecting, you are returned to your contact list. 
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16.3.5 Sending/Receiveing a file 
 
The Google Talk program on the Braille Sense U2 QWERTY supports the 
ability to send and receive files. With this function, you can send your files to 
your Google Talk contacts and save files from your contacts on your Braille 
Sense U2 QWERTY. 
 

16.3.5.1 Sending a file 
 
Use the "Send File" function to send files to your contacts. It allows you to 
send multiple files at one time, as well as to exchange messages in the 
"Chat" dialog while sending files.  
To send a file(s) to one of your contacts, do the following: 
 
(1) Navigate to the contact in your list to whom you want to send a file and 
press "Enter". The "Chat" window is opened.  
(2) Press hot key, "Ctrl-f". Or select the "Send File" option in the "Actions" 
menu.  
(3) You are placed in a file browser area. Use normal File Management 
commands to navigate to and select files you wish to send. 
(4) Sending File Information appears. It is displayed in the "Received 
message" area of the chat-window. The information is displayed as "Send: 
Pending acceptance XX File, file name". "XX" represents the number of files 
which you have requested to send. 
(5) If your contact accepts receipt of the file or files, transfer begins. Once 
sending starts, progress rate and file name are displayed on the 
"Sending/receiving file information" list.  
(6) When file transfer is completed, you are return to the Sending/Receiving 
File Information list. It is displayed as "Send: complete XX File, file name".  
To cancel sending files, move to the desired file on the "Sending/Receiving 
File Information list" and press "Esc" key. File transmission is canceled and 
the "Sending File Information list" displays "Send: Me canceled. XX, file 
name". If your contact cancels receiving files during transfer, the "Sending 
File Information list" displays "Send: To canceled. XX, file name". 



366 
 

 

16.3.5.2 Receiving a file 
 
In addition to sending files to contacts, you can receive files they wish to 
send to you. You can receive multiple files at once, and exchange messages 
in the "Chat" dialog while receiving files.  
Use the following steps to receive files from one of your contacts: 
  
(1) When a contact requests to send you a file, "XXX send to file" message 
is displayed.  The "Chat" window is opened and the "Receiving File 
Information list" is focused.  
(2) The "Receiving File Information list" displays "Receiving: Pending 
acceptance XX file name". "XX" refers to the number of files your contact is 
requesting you receive. 
(3) To accept file transmission, press "Enter". File transfer begins.  
Once sending starts, progress rate and file name are displayed on the 
"receiving file information" list.  
(4) When Receiving File is completed, you are return to the Receiving File 
Information list. It is displayed as "Receive: complete XX File, file name".  
To cancel receiving a file, move to the file on the "Receiving File Information 
list" and press "Esc" key. File transmission is canceled and the "Receiving 
File Information list" displays "Receive: Me canceled. XX, file name". If your 
contact cancels sending files while receiving, the "Receiving File Information 
list" displays "Receive: To canceled. XX, File name". 
 

16.3.6 Other functions 
 
The Google Talk Program on the Braille Sense U2 QWERTY supports 
additional features such as "Save conversation" and "Export/ Import Contact 
list", etc. The following is a detailed explanation of these additional features. 
 

16.3.6.1 Save Conversation 
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"Save Conversation" is a function to save messages exchanged with a  
contact as a text file. 
To execute this function, press "Alt-s" from the "Chat" window or select the 
"Save Conversation" item located in the "File" menu. 
 
The "Save Conversation" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab".  
 
1) File Name: A combo edit box in which to type in the name you want to 
give the conversation file.  
2) Confirm: A button to confirm and save the conversation.  
3) Cancel: Use this button to cancel saving the conversation and return to 
the "Chat" window.  
4) File list: A file browser area in which to set the path to save the 
conversation. By Default, the conversation is saved to the "My Documents" 
folder on the flashdisk. Use normal file and folder navigation to choose a 
different location.   
 

16.3.6.2 Manage Chat 
  
"Manage Chat" Allows you to view information about the open chat windows 
and to move directly to the selected window. You can also view the status of 
file transfers using this dialog. To open "Manage Chat" press "Ctrl-m” from 
the contact list or press "Enter" on the "Manage Chat" item in the "Actions" 
menu. 
"Manage Chat" consists of 5 controls. Move among the controls by pressing 
"Tab" or "Shift-tab". 
 
1) Chat list: a list of the currently open chat windows. You can navigate to a 
specific chat window using “up arrow button” or “down arrow button” and 
press "Enter".  
2) Status of sending File: A status bar displaying the status of 
sending/receiving files. This status bar only appears if you are currently 
sending or receiving files. 
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3) Move to Chat: Use this button to move to the selected chat window.  
4) Close chat: Use this button, to close the selected chat window.  
5) Cancel: Use this button to exit the "Manage Chat Window" dialog and 
return to the "Contact list". 
 

16.3.6.3 Find 
 
The "Find" command searches for a word or character string in the "History" 
edit box of the chat window. This can be useful in a situation where many 
messages are exchanged.  
To Execute "Find", press "Ctrl-f” from the chat window or press "Enter" on 
the "Find" item in the "Edit" menu.  
  
"Find" consists of 4 controls. Move among the controls by pressing "Tab" or 
"Shift-tab". 
 
1) Text to find: An edit box into which to enter the word you want to find. 
2) Search direction: A prompt button for choosing your search direction: 
"Forward" or "Backward". If you choose "Forward", the search is performed 
from the current position to the top of the chat. And if you choose "Backward", 
the search is performed from the current position to the end of the chat. You 
can change the search direction by pressing "Space" or "Backspace".  
3) Confirm: A button to execute "Find". 
4) Cancel: Use this button to exit the "Find" dialog and you are returned to 
the "Chat" window. 
  

16.3.6.4 Export Contact List  
 
You can use the "Export Contact list" function to save your "Contact list" as a 
CSV file. 
To open the "Export Contact list" dialog, press "Alt-x" from the "Contact list" 
or press "Enter" on the "Export Contact list" item in the "File" menu.  
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The "Export Contact list" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) File name: A combo edit box into which you can type the name for the 
contact list file.  
2) Confirm: Use this button to execute the "Export Contact list" function. 
3) Cancel: Use this button to exit the "Export Contact list" dialog and return 
to the "Contact list".  
4) File list: A file browser control in which you can set the path to save the 
"Contact list". Use normal file and folder navigation commands to navigate 
this list.   
 

16.3.6.5 Import Contact List  
 
You can use the "Import Contact List" function to import a CSV formatted 
contact list.  
To open the "Import Contact List" dialog, press "Alt-I" from the "Contact list" 
or press "Enter" on the "Import Contact list" item in the "File" menu.  
The "Import Contact List" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) File name: A combo edit box into which you can type the name of the file 
you want to import.  
2) Confirm: Use this button to execute the "Import Contact list" function. 
3) Cancel: Use this button to exit the "Import Contact list" dialog and return to 
the "Contact list".  
4) File list: A file browser control from which you can select the desired 
contact list file (CSV). Use normal file and folder navigation commands to 
navigate the file list. When you locate the file you want to import, press 
"Enter". 
 

16.3.7 Setup Options 
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The Google Talk Program on the Braille Sense U2 QWERTY contains 
several option settings, including "My status options", "on-line ID", "auto-
reply" "notification and sound". Below is a detailed explanation of each of 
these option settings.  
 

16.3.7.1 My status Options 
 
This menu allows you to set how your status and on-line ID is displayed to 
your contacts.  
To open the "My status options" dialog, press "Alt-u" from the contact list or 
press "Enter" on "My Status Options" from the "Options" menu. 
 
The "My Status Options" dialog consists of 3 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) My Status: A list from which you can select one of 5 status options: On-
line, Away, Idle, DND, Chat, or Off-line. Navigate among the options using 
“up arrow button” or “down arrow button”. 
2) Confirm: Use this button to save the setting. 
3) Cancel: Use this button to exit the "My status Options" dialog and return to 
your "Contact list".  
 

16.3.7.2 Action Options 
 
The "Action Options" dialog allows you to set auto-reply, idle time Display 
Contact List, etc.  
To open the "Action Options" dialog, press "Alt-a" from the contact list or 
press "Enter" on the "Action Options" item in the "Options" menu.  
  
The "Action Options" dialog consists of 5 controls. Move among the controls 
by pressing "Tab" or "Shift-tab". 
 
1) Action setting: A list of various option settings. Move among the settings 
using up arrow button or down arrow button.  
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A. Display contact list: Choose whether the contact list displays all contacts 
or only online contacts. Use "Space" or "Backspace" to change the setting.  
B. Contact request: Setup how to respond to an incoming contact request. 
The options are, "notification", "accept" and "reject". If you choose 
"notification", you are notified of the request and question to "accept" or 
"reject" the request. If you choose "accept", the request is automatically 
accepted. If you choose "reject", the contact is rejected automatically. Use 
"Space" and "Backspace" to change the value of the setting.  
C. Incoming chat request: Choose how to respond to an incoming chat 
request. You can choose to move to the chat-window immediately or for your 
focus to remain in the contact list. You can choose between "Move to the 
chat" and "Don't move". Use "Space" and "Backspace" to change the setting.  
D. File transfer request: This option allows you to set how to respond when 
one of your contacts requests to send you a file. The options are, "Alerts", 
"accept" and "reject". If you choose "Alerts", you are notified of the file 
transfer request and question to choose "Accept" or "Reject". If you choose 
"Accept", the transfer request is accepted automatically. If you choose 
"Reject", the request is automatically rejected. You can change the setting 
using "Space" or "Backspace". 
E. Incoming voice chat request: Choose how to respond when a contact 
requests to voice chat with you. Again, the options are, "Alerts", "accept" and 
"reject". If you choose "Alerts", you are notified of the voice chat request and 
question to choose "accept" or "reject". If you choose "accept", the voice-
chat request is accepted automatically. If you choose "reject", the voice chat 
request is rejected automatically. Use "Space" or "Backspace" to change the 
value of the setting.  
F. Auto reply to incoming chat request: You can set whether you send an 
auto-reply message when one of your contacts requests  a chat. You can 
choose between "Yes" and "No". Use "Space and "Backspace" to change 
the setting.  
2) Auto-reply message: An edit box into which to type a message for use 
with the auto reply function.  
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3) Show me as "Away" when I’m inactive for: When there is no input for the 
specified amount of time, your status is automatically displayed as "Idle". 
Enter time in minutes. 
4) Confirm: A button to save the settings. 
5) Cancel: A button to exit the "Action Options" dialog and return to the 
"Contact list".  
 

16.3.7.3 Alert Options 
 
The "Alert Options" dialog lets you set whether you use Message Sound 
Notifications While in Current Window and whether to play the keyboard 
sound when someone is typing. To open the "Alert Options" dialog, press 
"Alt-o" from the contact list or press "Enter" on the "Alert Options" item from 
the "Options" menu.  
The "Alert Options" dialog consists of 3 controls. Move among the controls 
by pressing "Tab" or "Shift-tab". 
 
1) Setting list: A list of various option settings. Move among the options using 
“up arrow button” or “down arrow button”. 
A. Play keyboard sound: You can select whether the keyboard sound is 
heard when you are typing a message. You can choose between "Yes" and 
"No"  by pressing "Space" or "Backspace". 
B. Message Sound Notification While Messenger is In the Background: You 
can set whether notification sounds are heard to alert you of events such as 
incoming chats, requests for file transfers, or changes in contact status while 
Google Talk is running in the background. You can choose between "Yes" or 
"No" by pressing "Space".  
C. Message sound Notification: You choose whether you hear notification 
sounds to alert you to Google Talk events.  You can choose between "Yes" 
and "No".   
2) Confirm: Use this button to save your settings. 
3) Cancel: Use this button to close the dialog without saving your changes 
and return to the "Contact list".  
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16.3.7.4 Path Options 
 
The "Path Options" Allows you to set the path for saving conversations, file 
transfers, and temporary storage. To open the "path options" dialog, press 
"Alt-p" or press "Enter" on the "Path Options" item from the "Options" menu. 
The "Path Options" dialog consists of 5 controls. Move among the controls 
by pressing "Tab" or "Shift-tab".  
 
1) Set download path: A button to set the path for saving messages. If you 
press "Enter" on the button, the "Set path" dialog appears. Navigate to your 
desired folder and press "Enter".  
2) Set temporary path: A button to set the path for saving temporary files. If 
you press "Enter" on this button, the "Set path" dialog appears. Navigate to 
your desired folder and press "Enter".  
3) Saving download path: A button to set the path for saving received files. If 
you press "Enter" on this button, the "Set path" dialog appears. Navigate to 
your desired folder and press "Enter".   
4) Confirm: Use this button to save your settings. 
5) Cancel: Use this button to close the "Path Options" dialog without saving 
changes and return to the "Contact list".  
 
 

16.4 MSN messenger 
 
The MSN messenger program on the Braille Sense U2 QWERTY is very 
similar in its operation to that which runs on a Personal computer. This is 
because we have made every attempt to keep the structure and features the 
same as those that are found in the MSN messenger program that runs on a 
PC. Using MSN messenger, you can chat online with other registered users 
of MSN messenger. Note that you need to create an MSN messenger 
account with Microsoft before using this service. 
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To launch MSN messenger, from the "Social Networking" menu, press the 
short cut key, "n". Or press “up arrow button” or “down arrow button” to move 
to "MSN messenger" and press Enter. 
 

16.4.1 Getting Started with MSN Messenger 
When you launch MSN messenger, the log-in dialog is displayed. 
1) When the log-in dialog appears, you are placed in the "E-mail" computer 
edit box. Type the e-mail address you have registered for your MSN 
passport in computer Braille.  
2) Press “Tab” to move to the "Password" computer edit box. Type the 
password you have setup for your MSN messenger account. Again, you 
need to use computer Braille.  
3) Press “Tab” to move to the "Remember me" check box. By default, this 
check box is unchecked. You can check the check box by pressing "space". 
THE next time you run the messenger program, the e-mail address is 
displayed automatically for you. 
4) Press “Tab” to move to the "Save password" check box. By default, this is 
unchecked. You can check this option by pressing "space". Next time you 
run the messenger program, the password is entered automatically, and is 
displayed in the password edit box as asterisks. To use this feature, also 
check the "Remember me" check box. Otherwise, the password is not stored 
even if you have checked the "Save password" check box. 
5) Press “Tab” to move to the "Auto Sign In" check box. The default is 
"Uncheck". To automatically log in when MSN messenger is opened, press 
"Space" to change to setting.  
6) Press “Tab” to move to the "Confirm" button. Pressing "Enter" logs you in 
to your Messenger account. Once you are logged in, a contact list appears. 
To cancel logging in, press “Tab” once more to move to the "Cancel" button. 
Then press "Enter". Or you can also press "Alt-F4". The messenger program 
closes. 
 
If you have successfully logged in and checked "Remember me" and "Save 
password", the next time you run MSN Messenger, you are automatically 
logged in.   
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If you try to execute MSN Messenger when the Braille Sense U2 QWERTY 
is not connected to the Internet, the Braille Sense U2 QWERTY announces 
"Connection failed. please check your Internet connection." and returns to 
the log-in dialog. 
 

16.4.2 Using a Contact List 
If you have successfully logged in, a list box containing your MSN contacts 
appears. In this list, the contact information for those who are online and for 
those who are offline is grouped together. Move through the list by pressing 
“down arrow button” or “up arrow button” repeatedly. When this list box 
appears, the number of people who are online is displayed first. Your online 
contacts are shown in the format, "(current status) nickname xx/yy" in Braille, 
and "nickname, current status, xx/yy" in speech. Where "yy" is the number of 
people who are online or offline, and "xx" is the order of the current item in 
the online or offline group. In Braille, the current status, "online", is displayed 
as "nln", and "offline" as "fln". In speech, status is announced as "online" or 
"offline". When a contact's status is "idle", it is displayed as "idl" in Braille, 
and "idle" in speech. If the status of a person changes after you log in, 
different sound is heard depending on their status. 
YOU can use the following hot keys in this list box:  
 
1. Move to the previous item : Up arrow button or up scroll button 
2. Move to the next item : down arrow button or down scroll button 
3. Move between online and offline groups : Ctrl-Down arrow key 
WHEN you receive a message, you can have the message stay on the 
Braille display until you are done reading it. When in the Contacts list box 
Press "Ctrl-l". When you are asked to "Confirm the received message: No", 
select "Yes" by pressing "space". When a message is received the message 
stays on the Braille display until you close it with "Esc". 
To close the messenger program, press "Enter" on "Close" in the file menu. 
Or Press "Alt-F4". 
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16.4.2.1 Instant Messaging 
To have a conversation with a person in your list of contacts, move to the 
contact, and press "Alt" to open the menu. Move to "Actions" and press 
"Enter". Press "Enter" again on "Send Instant Message". Or press "Enter" or 
“Ctrl-s” on the contact in the list. The "Instant message" dialog appears, in 
which you can type messages back and forth with your contact online.  
 

16.4.2.2 Adding, Deleting, or Viewing Contact Information 
To add a contact, do the following: 
1) Press “Alt” or F2 to open the menu. Move to "Contacts" by pressing “down 
arrow button”, and press "Enter". Press "Enter" on "Add Contact". You can 
also press "Ctrl-a" to activate this function directly. 
2) The "Add Contact" dialog is displayed, and you are placed in the "E-mail 
address" edit box. Type the e-mail address of the person you want to add in 
computer Braille. 
3) Press “Tab” to move to the "Confirm" button, and press "Enter". The 
contact information is stored and you are placed back in the contact list box. 
To cancel adding the contact information, press “Tab” to move to the 
"Cancel" button, and press "Enter". 
The added contact is displayed as offline until the person accepts your 
request for adding him or her to your contact list. As soon as the request is 
accepted, their status is changed to online, and from then on, will reflect the 
person's actual status. 
You can delete a contact you have stored by doing the following: 
 
1) Move to the contact you want to delete, by pressing “up arrow button” or 
“down arrow button” repeatedly. 
2) Press “Alt” to open the menu. Press “down arrow button” to move to 
"Contacts", and press "Enter". Move to "Delete Contact" by pressing “down 
arrow button”, and press "Enter". Or to activate this function directly, press 
"Ctrl-d". 
3) The "Delete Contact" dialog is displayed, showing the e-mail address of 
the person to be deleted in the "E-mail address" edit box. Make sure that the 
address is correct, and if not, make the necessary changes. 
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4) Press “Tab” to move to the "Confirm" button, and press "Enter". The 
contact is deleted and the contact list box appears again. To cancel deletion, 
press “Tab” once more to move to the "Cancel" button. Then press "Enter". 
 
You can delete a contact regardless of whether he/she is online or offline. 
To view information for a contact, do the following: 
1) Move to the contact for whom you want information by pressing “down 
arrow button” or “up arrow button”. 
2) Press “Alt” to open the menu. Press “down arrow button” to move to 
"Contacts", and press "Enter". Move to "Contact Information" by pressing 
“down arrow button”, and press "Enter". Or to activate this function directly, 
press "Ctrl-v". 
3) You are placed in the "Contact Information" dialog. First, "Nickname" is 
focused. Press “Tab” to move to the e-mail address for the contact. Press 
“Tab” again to move to his/her status. 
4) After reading all the information for the contact, press “Tab” to move to the 
"Close" button, and press "Enter". Or you can press "Esc". The dialog is 
closed and the contact list box appears again. 
 

16.4.2.3 Changing Your Nickname, Status and Viewing Your 
Information 

 
You can change your nickname as follows: 
1) Press “Alt” to open the menu. Press “down arrow button” repeatedly to 
move to "Tools", and press "Enter". Press "Enter" on "Nickname". Or to 
activate this function directly, press "Ctrl-p". 
2) The "Change Nickname" dialog appears, and the "Nickname" edit box is 
focused. Type the nickname you like. You can use letters, numbers, and 
other symbols in the nickname. 
3) Press “Tab” to move to the "Confirm" button, and press "Enter". Your 
nickname is changed and you are returned to the contact list box. 
 
To view your nickname or e-mail address, you can use "my status" as 
follows: 
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1) Press “Alt” to open the menu. Press "Enter" on "File". Move to "My Status" 
by pressing “down arrow button”, and press "Enter". Or to activate this 
function directly, press "Ctrl-m". 
2) The dialog appears, and your nickname is displayed. Press “Tab” to move 
to your e-mail address, and “Tab” again to move to "Status", and so on. 
3) When done reading the information, Press “Tab” to move to the "Close" 
button, and press "Enter". Or you can press "Esc". The information dialog is 
closed and you are placed in the contact list box. 
 
To change your status, do the following: 
1) Press “Alt” to open the menu. Press "Enter" on "File". Move to "Set My 
Status" by pressing “down arrow button”, and press "Enter". Or to activate 
this function directly, press "Ctrl-t". 
2) The "Set My Status" dialog appears, and the "Status" combo box has 
focus. Move to the status item you want by pressing “down arrow button” or 
“up arrow button”. 
3) Press “Tab” to move to the "Confirm" button, and press "Enter". Your 
online status is changed and you are placed in the contact list box. 
 

16.4.2.4 Additional Features 
 
1. Sign out 
If you want to log in using another account, you must log out of your current 
account first, and log in to the other account. Press “Alt” to open the menu. 
Press "Enter" on "File". Press “down arrow button” repeatedly to move to 
"Sign Out" and press "Enter". You are logged out, and the Sign In dialog 
appears again. In the "E-mail address" and "Password" edit boxes, the e-
mail address and password used in the previous login are displayed by 
default. To log in to another account, you must delete the log in information 
for the first account, and type the log in information for the second account. 
 
2. Save account 
If you did not check the "Remember me" and "Save password" check boxes 
in the Sign In dialog, later, you may want to save the account information 
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after logging in. You can use the "Save Account" option to do this. It is 
exactly the same as checking the two check boxes in the login dialog. To 
use "Save Account", press “Alt” to open the menu. Press “down arrow 
button” repeatedly to move to "Tools", and press "Enter". Press “down arrow 
button” to move to "Save account", and press "Enter". You are prompted, 
"Save account? Yes". Press "Enter" and you are placed back in the contact 
list box. 
 
3. View chat and last message 
When you are having a conversation with more than one person 
simultaneously, you can view a list of messages you have received 
previously. You can use the "Last Message" option, or when using "View 
Chat" go back to recent conversations via recent chat messages.  
To use "View Chat", press “Alt” to open the menu and press "Enter" on "File". 
Press “down arrow button” to move to "View Chat", and press "Enter". Or 
press "Ctrl-r" to activate this function directly. 
To use "Last Message", press “Alt” to open the menu. Press “down arrow 
button” repeatedly to move to "Actions", and press "Enter". Press “down 
arrow button” to move to "Last Message", and press "Enter". Or press "Alt-r" 
to activate this function directly. When executing "Last Message" the "list of 
messages" is displayed. In this list, Move through the messages by pressing 
“up arrow button” or “down arrow button” repeatedly. If you press "Enter" on 
a message, the focus moves to the corresponding conversation.  
 
4. Play keyboard sound 
You can select whether you hear a typewriter-like sound as you input text or 
when someone is typing a message to you. To access this setting, do the 
following: 
  
1) Press “Alt” to open the menu. 
2) Press “down arrow button” to move to "Tools" and press "Enter". 
3) Press “down arrow button” to move to "Play Keyboard Sound" and press 
"Enter". Or, Press "Ctrl-k" to move to the "Play Keyboard Sound" option 
directly. You are prompted, "Play keyboard sound: Yes"  



380 
 

4) If you press "Enter", the typewriter click sounds as you type. 
If you press “down arrow button” to move to "No" and press "Enter", the 
keyboard sound plays when a person is typing to you even if you are writing 
a message. 
 
5. Message sound notification while in current window 
Use this option to choose whether you are alerted to new messages via a 
notification sound while in a chat conversation. To adjust this setting, do the 
following: 
 
1) Press “Alt” to open the menu. 
2) Press “down arrow button” to move to "Tools" and press "Enter". 
3) Press “down arrow button” to move to "Message Sound Notification While 
In Current Window" and press "Enter". Or, Press "Fn-s" to move to the 
"Message Sound Notification While In Current Window" option directly. You 
are prompted, "Play message sound notification while in current window: 
Yes".  
4) If you press "Enter", you are alerted to a received message by a beep 
sound when in a conversation. 
5) If you press “down arrow button” and press "Enter", you are not alerted by 
a beep sound when in a conversation.  
However, even if you set this option to No", a sound alerts you to new 
messages when in the contact list. The setting is only effective for the 
current chat window.  
 
6. Message sound notification while messenger is in the background 
You can select whether you are alerted with a beep sound on receipt of new 
messages when running another application and messenger is in the 
background. To change this setting, do the following: 
1) Press “Alt” to open the menu. 
2) Press “down arrow button” to move to "Tools" and press "Enter". 
3) Press “down arrow button” to move to "Message Sound Notification While 
Messenger Is in the Background" and press "Enter". Or, Press "Alt-m" to 
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move to this option directly. You are prompted, "Play message sound 
notification while messenger is in the background: Yes".  
4) If you press "Enter", a beep sound is heard when a new message is 
received. 
If you press “down arrow button” and press "Enter", there is no beep sound, 
thus you are not alerted to new messages until you return to the messenger 
program and view them. 
 

16.4.3 Instant Message dialog 
 
If you press "Enter" on a contact in your contact list, the instant message 
dialog appears, thus opening a conversation window. The instant message 
dialog consists of the "history" window, the "input" edit box, and "Send" and 
"Close" buttons. The "history" window lists all the messages that have been 
sent to and from other contacts. In the "input" edit box, you can type 
messages to send to your contact. Move among these controls by pressing 
“Tab” or "shift-tab".  
When you open the dialog by pressing "Enter" on a contact to send a 
message, the "input" edit box is focused when the dialog appears. On the 
other hand, if the dialog was opened to read received messages, the 
"history" window is focused. In the "input" edit box, you can type one line, as 
pressing "Enter", sends the message. You can also move to the "Send" 
button, and press "Enter" to send the message. The message is then added 
to the "history" window. In the "history" window, for each message, the 
nickname of the writer of the message is displayed followed by the content of 
the message. Each message is considered as a paragraph.  
When you are in the instant message dialog, if the other person sends a 
message, the message is displayed in Braille and announced in speech 
immediately. If you receive a message while in the instant message dialog, 
Move to the contact list box by pressing "Page up or Page down”. Press the 
key again to return to the instant message dialog.  
 
More than one instant message dialog can be opened at the same time. For 
example, while in an instant message dialog, if you go to the contact list box 
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by pressing "Page up” and press "Enter" on another contact, another instant 
message dialog is opened. 
To close the instant message dialog, press "Enter" on the "Close" button, or 
press "Esc" key. The dialog is closed, and you are returned to the contact list 
box. 
 

16.4.3.1 Inviting Others to Start a Conversation 
 
You can invite multiple people to the same conversation so that all of you 
can write to each other in one instant message dialog. You can invite or add 
another participant as follows:  
Press “Alt” to open the menu. Move to "Actions" by pressing “down arrow 
button” repeatedly, and press "Enter". Press "Enter" on "Invite A Contact". Or 
to activate this function directly, press "Ctrl-i". The list of people who are 
online is displayed. Press “up arrow button” or “down arrow button” 
repeatedly to move to the contact you want to invite. Press "Enter". The 
Braille Sense U2 QWERTY announces that the person has been invited, and 
you are returned to the current conversation.  
 

16.4.3.2 Saving and Printing Your Messages 
 
You can save or print the messages shown in the "history" window. To save 
the messages, press “Alt” to open the menu. Press "Enter" on "File". Move to 
"Save As" and press "Enter". Or to activate this function directly, press "Alt-s". 
The save dialog appears and the "File name" edit box is focused. This dialog 
has the same controls and functions the same as the "Save As" dialog in the 
"Word Processor". 
To print the messages, press “Alt” to open the menu. Press "Enter" on "File". 
Move to "Print" by pressing “down arrow button” repeatedly, and press 
"Enter". Or to activate this function directly, press "Ctrl-p". The "Print" dialog 
is displayed. This dialog is the same as the "Print" dialog in the "Word 
processor". The messages can be printed or embossed in Braille. 
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16.4.3.3 Copying and Pasting Instant Messages 
 
You can copy the messages in the "history" window or "input" edit box, as 
you can do in the "Word Processor". However, since the "history" window is 
read only, you cannot paste, cut, or delete the messages in the "history" 
window. If you wish, you can paste text into the "input" edit box. To select a 
block of text, move the cursor to the start point, and press “Ctrl-b”. Move to 
the end point of the text to be selected. Press "Ctrl-c" to copy. Move the 
cursor to the place where you want to insert the copied text (the "input" edit 
box, or an edit box of another program), and press "Ctrl-v" to paste the text. 
You can press "Ctrl-a", to select all the text in the current control. IN addition 
to using the hot keys listed above, you can perform these functions using the 
"Edit" menu. 
 

16.4.3.4 Searching Messages 
 
You can search the messages in the "history" window for text. This is very 
useful especially when you have exchanged many messages. The "Find" 
dialog is used for this purpose, and works the same as the one in the "Word 
Processor". Press “Alt” to open the menu. Press “down arrow button” to 
move to "Edit", and press "Enter". Press “down arrow button” repeatedly to 
move to "Find", and press "Enter". Or to activate this function directly, press 
"Ctrl-f". The "Find" dialog appears, and the "Text to find" edit box is focused. 
Type the string to search for and set the search direction, and press "Enter". 
The focus moves to the message that contains the text you searched. To 
find it again in the same direction, press "Ctrl-f”. If the text is not found, the 
unit announces, "Not found", and the cursor is placed where you invoked the 
"Find" dialog. 
 

16.5 Hot Keys in Social Networking 

 
16.5.1 Twitter 
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Sign Out: Ctrl-g 
Personal Information: Ctrl-I  
Save Current Timeline: Alt-s 
Home Timeline: Ctrl-h  
Friend Timeline: Ctrl-f  
User Timeline: Ctrl-u  
Current User Timeline: Alt-u 
Mention Timeline: Ctrl-m  
Retweet By Me: Alt-b  
Retweet To Me: Alt-t  
Retweet Of Me: Alt-o  
Tweet: Ctrl-t  
Remove Tweet: Delete 
Retweet: Ctrl-e  
Reply: Ctrl-y  
Add To Favorite: Ctrl-v  
Favorite List: Ctrl-l  
Send Direct Message: Ctrl-s  
Sent Direct Message: Alt-m  
Received Direct Message: Alt-r  
Follow User: Alt-a  
Following: Alt-l  
Followers: Alt-e  
Global Search: Ctrl-f  
User Search: Alt-f  
Search Word List: Alt-w 
Next List: Ctrl-n  
Refresh: Ctrl-r  
Exit: Alt-F4 
Escape: Esc key 
 
Move to the next tweet: Down arrow key   
Move to the previous tweet: Up arrow key 
Move to the first tweet on the refreshing list: Ctrl-Fn-Left arrow key 
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Move to the last tweet on the refreshing list: Ctrl-Fn-Right arrow key 
Move to the previous 32 list: Fn-Un arrow key  
Move to the next 32 list: Fn-Down arrow key  
 
Move to the previous list: Up arrow key 
Move to the next list: Down arrow key 
Move to the top of the list: Ctrl-Fn-Left arrow key/Fn-Left arrow key 
Move to the bottom the list: Ctrl-Fn-Right arrow key/Fn-Right arrow key 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 

 
16.5.2 Google talk 
 

File Menu Commands 
Sign out: Ctrl-l  
Export Contact Lists: Alt-x  
Import Contact Lists: Alt-i  
Exit: Alt-F4 
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Send File: Alt-f  
Move to Recently Chat: Ctrl-t  
Manage Chat: Ctrl-m  
 
Contact Menu Commands 
Add Contact: Alt-q  
Delete Contact: Delete 
Block Contact: Alt-b  
Manage Block List: Alt-m  
Contact Information: Ctrl-i  
Manage Contact List: Ctrl-p  
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Option Menu Commands 
My Status Options: Alt-u  
Action Options: Alt-a  
Alert Options: Alt-o  
Path Options: Alt-p  
 
Chat Window Menus 
 
File Menu Commands  
Save Conversation: Alt-s  
Close Chat: Alt-F4 
 
Edit Menu Commands 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Delete  
Paste: Ctrl-v  
Start Selection: Ctrl-b  
Select All: Ctrl-a  
Find: Ctrl-f  
Find Again: F3  
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Stop Voice Chat: Esc key 
Send File: Alt-f  
View Contact List: Ctrl-t  
Manage Chat: Ctrl-m 
Move to Previous Chat: Ctrl-Shift-Tab 
Move to Next Chat: Ctrl-Tab 
 
The move keys in Google Talk. 
Move to the previous Contents: Up arrow key  
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Move to the next Contents: Down arrow key 
Move to the previous 32-items of the Contents: Fn-Up arrow key button 
Move to the next 32-item of the Contents: Fn-Down arrow key button 
Move to the first item of the Contents: Ctrl-Fn-Left arrow key 
Move to the last item of the Contents: Ctrl-Fn-Right arrow key 

 
16.5.3 MSN Messenger 
 
1. Sign-in dialog box 

Move to the next control: Tab 
Move to the previous control: Shift-tab  
Check or uncheck a check box: Space 

2. The contact list box 
Move to the previous item: Up arrow key  
Move to the next item: Down arrow key  
Move between online and offline groups: Ctrl-Down arrow key 
Open the menu: Alt 
Sign out: Ctrl-n  
View chat: Ctrl-r 
My status: Ctrl-m  
Close: Alt-F4 
Add contact: Ctrl-a  
Delete contact: Ctrl-d 
Contact information: Ctrl-v 
Send instant message: Ctrl-s  
Last message: Alt-r 
Play keyboard sound: Ctrl-k 
Message sound notification while in current window: Fn-s  
Message sound notification while messenger is in the background: Alt-m  
Nickname: Ctrl-p 
Save account: Ctrl-o  
Confirm the received message: Ctrl-l 

3. Instant message dialog box 
Move to the next control: Tab  
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Move to the previous control: Shift-Tab  
Move between the instant message dialog box and the contact list box: 
Page up or Page down 
Save as: Alt-s 
Print: Ctrl-p 
Close: ESC 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Ctrl-d 
Paste: Ctrl-v  
Select all: Ctrl-a 
Start selection: Ctrl-b 
Find: Ctrl-f 
Find again: F3  
Invitation: Ctrl-i 
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17. Utilities 
 
The "Utilities" menu provides several special functions and settings for the 
Braille Sense U2 QWERTY. The "Utilities" menu contains the following 
items: 
 
1) Calculator (for doing simple math equations as well as scientific 
calculations) 
2) Display Compass heading (for displaying your current cardinal direction 
3) (Set Time and Date (for setting the Braille Sense U2 QWERTY internal 
clock) 
4) Display Time and Date (for viewing the date and time)  
5) Wake up alarm (for setting an alarm) 
6) Calendar (for checking dates according to the lunar and solar calendar) 
7) Pronunciation Dictionary (for defining the way words are pronounced by 
the unit) 
8) Stopwatch (for timing events) 
9) Terminal for screen reader (for connecting your Braille Sense U2 
QWERTY to your PC for use as a Braille display, external speaker, etc)  
10) Setup internet (for creating Internet connection profiles) 
11) Display Network Status (for displaying the status of your Internet 
connectivity) 
12) Display power status (for discovering the amount of battery charge on 
the unit) 
13) Backup/ Restore personalized settings (for backup/restore of 
personalized settings for each program in the Braille Sense U2 QWERTY)  
14) Menu manager (for hiding some program options according to your 
preference) 
15) Format (for formatting the flashdisk as well as external storage devices) 
16) Set Sleep Timer (for defining the time before the unit automatically goes 
to sleep) 
17) Upgrade Braille Sense Firmware (for upgrading the Firmware) 
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To access the menu items, 
1) Press “up arrow button” or “down arrow button” in the "program" menu. 
2) Press "Enter" on the "Utilities" menu. Or, press "u" from the "program" 
menu to open the Utilities menu.  
3) The "Utilities" menu contains many settings dialogs and small applications. 
The following sections discuss each of these menu options and their 
functions in greater detail. 
 

17.1 Calculator 
 
Using the calculator on the Braille Sense U2 QWERTY you can do simple 
math equations as well as complex scientific calculations. The results and 
expressions are displayed in Braille, and spoken by the Braille Sense U2 
QWERTY. While using the calculator, you can refer to the "help" menu by 
pressing "F1" for hot key information on the various calculator functions.  
 
To use the calculator, press "c" from within the "Utilities" menu. When using 
the calculator on the Braille Sense U2 QWERTY, you need to type using 
computer Braille when calculating or inserting expressions. You can clear 
the calculator by pressing "Alt-c". If you insert numbers or a function into a 
result, the result disappears; and if you enter operators, you move to the 
next step. In addition, you can keep your result in the calculator's memory, 
and recall it later. You can use the functions and operators via the calculator 
menu or you can use the hot keys.  
The calculator functions are explained in greater detail below. 
 

17.1.1 General Functions 
 
"General functions" is a dialog box that contains the "general function list", a 
"Confirm" button, and a "Cancel" button. In the dialog box, you can navigate 
among the controls using “Tab” and "shift-tab". In the general function list, 
you can navigate the operators using “up arrow button” or “down arrow 
button”. Or, in the list, you can press the first letter of the operator you want 
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to access. In the "Calculator", you can open the menu by pressing “Alt”, and 
press "Enter" on "General Functions". Or, you can press "g" from the menu 
to access "General Functions". When the calculator is opened, 0 is displayed 
in computer Braille. From the calculation line, you can access the "General 
Functions" using the hot key, "Ctrl-g".  
 
When the dialog opens, you are placed on the general function list. Once 
there, you can select your desired operation and press "Enter" to run it. You 
can cancel the operator selection by pressing "Enter" on "Cancel", "Alt-F4", 
or "Esc". You can also use hot keys to quickly execute operations.  
 
Use the following hot keys to perform basic calculations: 
 

Plus: + 
Minus: - 
Divided by: / 
Multiply by: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal point: . 
Left parenthesis: ( 
Right parenthesis: ) 
PI: Ctrl-p  
Exponential: Ctrl-e  

 
To enter negative numbers type minus and the number in parentheses. For 
example, type in minus 2 in the following manner: (-2). 
For the percent operation, type the numbers first followed by the percent 
sign. Immediately after you type the percent sign (%), the number you have 
typed in is converted into a percent value. For example, 90 + 20% equals 90 
+ 18. The number 18 is displayed immediately on entering the % sign. The 
result of this expression is 108.  
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17.1.2 Memory Functions 
 
The "Memory Functions" store your resulting answers and calculations in 
memory for later use. The "Memory Functions" menu has four items: "Recall 
Item", "Delete All Saved Items", "Save Item", and "Statistics Functions". You 
can move among these items by pressing “down arrow button” or “up arrow 
button” repeatedly, and press "Enter" on the desired feature. To access 
these menu items, press “Alt” to open the menu, and press "Enter" on 
"Memory Functions". Or, you can press "v" from the menu. 
 

17.1.2.1 Recall Items 
 
"Recall Items" is a dialog, containing the following: "Variable list", "Delete", 
"Display detail", "Confirm", and "Cancel". You can navigate among these 
items by pressing tab or shift-tab. You can access "Recall Items" by pressing 
"r" from the "Memory Functions" menu. Or, you can access the dialog by 
pressing "Alt-r" in the calculation line.  
 
The "Variable list" displays "item name: the result value". You can move 
through the "Variable list" by pressing “up arrow button” or “down arrow 
button”. You can insert the result value into your calculation by pressing 
"Enter" on the item name. You can also copy items in the "Variable list". 
Press "Space" to select an item in the "Variable list". Then, press "Ctrl-Insert" 
to copy the selected items to the clipboard.  
 
The "Display detail" shows the item name and its result with the default set to 
"No". To review the detailed information, press "Space" to switch to "Yes". 
Then, it displays "item name: the expression = its result value" in Braille.  
"Delete" is used to remove a variable item. To delete an item, select the item 
you want to be deleted, and press "Enter" on "Delete". You can also select 
any number of individual items by pressing "Space" on each of them.  
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17.1.2.2 Delete All Saved Items 
 
You can delete all of the saved items stored in the "Recall Items". To do this, 
open the menu by pressing “Alt” or press "F2". Then, use “up arrow button” 
or “down arrow button” to move to the "Memory Functions" menu, and press 
"Enter". Next, use “up arrow button” or “down arrow button” to move to 
"Delete All Saved Items", and press "Enter". You can also press "Ctrl-d" 
while in the calculation line. 
 

17.1.2.3 Save Items 
 
"Save Items" is a dialog that allows you to define variables according to the 
current expression or result in the calculator and save them for future use. 
The dialog contains an edit box for typing in the variable name, a "Confirm" 
button and a "Cancel" button. You can move among the controls by pressing 
“Tab” or "shift-tab". From the "Memory Functions" menu, you can access 
"Save Items" by pressing "s". From the calculation line, use the hot key, "Alt-
s" to open the save items dialog.  
 
When the dialog is opened, the "item name" edit box is focused. Type a 
name for the variable, and press "Enter" or move to "confirm", and press 
"Enter". The current expression or result is then saved under the variable 
name you just specified. 
If you type names under variables which have already been created, you are 
prompted, "Replace variable xx with current value? Yes". To change the 
value, press "Enter" on "Yes". If you do not want to change the value, press 
"Enter" on "No". Press "Space" to toggle between "Yes" and "No". 
If you type function names like "sin", "coos", or "pi" as a variable name, you 
are warned, "Invalid item name", as you cannot use these functions in 
variable names.  
 
When you are on the calculation line, you can also define variables directly 
by typing "variable=expression" and press "Enter" to save the variable.. For 
example: "a=2+sin(30)" or "a=591",   
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17.1.2.4 Statistics Function 
 
If you select this menu item, a dialog opens, which consists of a list box 
containing all the stored variables, a list box displaying the results of several 
functions, and a "Close" button. You can move among these elements by 
pressing “Tab”, or "shift-tab". You can open this dialog by pressing "Alt-t" in 
the calculation line, or by pressing "t" in the "Memory Functions" menu. In 
the variable list, the variable names and their current values are displayed. 
You can move among these variables by pressing “down arrow button” or 
“up arrow button”. In order to select a variable to be used in the calculation, 
press "Space" on it. This list is the same as the one in the "Recall Items" 
dialog. The only difference is that this dialog always displays variable names 
and values, regardless of the value of "Detail display" option. After you select 
all of the variables to be used in the calculation, you can press “Tab” to move 
to the "result" list. The "result" list displays the sum, average, variance, and 
standard deviation of the selected variables. You can move among these 
items by pressing “down arrow button” or “up arrow button”. To copy results 
from the list to the clipboard, press "Space" on the items you wish to select 
 

17.1.3 Sine Functions 
 
The "Sine Functions" menu is activated when you press "Enter" on "Sine 
Functions", or press "s" from the menu. You can open the menu by pressing 
“Alt”. Or, you can activate the "Sine Functions" menu by pressing “Ctrl-s” in 
the calculation line. The "sine function" list consists of "Sine", "Arc sine", and 
"Hyperbolic sine". If you press "Enter" on one of the three functions while 
moving with “up arrow button” or “down arrow button”, or if you press "Enter" 
on "Confirm" while one of the functions is focused, you can insert it into your 
calculation line after selecting one of the sine functions. Or, you can insert 
one of the three sine functions by pressing the first letter of each from the list. 
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17.1.4 Cosine Functions 
 
You can activate the "Cosine Functions" by pressing "Enter" on "Cosine 
Functions" or by pressing "i" from the menu. Or, in your calculation line, you 
can open the "Cosine Functions" by pressing "Ctrl-i". The "cosine function" 
list consists of "Cosine", "Arc cosine", and "Hyperbolic cosine". If you press 
"Enter" on one of the three functions while moving with “up arrow button” or 
“down arrow button”, or press "Enter" on "Confirm" while one of the functions 
is focused, the calculation is performed. Or, you can activate one of the three 
cosine functions by pressing the first letter of each from the list. 
 

17.1.5 Tangent Functions 
 
You can activate the "Tangent Functions" when you press "Enter" on 
"Tangent Functions", or if you press "t" from the menu. You can also open 
the menu by pressing “Alt”. Or, in your calculation line, you can open the 
"Tangent Functions" by pressing "Ctrl-t". The "tangent functions" list consists 
of "Tangent", "Arc tangent", and "Hyperbolic tangent". If you press "Enter" on 
one of the three functions while moving with “up arrow button” or “down 
arrow button”, or press "Enter" on "Confirm" while one of the functions is 
focused, you can insert this function into your calculation. Or you can insert 
one of the three tangent functions by pressing the first letter of each from the 
list. 
 

17.1.6 Logarithm Functions 
 
The "Logarithm Functions" is a dialog, which contains the following: "function 
list", a "Confirm" button, and a "Cancel" button. You can move among the 
three items by pressing “Tab” or "shift-tab". The function list consists of 
"Common logarithm" and "Natural logarithm", in which you can move by 
pressing “up arrow button” or “down arrow button”. 
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You can activate the "Logarithm Functions" menu by pressing "Enter" on 
"Logarithm Functions", or by pressing "l" from the menu.  Or, in your 
calculation line, you can open the "Logarithm Functions" by pressing "Ctrl-l". 
If you press "Enter" on one of the logarithm functions, or "Tab" to "confirm" 
while one of the functions is focused, you can insert this function into your 
calculation. Or, you can run a "Natural logarithm" by pressing "n" from the list. 
You can run a "Common logarithm" by pressing "c". 
 

17.1.7 Copy to Clipboard 
 
The "Copy to Clipboard" function is used to copy your expression or result to 
the clipboard for pasting your expression or result in a document. You can 
activate it by pressing "Enter" on the "Copy to Clipboard" option, or by 
pressing "c" from the menu. Or, in the calculation line, you can press "Ctrl-c" 
to quickly copy your calculation to the clipboard. After copying, you can 
paste the calculation in a document.  
When you activate "Copy to Clipboard", you hear "Copy completed", and the 
Braille Sense U2 QWERTY returns to your calculation line.  
 

17.1.8 Option Settings 
 
"Option Settings" is a dialog, which contains the following: "setting list", a 
"Confirm" button, and a "Cancel" button. You can move among the three 
items by pressing “Tab” or "shift-tab". The "setting list" consists of "Radian" 
and "Degree", which you can navigate by pressing “up arrow button” or 
“down arrow button”. 
If you select "Radian", you can get the PI value while using the trigonometric 
function. If you select "Degree" and activate PI, you will get a wrong answer 
as this is not a valid calculation. You can activate the "Option Settings" by 
pressing "Enter" on the menu option or press "o" from the menu.  Or, in your 
calculation line, you can activate the "Option Settings" by pressing “Ctrl-o”. 
When the "Option Settings" are open, if you press "Enter" on the option you 
want, or press "Enter" on the "Confirm" button associated with it, the option 
is set according to your preference.  
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17.1.9 Exit 
 
This is used to exit the calculator. You can close the calculator by pressing 
"Enter" on "Exit Calculator" or press z in the menu. Or, in your calculation 
line, you can exit by pressing "Alt-F4". 
 

17.1.10 Sample Math Calculations 
 
The following are examples for each of the math functions you can perform 
when using the calculator on the Braille Sense U2 QWERTY. 
 

1. Addition Plus 
For Plus press “+” 
For example, to add the numbers 10 and 20, you would enter: 10+20. 
The result is displayed as 30. 

 

2. Subtraction Minus 
For Minus, press “-” 
For example, to add the numbers 10 and 20, and then subtract 5, you 
would enter: 10+20-5. The result is displayed as 25. 

 

3. Multiplication 
For multiplication, press “*” 
For example, to multiply 10 by 20, you would enter: 10*20. 
The result is displayed as 200. 

 

4. Division 
For Division, press “/” 
For example, to divide 20 by 10, you would enter: 20/10. The result is 
displayed as 2. 

 

5. Percent 
For Percent, press “%” 
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If you want to calculate, what a 10 percent mark-up of 20 would be, 
enter the following, 20+10% which gives you the result 22. You get this 
answer because, 2 is 10percent of 20. 

 
To calculate a 10 percent mark-down on 20, press: 20-10% which gives 
the result 18. 
You get this answer because, 2 is 10 percent of 20. 

 
To calculate what percentage 20 is of 10, press: 20/10% which gives 
you the result 200.  

 
To calculate 10 percent of 20, press: 20*10% which gives the result 2. 
That is, 10 percent is 0.1. 20*0.1 = 2. 

 

6. Power 
For Power, press “^” 
For example, to calculate 2 to the power of 10, you would press: 2^10. 
The answer will be given as 1024. 

 

7. Calculating Square Root 
To perform the Square root function, you can press “Ctrl” with “q” 
For example, to calculate the square root of 16, you press: “Ctrl” with q, 
16 “)”. Then, press enter. 
Your answer will be given as 4. 

 

8. Exponential 
For Exponential you can press “Ctrl” with “e” 
For example, to calculate the Exponential of 2, you would press: Ctrl 
with e then 2, followed by the “)” and “Enter.” That is, exp (2) which gives 
the result 7.3890561. 

 
1. Trigonometric Functions 
 

Sine Functions: 
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For Sine, press “Ctrl” with “s,” and then “s.” This is shown on the Braille 
display as, sin(. 
 
For Arc Sine, press “Ctrl” with “s,” then “a.” This is displayed as asin(. 
 
For Hyperbolic sine, press “Ctrl” with “s,” then “h.” This is displayed as sinh(. 
In order to calculate the sine of a 30 degree angle you would type the 
following: Ctrl with s, then “s,” 30 and then” ).” Press “Enter” and your 
answer is displayed as 0.5. 
 

Cosine Functions: 
 
For Cosine, you would press “Ctrl” with “i” and then you would press “i” This 
is displayed as cos(. 
 
For Arc cosine, press “Ctrl,” with “i” then, “a.” This is displayed as acos(. 
 
For Hyperbolic cosine, press “Ctrl” with “i” then, “h.” This is displayed as 
cosh(. 
For example, to calculate the cosine of the 30 degree angles, you press: 
Ctrl with i, I, 30 and then “)”. Then, press “Enter.” Your answer will be given 
as 0.8660254. 
 

Tangent Functions: 
 
For Tangent, press “Ctrl” with “t” and then “t.” This is displayed as tan(. 
For Arc tangent, press “Ctrl” with “t” then “a.” This is displayed as atan(. 
For Hyperbolic tangent, press “Ctrl,” with “t,” then, “h.” This is displayed as 
tanh(. 
For example, to calculate the tangent of the 30 degree angles, you press: 
Ctrl with t, T, 30 and then “)”. That is, tan(30) which gives you the result of 
0.57735027. 

 

Logarithm Functions: 
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Common logarithm 
For Common logarithm, press “Ctrl” with “l,” and then “n.” This is displayed 
as log(. 
For example, to calculate the common logarithm of the 100, you press: Ctrl 
with l, N, 100 and then “)”. That is, log(100) which gives the result 2. 
 

Natural Logarithm 
For Natural logarithm, press “Ctrl” with “l,” and then, “e.” This is displayed 
as ln(. 
For example, to calculate the natural logarithm of the 100, you press: Ctrl 
with l, E, 100 and then “)”. That is, ln(100) which gives the result 
4.60517019. 

 

17.2 Display Compass Heading 
 
Use this option to display the direction of the compass on the Braille Sense 
U2 QWERTY. You can display the compass heading from anywhere on the 
unit. 
 
To display the compass heading, do the following: 
Press "Enter-5-6" from anywhere on the Braille Sense U2 QWERTY. 
The current status of the compass is displayed. 
 
You can also access compass status in the "Utilities" menu. Move to 
"Display Compass Heading" by pressing “down arrow button”. Press "Enter" 
on the "Display Compass Heading" or simply press "h". 
 
 As you change direction, to check the current compass status, press 
"Space". The current direction is announced.  
To exit this function, press "Esc" or Alt-F4. 
 
Note: It will take about 15 minutes to initialize the unit should the following 
situations occur: 
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1. The unit discharges a great distance from the location where the compass 
was  last used. 
2. The unit remains discharged for more than a month. 
 

17.2.1 Options of gyrocompass 
 
There are 2 option settings available when viewing compass status: 
"Refreshing time" and "Compass display type".  
Refreshing time: 
You can set the interval of the automatic announcement of the compass 
status. To set this option, follow these steps: 
1) Execute "Display Compass Heading". 
2) The Braille Sense U2 QWERTY displays the current compass status.  
3) Press "Tab". 
4) You are placed in the "Refreshing time" edit box. 
5) Type the number of seconds between compass status announcements. 
By default, it is set to 0. You may type a number between 0 and 120. 
 
Compass display type: 
You can set the type of the compass display. To set, follow these steps: 
1) Execute "Display Compass Heading". 
2) The current compass status is displayed. 
3) Press "Tab" to move to "Compass display type". 
4)  The setting values are "cardinal and degrees", "cardinal only" and 
"degrees only". By pressing "Space", you can change the value of the setting. 
By default, it is set to "cardinal and degrees". 
 

17.3 Set Time and Date 
 
To set the Braille Sense U2 QWERTY's internal clock, press "Enter" on "Set 
Time and Date" in the "Utilities" menu.  You can find it by navigating the 
"Utilities" menu with “up arrow button” or “down arrow button” Or press "t" to 
open the "set time and date" dialog from the menu.  
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The set time and date is a dialog, consisting of the following: "Time zone", 
"Use Daylight Savings", "Time format", "Time", "Date", "Synchronize with 
time server", a "Confirm" button, and a "Cancel" button. You can move 
among these items by pressing “Tab” or "shift-tab". 
When you activate "Set Time and Date" for the first time, you will likely see 
"Time zone? Pacific Time (US & Canada); Tijuana (GMPT-08:00)" as this is 
the default. You can review the "time zone" list by pressing “down arrow 
button” or “up arrow button”, or by typing the first letter of time zones or 
represented cities. Select your time zone, and move to the next item by 
pressing “Tab”.  
 
The "Use Daylight Saving" checks box displays according to "Time zone". If 
daylight saving time is used in the selected time zone, this item is displayed. 
If it is not used, this item is not displayed. You can check and uncheck this 
item using "Space". 
 
The next item is "Time format", the options for which are 12 hour and 24 
hour time. You can toggle between the two using “up arrow button” or “down 
arrow button”.  
Move to "Time" by pressing “Tab”. Use this option to set the clock's time. If 
you select 12 hour clock in the "Time format", A.M. or P.M. is displayed after 
the hour and minute. In the 12 hour clock, you can toggle A.M. it P.M. by 
pressing "Fn-x". In the 24 hour clock setting, you can type a 24-hour time 
regardless of A.M. or P.M. When typing the time, separate the hour and 
minute using a space or a colon.  
 
Move to "Date" by pressing “Tab”. Type the "Date" month, date, and year  as 
mm/dd/yyyy. Use 2 digits for the month, 2 digits for the day, and 4 digits for 
the year, separating them by a space or a slash.  
The next item is "Synchronize with time server", used to synchronize time 
and date with a time server on the Internet. This function is extremely useful 
when the date and time of Braille Sense U2 QWERTY is faster or slower 
than the current time. To to execute this function, your Braille Sense U2 
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QWERTY must be connected to the Internet. When connected, press "Enter" 
on the "Synchronize with time server" button. After synchronization, it 
displays the synchronized time in the "Time" edit combo box. The 
synchronized date is also displayed in the "Date" edit combo box. 
 
To save your settings, press “Tab”, to the "confirm" button and press "Enter" 
you are returned to "Set Time and Date" in the "Utilities" menu. Or, when you 
have completed entering all of the information simply presses "Enter". 
 

17.4 Display Time and Date 
 
Use this function to check the current date and time. To activate this function, 
press "up arrow button" or “down arrow button” to navigate to "Display Time 
and Date" in the "Utilities" menu, and press "Enter". Or, you can activate this 
function by pressing d from the menu. You can also query the time and date 
from anywhere on the Braille Sense U2 QWERTY. Press "Fn-t " to check the 
time. Press “Tab”, and today's date is displayed. 
 

17.5 Wake up alarm 
 
You can set a "Wake up alarm" so that an alarm sounds on the Braille Sense 
U2 QWERTY at a specified time every day. To open "Wake up alarm", from 
the "Utilities" menu, use “up arrow button” or “down arrow button” to navigate 
to "Wake up alarm", and press "Enter". If this is the first time you have 
opened "Wake up alarm", and you have not yet set the time or date in the 
Braille Sense U2 QWERTY, the unit prompts, "Set time:" After you set the 
time, the Braille Sense U2 QWERTY displays the "Wake up alarm" dialog. 
You are then prompted, "Set time:" The "Wake up alarm" dialog contains the 
following: "Set time", "Bell", "Term", "Alarm duration", "Repeat interval", 
"Wake up call times", a "Confirm" button, and a "Cancel" button. You can 
move among the controls by pressing “Tab” and "shift-tab".  
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When the alarm sounds, the Braille display also displays the message 
"Wake up call. Press “Ctrl” to stop the alarm". As the message indicates, to 
stop the alarm, press "Ctrl".  
 

17.5.1 Set Time 
 
When you open the "Wake up alarm" dialog, the Braille Sense U2 QWERTY 
displays the "Set time" field. The value is set to the current time or the time 
specified previously. Here you can directly type the time, or set the time 
using the shortcut keys, as explained in section 6.3. After you set the time 
press “Tab” to move to the next field.  
 

17.5.2 Alarm Sound 
 
You can select an alarm sound for the wake up alarm. If you press “Tab” 
from "Set time", the current alarm sound plays. Press “up arrow button” or 
“down arrow button” to change the alarm sound. As you move among the 
sounds, the different alarm sounds are played. When you have selected the 
sound you want press “Tab” to move to the next field. 
 

17.5.3 Term 
 
In this field, you can set which days of the week the alarm sounds. There are 
four options: "Off", "Once", "Week days", and "Every day". Move among 
these options by pressing “up arrow button” or “down arrow button”. If the 
"Term" is set to "Off", the alarm does not go off at the specified time, no 
matter how the other options in the dialog are set. If the "Term" is set to 
"Once", the alarm goes off only once. If the "Term" is set to "Week day", the 
alarm goes off at the same time every weekday, Monday through Friday. If 
the "Term" is set to "Everyday", the alarm goes off at the specified time 7 
days a week. When you have selected your preference, press “Tab” to move 
to the next field. 
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17.5.4 Ringing Duration 
 
This option sets the amount of time that the alarm sounds. The options are 1 
minute, 2 minutes, or 3 minutes. Move among these options by pressing “up 
arrow button” or “down arrow button”. If you set the ringing duration to "1 
minute", the alarm sounds for one minute, then is silent. To stop the alarm 
before a minute has passed, press "Ctrl". 
 

17.5.5 Repeat Interval 
 
This option sets the amount of time that is between the times that the alarm 
sounds. For example, if you set the repeat interval to three minutes, after the 
alarm has stopped sounding, it rings again in 3 minutes, . The available 
settings are 1, 3, 5, 10, 15, or 20 minutes. Move among these options by 
pressing “up arrow button” or “down arrow button”.  
 

17.5.6 Wake up Call Times 
 
This option allows you to decide how many times the alarm sounds. If the 
alarm is not turned off by pressing "Ctrl", it repeats according to the number 
of times you set for this option. The available settings are 1 to 10. Move 
among these options by pressing “up arrow button” or “down arrow button”.  
 

17.5.7 Confirm/Cancel 
 
If you press "Enter" on the "Confirm" button, the changes are saved, and the 
dialog is closed. If you do not want to save the changes, press "Enter" on the 
"Cancel" button. The Braille Sense U2 QWERTY keeps the previous alarm 
settings, and closes the dialog. 
 

17.6 Calendar 
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You can open the calendar by pressing "Enter" on "Calendar" in the 
"Utilities" menu, or by pressing "l". The following options are available: "Solar 
calendar", and "Lunar calendar"". In the calendar, you can check three kinds 
of information starting from the year 1841 to the year 2043. If you type a date 
that is not in the range and press "Enter", you get the message, "Invalid 
date", and return to the "Date" edit combo box.  
 

17.6.1 Using the Calendar 
 
The "Calendar" is composed of the "Solar calendar", and the "Lunar 
calendar". In the "Lunar calendar", a leap month is displayed with "l". The 
calendar works according to a date unit. The default is the date set on the 
Braille Sense U2 QWERTY.  
The following is an explanation of how to check the dates. 
 
1. Moving items 
You can switch among "Solar calendar", and "Lunar calendar" by pressing 
“Tab” or "shift-tab". 
2. Typing date 
In the calendar, you can type a month, date, and year in the form of 
mm/dd/yyyy. Use 2 digits for the day, 2 digits for the month, and 4 gigits for 
the year, separating them using a slash or space. If you press "Enter" after 
typing a date, the date is announced in one calendar, and you can press 
"Tab”  to move to the equivalent date in the other calendar.  
3. Hotkeys for switching dates 
 
After typing a date, you can check the "Solar calendar", "Lunar calendar", 
and "Day of week" by pressing “Tab” or "shift-tab". 
Move to the next day: Right arrow button 
Move to the previous day: Left arrow button 
Move to the next week: Ctrl-Right arrow button 
Move to the previous week: Ctrl-left arrow button 
Move to the next month: Down arrow button 
Move to the previous month: Up arrow button 
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Move to the next year: Ctrl-Down arrow button 
Move to the previous year: Ctrl-Up arrow button 
 

17.7 Pronunciation Dictionary 
 
The "Pronunciation dictionary" is used to modify how Braille Sense U2 
QWERTY pronounces specified words as defined by your entries into the 
dictionary.  You can open it by pressing "p" from the "Utilities" menu. 
The "Pronunciation dictionary" is composed of the list, "Add Word" button, 
"Modify Word" button, "Delete Word" button and "Close" button. You can 
move among these controls by pressing “Tab” or "shift-tab".  
The list is shown as "word: xx ?yy" where "xx" is the original word and "yy" is 
the alternative pronunciation. For example, if you wanted to hear "Who" 
pronounced as "world health organization" and you added the word to the 
pronunciation dictionary, it is listed as "word: WHO ?world health 
organization". You can move up or down through items in the pronunciation 
dictionary by pressing “up arrow button” or “down arrow button”. You can 
also click the cursor routing key corresponding to the item position you want 
to focus. For example, if there are 10 items in the list and you want to focus 
the 5th item, you can click the 5th cursor routing key and your focus is 
placed on the 5th item on the list. The pronunciation dictionary does not list 
entries in alphabetical order, but rather, in the order they were added to the 
dictionary.  
To add a new word, press "Enter" on the "Add Word" button or you can 
press " Alt-i ". You are prompted to, "Add entry:" Type the word for which you 
want to change the pronunciation and press “Tab” to "Replacement:" Type 
the letters that produce the alternative pronunciation you desire. Press 
"Enter" or press “Tab” to move to the "Confirm" button and press "Enter". 
The word is added, and the focus is returned to the "Add Word" button.  To 
cancel this modification, press "Enter" on the "Cancel" button or press "Esc" 
or press "Alt-F4". 
 
To modify a stored entry, navigate to the item you want to modify. Move to 
the "Modify Word" button by pressing “Tab”, and press "Enter". Or when the 
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entry is focused, press “Alt”. You are prompted to, "Modify entry: (focused 
word)". Press “Tab” and you are placed in the "Replacement: (new 
pronunciation)" edit box. Type the new replacement pronunciation text and 
press "Enter". Or press “Tab” again to move to the "Confirm" button and 
press "Enter". The word is modified and the focus is returned to the "Modify 
Word" button. To cancel this modification, press "Enter" on the "Cancel" 
button or press "Esc" or press "Alt-F4". 
To delete a stored entry, navigate to the entry you want to delete. Move to 
the "Delete word" button by pressing “Tab”, and press "Enter". Or, press 
"Del" on the item you want to delete. You are prompted, "Delete? Yes". If 
you are sure you want to delete the item, press "Enter". If not, press "Space" 
to change to "No" and press "Enter". 
To exit the "Pronunciation dictionary", you can press "Enter" on the "Close" 
button or press "Alt-F4". 
 

17.8 Stopwatch 
 
When you press "Enter" on the "Stopwatch", "00:00:00" is displayed. Press 
"Enter", to start the stopwatch running. Press "Enter" again, to pause, and 
the Braille Sense U2 QWERTY announces the elapsed time, and displays it 
in Braille. Pressing "Enter" again restarts the stopwatch running. 
If you press "Backspace" while the stopwatch is paused or running, The 
Braille Sense U2 QWERTY announces the elapsed time and clears to 
"00:00:00". While the stopwatch is running, pressing "Space" gives you the 
elapsed time. As the stopwatch is still running, the Braille display continues 
displaying the time second by second as it passes.  
Press "Fn-Space" to stop displaying the time. If you press "Fn-Space" once 
more, the time is displayed again. 
 
If you press “Tab” or "shift-tab" when the stopwatch is idle or while it is 
running, you switch to the "Countdown timer". If you activate the "Countdown 
timer", you are asked to type hours, minutes, and seconds. When typing the 
hours, minutes, and seconds, type a two-digit number for the hour, minute, 
and the second using Computer Braille or grade 1.  You do not need to use 
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a number sign. If you press "Enter" without typing any numbers, the 
"Countdown timer" starts counting down by the default time, which is set to 
one minute. When started, the "Countdown timer" displays "countdown xx 
minute", and begins running. 
Press "Enter" on the "Countdown timer", and the Braille Sense U2 QWERTY 
tells you the remaining time, and pauses countdown. Press "Enter" again to 
restart the timer. Pressing "Backspace" clears the "Countdown timer". If the 
timer reaches zero, a 10-second alarm sounds, and the "Countdown timer" 
clears. If you press "Ctrl" while the alarm is sounding, the alarm stops and 
your timer clears, and is ready to accept a new time. 
Press “Tab” or "shift-tab", to return to the stopwatch. To exit the "Stopwatch" 
or "Countdown timer", press "Alt-F4", and you return to the "Stopwatch" item 
in the "Utilities menu. 
 

17.9 Terminal for Screen reader 
 
The "Terminal for screen reader" function allows the Braille Sense U2 
QWERTY to be used as a Braille display when connected to a computer or 
cell phone that uses a compatible screen reader such as Window-Eyes, 
Supernova, or Apple's VoiceOver. Before using this function, make sure that 
the Braille Sense U2 QWERTY is connected to your personal computer or 
smart phone via a Bluetooth serial connection, or to the USB client port. To 
turn on this function, from the "Utilities" menu, press “down arrow button” 
repeatedly to reach "Terminal for screen reader". Then press "Enter". 
 
 When you activate "terminal for screen reader", the list of connection 
options is displayed. The options are "Bluetooth serial port" and "USB port". 
Press “up arrow button” or “down arrow button” to reach your desired 
connection type. Press "Enter" and the unit announces, "Terminal mode". 
The Braille Sense U2 QWERTY no longer speaks as it is now simply acting 
as a Braille display for your computer or smart phone. If the connection fails, 
you are returned to the list of connection methods. 
To exit the "Terminal for Screen reader" press "Alt-x". 
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For more information on using the Braille Sense U2 QWERTY as a Braille 
display, see section 13.2.5 on using the Bluetooth serial service. You can 
also download USB drivers and installation instructions for various screen 
readers under the "Resource Center" section of our website: www.hims-
inc.com. 
 

17.10 Setup Internet 
 
The "Setup internet" function is used to configure your Braille Sense U2 
QWERTY to use various connection types to access the Internet. The "Setup 
internet" utility contains the following connection options: "LAN", "Wireless 
LAN", "Modem", "ADSL", and "Bluetooth DUN". You can move among the 
five items by pressing “down arrow button” or “up arrow button”. The "LAN" 
setup should be used if you are connecting to the Internet via a Ethernet 
network or router. The "Modem" setup should be used if you are connecting 
to the Internet via a dial-up modem. The "ADSL" setup should be used if you 
are connecting to the Internet via a DSL modem. To connect to the Internet 
via a wireless network, use the "Wireless LAN" option.  
To activate "Setup internet", press "Enter" on "Setup internet" in the "Utilities" 
menu, or press "I" from the menu.  
Or, if the PC on which the Active Sync program is installed is connected to 
the Internet, and the Braille Sense U2 QWERTY is connected to that PC, 
you can also connect the Braille Sense U2 QWERTY to the Internet via that 
connection. 
 
The various connection types are explained in greater detail in the following 
sections. 
 

17.10.1 LAN Setup 
 
Before attempting to set up a LAN connection,  connect one end of a LAN 
cable to the Braille Sense U2 QWERTY and the other to a router or direct 
LAN connection to the Internet. ALSO, be sure the Ethernet port is turned on 
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in the "Global Options" dialog. You can toggle the Ethernet port on and off 
from anywhere on Braille Sense U2 QWERTY using "Fn-F11". From the list 
of connection options in "Set up Internet", navigate to "LAN" and press 
"Enter".  
"Setup IP: Automatic" is displayed. If your service provider does not require 
you to use a static IP address, simply press "Enter" on this option for 
automatic setup. For the automatic setup, your host server should provide 
DHCP service (Dynamic Host Configuration Protocol). 
 
To set up your IP configuration manually, move to "Manual" by pressing “up 
arrow button”, and press "Enter". The following settings are displayed: "IP", 
"Subnet mask", "Gateway", and "Primary DNS". These settings require 
specific numeric addresses. Please contact your Internet service provider for 
the correct addresses. Use computer Braille to type the information for each 
setting, using “up arrow button” and “down arrow button” to move among the 
settings. When you have entered the information for each item, press "Enter" 
to save the settings. The unit announces, "Setting completed". And you are 
returned to "Setup internet". Your Internet connection should be active, thus 
allowing you to use E-mail, the Social Networking programs, or the Web 
browser. 
 

17.10.2 Setup Wireless LAN 
 
Before setting up a Wireless LAN connection, be sure wireless is turned on 
in the "Global Options" dialog. You can toggle wireless on and off  from 
anywhere on the Braille Sense U2 QWERTY using "F11". To connect to a 
wireless network,  navigate to the "Wireless LAN" option in the connection 
types list under "Setup Internet" and press "Enter".  
The "Wireless LAN" dialog consists of the "access points" list, "Advanced" 
button and "Close" button. You can move among these controls by pressing 
“Tab” or "shift-tab". If wireless is not turned on, the "access points" list 
displays "no items".  
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When wireless is on, this list shows the wireless "access points" (networks) 
in range of your notetaker. The "Access points" list displays the "access 
point name", "encryption", and "sensitivity" of each item. (Ex: linksys, 
encryption: WEP, sensitivity: good.) If there is more than one access point in 
the list, you can move among them by pressing “up arrow button” or “down 
arrow button”. Move to the "access point" to which you want to connect, and 
press "Enter". If the access point has no encryption, the Braille Sense U2 
QWERTY announces, "Connecting to (access point name)". If connection is 
successful, the connecting sound is heard. If the network is encrypted and 
requires a network key, when you press "Enter" on the access point, the 
"Network key" edit box is displayed. Type the network key in computer 
Braille in the edit box and press "Enter". If your settings are correct, the unit 
says, "Completed setting profile" and the connecting sound is heard.  
 
The "Advanced" common dialog is used to modify an existing profile, 
manually add a new profile, or check the settings of an existing profile. If you 
press "Enter" on the "Advanced" button while wireless LAN is turned off, "no 
items" is displayed. Pressing "Enter" on the "advanced" button, while 
wireless LAN is turned on, displays a list of the wireless profiles saved on the 
Braille Sense U2 QWERTY..  
The "Advanced" dialog has 5 controls. You can navigate among these 
controls by pressing “Tab” or "shift-tab". The "Advanced" common dialog 
contains the "profile list", "Connect" button, "Add" common dialog button, 
"Remove" button, "Properties" common dialog button, and "Close" button.  
 
1. "Profile list": The list of profiles you have added. You can move through 
the list by pressing “down arrow button” or “up arrow button”. 
 
2. "Connect" button: Used to connect to the selected wireless profile.  
 
3. "Add" common dialog button: Used to manually add a profile, specifically 
where an SSID is hidden, and thus does not appear in the "access points" 
list. "Add common dialog" contains 10 controls. 
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1) "Setup IP: Automatic" combo box: You can switch between automatic and 
manual by pressing “down arrow button” or “up arrow button”. If you select 
"Manual", you must enter your IP address, subnet mask, gateway IP address, 
and DNS IP address. You can move among these computer edit boxes by 
pressing “down arrow button” or “up arrow button”. Press “Tab” to move to 
the next control. 
2) "Network name (SSID)" computer edit box: Type the network ID in the 
computer edit box. 
3) "Network mode" combo box: You can select among "Infrastructure", and 
"802.11 ad-hoc" mode by pressing “up arrow button” or “down arrow button”. 
4) "Network authentication mode" combo box: Select among "Open", 
"Shared", "WPA-PSK", and "WPA2-PSK" by pressing “up arrow button” or 
“down arrow button”. 
5) "Data encryption" combo box: Select the data encryption method by 
pressing “up arrow button” or “down arrow button”. If you select "Open" or 
"Shared" in network authentication mode, you can choose among "Disable" 
and "WEP". And if you select "WPA-PSK" or "WPA2-PSK" in network 
authentication mode, either "AES" or "TKIP" can be selected in the "Data 
encryption" combo box. 
6) "The key is provided automatically" check box: If the "access point" does 
not provide a key for users automatically, uncheck this check box by 
pressing "Space". The default is checked.  
7) "Network key" computer edit box: This is a computer edit box to type the 
network key if the key is not provided automatically. 
8) "Key index" edit box: This is an edit box to type the key number of the 
wireless access point that matches the network key input. 
9) "Confirm" button: Pressing this button applies the changes. 
10) "Cancel" button: You can press this button to cancel the setup. 
 
Note:  
1) If "Data encryption" has been set as "disabled", press "Tab" and you are 
taken directly to the "Confirm" button.  
2) "Network key" and "Key index" is displayed only if you uncheck "The key 
is provided automatically". 
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4. "Remove" button: To delete a profile item in the profile list, select the 
profile item you wish to delete, and press "r" or navigate to the "Remove" 
button by pressing “Tab”, and press "Enter" on the "Remove" button. 
 
5. "Properties" common dialog button: To get information about a selected 
profile item in the profile list, press "Enter" on the "Properties" common 
dialog button after focusing on a profile item.  By using “Tab”. You can 
reconfirm the information for each profile. You can also modify the 
information in the "Properties". 
To exit the "Advance" dialog, press "Esc" or "Alt-F4". 
 

17.10.3 Modem & Bluetooth DUN setup 
 
Before setting up the Braille Sense U2 QWERTY to connect to the Internet 
via a modem, you must connect a USB 3G modem card to the USB port. 
From the list of connection types under the "Setup internet" option in the 
"Utilities" menu, move to the modem by pressing “up arrow button” or "down 
arrow button," and press "Enter."  
If you wish to connect to a Mobile network using Bluetooth DUN, move to 
"Bluetooth DUN" and press "Enter". Bluetooth DUN does not require the 
insertion of a modem, however, its user interface is the same as setting up a 
connection using the modem. 
 
The modem setup contains the following: "connect list", "Default", "Add", 
"Modify", "Delete", and "Close". You can move among these controls by 
pressing “Tab” or "shift-tab". You can move among the items in each control 
by pressing “down arrow button” or “up arrow button”. 
The "connect list" contains previously added connection configurations. You 
can move among these by pressing “down arrow button” or “up arrow button”. 
The "Default" is to set the default connection to use when connecting via a 
modem. To set a connection as the default, move to the "connect list", and 
navigate to "Default" by pressing “Tab”", and press "Enter". 
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"Add" is a dialog for creating a modem connection configuration. It contains 
"connection settings  list", a "Confirm" button, and a "Cancel" button. You 
can move among these by pressing “Tab” or "shift-tab". The "connection 
settings list" contains "Connect name", "Connect number", "ID", "Password", 
and "Modem speed". In the "Connect name" edit box, type the host name or 
something that clearly identifies this connection to you. In the "Connect 
number" edit box, type the number of the host in computer Braille. Note: you 
can type numbers and commas only. If the connection requires an ID and 
password, enter these in the appropriate edit boxes using computer Braille. If 
the connection does not require an ID and password, leave these blank. In 
the "Modem speed", combo box, select one from the list by pressing 
"Backspace" or "Space". When you have entered all of the necessary 
information, press "Enter" to save the connection configuration. If you do not 
want to save, you can cancel by moving to "Cancel" using “Tab”, and press 
"Enter" on it. 
 
"Modify" is used to change the information in a given connection 
configuration. You can do this by moving to the connection you want to 
modify and pressing "Enter". You can also press “Tab” to navigate to 
"Modify" and press "Enter". Or, you can press "Enter-m (1-3-4)" on the 
"Connect name" in the "connect list". "Modify" contains the same items as 
the "Add" dialog, and you navigate and set the values in the same way. 
 
To delete an item, move to the connection you want to delete, and press 
"Enter" on the "delete" button.  Or, you can delete an item by pressing "Del" 
on the connection you wish to delete.  
To exit the "Modem setup", press "Alt-F4", or press “Tab” to move to the 
"Close" button and press "Enter".  
 

17.10.4 ADSL Setup 
 
To connect the Braille Sense U2 QWERTY to the Internet via a DSL 
connection,  use the ADSL connection option in "Set up Internet". Before 
configuring the connection, connect one end of a LAN cable to the Braille 
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Sense U2 QWERTY's LAN port and the other end to a DSL modem. Be sure 
the Ethernet port is turned on in the "Global Options" dialog. From the 
connection types list under "Setup Internet", navigate to "ADSL" and press 
"Enter".  
The ADSL configuration dialog contains the following controls: connect list, 
default, add, modify, delete, and close. You can move among the controls by 
pressing “Tab” or "shift-tab". Within each control, you can move among the 
items by pressing “down arrow button” or “up arrow button”. 
The "connect list" contains the names of previously added connection 
configurations. Select one by pressing "Enter" on it. Use the "Default" button , 
to set one of the configurations as the default ADSL connection.  
Use the "Add" button to create a new ADSL connection configuration. The 
"Add" dialog has three controls: a settings list, a "Confirm" button, and a 
"Cancel" button. You can move among the three controls by pressing “Tab” 
or "shift-tab".  
 
The settings list contains the following: Connect name, ID, and Password. 
You can move among the settings by pressing '“down arrow button” or “up 
arrow button”. In the "Connect name" edit box, type the server host name or 
something that identifies this connection to you. In the "ID" and "Password" 
edit boxes, type the information in computer Braille. After entering the 
necessary information, press "Enter" to save the connection settings, or tab 
to the "Confirm" button and press "Enter". To cancel creation of the 
connection configuration, tab to the "Cancel" button and press "Enter", or 
press "Alt-F4".   
 
Use the "Modify" button to change the information in a given connection 
configuration. To modify a connection, select the connect name you want to 
modify from the list, and press "Enter" on the "Modify" button. Or, press "Ctrl-
m" on the connection you wish to modify. The "Modify" dialog contains the 
same items as "Add", and you navigate and enter information the same way. 
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To delete a connection configuration from the list, select the connect name 
you want to delete from the list, and press "Enter" on the "delete" button. Or, 
press "Delete" on the connection name you want to delete. 
To exit the ADSL setup, press "Alt-F4", or press "Enter" on the "Close" 
button. 
 

17.11 Display Network Status 
 
Using this utility, you can check whether the Braille Sense U2 QWERTY is 
currently connected to the Internet. This utility provides information about the 
current connection type, the current IP of the unit, subnet mask, gateway, 
and MAC address. To check network status, press "Enter" on "Display 
Network Status", or press "n" from the "Utilities" menu. You can also queery 
network status from the "program" menu by pressing "Fn-n".  
When you launch "Display network status", the information about the current 
connection is displayed. If you press “Tab”, the Braille Sense U2 QWERTY 
displays a "Renew" button. If you press “Tab” again, "close" is displayed. If 
you press "shift-tab", the Braille Sense U2 QWERTY moves among these 
elements in the opposite direction.  
 
The first item in the information list (status) indicates whether the Braille 
Sense U2 QWERTY is currently connected to the Internet (online/offline), 
and if so, the current connection type (LAN, Modem, ADSL, or Wireless 
LAN). The next item is the "current IP address", followed by "Subnet mask", 
and "Gateway", and finally "MAC address". You can move among these 
items by pressing “down arrow button” or “up arrow button”. If the Braille 
Sense U2 QWERTY is not currently connected to the Internet, the status 
information shows "offline", and the IP address, subnet mask, and gateway 
display 0's.  
 

17.12 Display Power Status 
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You can activate the "Display power status" function by pressing b or press 
"Enter" on "Display power status" from the "Utilities" menu.  You can queery 
power status from anywhere on the Braille Sense U2 QWERTY by pressing 
"Fn-b". When you execute this command, 2 pieces of information are 
displayed: the percentage of charge remaining in the battery, and whether 
the Braille Sense U2 QWERTY is using the AC adapter or the battery to 
receive power. After checking power status, you can exit by pressing "Alt-F4", 
and you are returned to your previous location on the unit.  
 

17.13 Backup/Restore Personalized settings 
 
"Backup/Restore Personalized settings" is a utility used to backup/restore 
the option settings for each program in the Braille Sense U2 QWERTY all at 
once. You can run this utility by pressing "k" from the "Utilities" menu.   
The "backup/restore" dialog contains: the "program option check box list", a 
"Select all" button, a "Backup" button, a "Restore" button, and a "Cancel" 
button. You can move among the check boxes in the "program option check 
box list", by pressing “up arrow button” or “down arrow button”. You can 
move among the controls in the dialog by pressing “Tab” or "shift-tab".  
The "program option check box list" contains "Options settings", "File 
manager options", "Word processor options", "Address manager options", 
"Schedule manager options", "Media player options", "Web browser options", 
"E-mail options", "Bluetooth manager options", "MSN messenger options" 
and "Database manager options". 
 
In this list, move to the program options you want to backup or restore and 
check the item by pressing "Space". You can uncheck a checked item by 
pressing "Space" again. To select all of the program options in the list, press 
"Enter" on the "Select all" button.  
After selecting all the options you want to backup or restore, press "Enter" on 
the "Backup" or "Restore" button. If you select the "Backup" button, you are 
prompted to select a path for storing the backup file. Navigate to the folder in 
which to store the backup files using normal file/folder navigation commands. 
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Select the folder or disk in which to store the backup by pressing "Space", 
and press "Enter" to start the backup process.  
 
Each of these options has its own backup file. This means that if you backup 
options for 5 programs, it generates 5 backup files.  
If you select the "Restore" button, you are prompted for the path from which 
to restore backup files. Again, use normal file and folder navigation to select 
the folder containing your backup files. If you select a folder in which there is 
no backup, you receive a message indicating there is no backup option file. 
To restore your settings, select the folder containing the backup files by 
pressing "Space", then press "Enter" to initiate the restore process. 
If you hard reset your Braille Sense U2 QWERTY, or its battery is fully 
discharged, the main option settings and settings for each program are 
initialized to the default values. If you have created a backup of your settings,  
you can restore the option settings after the hard reset. 
 

17.14 Menu manager 
 
Using the Menu manager, on the Braille Sense U2 QWERTY, you can 
manage whether or not certain programs are displayed in the menus. The 
following programs can be shown or hidden using the Menu manager. 
1) Sense Dice Game 
2) Sense Brain Game 
3) Twitter 
4) Google Talk 
5) MSN Messenger. 
 
To execute the "Menu manager", follow these steps:  
(1) From the "program" menu, press U or Enter on the "Utilities" menu. 
(2) Press the short cut key, "m" or "Enter" on "Menu manager". 
(3) The "Menu manager'" dialog is displayed.  
 
The dialog of the "Menu manager" consists of the following items: 
1) The program list  
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2) Confirm button 
3) Cancel button 
 
To navigate among the programs, press “up arrow button” or “down arrow 
button”.  
Press "Tab" or "Shift-tab" to navigate to the "Confirm" and "Cancel" buttons.  
 
To hide unused programs on the Braille Sense U2 QWERTY, press "Space" 
on each of the programs you wish to hide in the program list. Press "Enter" 
to save your settings, or tab to "Confirm" and press "Enter". You must reset 
the Braille Sense U2 QWERTY using the "Reset" button on the back of the 
unit for these settings to take effect. When the Braille Sense U2 QWERTY 
reboots, the programs you chose to hide are no longer displayed.  
 
To unhide the programs, return to the "Menu Manager" dialog, and press 
"Space" on the programs you wish to unhide, and press "Enter" to save the 
settings. Press "Reset" once again, and the programs reappear in the menus 
after the unit reboots. 
 

17.15 Format 
 
At times, it may become necessary to reformat the flashdisk in the Braille 
Sense U2 QWERTY.  You can access the "format" function by pressing f 
from the "Utilities" menu. When you format the flashdisk, or any disk on the 
Braille Sense U2 QWERTY, all information is erased. Therefore, before you 
format, you are advised to backup any important data if possible. 
 

17.15.1 Formatting the disk 
 
You can format the flashdisk using 2 methods: 
1. Formatting the disk from the "Utilities" menu. 
1) Go to "Format" in the "Utilities" menu. 
2) Press "Enter", and "flashdisk" is focused. 
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3) Press "Enter" 
4) You are prompted, "Format flashdisk?" Yes".  
5) Press "Enter" 
6) You are prompted, "All data will be lost. Continue? Yes".  
7) Press "Enter".  
8) The unit announces, "Now formatting flashdisk" and the format is started. 
9) When the format is complete, you are returned to the "Disk" list. 
 
To cancel the format, press "Space", or press "Enter" on "No" in step 4 or 6. 
You can also use this utility to format external storage devices such as SD 
cards or USB drives by choosing them from the disk list and following the 
procedure as described above.  
 
2. Formatting the flashdisk using "Reset". 
 
1) Press and hold "Fn-f".  
2) While holding down "Fn-f", quickly press and release the reset button. 
3) Continue holding "Fn-f" until the unit announces, "Format start".  
4) When the format completes, the unit reboots and you are placed in the 
"program" menu. 
 

17.16 Set Sleep Timer 
 
YOU can set the sleep timer to turn the Braille Sense U2 QWERTY off after 
a specified amount of time regardless of what you are doing. 
To set the sleep timer, follow these steps: 
1) Open the "Utilities" menu. 
2) Press “up arrow button” or “down arrow button”, to move to "Sleep timer". 
3) Press "Enter".  
4) Or press "Fn-j" from anywhere on the unit.  
5) You are prompted, "Sleep timer: 0". 
6) Enter the number of minutes for the sleep timer in the edit box. The 
available settings range from 0 to 90. 
7) Press "Enter". 
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When the sleep timer is set, even if the device is active, it powers off after 
the specified amount of time. If you set the sleep timer for "5" minutes and 
press "Fn-j" after 2 minutes, "3" is displayed in the edit box, indicating the 
time remaining before the sleep timer powers the unit off.  
 
 

17.17 Upgrade Braille Sense U2 QWERTY Firmware 
 
Using this utility, you can update the Braille Sense U2 QWERTY either via 
an Internet connection or from external media containing the upgrade files. If 
you choose the "Online" method, be sure you have an active Internet 
connection before attempting the upgrade.  When you update the Braille 
Sense U2 QWERTY, all of the settings are returned to their default status. 
Data in the flashdisk is protected. However, we recommend you backup your 
files before updating the Braille Sense U2 QWERTY Firmware as 
unexpected problems can occur. 
 
Note: You cannot cancel the update once it has started. You must not reset 
the unit during an upgrade. You must keep the unit connected to AC power 
throughout the upgrade process. We recommend you do not touch the 
Braille Sense U2 QWERTY while it is updating. It may take up to 30 minutes 
to update the Braille Sense U2 QWERTY, depending on the speed of your 
Internet connection. On completing the installation, the Braille Sense U2 
QWERTY reboots again to finish the update and places you in the "program" 
menu. 
 
Also note: the upgrade files are temporarily stored on the flashdisk for 
installation. If you do not have enough memory available on the flashdisk, 
the Braille Sense U2 QWERTY is unable to update until you make room for 
the upgrade files. 
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17.17.1 Upgrading the Braille Sense U2 QWERTY Firmware 
Using the Internet 

 
To upgrade the Braille Sense U2 QWERTY Firmware via the Internet, follow 
these steps: 
 
1) Make sure you are connected to the Internet and plugged into AC power. 
Press "Enter" on "Upgrade Braille Sense U2 QWERTY Firmware" in the 
"Utilities" menu.  
2) Press "Enter" on "Upgrade: Online". The Braille Sense U2 QWERTY 
connects to the HIMS server, and your current software version is compared 
to the HIMS server version. You are prompted to continue with the upgrade. 
 
3) If you press "Enter" on "No", the upgrade is cancelled. Press "Space" to 
toggle between "Yes" and "No". If you press "Enter" on "Yes", the Braille 
Sense U2 QWERTY begins downloading the upgrade files. If the upgrade 
fails, you may receive the message, "Internet connection is not available. 
Check your cable and try again". To try the upgrade again, press "Alt-F4" to 
cancel, and activate "Upgrade Braille Sense U2 QWERTY Firmware" again. 
If the connection is successful, the upgrade files are downloaded.    
 
4) After downloading the upgrade files, Braille Sense U2 QWERTY 
automatically starts the upgrade process. Please remember you must not 
touch the Braille Sense U2 QWERTY until the upgrade is complete as 
pressing keys, resetting, or unplugging the unit can interrupt the upgrade 
process, thus resulting in an incomplete installation. . When the upgrade is 
complete, you are returned to the "program" menu, and the unit announces, 
"File manager". 
 
5) After the upgrade is complete, check the software version by pressing 
"Fn-v” while in the "program" menu. 
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17.17.2 Upgrading the Braille Sense U2 QWERTY Firmware 
from a Disk 

 
To upgrade the Braille Sense U2 QWERTY Firmware from a disk, follow 
these steps: 
 
1) Download the upgrade files from the HIMS, Inc. website. Extract the zip 
file and copy the 3 files contained in it to the root of an external storage 
device such as an SD card or USB thumb drive.  
 
2) Connect the SD card or USB drive to the Braille Sense U2 QWERTY, and 
be sure the Braille Sense U2 QWERTY is connected to AC power. Then, 
press "Enter" on "Upgrade Braille Sense U2 QWERTY Firmware" from the 
"Utilities" menu. 
 
3) "Upgrade: Online" is displayed. Press “down arrow button” to go to the 
"Upgrade: Offline" option. Press "Enter".  
 
4) If you are already running the latest version of the software, you are asked 
to continue with the upgrade. If you press "Enter" on "No", the upgrade is 
cancelled. Press "Space" to toggle between "Yes" and "No".  
 
5) If you press "Enter" on "Yes", the Braille Sense U2 QWERTY warns you 
that all settings will be set to factory defaults, and again, asks if you would 
like to continue. Press "Enter" on "Yes". 
 
6) The Braille Sense U2 QWERTY starts the upgrade process. Please 
remember you must not touch the Braille Sense U2 QWERTY until the 
upgrade is complete. When the upgrade is complete, you are returned to the 
"program" menu, and "File manager" is displayed. 
 
7) When the upgrade is complete, check the software version by pressing 
"Fn-v" while in the "program" menu. 
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17.18 Hot Keys for Utilities 
 
Calculator: c 
Calculator Clear:Alt-c 
Delete numbers or operators: Backspace 
 
General functions: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p  
Exp: Ctrl-e 
 
Memory Functions: 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d  
Save Items: Alt-s 
 
Trigonometric Functions: Ctrl-s 
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h  
Cosine: Ctrl-i, i 
Arc Cosine: Ctrl-c, a  
Hyperbolic Cosine: Ctrl-c, h  
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
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Hyperbolic Tangent: Ctrl-t, h 
 
Logarithm Functions: Ctrl-l 
Natural Logarithm: Ctrl-l, e  
Common Logarithm: Ctrl-l, n 
 
Copy to Clipboard: Ctrl-c 
 
Option Settings: Ctrl-o 
 
Set time and date: t  
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Left arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 
Switch Between a.m. and p.m.: Fn-x 
 
Check date and time: Fn-t 
 
Calendar: l  
Move items 
Move to the previous item: Tab  
Move to the next item: Shift-tab 
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Navigation keys for date in calendar 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 
Pronunciation dictionary: p  
Move to the previous control: Tab 
Move to the next control: Shift-tab  
Move to the previous item in entry: Up arrow key 
Move to the next item in entry: Down arrow key 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 
 
Stopwatch: w  
Stopwatch start, pause, restart: enter 
Check the elapsed time: Backspace 
Stop Braille display: Fn-Space 
Restart Braille display: Fn-Space 
Switch between stopwatch and count down timer: “Tab” or “shift-tab” 
Count down timer pause or restart: enter 
Count down timer Clear: Backspace 
Exit stopwatch or count down timer: Alt-F4 
 
Setup internet: i  
 
Display power status: Fn-b 
 
Display network status: Fn-n 
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Backup/Restore personalized settings: k  
Move to previous item: Up arrow key or up scroll button 
Move to next item: Down arrow key or down scroll button 
Move to previous control: Shift-tab  
Move to next control: Tab  
 
Format: Hold Fn-f and press and release "Reset" 
 
Set Sleep Timer: Fn-j 
 
Upgrade Braille Sense U2 QWERTY Firmware: u  
Check download information: Space 
Cancel download and exit: Alt-F4 
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18. Using the help menu 
 
The help section consists of various text files that allow you to read about the 
many functions of the Braille Sense U2 QWERTY. The "Help" menu contains 
the following sections: 
 
1. Help Overview 
2. Basic Functions Help 
3. Global Options Help 
4. File Manager Help 
5. Word Processor Help 
6. Address Manager Help 
7. Schedule Manager Help 
8. Email Help 
9. Media Player Help 
10. FM Radio Help 
11. Web Browser Help 
12. DAISY Player Help 
13. Bluetooth Manager Help 
14. Database Manager Help 
15. Extras Help 
16. Social Networking Help 
17. Utilities Help 
18. Using the Help menu 
19. Using ActiveSync 
20. Command Summary 
21. Command Summary for USB Keyboard 
22. Troubleshooting Guide 
23. Accessories 
24. Information about the Braille Sense U2 QWERTY 
 
The section, "Help overview," gives a physical orientation to the Braille 
Sense U2 QWERTY and an overview of its functionality. To access the help 
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file, press "Win key" to go to the "program" menu, and use “down arrow 
button” repeatedly until you locate "Help." Press "Enter". The first item is 
"Help Overview". Press "Enter" on "Help Overview" to open it. Keys for 
navigating are the same as those in the Word Processor. For a list of 
navigation keys, please see section 20.3.2.  
As you read the manual on the Braille Sense U2 QWERTY, you can search 
for text in the various sections by pressing "Ctrl-f". Type the text you wish to 
find, and press "Enter". You can find the next occurrence of the particular 
text you searched for by pressing "F3". 
The section, "Basic Functions Help", gives a basic overview of the 
programming and operation of the Braille Sense U2 QWERTY.  
The section, "Global Options Help" provides an explanation of the "Global 
Options" and how to use them to configure your Braille Sense U2 QWERTY 
according to your preferences.  
Most of the remaining sections cover each of the functions of the Braille 
Sense U2 QWERTY in detail. To access these help files, press "Win key" to 
go to the "program" menu, and use “down arrow button” repeatedly until you 
locate "Help". Or press the letter h to quickly jump to and open "Help". Use 
"down arrow button" to navigate to the section you wish to read. Press 
"Enter" on your desired section to open it.  
 
The "Commands Summary" section is a quick reference of hot keys for all 
the programs on the Braille Sense U2 QWERTY: useful when you simply 
want to know the keystroke for performing an action without reading the 
entirety of the instructions on a given program. 
The "Information about the Braille Sense U2 QWERTY" section provides the 
copyright and version of the Braille Sense U2 QWERTY, as well as the 
version of Windows CE that the Braille Sense U2 QWERTY is using, the 
version of the Braille Sense U2 QWERTY firmware, and other useful items 
such as Mac address and Key number. When the "information" section is 
open, you can save the information about the Braille Sense U2 QWERTY by 
pressing "Tab", to navigate to the "Save" button and press "Enter". The unit 
displays "Successfully saved", and returns you to the "Save" button.  
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The saved file is named "bs-information.txt", and is stored in "flashdisk" for 
easy access. 
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19. Using ActiveSync 
 

19.1 What is ActiveSync? 
 
ActiveSync, or Windows Mobile Device Center as it is called in later versions 
of Windows, is a program that allows mobile devices to connect to a 
personal computer. This program enables file transfer from a personal 
computer to a mobile device and vice versa. This program also facilitates 
synchronization of the calendar and contacts on Braille Sense U2 QWERTY 
with those on Microsoft Outlook. ActiveSync/Windows Mobile Device Center 
is not shipped with the Braille Sense U2 QWERTY. It is available free of 
charge from Microsoft for anyone using a Windows PC. If you would like to 
use ActiveSync, you must download it from the Internet and install it on your 
personal computer. If you are using Windows 7, Windows Mobile Device 
Center is automatically downloaded and installed when a Windows Mobile 
device is connected to the PC. 
 

19.2 Connecting the Braille Sense U2 QWERTY to a 
PC 

 
To use ActiveSync/Windows Mobile Device Center with the Braille Sense U2 
QWERTY, you must disable Mass Storage Device Mode before connecting 
to the PC. To do this, press "F10" to open "Global Options". Press "Ctrl-right 
arrow button" to jump to the end of the "Global Options" dialog, as Mass 
Storage Device Mode is the last item. If Mass Storage Device Mode is turned 
on, press "Space" to turn it off. Press "Enter" to save the option settings. 
 
Before connecting the Braille Sense U2 QWERTY to your personal computer 
for the first time, make sure that the Braille Sense U2 QWERTY is powered 
off. Once you have ActiveSync installed, connect a USB cable to the USB 
OTG port on the right panel of the Braille Sense U2 QWERTY. Then, 
connect the other end of the USB cable to a USB port on your personal 
computer. Now, turn on the Braille Sense U2 QWERTY. You will hear 
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several sounds. First, on the Braille Sense U2 QWERTY, you will hear 
chimes. Then, on your computer, you will hear a "ding-dong" sound 
indicating the Braille Sense U2 QWERTY is connected to the PC. You will 
again hear chimes on the Braille Sense U2 QWERTY, and then on your 
computer indicating that each recognizes the other as a device for 
synchronization. 
 

19.3 Setting up the Braille Sense U2 QWERTY in the 
ActiveSync Program 

 
When the PC detects the Braille Sense U2 QWERTY as a Windows Mobile 
device, a screen pops up on your computer prompting you to "Set up a 
Partnership". You can choose "Yes" or "No". If you select "Yes" on this 
screen, the next time you connect the Braille Sense U2 QWERTY to your 
computer, synchronization with Microsoft Outlook will occur automatically. If 
you select "No," the "Set up a Partnership" screen will pop up each time you 
connect the Braille Sense U2 QWERTY to your computer. 
If you want to synchronize the Braille Sense U2 QWERTY with Microsoft 
Outlook, select "Yes," and press the "next" button. Then, you are asked to 
select a name for the mobile device. You can  use only _, A-Z, and 0-9 in 
your device name. You cannot use spaces. Once you have entered an 
appropriate name, press "Enter" on the "next" button.  
A list of functions appears on your computer. Each function has a check box 
located next to it. Make sure no check boxes other than the "Contacts" and 
"Calendar" check boxes are checked, as synchronization of Calendar and 
Contacts is all that is currently supported on the Braille Sense U2 QWERTY. 
You may choose to check "Contacts", "Calendar", or both, depending on 
your preference.  After setting your preferences, press "next". A dialog box 
appears displaying, "setup complete." Tab to the "finish" button and press 
"Enter".  
ActiveSync then looks for changes, and synchronizes with Microsoft Outlook. 
For more information on how to use ActiveSync/Windows Mobile Device 
Center  or Microsoft Outlook, please visit www.microsoft.com. 
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19.4 Transferring Files to the Braille Sense U2 
QWERTY Via ActiveSync 

 
To transfer files to the Braille Sense U2 QWERTY from your computer, 
locate the file(s) you want to transfer from your PC using Windows Explorer. 
Select the file(s), and press "ctrl-c" on your PC to copy the file(s) to the 
clipboard. Go to the desktop on your computer by pressing "Windows-key-d". 
Press the letter m repeatedly until you reach "My computer". Press "Enter". 
Again, press the letter m repeatedly until you reach "mobile device", and 
press "Enter". The "mobile device" is the Braille Sense U2 QWERTY. When 
the "mobile device"  is opened, you are placed in the file list on the Braille 
Sense U2 QWERTY. One of the items in the list is another "my computer" 
icon. Press the letter m repeatedly until you reach "my computer", and press 
"Enter". Another file list opens. In this list, is located a folder called 
"flashdisk." This is the same "flashdisk" that appears under "File Manager" 
on your Braille Sense U2 QWERTY, and is the internal drive on your 
notetaker. Press f until you reach "flashdisk," and then press "Enter."  You 
can paste the file(s) here directly by pressing "ctrl-v," or you can paste the 
file(s) in to one of the folders on the flashdisk. 
If you want to copy folders from the Braille Sense U2 QWERTY to your PC 
via ActiveSync, follow the same steps; but copy files from the Braille Sense 
U2 QWERTY, and paste the file(s) into your preferred directory on the PC. 
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20. Command Summary 
 
20.1 Common Combination Keys 
 
Call up the program menu: Win key 
Key help mode: Ctrl-ESC 
Run the individual program in the program menu Win key-”shortcut key” 
(varies for each program) 
Call up the Task Name list: Fn-F10 
Switch to previous program: Alt-Shift-tab 
Switch to next program: Alt-Tab 
Call up the menu in the individual program: Alt 
Exit: Alt-F4 
Escape: Esc 
Move to the next control in a dialog box: Tab 
Move to the previous control in the dialog box: Shift-tab 
Move to the previous character: Left arrow key 
Move to the next character: Right arrow key 
Move to the previous line/item: Up arrow key 
Move to the next line/item: Down arrow key 
Move to the beginning of line/item: Fn-Left arrow key 
Move to the end of line/item: Fn-Right arrow key 
Move to the top of a document or to the first item: Ctrl-Fn-Left arrow key 
Move to the bottom of a document or to the last item: Ctrl-Fn-Right arrow 
key 
Move to the previous page or to the first item of the previous 32-item group: 
Page up (Fn-Up arrow key) 
Move to the next page or to the first item of the next 32-item group: Page 
down (Fn-Down arrow key) 
Scroll left: Up scroll button 
Scroll right: Down scroll button 
Move the cursor to each cell or move to an item: The corresponding cursor 
routing key 
Capital sign: Caps lock 
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Read the current item again: Fn-r 
Say current time: Fn-t  
Display power status: Fn-b 
Call up the “global options”: F10 
Online help: F1 
Check software version: Fn-v only in the Braille Sense U2 QWERTY 
“program” menu. 
Display network status: fn-n in the Braille Sense U2 QWERTY “program” 
menu 
 
Braille display on/off: F4 
Voice on/off: F5 
Increase the voice volume: F6 
Decrease the voice volume: Shift-F6 
Increase the voice rate: F7 
Decrease the voice rate: Shift-F7 
Increase the voice pitch: F8 
Decrease the voice pitch: Shift-F8 
 
One-handed mode on/off: Fn-h 
Bluetooth on/off: F9 
Wireless LAN on/off: F11 
Ethernet port on/off: Fn-F11 
 
Scroll voice on/off: Fn-F5 
Selecting Braille cursor: Fn-F3 
Selection control information: Fn-F1 
Eight dot mode on/off: Fn-F4 
Open txt help: Win key-F1 while executing program 
 
20.2 File Manager 
 
20.2.1 Navigation keys on the file list and menu list 
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Move to previous item: Up arrow key or up scroll button 
Move to next item: Down arrow key or down scroll button 
Move to the beginning of the list: Ctrl-Fn-Left arrow key 
Move to the end of the list: Ctrl-Fn-Right arrow key 
 
20.2.2 Navigation Keys for the File List 
 
Fast move to folder list or move to file list: Ctrl-Down arrow key 
Move between file list and address window: Tab / shift-tab 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 
Fast move to the top level disk: Shift-Backspace 
 
20.2.3 Item (folder or File) Selection Key 
 
Select item by item: Space 
Continuous selection: Ctrl-b 
Select all Ctrl-a 
 
20.2.4 Hot Keys for the Commands 
 
Open: Ctrl-o  
Open with: Ctrl-h  
Zip: Ctrl-z  
Unzip: Ctrl-u 
Send: Ctrl-s 
Copy: Ctrl-c 
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete: DEL 
Rename: F2 
New document: Ctrl-n 
New folder: Alt-f  
File conversion: Ctrl-t 
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Select all: Ctrl-a  
Sort files by: Ctrl-g 
Set file info: Ctrl-l 
Display only files of type: Ctrl-w  
Search for file: Ctrl-f  
Information: Alt-Enter 
Setup Network connection: Alt-e 
Cancel setting of Network connection: Alt-F4 
Sharing a folder with other computer: Alt-s 
Remove remote folder on network: Alt-u 
Setup sharing security: Alt-p 
 
 
20.3 Word Processor 
 
20.3.1 Hot Keys for the Commands 
 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s  
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p  
Settings: Ctrl-e  
Exit: Alt-F4 
 
Start selection: Ctrl-b 
Copy: Ctrl-c 
Cut: Ctrl-x  
Paste: Ctrl-v 
Delete: Del 
Delete blank lines: Alt-e 
Add to clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del or Ctrl-d 
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Select All: Ctrl-a  
Insert from file: Ctrl-i 
Insert date: Ctrl-w 
Insert Time: Alt-w 
Toggle insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 
 
Find: Ctrl-f 
Find again: F3 
Replace: Ctrl-r  
Go to location: Ctrl-g 
Go to previous page: Page up (Fn-Up arrow key) 
Go to next page: Page down (Fn-Down arrow key) 
Set mark: Ctrl-m  
Go to mark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: Tab 
 
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u  
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter 
Auto scroll: up-down scroll buttons 
Read status: Fn-/ 
 
Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 
 
20.3.2 Miscellaneous Hot Keys 
 
Move to previous character: Left arrow key 
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Move to next character: Right arrow key 
Move to previous word: Ctrl-Left arrow key 
Move to next word: Ctrl-Right arrow key 
Move to the beginning of the line: Fn-Left arrow key 
Move to the end of the line: Fn-Right arrow key 
Move to previous line: Up arrow key 
Move to next line: Down arrow key 
Move to previous paragraph: Ctrl-Up arrow key  
Move to next paragraph: Ctrl-Down arrow key 
Move to the beginning of the document: Ctrl-fn-Left arrow key 
Move to the end of the document: Ctrl-fn-Right arrow key 
Read current paragraph: Fn-v 
Read current line: Fn-c 
Read current word: Fn-x 
Read current character: Fn-z 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
Confirm current cursor position: Fn-s 
Set view format character: Ctrl-5 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 
Set reading mode: Ctrl-4 
 
20.4 Address Manager 
 
20.4.1 Move keys for adding an address or in the menu 
 
Move to the previous field or menu item: Left arrow key 
Move to the next field or menu item: Right arrow key 
Move to the first field or menu item: Fn-Left arrow key 
Move to the last field or menu item: Fn-Right arrow key 
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20.4.2 Move Keys in the Search Result List 
 
Move to the previous field: Ctrl-Left arrow key 
Move to the next field: Ctrl-Right arrow key 
Move to the first field: Fn-Left arrow key 
Move to the last field: Fn-Right arrow ey 
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 
Move to the last record: Ctrl-Fn-Right arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
 
20.4.3 Hot keys for the Commands 
 
Add address: Ctrl-n 
Find address: Ctrl-f 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Setting backup option: Ctrl-e 
Setting add/searching address fields: Ctrl-o 
 
20.4.4 Miscellaneous Hot Keys 
 
Cancel: ESC  
Exit: Alt-F4 
 
20.5 Schedule Manager 
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20.5.1 Hot keys for the commands 
 
Move to the next field: Tab  
Move to the previous field: Shift-tab  
Add schedule: Ctrl-n 
Modify schedule: Ctrl-m 
Delete schedule: Del 
Alarm option: Ctrl-o  
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Save schedule as file: Alt-s 
Print schedule: Ctrl-p 
 
20.5.2 Move Keys in the Search Result List 
 
1. Move from an appointment to another in the schedule list 
Move to the previous a in the same day: Up arrow key 
Move to the next appointment in the same day: Down arrow key 
Move to the first appointment in the same day: Fn-Left arrow key 
Move to the last appointment in the same day: Fn-Right arrow key 
2. Move from one appointment to another in all the appointments 

registered 
Move to the previous schedule: Ctrl-Left arrow key 
Move to the next schedule: Ctrl-Right arrow key 
Move to the first schedule: Ctrl-Fn-Left arrow key 
Move to the last schedule: Ctrl-Fn-Right arrow key 
 
20.6 E-mail 
 
20.6.1 Hot keys that are used in the inbox 
 
Call “Accounts manager”: Ctrl-m  
Check for new mail: Alt-m 
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Write new message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Call up “set path”: Ctrl-p 
Call up “set option”: Ctrl-o 
Call up “set spam”: Ctrl-e 
Find: Ctrl-f 
Find again: F3 
Move to unread message: Ctrl-u 
Move to mailbox: Alt-x 
Copy to mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (This is valid only at the “from” item 
of the “inbox”). 
Delete received e-mail: Del (It is valid only at the “Subject” and “date” item 
in the “inbox”). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
20.6.2 Hot keys for Sending E-Mail Including Reply, Forward, and 
Save in the Mail Outbox 

 
Search address list: Ctrl-l 
Attach file: Ctrl-f 
Send e-mail: Ctrl-s 
Save in mail storage box: Fn-s 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
20.6.3 Hot Keys for Reading E-Mails or Writing an E-Mail Message 

 
Start selection: Ctrl-b 
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Select all: Ctrl-a  
Copy to the clipboard: Ctrl-c  
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in the 
“inbox”). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-mail 
in the “inbox”). 
Delete: Del (It is not valid when you are reading e-mail in the “inbox”). 
Cancel block: ESC 
 
20.7 Media Player 
 
20.7.1 Hot keys for commands 
 
Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete item: Del 
Open URL: Ctrl-l 

 
Play: Enter, Play button 
Previous track: Alt-Left arrow key, Previous button 
Next track: Alt-Right arrow key, Next button 
Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up arrow key) 
Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down arrow 
key)  
Back 5 track: Alt-Up arrow key 
Forward 5 track: Alt-Down arrow key 
First track: Ctrl-Fn-Left arrow key 
Last track: Ctrl-Fn-Right arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key  
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Speed up: Shift-Right arrow key 
Slow down: Shift-Left arrow key 
Pause/continue: Space, Play button 
Stop: Backspace, Stop button 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
Delete play list during stop: Del 
 
Call up the record dialog box: Ctrl-r, Record button 
Record: Record button 
Pause/continue recording: Space, Record button 
Play: Play button 
Pause/continue play: Space, Play button 
Stop: Backspace, Stop button 
Set bookmark: Ctrl-m  
Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
Set mark: Alt-m 
Move to mark: Alt-j 
Move to previous mark: V 
Move to next mark: N 
Delete mark: Alt-d 
Mark manager: Alt-k 
 
Configuration dialog box: Alt-c 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
 
20.7.2 Hot Keys in the Play Information Tab 
 
Move to the next information: Down arrow 
Move to the previous information: Up arrow 
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“Pause” when it is play state and “play” when it is pause state: Space 
Start playing: Enter 
Stop playing: Backspace 
Play the next file: Alt-right arrow 
Play the previous file: Alt-Left arrow key 
Play the last file: Ctrl-Fn-Left arrow key 
Play the first file: Ctrl-Fn-Right arrow key 
Play the fifth file after the current file: Alt-Down arrow key 
Play the fifth file before the current file: Alt-Up arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Right arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key  
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
Open menu: Alt 
Open help: F1 
Move to “play list” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
20.7.3 Hot Keys in the Play List Tab 
 
Move to the next file: Down arrow key 
Move to the previous file: Up arrow key 
Move to the last file: Fn-Right arrow key  
Move to the first file: Fn-Left arrow key 
Select/resume current file (while playing, it is used as play/pause): Space 
Start selecting files: Ctrl-b 
Start playing the selected files: Enter 
Stop playing: Backspace 
Delete the selected files in the play list: Del 
Play the next file: Alt-Right arrow key 
Play the previous file: Alt-Left arrow key  
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Play the last file: Ctrl-Fn-Right arrow key 
Play the first file: Ctrl-Fn-Left arrow key 
Play the fifth file after the current file: Ctrl-Down arrow key 
Play the fifth file before the current file: Ctrl-Up arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key 
Change time index: Ctrl-Up arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
Open menu: Alt 
Open help: F1 
Move to “playback information” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
20.8 FM radio 
 
Call up the sets dialog box: Ctrl-e 
Call up the menu: Alt 
Internal speakers on/off: X or Fn-x 
Move to next frequency: Ctrl-Up arrow key 
Move to previous frequency: Ctrl-Down arrow key 
Auto previous frequency: Ctrl-Left arrow key or short press pevious button 
Auto next frequency: Ctrl-Right arrow key or short press next button 
Go to frequency: Ctrl-f 
Move to previous preset: Alt-Left arrow key or long press previous button 
Move to next preset: Alt-Right arrow key or long press next button 
Registry preset: Ctrl-s or long press record button 
Delete the preset: Delete or long press stop button 
Call up the record dialog box: Ctrl-r 
Record start/pause: short press record button 
Record stop: short press stop button 
Mute on: short press stop button or Space 
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Muto off: short press play button or Space 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
 
20.9 Web Browser 
 
20.9.1 Hot keys for the command 
 
Open URL: Ctrl-l 
Open: Ctrl-o 
Save as: Alt-s 
Information: Alt-Enter 
Exit: Alt-F4 
 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter  
Auto scroll: Up scroll button-down scroll button 
 
Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to clipboard: Ctrl-Insert 
Copy URL: Alt-d 
Copy link: Alt-l 
 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow key 
Go to the next page: Alt-Right arrow key 
Go to previous heading: Alt-b or Ctrl-F3  
Go to next heading: Alt-f or Ctrl-F4 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
Refresh: Ctrl-r 
Open the history list: Ctrl-h  
Check the address of the selected title in the history list: Fn-i  
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Find: Ctrl-f  
Find again: F3  
Links list: Alt-i 
 
Set current as your home page: Ctrl-s  
Add to favorites: Alt-a  
Favorites list: Ctrl-l 
 
Options setting: Alt-o  
 
20.9.2 Hot Keys When Playing Audio Files in web browser 
 
Turn up the volume: Shift-Up arrow key 
Turn down the volume: Shift-Down arrow key 
Play: play button of the front panel 
Stop: stop button of the front panel 
 
20.9.3 Hot Keys for Reading Web Pages 
 
Move between controls 
Move to the previous control: Shift-tab  
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow key 
Select the previous item in the combo box (list box): Alt-Up arrow key 
 
Moving to the form 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
 
Table navigation hot keys 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow key 
Move to the next cell: Ctrl-Shift-Right arrow key 
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Move to the upper cell: Ctrl-Shift-Up arrow key 
Move to the lower cell: Ctrl-Shift-Down arrow key 
Read current cell: Ctrl-Shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow key 
Move to the next cell of the upper level table: Ctrl-Right arrow key 
Move to the upper cell of the upper level table: Ctrl-Up arrow key 
Move to the lower cell of the upper level table: Ctrl-Down arrow key 
Check the current position: Fn-s 
 
Move to frame 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 
Read the current line: Fn-r 
 
20.10 Daisy Player 
 
Move to the title list: Shift-Backspace 
Open DAISY file: Ctrl-o 
Voice setting: Ctrl-s 
Check the book-info: Alt-Enter 
Exit: Alt-F4 
Play/Pause: Space 
Move to the beginning of document: Fn-Left arrow key 
Move to the last phrase: Fn-Right arrow key 
Increase the speed: Shift-Right arrow key 
Decrease the speed: Shift-Left arrow key 
Increase the volume: Shift-Up arrow key 
Decrease the volume: Shift-Down arrow key 
Move to the next phrase: Ctrl-Right arrow key or short press “next” button 
Move to the previous phrase:Ctrl-Left arrow key or short press “previous” 
button 
Move to the next fifth phrase: Ctrl-Down arrow key 
Move to the previous fifth phrase: Ctrl-Up arrow key 
Move to the next page: Page down (Fn-Up arrow key) 
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Move to the previous page: Page up (Fn-Down arrow key) 
Go to the page: Ctrl-g 
Move up: Alt-Left arrow key 
Move down: Alt-Right arrow key 
Set to prior level: Alt-Up arrow key 
Set to next level: Alt-Down arrow key 
Move to the next heading: Ctrl-F6 or long press “next” button 
Move to the previous heading: Ctrl-F5 or long press “previous” button 
Move to the last heading: Ctrl-F8 
Move to the first heading: Ctrl-F7 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n  
Find heading: Ctrl-f 
Find again: F3  
Scan heading: Ctrl-n 
Read heading: Ctrl-w  
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
 
20.11 Bluetooth Manager 
 
Scanning Bluetooth device: Ctrl-r 
Connecting device: Enter on the device name 
Connecting service: Enter on the service name 
Disconnect service in Bluetooth service list: Ctrl-d  
Move to Bluetooth device list in service list: Backspace 
Remove device setting in Bluetooth device list: Del  
 
1) FTP service 
Open local folder/move remote folder: Ctrl-o  
Copy: Ctrl-c 
Paste: Ctrl-v  



452 
 

Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 
Delete file/folder: Del 
Information: Ctrl-i 
 
20.12 Database Manager 
 
Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r  
Setting backup option: Ctrl-e  
Backup database: Ctrl-u  
Restore database: Ctrl-o 
 
1. Move by controls 

Move to the next control: Tab  
Move to the previous control: Shift-Tab  

2. Move in a list box 
Move to the next list item: Down arrow key or down scroll button 
Move to the previous list item: Up arrow key or up scroll button 

3. Select your answer in the prompt box 
Move to the next answer: Space or Down arrow key 
Move to the previous answer: Backspace or Up arrow key 

4. Move in the “list of records found” 
Move to the next record: Down arrow key or down scroll button 
Move to the previous record: Up arrow key or up scroll button 
Move to the last record: Ctrl-Fn-Right arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to the last field: Fn-Right arrow key  
Move to the first field: Fn-Left arrow key 
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Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 

 
20.13 Extras 
 
20.13.1 Games  
Skip record: Esc key/Alt-F4 
 
20.14 Social Networking 
 
20.14.1 Twitter 
 

Sign Out: Ctrl-g 
Personal Information: Ctrl-I  
Save Current Timeline: Alt-s 
Home Timeline: Ctrl-h  
Friend Timeline: Ctrl-f  
User Timeline: Ctrl-u  
Current User Timeline: Alt-u 
Mention Timeline: Ctrl-m  
Retweet By Me: Alt-b  
Retweet To Me: Alt-t  
Retweet Of Me: Alt-o  
Tweet: Ctrl-t  
Remove Tweet: Delete 
Retweet: Ctrl-e  
Reply: Ctrl-y  
Add To Favorite: Ctrl-v  
Favorite List: Ctrl-l  
Send Direct Message: Ctrl-s  
Sent Direct Message: Alt-m  
Received Direct Message: Alt-r  
Follow User: Alt-a  
Following: Alt-l  
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Followers: Alt-e  
Global Search: Ctrl-f  
User Search: Alt-f  
Search Word List: Alt-w 
Next List: Ctrl-n  
Refresh: Ctrl-r  
Exit: Alt-F4 
Escape: Esc key 
 
Move to the next tweet: Down arrow key   
Move to the previous tweet: Up arrow key 
Move to the first tweet on the refreshing list: Ctrl-Fn-Left arrow key 
Move to the last tweet on the refreshing list: Ctrl-Fn-Right arrow key 
Move to the previous 32 list: Fn-Un arrow key  
Move to the next 32 list: Fn-Down arrow key  
 
Move to the previous list: Up arrow key 
Move to the next list: Down arrow key 
Move to the top of the list: Ctrl-Fn-Left arrow key/Fn-Left arrow key 
Move to the bottom the list: Ctrl-Fn-Right arrow key/Fn-Right arrow key 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 

 
20.14.2 Google talk 
 

File Menu Commands 
Sign out: Ctrl-l  
Export Contact Lists: Alt-x  
Import Contact Lists: Alt-i  
Exit: Alt-F4 
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
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Send File: Alt-f  
Move to Recently Chat: Ctrl-t  
Manage Chat: Ctrl-m  
 
Contact Menu Commands 
Add Contact: Alt-q  
Delete Contact: Delete 
Block Contact: Alt-b  
Manage Block List: Alt-m  
Contact Information: Ctrl-i  
Manage Contact List: Ctrl-p  
 
Option Menu Commands 
My Status Options: Alt-u  
Action Options: Alt-a  
Alert Options: Alt-o  
Path Options: Alt-p  
 
Chat Window Menus 
 
File Menu Commands  
Save Conversation: Alt-s  
Close Chat: Alt-F4 
 
Edit Menu Commands 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Delete  
Paste: Ctrl-v  
Start Selection: Ctrl-b  
Select All: Ctrl-a  
Find: Ctrl-f  
Find Again: F3  
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Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Stop Voice Chat: Esc key 
Send File: Alt-f  
View Contact List: Ctrl-t  
Manage Chat: Ctrl-m 
Move to Previous Chat: Ctrl-Shift-Tab 
Move to Next Chat: Ctrl-Tab 
 
The move keys in Google Talk. 
Move to the previous Contents: Up arrow key  
Move to the next Contents: Down arrow key 
Move to the previous 32-items of the Contents: Fn-Up arrow key button 
Move to the next 32-item of the Contents: Fn-Down arrow key button 
Move to the first item of the Contents: Ctrl-Fn-Left arrow key 
Move to the last item of the Contents: Ctrl-Fn-Right arrow key 

  
20.14.3 MSN Messenger 
 
1. Sign-in dialog box 

Move to the next control: Tab 
Move to the previous control: Shift-tab  
Check or uncheck a check box: Space 

2. The contact list box 
Move to the previous item: Up arrow key  
Move to the next item: Down arrow key  
Move between online and offline groups: Ctrl-Down arrow key 
Open the menu: Alt 
Sign out: Ctrl-n  
View chat: Ctrl-r 
My status: Ctrl-m  
Close: Alt-F4 
Add contact: Ctrl-a  
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Delete contact: Ctrl-d 
Contact information: Ctrl-v 
Send instant message: Ctrl-s  
Last message: Alt-r 
Play keyboard sound: Ctrl-k 
Message sound notification while in current window: Fn-s  
Message sound notification while messenger is in the background: Alt-m  
Nickname: Ctrl-p 
Save account: Ctrl-o  
Confirm the received message: Ctrl-l 

3. Instant message dialog box 
Move to the next control: Tab  
Move to the previous control: Shift-Tab  
Move between the instant message dialog box and the contact list box: 
Page up or Page down 
Save as: Alt-s 
Print: Ctrl-p 
Close: ESC 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Ctrl-d 
Paste: Ctrl-v  
Select all: Ctrl-a 
Start selection: Ctrl-b 
Find: Ctrl-f 
Find again: F3  
Invitation: Ctrl-i 

 
20.15 Utilities 
 
20.15.1 Calculator 
 
Calculator initialize: Alt-c 
Delete numbers or operators: Backspace 
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General function: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p  
Exp: Ctrl-e 
 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d  
Save Items: Alt-s  
 
Trigonometric Function: Ctrl-s  
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h  
Cosine: Ctrl-c, c 
Arc Cosine: Ctrl-c, a  
Hyperbolic Cosine: Ctrl-c, h  
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h  
 
Logarithm Function: Ctrl-l  
Natural Logarithm: Ctrl-l, e  
Common Logarithm: Ctrl-l, n  
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Copy to Clipboard: Ctrl-Insert 
 
Option Setting: Ctrl-o  
 
20.15.2 Setting time and date 
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Left arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 
Switch Between a.m. and p.m.: Fn-x 
 
20.15.3 Checking Date and Time 
 
Checking date and time: Fn-t 
 
20.15.4 Calendar 
 
Move to the previous item: Tab  
Move to the next item: Shift-tab  
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
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Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 
20.15.5 Pronunciation dictionary 
 
Move to the previous control: Tab 
Move to the next control: Shift-tab  
Move to the previous item in entry: Up arrow key 
Move to the next item in entry: Down arrow key 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 
 
20.15.6 Stopwatch 
 
Stopwatch start, pause, restart: enter 
Check the elapsed time: Backspace 
Stop Braille display: Fn-Space 
Restart Braille display: Fn-Space 
Switch between stopwatch and Countdown timer: “Tab” or “shift-tab” 
Count down timer pause or restart: enter 
Count down timer Clear: Backspace 
Exit stopwatch or count down timer: Alt-F4 
 
20.15.7 Display network status 
 
Display network status: Fn-n 
 
20.15.8 Display power status 
 
Display power status: Fn-b 
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20.15.9 Backup/Restore personalized settings 
 
Move to previous item: Up arrow key or up scroll button 
Move to next item: Down arrow key or down scroll button 
Move to previous control: Shift-tab  
Move to next control: Tab  
Select/unselect check box: Space 
 
20.15.10 Format 
 
Disk format: Fn-f 
 
20.15.11 Sleep Timer 
 
Set Sleep Timer: Fn-j 
 
20.15.12 Upgrading the Braille Sense U2 QWERTY Firmware 
 
Check download information: Space 
Cancel download and exit: Alt-F4 
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21. Command Summary for USB Keyboards 
 

21.1 Common Combination Keys 
 
Open the program menu: Win key 
Open the Task Name list: Ctrl-Shift-F10 
Open the “menu” in the individual program: Alt  
Run the individual program in the program menu: Win key-”shortcut key” 
(varies for each program) 
Switch to previous program: Alt-Shift-Tab 
Switch to next program: Alt-Tab 
Exit: Alt-F4 
Escape: ESC 
Move to the next control in a dialog box: Tab 
Move to the previous control in the dialog box: Shift-tab 
Move to the previous character: Left arrow key 
Move to the next character: Right arrow key 
Move to the previous line item: Up arrow key 
Move to the next line item: Down arrow key 
Move to the beginning of line item: Home key 
Move to the end of line item: End key 
Move to the top of a document or to the first item: Ctrl-home 
Move to the bottom of a document or to the last item: Ctrl-end 
Move to the previous page or to the first item of the previous 18-item group: 
Page up 
Move to the next page or to the first item of the next 18-item group: Page 
down 
Read the current item again: Ctrl-shift-r 
Say current time: Ctrl-shift-t 
Display power status: Ctrl-shift-b 
Print spool: Alt-shift-p 
Open the “Global options”: F10 
Online help: F1 
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Check your version: Ctrl-shift-v only in the Braille Sense U2 QWERTY 
“program” menu. 
Display network status: Ctrl-shift-n in the Braille Sense U2 QWERTY 
“program” menu 
Voice volume up: F6 
Voice volume down: Shift-F6 
Voice rate up: F7 
Voice rate down: Shift-F7 
Voice pitch up: F8 
Voice pitch down: Shift-F8 
Voice on/off: F5 
Braille display on/off: F4 
Bluetooth on/off: F9 
Wireless LAN on/off: F11 
 

21.2 File Manager 
 

21.2.1 Navigation keys on the file list and menu list 
 
Move to previous item: Up Arrow key 
Move to next item: Down Arrow key 
Move to the beginning of the list: Ctrl-home 
Move to the end of the list: Ctrl-end 
 

21.2.2 Navigation Keys in the File List 
 
Fast move to folder list or move to file list: Ctrl-down Arrow 
Move between file list and address window: Tab / shift-tab 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 
Fast move to the top level disk: Shift-Backspace 
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21.2.3 Item (Folder or File) Selection Keys 
 
Select item by item: Space 
Continuous selection: Ctrl-b 
Select all: Ctrl-a 
 

21.2.4 Hot Keys for the Commands 
 
Open: Ctrl-o 
Open with: Ctrl-h 
Zip: Ctrl-z 
Unzip: Ctrl-u 
Send: Ctrl-s 
Copy: Ctrl-c 
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete: DEL 
Rename: F2 
New document: Ctrl-n 
New folder: Alt-f 
File conversion: Ctrl-t 
Select all: Ctrl-a 
Sort files by: Ctrl-g  
Set file info: Ctrl-i 
Display only files of type: Ctrl-w 
Search file: Ctrl-f 
Information: Alt-Enter 
Setup Network connection: Alt-e 
Cancel setting of Network connection: Alt-F4 
Sharing a folder with other computer: Alt-s 
Remove remote folder on network: Alt-u 
Setup sharing security: Alt-p 
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21.3 Word Processor 
 

21.3.1 Hot keys for the command 
 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s 
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p 
Settings: Ctrl-e 
Exit: Alt-f4 
Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to the clipboard: Ctrl-Ins 
Clear clipboard: Ctrl-Del 
Delete: Del 
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete blank lines: Alt-e 
Select All: Ctrl-a 
Insert from file: Ctrl-i  
Insert date: Ctrl-w 
Change insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 
 
Find: Ctrl -f 
Find again: F3  
Replace: Ctrl-r 
Go to location: Ctrl-l 
Go to previous page: Page up 
Go to next page: Page down 
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Set bookmark: Ctrl-m 
Go to bookmark: Ctrl-j 
Go to previous document: Shift-Tab 
Go to next document: Tab 
  
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Ctrl-g 
 
Read status: Ctrl-shift-/ 
Braille document layout: Alt-F5 
Print document layout: Alt-F7 
Braille paragraph layout: Alt-F6 
Print paragraph layout: Alt-F8 
 

21.3.2 Miscellaneous Hot Keys 
 
Move to previous character: Left arrow key 
Move to next character: Right arrow key 
Move to previous word: Ctrl-Left arrow 
Move to next word: Ctrl-Right arrow 
Move to the beginning of the line: Home key 
Move to the end of the line: End key 
Move to previous line: Up arrow key 
Move to next line: Down arrow key 
Move to previous paragraph: Ctrl-up arrow 
Move to next paragraph: Ctrl-down arrow 
Move to the beginning of the document: Ctrl-home 
Move to the end of the document: Ctrl-end 
 
Read current paragraph: Ctrl-shift-v 
Read current line: Ctrl-shift-c 
Read current word: Ctrl-shift-x 
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Read current character: Ctrl-shift-z 
 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
 
Confirm current cursor position: Ctrl-Shift-s 
Set view format character: Ctrl- 5 
Set reading unit: Ctrl-3  
Set read only: Ctrl-2 
Set reading mode: Ctrl-4 
 

21.4 Address Manager 
 

21.4.1 Move keys for moving from field to field in the record 
or in the menu 

  
Move to the previous field or menu item: Up arrow key 
Move to the next field or menu item: Down arrow key 
Move to the first field or menu item: Ctrl-Home 
Move to the last field or menu item: Ctrl-End 
 

21.4.2 Move Keys for Moving from Record to Record 
  
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
Move to the first field: Ctrl-Home 
Move to the last field: Ctrl-End 
Move to the previous field: Ctrl-Left arrow key 
Move to the next field: Ctrl-Right arrow key 
Move to the first record: Ctrl-Home 
Move to the last record: Ctrl-End 
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Move to next same field different record: Left arrow key 
Move to previous same field different record: Right arrow key 
 

21.4.3 Hot Keys for the Commands 
 
Add address: Ctrl-n 
Find address: Ctrl-f 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Backup option: Ctrl-e 
Setting add/searching address fields: Ctrl-o  
 

21.4.4 Miscellaneous Hot Keys 
 
Tab: Tab 
Shift-tab: Shift-Tab 
Cancel: ESC 
Exit: Alt-f4 
 

21.5 Schedule Manager 
 

21.5.1 Hot keys for the commands 
 
Move to the next field: Tab 
Move to the previous field: Shift-Tab 
Add schedule: Ctrl-n 
Search schedule: Ctrl-s 
Modify schedule: Ctrl-m 
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Delete schedule: Del 
Alarm option: Ctrl-o 
Save schedule as file: Alt-s 
Print schedule: Ctrl-p 
Backup schedule list: Ctrl-u 
Restore schedule list: Ctrl-r 
Backup option: Ctrl-e 
Switch searching mode: Ctrl-F2  
 

21.5.2 Movement Keys for the Search Result List 
 
1. Move from an appointment to another in the schedule list 

Move to the previous appointment in the same day: Up arrow key 
Move to the next appointment in the same day: Down arrow key 
Move to the first appointment in the same day: Home 
Move to the last appointment in the same day: End 

2. Move from one appointment to another in all the appointments 
registered 

Move to the previous schedule: Ctrl-Left arrow key 
Move to the next schedule: Ctrl-Right arrow key 
Move to the first schedule: Ctrl-Home 
Move to the last schedule: Ctrl-End 

 

21.6 E-mail 
 
21.6.1 Hot keys for reading e-mails 
 
Call “Accounts manager”: Ctrl-m 
Check for new mail: Alt-m 
Write new message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
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Call up “set path”: Ctrl-p 
Call up “set option”: Ctrl-o 
Call up “set spam”: Ctrl-e 
 
Find: Ctrl-shift-f 
Find again: f3  
Move to mailbox: Alt-x 
Copy to mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (This is valid only at the “from” item). 
Delete received e-mail: DEL (It is valid only at the “Subject” and “date” 
item). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Move to unread message: Ctrl-u (It is valid only at the “Subject” and “date” 
item) 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-f4 
 
21.6.2 Hot Keys for Sending E-mail Including Reply, Forward, and 
Save in the Pail Outbox 

 
Search address list: Ctrl-l 
Attach file: Ctrl-f 
Send e-mail: Ctrl-s 
Save in mail Outbox: Fn-s 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-f4 
 
21.6.3 Hot Keys for Reading E-mail messages or Writing an E-mail 
Message 

  
Start selection: Ctrl-b 
Select all: Ctrl-a 
Copy to the clipboard: Ctrl-c 
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Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-mail). 
Delete selection and delete a letter: DEL (It is not valid when you are 
reading e-mail). 
Cancel block: ESC 
 

21.7 Media Player 
 

21.7.1 Hot keys for commands 
 
Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete time: Del 
 
Play: x or Enter 
Previous track: z or Alt-Left arrow key 
Next track: b or Alt-Right arrow key 
5th previous track: Alt-Up arrow key 
5th next track: Alt-Down arrow key 
First track: Ctrl-home key 
Last track: Ctrl-end key 
Move to backward by time index and play: Ctrl-Left arrow key 
Move to forward by time index and play: Ctrl-Right arrow key 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key 
Pause/Continue: Space 
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Stop: c or Backspace 
Delete play list during stop: DEL 
 
Record: Ctrl-r 
Play: Enter 
Stop: Backspace 
Pause/Continue recording: Space 
 
Configuration dialog box: Alt-c 
Set bookmark: Ctrl-m 
Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
 

21.7.2 Hot Keys in the Play Information Tab 
 
Move to the next information: Down arrow key 
Move to the previous information: Up arrow 
Pause/Play when it is pause state: Space 
Start playing: Enter 
Stop playing: Backspace 
Play the next file: Alt-Right arrow key 
Play the previous file: Alt-Left arrow key 
Play the last file: Ctrl-End key 
Play the first file: Ctrl-Home key 
Play the fifth file after the current file: Alt-Down arrow key 
Play the fifth file before the current file: Alt-Up arrow key 
Move to backward by time index and play: Ctrl-Left arrow key 
Move to forward by time index and play: Ctrl-Right arrow key 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Volume up: Shift-Up arrow key 
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Volume down: Shift-Down arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key 
Open menu: Alt 
Open help: F1 
Move to “play list” tab: Tab/Shift-Tab 
Exit “media player”: Alt-F4 
 

21.7.3 Hot Keys in the Play List Tab 
 
Move to the next file: Down arrow key 
Move to the previous file: Up arrow key 
Move to the last file: End key 
Move to the first file: Home key 
Select resume current file (while playing, it is used as plays/pause): Space 
Start selecting files: Ctrl-b 
Start playing the selected files: Enter 
Stop playing: Backspace 
Delete the selected files in the play list: Del 
Play the next file: Alt-Right arrow key 
Play the previous file: Alt-Left arrow key 
Play the last file: Ctrl-end key 
Play the first file: Ctrl-home key 
Play the fifth file after the current file: Alt-Down arrow 
Play the fifth file before the current file: Alt-Up arrow 
Move to backward by time index and play: Ctrl-Left arrow key 
Move to forward by time index and play: Ctrl-Right arrow key 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key 
Open menu: Alt 
Open help: F1 
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Move to “playback information” tab: Tab/Shift-Tab 
Exit “media player”: Alt-F4 
 

21.8 FM Radio 
 
Open the sets dialog box: Ctrl-e 
Open the “menu”: Alt 
Internal speakers on/off: x or Ctrl-shift-x 
Move to next frequency: Right arrow key 
Move to previous frequency: Left arrow key 
Auto previous frequency: Ctrl-Left arrow key 
Auto next frequency: Ctrl-Right arrow key 
Go to frequency: Ctrl -f 
Move to previous preset: Alt-Left arrow key 
Move to next preset: Alt-Right arrow key 
Delete the preset: Del 
Registry preset: Ctrl-s 
Open the record dialog box: Ctrl-r 
Mute on/off: Space 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Recoding settings: Alt-r 
 

21.9 Web Browser 
 

21.9.1 Hot keys for the command 
 
Open URL: Ctrl-l 
Open: Ctrl-o  
Save as: Ctrl-s 
Page information: Alt-Enter 
Exit: Alt-F4 
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Read from beginning to cursor: Alt-g 
Read from cursor to end: Ctrl-Shift-Enter 
 
Copy selection: Ctrl-b 
Copy: Ctrl-c 
Add clipboard: Ctrl-Ins 
Copy URL: Alt-d  
Copy link address: Alt-l 
 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow key 
Go to the next page: Alt-Right arrow key 
Go to previous text: Ctrl-F5Go to next text: Ctrl-F6 
Go to previous heading: Alt-b or Ctrl-F3 
Go to next heading: Alt-f or Ctrl-F4 
Refresh: Ctrl-r 
Open the history list: Ctrl-h 
Check the address of the selected title in the history list: Ctrl-shift-i 
Find: Ctrl-f 
Find again: F3 
Links list: Alt-i 
 
Register as your home page: Ctrl-s 
Add to favorites: Alt-a 
Favorites list: Ctrl-l 
 

21.9.2 Hot Keys When Playing Audio Files in web browser 
 
Turn up the volume: Shift-Up arrow key 
Turn down the volume: Shift-Down arrow key 
 

21.9.3 Hot Keys for Reading Web Pages 
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Move to the previous control: Shift-Tab 
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow key 
Select the previous item in the combo box (list box): Alt-Up arrow key 
 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow key 
Move to the next cell: Ctrl-Shift-Right arrow key 
Move to the upper cell: Ctrl-Shift-Up arrow key 
Move to the lower cell: Ctrl-Shift-Down arrow 
Read current cell: Ctrl-Shift-F 
Move to the previous cell of the upper level table: Ctrl-Left arrow key 
Move to the next cell of the upper level table: Ctrl-Right arrow key 
Move to the upper cell of the upper level table: Ctrl-Up arrow key 
Move to the lower cell of the upper level table: Ctrl-Down arrow key 
Check the current position: Ctrl-shift-s 
 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 
 
Read the current line: Ctrl-Shift-r 
 

21.10 Daisy Player 
 
Play/Pause: Space  
Move to the beginning of document: Home 
Move to the last phrase: End 
Increase the speed: Shift-Left arrow key 
Decrease the speed: Shift-Right arrow key 
Increase the volume: Shift-Up arrow key 
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Decrease the volume: Shift-Down arrow key 
 
Move to the next phrase: Right arrow key 
Move to the previous phrase: Left arrow key 
Move to the next fifty phrase: Ctrl-Up arrow key 
Move to the previous fifty phrase: Ctrl-Down arrow key 
Move to the next page: Page down 
Move to the previous page: Page up 
Go to the page: Ctrl-g 
 
Move to the upper-level: Alt-Left arrow key 
Move to the down-level: Alt-Right arrow key 
Move to the next level at the preset level: Alt-Up arrow key 
Move to the previous level at the preset level: Alt-Down arrow key 
 
Move to the next heading: Ctrl-F6 
Move to the previous heading: Ctrl-F5 
Move to the first heading: Ctrl-F7 
Move to the last heading: Ctrl-F8 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n 
Find heading: Ctrl-f 
Find again: F3 
 
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
 
Move to the title list: Shift-Backspace 
Open daisy file: Ctrl-o 
Check the book-info: Alt-Enter 
Voice setting: Ctrl-s 
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21.11 Bluetooth Manager 
 
Scanning Bluetooth device: Ctrl-r 
Connecting device: Enter in the device name 
Connecting service: Enter in the service name 
Disconnect the service: Ctrl-d 
Move to Bluetooth device list in service list: Backspace 
 
1. FTP service 

Open local/remote folder: Ctrl-o 
Copy: Ctrl-c 
Paste: Ctrl-v 
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 
Delete file/folder: DEL 
Information: Ctrl-i 
 

21.12 Database Manager 
 
Add record: Ctrl-n 
Search records: Ctrl-f 
Modify record: Ctrl-m 
Table manager: Ctrl-t 
List of records found: Ctrl-r 
Setting backup option: Ctrl-e 
Backup database: Ctrl-u 
Restore database: Ctrl-o 
Print: Ctrl-p 
Save as: Alt-s 
 
1. Move by controls 

Move to the next control: Tab 
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Move to the previous control: Shift-Tab 
2. Move in a list box 

Move to the next list item: Down arrow key 
Move to the previous list item: Up arrow key 

3. Select your answer in the prompt box 
Move to the next answer: Space, or Down arrow key 
Move to the previous answer: Backspace, or Up arrow key 

4. Move in the “list of records found” 
Move to the next record: Down arrow key 
Move to the previous record: Up arrow key 
Move to the last record: Ctrl-end 
Move to the first record: Ctrl-home 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
Move to the last field: End 
Move to the first field: Home 

 

21.13 Extras 
 

21.13.1 Games  
1) Sense Dice Game 
Execute Dice Game: I  
Move to next item: Down arrow button or down scroll button 
Move to previous item: up arrow button or up scroll button 
Rolling dice: Enter 
Exit: Alt-F4 
 
2) Sense Brain Game 
Execute Sense Brain game:  A 
Move to next item: down arrow button or down scroll button 
Move to previous item: up arrow button or up scroll button 
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Execute game: Enter 
Exit: Alt-F4 
 

21.14 Social Networking 
 

21.14.1 Twitter 
 
Sign Out: Ctrl-g 
Personal Information: Ctrl-I  
Save Current Timeline: Alt-s 
Home Timeline: Ctrl-h  
Friend Timeline: Ctrl-f  
User Timeline: Ctrl-u  
Current User Timeline: Alt-u 
Mention Timeline: Ctrl-m  
Retweet By Me: Alt-b  
Retweet To Me: Alt-t  
Retweet Of Me: Alt-o  
Tweet: Ctrl-t  
Remove Tweet: Delete 
Retweet: Ctrl-e  
Reply: Ctrl-y  
Add To Favorite: Ctrl-v  
Favorite List: Ctrl-l  
Send Direct Message: Ctrl-s  
Sent Direct Message: Alt-m  
Received Direct Message: Alt-r  
Follow User: Alt-a  
Following: Alt-l  
Followers: Alt-e  
Global Search: Ctrl-f  
User Search: Alt-f  
Search Word List: Alt-w 
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Next List: Ctrl-n  
Refresh: Ctrl-r  
Exit: Alt-F4 
Escape: Esc key 
 
Move to the next tweet: Down arrow key   
Move to the previous tweet: Up arrow key 
Move to the first tweet on the refreshing list: Ctrl-Fn-Left arrow key 
Move to the last tweet on the refreshing list: Ctrl-Fn-Right arrow key 
Move to the previous 32 list: Fn-Un arrow key  
Move to the next 32 list: Fn-Down arrow key  
 
Move to the previous list: Up arrow key 
Move to the next list: Down arrow key 
Move to the top of the list: Ctrl-Fn-Left arrow key/Fn-Left arrow key 
Move to the bottom the list: Ctrl-Fn-Right arrow key/Fn-Right arrow key 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 
 

21.14.2 Google talk 
 
File Menu Commands 
Sign out: Ctrl-l  
Export Contact Lists: Alt-x  
Import Contact Lists: Alt-i  
Exit: Alt-F4 
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Send File: Alt-f  
Move to Recently Chat: Ctrl-t  
Manage Chat: Ctrl-m  
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Contact Menu Commands 
Add Contact: Alt-q  
Delete Contact: Delete 
Block Contact: Alt-b  
Manage Block List: Alt-m  
Contact Information: Ctrl-i  
Manage Contact List: Ctrl-p  
 
Option Menu Commands 
My Status Options: Alt-u  
Action Options: Alt-a  
Alert Options: Alt-o  
Path Options: Alt-p  
 
Chat Window Menus 
 
File Menu Commands  
Save Conversation: Alt-s  
Close Chat: Alt-F4 
 
Edit Menu Commands 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Delete  
Paste: Ctrl-v  
Start Selection: Ctrl-b  
Select All: Ctrl-a  
Find: Ctrl-f  
Find Again: F3  
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Stop Voice Chat: Esc key 
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Send File: Alt-f  
View Contact List: Ctrl-t  
Manage Chat: Ctrl-m 
Move to Previous Chat: Ctrl-Shift-Tab 
Move to Next Chat: Ctrl-Tab 
 
The move keys in Google Talk. 
Move to the previous Contents: Up arrow key  
Move to the next Contents: Down arrow key 
Move to the previous 32-items of the Contents: Fn-Up arrow key button 
Move to the next 32-item of the Contents: Fn-Down arrow key button 
Move to the first item of the Contents: Ctrl-Fn-Left arrow key 
Move to the last item of the Contents: Ctrl-Fn-Right arrow key 
 

21.14.3 MSN messenger 
 
1. Sign-in dialog box 
Move to the next control: Tab 
Move to the previous control: Shift-Tab 
Check or uncheck a check box: Space 
 
2. The contact list box 
Move to the previous item: Up arrow key 
Move to the next item: Down arrow key 
Move between online and offline groups: Ctrl-Down arrow key 
Open the menu: Alt 
Sign out: Ctrl-n 
View chat: Ctrl-r 
My status: Ctrl-m 
Exit: Alt-F4 
Add contact: Ctrl-a 
Delete contact: Ctrl-d 
Contact information: Ctrl-v 
Send instant message: Ctrl-s 
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Last message: Alt-r 
Play keyboard sound: Ctrl-k 
Message sound notification while in current window: Ctrl-Shift-s 
Message sound notification while messenger is in the background: Alt-m 
Nickname: Ctrl-p  
Save account: Ctrl-o 
Confirm the Received Message: Ctrl-l 
 
3. Instant message dialog box 
Move to the next control: Tab  
Move to the previous control: Shift-Tab 
Move between the instant message dialog box and the contact list box: 
Page up, Page down 
Save as: Alt-s 
Print: Ctrl-p 
Close: ESC 
Cut: Ctrl-x 
Copy: Ctrl-c 
Delete: Del 
Paste: Ctrl-v  
Select all: Ctrl-a 
Start selection: Ctrl-b or F2 
Find: Ctrl-f 
Find again: F3 
Invitation: Ctrl-i 
Change my status: Ctrl-t 
Line break in the message box: Ctrl-Enter 
 

21.15 Utilities 
 

21.15.1 Calculator 
 
Calculator initialize: Alt-c 
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Delete numbers or operators: Backspace 
 
General function: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q  
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p 
Exp: Ctrl-e 
 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d 
Save Items: Alt-s 
 
Trigonometric Function: Ctrl-s 
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h 
Cosine: Ctrl-c, c 
Arc Cosine: Ctrl-c, a 
Hyperbolic Cosine: Ctrl-c, h 
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h 
 
Logarithm Function: Ctrl-l 
Natural Logarithm: Ctrl-l, e 
Common Logarithm: Ctrl-l, n 
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Copy to Clipboard: Ctrl-Ins 
Option Setting: Ctrl-o 
Statistics function: Alt-t 
 

20.15.2 Display Compass Heading 
 
Open Display Compass Heading: Ctrl-shift-Space  
Move to the next control: Tab  
Move to the previous control: Shift-Tab 
Change compass display type: Backspace or Space 
Exit: Esc or Alt-F4 
 

21.15.3 Setting the Date and Time 
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 
Switch Between A.M. and P.M.: Ctrl-Shift-x 
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21.15.4 Checking the Date and Time 
 
Checking date and time: Ctrl-shift-t 
 

21.15.5 Calendar 
 
Move to the previous item: Tab 
Move to the next item: Shift-Tab 
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 

21.15.6 Pronunciation dictionary 
 
Move to the previous control: Tab 
Move to the next control: Shift-Tab 
Move to the previous item in entry: Up arrow key 
Move to the next item in entry: Down arrow key 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 
 

21.15.7 Stopwatch 
 
Stopwatch start, pause, restart: Enter 
Check the elapsed time: Space 
Stop Braille display: Ctrl-Shift-Space 



488 
 

Restart Braille display: Ctrl-Shift-Space 
Switch between stopwatch and countdown timer: Tab 
Count down timer pause or restart: Enter 
Count down timer Initialize: Backspace 
Exit stopwatch or countdown timer: Alt-F4 
 

21.15.8 Display Network Status 
 
Display network status: Ctrl-Shift-n 
 

21.15.9 Display power status 
 
Display power status: Ctrl-Shift-b 
 

21.15.10 Backup/Restore personalized settings 
 
Move to previous item: Up arrow key 
Move to next item: Down arrow key  
Move to previous control: Shift-Tab 
Move to next control: Tab 
Select/unselect check box: Space 
 

21.15.11 Upgrading Braille Sense U2 QWERTY Firmware 
 

  Check download information: Space 
Cancel download and exit: Alt-F4 
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22. Troubleshooting Guide 
If you are encountering problems with the Braille Sense U2 QWERTY, 
please take a look at the following suggestions for solving many common 
problems:  
 

22.1 The Braille Sense U2 QWERTY Will Not Turn On 
 
1. Check to make sure that the battery is inserted in to its compartment 
properly. 
2. If the battery is inserted properly, connect the AC adapter, and plug the 
AC adapter in to an electrical outlet. The battery may need to be charged. 
3. Or, Check the location of the keyboard lock switch. If this switch is placed 
in the "lock" position, the power switch is not functional. 
 

22.2 The Voice Cannot Be Heard 
 
1. Make sure the volume is loud enough to be heard. Press "F6" to raise the 
volume. 
2. Make sure the voice is turned on. Press "F5" to toggle the voice on/off. 
 

22.3 The Voice is Too Fast to Understand 
 
1. Press "Shift-F7" to lower the voice rate. 
 

22.4 The Voice Pitch Is Too Low or Too High to 
Understand 

 
1. Press "Shift-F8" to lower the pitch, or press "F8 to raise the pitch of the 
voice. 
 

22.5 You Don't Know Where You Are 
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1. If you have become disoriented as to your location on the Braille Sense 
U2 QWERTY, and cannot remember where you are, press "Win key" to 
access the "program" menu. Then, press "Alt-Tab" to switch among the open 
programs. If you are in the Word Processor, pressing "Fn-s" gives you your 
current location in the open document. 
 

22.6 No Internet Connection 
 
1. If you are using a LAN connection, make sure that the Ethernet cable is 
connected and that the Ethernet port is turned on in "Global Options". 
2. If you are using a modem, make sure that the phone line is connected to 
the modem. 
3. If you are using a DSL connection, make sure that the Ethernet cable is 
connected and that the Ethernet port is turned on in "Global Options". 
4. If you are using a Wi-Fi connection, ensure wireless is turned on. Use 
"F11" to toggle wireless on/off.  
 

22.7 Email 
 
1. If you are having trouble downloading email, please contact your Internet 
service provider to make sure that you have the correct POP3 and SMTP 
settings. 
2. If you cannot send or receive mail, make sure you have an active 
connection to the Internet. 
 

22.8 The Braille display Does Not Display Braille 
 
1. If the Braille display does not display Braille, make sure that the Braille 
display is turned on. Use "F4" to toggle the Braille display on/off. 
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22.9 The Braille Sense U2 QWERTY Does Not 
Respond 

 
1. If the Braille Sense U2 QWERTY does not respond to keystrokes or 
commands, it may be necessary to reset the unit. To reset the Braille Sense 
U2 QWERTY, press the reset button on the rear panel, or press "1-2-3-4-5-
6-F2-F3." Do NOT hold the reset button for more than 5 seconds. 
2. If pressing the "Reset" button does not revive the Braille Sense U2 
QWERTY, you may need to perform a hard reset. Press and hold the 
"Forward" button on the front media panel. (This button is the right-most 
button in the media group and looks like a right arrow.) While holding 
"Forward", quickly press and release the "Reset" button. Continue to hold the 
"Forward" button until the unit revives (this should occur within 30 to 45 
seconds).  
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23. Accessories 
 
For information on available accessories for the Braille Sense U2 QWERTY, 
please contact HIMS Inc. You can contact HIMS by e-mail at sales@hims-
inc.com. Or, contact the HIMS Sales department by phone at 888-520-4467. 
You can also visit HIMS on the web at www.hims-inc.com. 
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24. Obtaining Support  
 
If you are having problems with your Braille Sense U2 QWERTY, please 
contact Hims, Inc. technical support. E-mail us at support@hims-inc.com. Or, 
contact the HIMS Technical Support department by phone at 512-837-2000. 
To obtain the most recent documentation, tutorial, and software downloads, 
please visit our website at www.hims-inc.com. Navigate to the "Resource 
Center" and to the Braille Sense U2 QWERTY product page for the most up-
to-date product-related information and software for your Braille Sense U2 
QWERTY. 




